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Appunto agli appunti 
Utilizzando Clip Studio Paint (CSP) talvolta incontro delle difficoltà o banalmente dimentico come si 

fanno anche le cose più semplici. Per questo raccolgo via via le soluzioni che trovo a particolari problemi, da 
solo o con l'aiuto principalmente del gruppo Facebook Clip Studio Paint Italia, del Manuale del programma, 
di alcuni forum o di blog di qualche utente, anche straniero. 

 

Questi appunti non sono una traduzione del Manuale (se non in alcune piccole parti) ma piuttosto un 
insieme di piccoli tutorial passo-passo e di spiegazioni di argomenti a volte poco chiari. Alcune cose, 
specialmente quelle che cronologicamente ho scritto prima, sono un po' banali, poiché dovevo ancora 
imparare l'ABC del programma, altre per me rappresentano delle vere conquiste nella sua comprensione. 

Sono delle note nate per mia consultazione, un lavoro in corso costantemente aggiornato e modificato; 
ho deciso di condividerle perché alcuni lamentano la mancanza di documentazione per CSP in italiano e, nel 
loro piccolo, questi appunti sono un po’ di documentazione.  

Non hanno la pretesa di essere esaustivi, ma credo possano essere d'aiuto. Per quelle cose che ho preso 
pari pari da siti o blog in inglese (col copia e incolla) ho approntato una traduzione (di sicuro migliorabile). 

 

L'ordine degli argomenti era inizialmente casuale; un po’ alla volta, dal caos iniziale ho cercato di 
raggruppare argomenti affini o collegati. Ho inserito poi un sommario e un indice analitico che possono 
aiutare la ricerca a colpo d'occhio; cliccando su una voce del sommario si viene portati direttamente alla 
pagina corrispondente. 

Cerco di riportare sempre le fonti quando l'origine di quanto scritto non è mia (nome del blogger; di chi 
ha posto una data domanda sul gruppo Facebook e di chi è riuscito a trovare la risposta e talvolta anche il 
collegamento proprio al post; siti in cui ho trovato chiarimenti ai miei dubbi; ecc.), per poterli ritrovare in 
caso di necessità. Non l'ho fatto fin dall'inizio, per cui mi scuso se mi è sfuggito qualcosa. Si trovano anche 
alcune cose che sembrano senza senso (non per me, però); d'altra parte, ripeto, questa è la condivisione di 
una cosa nata per mio uso e consumo. Comunque qualcuna non la capisco manco io. 
 

Sto un po’ alla volta eliminando i riferimenti diretti ai numeri di pagina del Manuale, poiché gli stessi 
argomenti vengono trattati in pagine diverse per le varie release del programma, ed è impossibile 
aggiornare tutto ogni volta. Non solo: da release a release una stessa caratteristica talvolta cambia di nome 
pur continuando a svolgere la stessa funzione, cosicché si può trovare un riferimento, che ho scritto nelle 
stesure precedenti, a una funzione che non ha più lo stesso nome. Cerco di controllare, ma spesso non me 
ne accorgo.  

Al posto dei numeri delle pagine, indico spesso i titoli dei capitoli o dei paragrafi in cui un certo 
argomento è trattato, cosicché basta cercarli sul Manuale. Dato che anche i titoli cambiano, suggerisco di 
fare le ricerche sul Manuale anche per parole chiave. 

 

L’edizione di riferimento di CSP in questi appunti è la EX, quella che possiedo, con Windows 10 come 
sistema operativo (di recente sono passato a Windows 11, ma tutto è come prima). Alcune funzioni non 
sono disponibili nelle edizioni DEBUT e PRO; per le differenze tra le varie versioni vedi più sotto.  

Se si sente il bisogno di funzioni trattate qui ma non presenti nel proprio CSP, allora è il momento 
dell’upgrade! 

 

Esistono le versioni di CSP per macOS,  iPad,  iPhone, Galaxy, Android, Chromebook. Per problemi 
strettamente legati a questi dispositivi, invito a cercare sul sito Celsys o a fare una ricerca nel gruppo 
Facebook Clip Studio Paint Italia. Per informazioni su piani di abbonamento a CSP (al posto dell’acquisto 
una tantum, o One-Time come indicato nel sito), leggi più sotto e consulta anche le fonti appena citate. 

 

Dalla v.2 degli appunti aggiungo dei commenti lì dove le spiegazioni non frutto del mio sacco mi 
sembrano un po' carenti. Mi è successo soprattutto traducendo quelle parti prese da blog o forum in 
inglese in cui spesso il discorso viene liquidato velocemente, forse dando per scontato che l'utente sappia 
già di cosa si stia parlando. I commenti aggiunti sono inseriti in parentesi quadre e formattati in corsivo; a 
volte ho aggiunto la dicitura  - N.d.M. = Nota di Matt , es.: [commento - N.d.M.]. 

Uno o più asterischi rossi (* o **) rinviano a brevi puntualizzazioni al termine dello stesso paragrafo. 
 

https://www.facebook.com/groups/mangastudioitalia/
https://www.clipstudio.net/en/purchase/?fbclid=IwAR2gdUwYrgaVwmo3qWTrFku8_4WXeWGfPGknG690qZnkLS_KHsy7tJqt6so
https://www.facebook.com/groups/mangastudioitalia/
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Spesso introduco degli acronimi per evitare di dover scrivere per esteso molte volte le stesse parole 
all’interno di un paragrafo; capita poi che riprenda tali acronimi in altre parti degli appunti. La prima volta 
che uso un acronimo lo scrivo di seguito alle parole usate per formarlo, per stabilirne la corrispondenza, es. 
“… secondo tasto laterale, STL, ...”, oppure “… Sweet Home 3D (SH3D), …”. 

 

Talvolta uso queste abbreviazioni: tx (= tasto), dx (= destro), sx (= sinistro), px (pixel), ~ (circa), ≠ (diverso 
da), prox (prossimo/prossima). 

 

All’interno degli appunti ci sono dei riferimenti ad altre parti degli appunti stessi; generalmente ho 
inserito dei collegamenti ipertestuali colorati  in azzurro (così), che riportano il titolo del paragrafo a cui 
rinviano o al numero di un’immagine o un generico “più sopra/più sotto”. Basta cliccarli per essere 
teletrasportati alla pagina relativa.  

Analogamente, sono presenti link ad articoli, post, a risorse varie ecc. che trattano l’argomento 
approfondito nel paragrafo in cui sono inseriti. Cliccandoli, si apre il proprio browser internet verso la 
risorsa di interesse. 

 

Ci sono pochi collegamenti a videotutorial, essenzialmente perché, anche se mi capita di guardarne, 
faccio fatica a seguirli; preferisco di gran lunga la spiegazione scritta, che posso scaricare ed eventualmente 
modificare/integrare se vedo che non mi soddisfa, ecc.  

 

Nel mio CSP l'Operation tool si chiama Select, non so per quale motivo. Pertanto può capitare che 
talvolta mi riferisca all’Operation tool con Select; potrei cambiargli il nome, ma ormai ci sono abituato. 
 

Infine, con CSP è possibile creare e gestire delle animazioni. Non ho mai affrontato queste sue 
funzionalità, per cui in questi appunti non ci sono riferimenti a problematiche, comandi o strumenti 
direttamente legati all'animazione.  

 
dicembre 2022 Matt 
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Informazioni generali 

 Clip Studio Paint  (CSP) è il programma di disegno digitale sempre più diffuso tra professionisti e non 
dell'illustrazione e del fumetto. Creato dalla casa giapponese CelSys, è stato commercializzato in occidente 
dalla Smith Micro con il nome di Manga Studio (MS) fino alla versione 5.0.6. In seguito MS è stato chiamato 
CSP anche in occidente e la versione corrente (a dicembre 2022) è la 1.12.8; la differenza di numerazione 
(MS v.5 ≠ CSP v.1) è dovuta al fatto che non c'era corrispondenza nominale tra la versione di MS e quella di 
CSP.  

CSP è potente, versatile e relativamente economico; inoltre, almeno una volta l’anno (generalmente 
intorno all'inizio dell'autunno o in occasione del Black Friday) CelSys mette in offerta il programma con 
sconti davvero importanti. 

Clip Studio Paint, Clip Studio, Clip Studio Modeler  

Dalla versione 1.6.2, con l'installazione Clip Studio Paint viene installato anche un altro programma, Clip 

Studio   (CS), che viene definito come portal application, ossia uno strumento di servizio di Celsys per 
CSP che opera via Internet. È diviso in varie sezioni, la più utilizzata delle quali è sicuramente quella degli 
Assets (= risorse): una specie di magazzino specializzato che contiene i più svariati materiali che si possono 
scaricare e su cui si possono caricare i propri. Per materiali vengono intesi anche i pennelli e altro (vedi pag. 
226).  

Ma forse la più importante delle sezioni di CS è quella che permette il backup in cloud delle impostazioni 
del programma e dei materiali. Se si deve formattare il computer o se si vogliono tenere allineate due 
macchine, è decisamente utile. Guarda anche questo post. 

Dalla versione 1.8.0 è infine possibile scaricare da Clip Studio il programma Clip Studio Modeler  
(CSM), che serve a realizzare modelli 3D (o importarli da altri programmi 3D) per poterli poi utilizzare in 
CSP. 

Manuale, Tool Settings Guide e Startup Guide 

Nella pagina di download del programma (questa) ci sono anche dei link al Manuale (Instruction 
Manual) e alla Tool Settings Guide; non mi sono accorto quando l’hanno rimossa, ma fino a qualche 
versione fa c’era anche la Startup Guide (l’ultima versione che ho io è della v. 1.9.3 del programma), che è 
ancora presente sul sito ma per raggiungerla bisogna avere il link corretto. Manuale e Tool Settings Guide 
sono presenti sia come pagine HTML che come .pdf da scaricare; della Startup Guide si trova solo la 
versione HTML. 

Il Manuale è, come per altri software, appunto il libretto delle istruzioni del programma; la Tool Settings 
Guide approfondisce le impostazioni degli strumenti; la Startup Guide spiega alcuni concetti di base per 
approcciarsi all’uso di CSP.  

Va da sé che fare riferimento a queste tre guide quando si incontrano dei problemi sarebbe d’obbligo. 
Alla fine di questi appunti, tra i link utili (più sotto), metto i collegamenti diretti alle versioni HTML delle tre 
guide (anche la Startup Guide). 

Quando CSP viene aggiornato, non sempre lo sono le tre guide. Capita così che, ad es., un Manuale 
possa servire per versioni successive del programma. Basta controllare nella pagina di download: se la 
versione del Manuale è per una versione precedente di CSP allora ovviamente si deve fare ancora 
riferimento a questa. 

C’era anche un altro documento che ormai si è perso nel tempo, l’Install Guide. Francamente, non so 
quando abbiano smesso di pubblicarlo; probabilmente i suoi contenuti sono stati accorpati al Manuale. 

 
 
 

  

https://it.wikipedia.org/wiki/Black_Friday_(shopping)
https://www.facebook.com/groups/mangastudioitalia/permalink/1522936914483970/
https://www.clipstudio.net/en/dl/
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Domande frequenti 
Le risposte a molte di queste domande si trovano anche sparse all’interno di questi appunti, alcune in forma un po’ 

più approfondita. Le raggruppo qui in caso serva una consultazione rapida. Molte di queste sono anche tra le 
domande che vengono poste più spesso nel gruppo Facebook Clip Studio Paint Italia; ovviamente l’elenco è 
incompleto. 
 

Acquisto e installazione 
Quanto segue è relativo alla v.1.x.x di CSP; nella prima metà del 2023 uscirà la versione 2.0.  
Ho approfondito un po’ solo la seconda domanda, in base ai dati che si hanno al momento dell’annuncio 

dell’uscita della nuova versione. 
 

Dove posso acquistare CSP? 
Da questa pagina si possono acquistare le varie edizioni di CSP o effettuare l’upgrade. 
 

Una volta  comprato è per sempre o è come un abbonamento, da rinnovare ogni tot di tempo? 
V. 1.x.x One-time fino al rilascio della v. 2.0 
Se si compra la versione per PC o Mac (acquisto One-time, valida per due macchine anche con 

sistemi operativi differenti), l’acquisto vale per sempre e per tutti i successivi aggiornamenti, fino 
al rilascio dell v. 2.0 (marzo 2023) .  

 

Chi ha comprato CSP nel 2022, avrà gratuitamente l’aggiornamento alla v.2.0 . 
Chi ha già la v.1.x.x, avrà uno sconto per passare alla v.2.0; il passaggio costerà 19,99 $per la 
versione PRO, 56,99 $ per la versione EX. Vedere anche qui. 
 

Con la v.2.0 il supporto gratuito per nuove funzioni per la v. 1.x.x cesserà, ma rimarrà quello 
per bug o errori dipendenti dal sistema operativo (contrariamenta a quanto annunciato 
inzialemte, sarà così anche dopo il rilascio della v.3: in sostanza, credo che intendano fino al 
rilascio della v.4). 

Sarà però possibile tenere aggiornato CSP all’ultima versione acquistando annualmente un 
Update Pass. Se non si rinnova l’Update Pass, sarà possibile tornare a utilizzare la v.1.x.x 
posseduta prima dell’update. L’Update Pass potrà essere acquistato anche dopo la scadenza del 
rinnovo per tornare ad avere le funzionalità complete; in ogni caso sarà possibile continuare a 
utilizzare la versione 1.x.x indefinitamente. 

 

V. 2.0, annunciata a marzo 2023 
Celsys ha annunciato che a marzo 2023 verrà rilasciata la versione 2.0 del programma;  
 

La politica di acquisto, al momento, sembra che sarà diversa: 
- acquistare ex-novo la v. 2.0 con una versione One-time, ora definita sul sito perpetual 

version (vedi qui); la versione PRO costerà 49,99 $, la versione EX 219,00 $. Vedi anche qui. 
 

Chi ha comprato CSP nel 2022, avrà gratuitamente l’aggiornamento alla v.2.0 . 
Chi ha già la v.1.x.x, avrà uno sconto per passare alla v.2.0; il passaggio costerà 19,99 $per 
la versione PRO, 56,99 $ per la versione EX. Vedere anche qui. 
 

Per ottenere gli aggiornamenti successivi alla versione 2.0 (ossia 2.1, …., 2.x.x) sarà 
necessario acquistare annualmente un Update Pass, tranne che per gli aggiornamenti 
relativi a bug, che continueranno a essere gratuiti; l’Update Pass annuale costerà per la 
versione PRO 9,99 $, per la versione EX 28,99 $; per altri costi vedere qui. 
 

Dal rilascio della futura v. 4.0, verrà cessato ogni supporto anche per la v. 2.x.x . 
 

- se già possessori della v. 1.x.x, acquistare annualmente gli Update Pass, che garantiscono 
tutti gli aggiornamenti. Secondo Celsys, è la modalità raccomandata, dato che è chiaro che, 
in futuro, CSP sarà utilizzabile solo così o con abbonamento mensile (Monthly Usage Plan). 
Se non si rinnova l’Update Pass, sarà possibile tornare a utilizzare la v.1.x.x; l’Update Pass 
può essere acquistato anche dopo la scadenza del rinnovo per tornare ad avere le 
funzionalità complete; 
 

- se utilizzatori dell’abbonamento mensile (Monthy Usage Plan), non cambia nulla: 
continuando a pagare l’abbonamento, si riceveranno gli aggiornamenti disponibili. 

https://www.facebook.com/groups/mangastudioitalia
https://www.clipstudio.net/en/purchase/
https://www.clipstudio.net/en/news/202210/13_01/#02
https://www.clipstudio.net/en/news/202208/22_01/?fbclid=IwAR0nFXE4eFT93KhTZ9UtpYkSplJ699qjVHRBTFWZyj9Yf9O53Xh2Kjneg9A
https://www.clipstudio.net/en/news/202210/13_01/#02
https://www.clipstudio.net/en/news/202210/13_01/#02
https://www.clipstudio.net/en/news/202210/13_01/#02
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In futuro sarà possibile acquistare le successive versioni “perpetual” (fino a quando saranno 
prodotte), ottenendo CSP allo stato dell’arte al momento della loro uscita. Anche per queste 
versioni, per avere il programma sempre aggiornato, bisognerà acquistare l’Update Pass annuale. 

 

Licenze in abbonamento 
Al momento si può anche acquistare una licenza in abbonamento valida per un solo 

disposititivo (Win, macOS, iPad, iPhone, Galaxy, Android o Chromebook), oppure fino a due 
dispositivi, fino a quattro dispositivi  o per un singolo smartphone (iPhone, Galaxy o Android), con 
possibilità di pagamento mensile o annuale. Qui si possono vedere le varie combinazioni e il loro 
prezzo.  

Per chi ha già una versione One-time (a esempio una EX per PC/Mac) esiste una scontistica 
dedicata se si vuole avere il programma anche su altri dispositivi, vedi qui.  

In futuro, con l’uscita delle nuove versioni, questo sistema garantirà di avere il programma 
sempre aggiornato senza dover acquistare nulla, se non l’abbonamento, appunto. 

 

Quanto costerà la v.2.0? 
Acquisto One-time: 
 Acquisto ex-novo della v.2 Upgrade dalla v.1 alla v.2 Update Pass annuale 
PRO 
EX 

49,99 US$ 
219,00 US$ 

19,99 US$ 
56,99 US$ 

9,99 US$ 
28,99 US$ 

 

Abbonamenti, per un solo dispositivo: 
 Mensile Annuale 
PRO 
EX 

  4,49 US$ 
8,99 US$ 

24,99 US$ 
71,99 US$ 

 

Il costo in € dipende dal cambio al momento dell’acquisto. Per altre informazioni sui costi, vedi 
qui. 
 

Ho visto che c’è un aggiornamento disponibile: è a pagamento? 
No. Al momento e fino all’uscita della versione 2.0 (marzo 2023), gli aggiornamenti del 

programma non si pagano; basta scaricarli dalla pagina di download e installarli.  
Quando uscirà la v. 2.0 le cose però cambieranno, vedi domande precedenti. 
 

Se ho l’edizione PRO e voglio passare alla EX devo pagare il prezzo intero? 
No, per il passaggio dalla PRO alla EX (o dalla DEBUT alla PRO) esistono degli sconti, consultabili 

qui (scendi fino a Discounted Upgrade from PRO to EX oppure Discounted Upgrade from DEBUT to 
PRO).  

 

Si può installare CSP su più di un computer? 
Sì, con l’acquisto One-Time (PC o Mac, vedi qui) CSP si può installare al massimo su due 

computer, anche con sistemi operativi diversi, utilizzando lo stesso serial e non usando i due CSP 
contemporaneamente (se collegati a Internet). 

Utilizzando CSP su una terza macchina (un nuovo PC, ad esempio), bisogna disattivare la 
licenza su una delle altre due. Se non lo si fa, dovrebbe apparire un messaggio nel nuovo 
computer, con  le istruzioni per disattivare la licenza in eccesso. Vedi anche questo post. 

Con i piani in abbonamento, il numero di dispositivi in cui si può installare va da uno fino a 
quattro (tra Win, macOS, iPad, iPhone, Galaxy, Android o Chromebook): vedi qui e qui, leggi 
questo post. 

 

Ho cambiato/formattato il PC: posso installare CSP nuovamente o la licenza non è più valida? 
Installando CSP su un nuovo PC (o dopo averlo formattato), bisogna disattivare la licenza 

eventualmente in eccesso, se presente su più di due macchine (vedi domanda precedente). Se 
non lo si fa, dovrebbe apparire un messaggio nel nuovo computer, con  le istruzioni per disattivare 
la licenza in eccesso. Vedi anche questo post, in cui è spiegato che effettuando il login prima di 
inserire il codice di attivazione, il programma riconosce che si è in possesso della licenza valida. 

 

 

https://ec.clip-studio.com/en-us/application/plans?transitionSourceUrl=https://www.clipstudio.net/en/purchase/
https://www.clipstudio.net/en/lineup/#specialoffers
https://www.clipstudio.net/en/news/202210/13_01/#02
https://www.clipstudio.net/en/purchase/?fbclid=IwAR21edIM8WKYyWguJHsQnKus7czh_FEkNSU0hl1DhsQforZDiuT1L5suV6E
https://www.clipstudio.net/en/purchase/
https://www.facebook.com/groups/mangastudioitalia/permalink/3937704073007230
https://ec.clip-studio.com/en-us/application/plans?transitionSourceUrl=https://www.clipstudio.net/en/purchase/
https://ec.clip-studio.com/en-us/help#plan_list
https://www.facebook.com/groups/mangastudioitalia/permalink/3376888895755420
https://www.facebook.com/groups/mangastudioitalia/permalink/3937704073007230
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Quali differenze ci sono tra le edizioni DEBUT/PRO/EX? 
Le differenze tra le edizioni  riguardano essenzialmente la possibilità di creare file multipagina, 

la possibilità di convertire modelli 3D in 2D e di creare animazioni superiori a 24 fotogrammi 
(possibili con la EX).  La Debut inoltre non permette di disegnare in vettoriale e di personalizzare 
gli strumenti.  

Non vorrei sbagliare, ma credo che la DEBUT sia la versione che si trova talvolta in bundle 
quando si acquista una tavoletta grafica; in effetti, in vendita sul sito Celsys si trovano solo la PRO 
e la EX, e gli upgrade da una versione all’altra (almeno credo: non ho trovato in vendita la DEBUT 
sul sito). 

Per una lista generale delle differenze guarda qui, per una lista dettagliata guarda qui (in 
inglese). 

 

Quale versione di Clip Studio Paint possiedo? 
L’edizione di CSP in uso (DEBUT/PRO/EX) appare sempre nella Title bar (vedi Fig.  4); se si vuole 

sapere il numero della release andare in Help > Version information… 
 

Come faccio a sapere che è uscita una nuova release? 
Quando esce una nuova versione di CSP, all’avvio del programma appare un avviso. Basta 

cliccarci sopra per far aprire CS, poi seguire il link giusto. Oppure vedi la prossima domanda. 
 

È uscita una nuova release, come si fa l’aggiornamento? 
Vado sulla pagina di download del programma (questa), clicco sul pulsante del sistema 

operativo desiderato, scarico il programma e lancio l’installazione. Non occorre disinstallare la 
vecchia versione; tutte le impostazioni vengono mantenute. 

 

Dopo un aggiornamento è sparita l’icona di CSP. Cosa devo fare per farla riapparire? 
Tasto destro sull'icona a desktop di Clip Studio > Proprietà > Apri percorso file. Così facendo ci 

si ritrova nella cartella di installazione di CS, CLIP STUDIO. Salire di una cartella, arrivando alla 
cartella CLIP STUDIO 1.5. Entrare nella cartella CLIP STUDIO PAINT, dove si trova l'eseguibile di 
CSP. Tasto destro > Invia a >  Desktop (crea collegamento). 

 

Recuperare i dati 
A causa di un black-out o di un crash ho perso ore di lavoro; c’è modo di recuperare i miei file? 

Per tentare di recuperare i file si può andare nella cartella (nel PC, in Mac credo esista qualcosa 
di molto simile): 

C:\Utenti\nomeutente\AppData\Roaming\CELSYSUserData\CELSYS\CLIPStudioPaintData; 
all’interno di quest’ultima si trovano tre cartelle: DocumentBackup, InitialBackup, 
RecoveryBackup; all’interno di queste cartelle si dovrebbero trovare gli ultimi salvataggi dei file 
cercati. Senza dover impazzire a scrivere percorsi, la stessa destinazione è facilmente raggiungibile 
da CS, cliccando Settings > Maintenance Menu > Open folder with Clip Studio Paint backup data 
(l’ho scoperto da poco grazie a questo post) : 

 

 
Fig.  1 

Attenzione: la posizione di queste cartelle è cambiata con le ultime versioni del programma, 
credo dalla v. 1.10.13. Nelle versioni precedenti il percorso era: 

 C:\Utenti\nomeutente\Documents\CELSYS\CLIPStudioPaintData 

https://dizionari.corriere.it/dizionario_italiano/B/bundle.shtml
https://www.clipstudio.net/en/purchase/
https://support.clip-studio.com/en-us/faq/articles/20200186
http://www.clipstudio.net/en/functional_list
https://www.clipstudio.net/en/dl/
https://www.facebook.com/groups/mangastudioitalia/permalink/5297650167012607
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C’è una funzione di salvataggio automatico? 
Sì, per abilitarla andare in File > Preferences > File, mettere  la spunta a Enable Canvas recovery 

e impostare l’intervallo di tempo X adeguato tra i salvataggi con Save recovery data every: X > 
minutes. Vedi anche più sotto. 

 

Aspetto 
Per errore ho cambiato la disposizione delle finestre, come posso tornare alla configurazione di 

default? 
Vado su  Window > Workspace > Reset to Default. In alternativa, avviare il programma tenendo 

premuto il tasto Shift: così facendo  appare una finestra da cui è possibile ripristinare il workspace 
di default e altro (attenzione: altri workspace eventualmente registrati verranno cancellati). 

 

È scomparso uno strumento, come faccio a farlo tornare? 
Vado nel menù della barra degli strumenti (in altro a sinistra sulla tool palette), seleziono Add 

from default…, seleziono lo strumento da ripristinare e do l’OK.  In alternativa, avviare il 
programma tenendo premuto il tasto Shift: così facendo  appare una finestra da cui è possibile 
ripristinare gli strumenti e altro. 

 

Le icone sono troppo grandi, posso portarle a una dimensione meno invadente? 
da un post di Rossana Stanganello nel gruppo FB Clip Studio Paint Italia 

Dopo un aggiornamento o dopo aver installato il programma in un altro computer, può 
capitare che l’interfaccia si mostri con le icone molto grandi e apparentemente non ci sia nessun 
comando per regolarne le dimensioni. 

Cercando tra le FAQ, qui si scopre che anche altri utenti sono incappati nel problema. 
La soluzione si ottiene andando in File > Preferences… > Interface > Touch operations;  mettere 

la spunta a Adjust interface for touch operations e selezionare Default.  
Attenzione: riavviare CSP, sennò la modifica non viene applicata. 
Attenzione 2: cambiando le impostazioni in Touch Operations si resetta anche il workspace 

utilizzato. Prepararsi quindi a un’eventuale rottura di scatole per ripristinare le proprie 
impostazioni; purtroppo non serve a nulla scegliere il proprio workspace in Window > Workspace. 

Attenzione 3: il percorso descritto esiste per PC, in Mac questa opzione non c’è (vedi questo 
post). 

 

È sparita l'icona di Clip Studio Paint! 
Installando la v. 1.6.8, sul desktop è rimasta solamente l'icona di CS: lanciando CS si può poi 

avviare CSP da lì. Tuttavia a me questa cosa non piace, preferisco avere l'icona di CSP sul desktop 
e lanciarlo senza dover aprire CS. Nel caso sparisca l’icona di CSP, o se si vuole lanciare il 
programma separatamente da CS, è possibile estrarre l'icona di CSP nel seguente modo: 

- tasto destro sull'icona a desktop di CS > Proprietà > Apri percorso file. Così facendo ci si 
ritrova nella cartella di installazione di CS, CLIP STUDIO. Salire di una cartella, arrivando alla 
cartella CLIP STUDIO 1.5. Entrare nella cartella CLIP STUDIO PAINT, dove si trova l'eseguibile di 
CSP. Tasto destro > Invia a >  Desktop (crea collegamento).  
 

Con l'aggiornamento alla v. 1.7.1 non è sparita nessuna icona. 
 

Perché quando esporto c’è sempre dello spazio attorno, più grande della mia pagina? 
Al momento dell’esportazione bisogna decidere cosa, della pagina in lavorazione, esportare. Il 

parametro della finestra Export settings che regola “quanta” pagina esportare è Export range. A 
seconda dell’opzione scelta verrà esportato il Canvas intero, la pagina più il bleed o la pagina 
effettiva. Vedi più sotto. 

 

Le immagini in questi appunti non corrispondono a quello che vedo nel mio CSP: perché? 
Con la versione 1.9.5 rilasciata a dicembre 2019 l’aspetto di CSP è stato livemente modificato, 

introducendo delle icone più stilizzate, un ambiente più scuro e più contrastato. Sostanzialmente 
però non è cambiato nulla, quindi negli appunti ho lasciato per lo più le immagini che ho 
realizzato nel momento in cui li ho scritti.  

Non ho ricontrollato ancora tutto, può essere che non ci sia un perfetto allineamento tra la 
versione attuale e le precedenti, soprattutto per quel che riguarda il nome dato alle varie funzioni 

https://www.facebook.com/photo.php?fbid=1395650657275997&set=gm.2409967935780859&type=3&theater&ifg=1
https://ask.clip-studio.com/en-us/detail?id=6382&fbclid=IwAR1dtIvVfxUsVuz0jQTj932zvbORSkUOsV2Q3ux4RHI3V2r2xb2l0QUxgPE
https://www.facebook.com/groups/mangastudioitalia/posts/3861315127312792/?comment_id=3861370167307288&reply_comment_id=3861485980629040&notif_id=1624439361080971&notif_t=group_comment&ref=notif


Appunti di Manga Studio/ClipStudioPaint   

19 

o l’aspetto di qualche icona: ad esempio, quando si esporta un’immagine, un parametro che si 
può modificare è, nella versione 1.9.5, l’Export range; in precedenza lo stesso parametro si 
chiamava Output range. 

Pochi giorni dopo il rilascio della 1.9.5 è stata rilasciata la 1.9.7, con alcune piccole modifiche 
(ad esempio l’icona dello strumento Gradient è stata modificata da circolare a quadrata): capita 
spesso che dopo una release ne segua immediatamente un’altra. In questo caso non mi sono 
neanche accorto della 1.9.6, se mai c’è stata… (la 1.9.5 è del 5 dicembre, la 1.9.7 del 19).  

Un po’ alla volta, man mano che tornerò a revisionare gli argomenti, aggiornerò le immagini. 
 

 
Fig.  2 – Interfaccia fino alla versione 1.9.4 

 

 
Fig.  3 – Interfaccia dalla versione 1.9.5 

 

Posso salvare un  workspace diverso da quello di default? 
Sì, si può salvare la configurazione di un workspace in Window > Workspace > Register 

Workspace…, dopodiché il workspace salvato sarà disponibile nell’elenco visibile in Window > 
Workspace e selezionabile all’occorrenza. 

 

Posso installare il mio workspace su un’altra macchina? 
Sì, si può  registrare come material da Window > Workspace > Register workspace as material 

e, ad esempio, pubblicarlo sugli Assets. Sull’altra macchina si può poi scaricare dagli Assets e 
installarlo. 

 

Funzionalità 
Vorrei usare un certo font: ce n’è uno simile in CSP? 

CSP utilizza i font presenti nel sistema operativo, non ne ha di propri. Per utilizzare un font in 
particolare bisogna installarlo nel proprio S.O. 

 

Posso usare il cellulare come periferica di input mentre lavoro al PC?  
Certo, installando CSP sul proprio smartphone e utilizzandolo in modalità Companion, è 

possibile utilizzare il cellulare come una sorta di telecomando, per molte funzioni. Usare CSP nel 
cellulare in Companion mode non comporta licenze aggiuntive. Vedi anche più sotto. 

 

Posso esportare o salvare il mio file come Tiff multilayer? 
No. Al momento non è possibile; per esportare i livelli bisogna esportare in .psd e da 

Photoshop esportare poi in .tif . Vedi anche qui e qui. 
 

Con la tavoletta grafica 
Usando la tavoletta grafica con display integrato, il cursore non è allineato alla penna. Che si fa? 

Problema riportato da più utenti 

Spesso viene segnalato il non allineamento tra il punto dove si tocca lo schermo della tavoletta 
grafica con la penna e il punto dove si trova il cursore. Viene anche riportato che succede solo con 
CSP, mentre con altri programmi è tutto normale. Provare ad andare in File > Preferences > Tablet 
e cambiare l’impostazione da Wintab a Tablet PC o viceversa. Se non funziona, provare a 
reinstallare il driver della tavoletta. 

 

I pennelli non rispondono alle variazioni di spessore impostate. Che fare? 
Provare ad andare in File > Preferences > Tablet e cambiare l’impostazione da Wintab a Tablet 

PC o viceversa. Se non funziona, provare a reinstallare il driver della tavoletta. 
 

 

https://www.facebook.com/groups/mangastudioitalia/permalink/4900783163365978
https://www.facebook.com/groups/mangastudioitalia/permalink/3312684068842570
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Non mi appaiono le finestre di dialogo (es. Preferences) - Non funziona la penna sulla tavoletta. 
Che faccio? 

Problema che mi è capitato: ho installato i nuovi driver della tavoletta grafica ma hanno in 
qualche modo interferito con i driver della scheda grafica del PC, cosicché non riuscivo a 
impostare una risoluzione adeguata sia al monitor che alla tavoletta. Allora ho installato (già che 
c’ero) l’aggiornamento anche dei driver della scheda grafica. Ho impostato il monitor a 1920x1080 
e la tavoletta a 3840x2160.  

Sembrava tutto a posto ma, utilizzando CSP, non riuscivo a utilizzare la penna sulla tavoletta: 
mostrava un puntino sotto alla punta, segno che veniva rilevata, ma non appariva la sagoma dello 
strumento che volevo utilizzare (in genere utilizzo questa visualizzazione del cursore).  

Ho pensato a un problema risolvibile con la modifica dell’impostazione Tablet, come nel 
paragrafo precedente, ma andando ad attivare File > Preferences non mi appariva la relativa 
finestra. Mumble-mumble… Pensando a qualche scherzo con la risoluzione, ho portato quella 
della tavoletta a 1920x1080, e così mi è apparsa la finestra Preferences sul monitor: era nascosta 
nel limbo tra la visualizzazione del monitor e quella della tavoletta. 

Ho trascinato la finestra più o meno al centro dell’area di CSP sulla tavoletta e ho riportato la 
risoluzione a 3840x2160. Ancora non riuscivo a utilizzare la penna. Sono andato su File > 
Preferences > Tablet e ho impostato Tablet PC. Tutto è tornato alla normalità. 
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L'interfaccia 
È bene familiarizzare presto con l'interfaccia del programma, dato che spesso le spiegazioni che si 

trovano in giro (e anche in questi appunti) fanno riferimento alle sue varie aree. È bene anche ricordare il 
nome di tali aree, nonché i nomi dei comandi in inglese, poiché al momento non c'è una versione in italiano 
del programma e quindi anche le spiegazioni in italiano utilizzano perlopiù i nomi in inglese, a meno di aree 
e comandi analoghi con il nome mutuato da altri programmi, ad esempio da Photoshop. Leggere sul 
Manuale o nella Startup Guide il paragrafo CLIP STUDIO PAINT Screen Configuration (dalla v. 1.8.0; era 
Screen Components nelle versioni precedenti). 

Di seguito (Fig.  4), lo schema di default delle varie aree della versione 1.9.5. Non c’è la didascalia di 
tutto, ma direi che è più che sufficiente per chi inizia. 
 

 
Fig.  4 - Interfaccia di default, v. 1.9.5 

L’interfaccia è ampiamente personalizzabile spostandone le varie parti (quelle che nella Fig.  4 sono le 
varie palette ecc.), e ogni riarrangiamento si può salvare in un Workspace che può essere richiamato se si 
desidera. 

Con la versione 1.9.5 (dicembre 2019) l’interfaccia è stata lievemente modificata, introducendo una 
diversa visualizzazione dell’aspetto e delle icone.  

 

Cliccando il tasto Tab le varie palette collassano, e le palette flottanti scompaiono; ricliccandolo, torna 
tutto come prima. 

Workspace 

Come detto, l’area di lavoro (Workspace) si può personalizzare. 
Una volta aggiustata come più mi è comodo, posso salvare la configurazione in: 

Window > Workspace > Register Workspace… 
Il nuovo spazio di lavoro verrà aggiunto nella stessa finestra. 
Se voglio richiamare un Workspace differente da quello con cui sto lavorando vado in: 

Window > Workspace  e clicco sul nome del Workspace desiderato. Mi chiederà conferma e darò l’ok. 
Nella stessa maniera posso riportare il Workspace alle impostazioni di default; vado su: 

 Window > Workspace > Reset to Default.  
In alternativa, avviare il programma tenendo premuto il tasto Shift: così facendo  appare una finestra da 

cui è possibile ripristinare il workspace di default e altro (attenzione: altri workspace eventualmente 
registrati verranno cancellati).  

https://www.clip-studio.com/site/gd_en/csp/userguide/table_of_contents.htm
https://www.clip-studio.com/site/gd_en/csp/startupguide/table_of_contents.htm
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Ad esempio, questo è il mio Workspace nel momento in cui scrivo: 
 

 
Fig.  5 – Il mio Workspace 

Ci sono alcune differenze con il default; ad esempio, utilizzando una tavoletta grafica con display 
indipendente preferisco tenere il Navigator ingrandito sullo schermo del pc piuttosto che averlo (piccolo) 
sulla tavoletta; ho spostato la Brush Size palette; preferisco aver la Command bar della Layer palette sotto i 
layer e non sopra e ho messo lì sotto anche la finestra Information; ho cambiato la visualizzazione dei 
colori; ecc. 

 

Si può  anche salvare il proprio workspace e metterlo a disposizione di altri utenti di CSP (o di sé stessi, 
su un'altra macchina…): si salva il workspace come material da Window > Workspace > Register workspace 
as material e poi lo si pubblica sugli Assets. Dagli Assets si può quindi scaricare e installare su un altro CSP. 

Canvas 

Il Canvas è la “tela”: dove fisicamente si va a disegnare, il rettangolo bianco del foglio che costituisce il 

mio documento. 

Canvas window 

È la finestra del programma che contiene il Canvas (Fig.  4). Dato che posso avere più Canvas window 
aperte, al di sopra di esse si trova la Canvas switching tab, in cui posso passare velocemente da una finestra 
all’altra semplicemente toccando l’etichetta del Canvas che mi interessa. 

Title bar e Menu bar 

In alto nella schermata del programma ci sono due barre, che corrono per tutta la larghezza della 
finestra: la Title bar e la Menu bar.  

La Title bar contiene alcune informazioni relative al file in lavorazione (nome, dimensioni del Canvas, 
dimensioni della pagina, risoluzione e livello di zoom), la versione in uso di CSP (PRO o EX) e i classici 
pulsanti Riduci a icona (Minimize), Ingrandisci (Maximize) e Chiudi (Close); la Menu bar è  analoga a quelle 
presenti in quasi tutti i programmi, ovvero una serie di menù a tendina che contengono i comandi del 
programma. 

Cliccando più volte in successione la combinazione di tasti Shift + Tab, dapprima scompare la Title bar, 
poi scompare la Menu bar, infine riappaiono entrambe. 
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Fig.  6 

Command bar 

Anche la Command bar, ossia l’insieme di icone che stanno sopra al Canvas che danno diretto accesso 
ad alcuni comandi, è personalizzabile. 

Per aggiungere o togliere comandi alla Command bar andare su File > Command Bar Settings… oppure 
fare tasto destro sulla Command Bar e selezionare Command Bar Settings… 

Ad esempio, per aggiungere pulsanti per i Flip orizzontale e verticale della visualizzazione (analoghi a 
quelli presenti nel Navigator), scendere fino a View > Rotate/Invert e scegliere i due pulsanti.  

Selezionare il comando scelto e cliccare su Add, oppure trascinarlo sulla barra, dove si vuole. 
 

La mia attuale Command bar (l’ho divisa qui in due righe, sennò le icone vengono troppo piccole): 
 

 
Fig.  7  

Dalla prima riga e da sinistra, i comandi: 

New; Open; Save|Undo; Redo|Delete; Delete Outside Selection; Scale/Rotate; Deselect; Invert selected area; Show 

border of selected area; Show selection launcher|Fill|Reset Display|Snap to Ruler; Snap to Special Ruler; Snap to Grid; 

Toggle special ruler snapping|Show/hide title bar and menu bar|Flip Horizontal; Flip Vertical; Flip Detail Horizontal*; 

Flip Detail Vertical*|Execute/Cancel quick mask; Pen Pressure Settings|Export in .jpg (JPEG); Export in .png 

(PNG)|Show/Hide all palette; Display Quick Access Palette|Layer selection|Convert to Selection Layer; Convert 

Selection Layer to Selection|Duplicate Layer; Merge with layer below|Open CLIP STUDIO|Show color wheel 

palette|Convert to drawing color|CLIP STUDIO PAINT support; Preferences; Connect to smartphone. 
 

È possibile aggiungere alla Command bar anche dei Sub tool: è quello che ho fatto io aggiungendo il 
comando Select layer (ex Layer selection, come continua a chiamarsi nel mio CSP), che trovo molto utile per 
capire su quale layer si trova una parte di disegno senza doverli scorrere tutti. Ho semplicemente duplicato 
il Sub tool e l’ho trascinato sulla Command bar.  

Ho messo nella Command bar il tasto Open Clip Studio e il Duplicate Layer; ho spostato la Color wheel, 
mettendone l’icona sulla Command bar selezionandola da Command Bar Settings > Window > Color Wheel 
e rendendola fluttuante. 

* Queste icone non esistono nel programma, le ho personalizzate io. Se vuoi usarle puoi scaricarle qui. Per inserirle nel 

programma vedi più sotto, dove spiego la procedura (valida anche per altre icone). 

https://www.paolelli.com/Risorse/CSP/Icone/FlipDetailIcons.rar
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Fig.  8  

Tool palette 
A sinistra nell’interfaccia, posta in verticale, c’è la Tool palette ovvero la cassetta degli attrezzi 

di CSP; questa è forse la palette che viene utilizzata maggiormente, soprattutto quando ancora non 
si preferisce raggruppare gli strumenti altrove (ma anche dopo…). In questa colonna sono 
raggruppati, per tipo di funzione, gli strumenti di CSP più utilizzati: è qui che si vanno a spulciare i 
pennelli, ad attivare lo strumento selezione, a scegliere i balloon, ecc.  

Sub Tool palette e Tool property palette 
Immediatamente alla destra della Tool palette trovo altre due palette, che in sostanza sono 

delle sue estensioni, le zone dove andare a raffinare la scelta dello strumento: la Sub Tool palette e 
la Tool property palette (vedi Fig.  4). 

Nella Sub Tool palette scelgo, tra vari strumenti raggruppati per affinità di funzione, quello che 
più fa al caso mio: un pennello G-pen oppure un pennello Calligraphy, una matita leggera o una 
tecnica, un riempimento, un balloon o un testo. 

Nella Tool property palette posso andare a modificare i parametri che caratterizzano lo 
strumento scelto, così posso impostare una determinata risposta alla pressione della penna o 
l’opacità del tratto; lo spessore di una vignetta o il raggio di curvatura dei suo angoli, e così via. 

Vedi anche più sotto. 

Icone colore 

Nella parte bassa della Tool palette si trovano le icone colore. Sono tre, il Main color (1 - colore 
principale), il Sub color (2 - colore secondario) e il Transparent color (3 - trasparenza).  

 

Icone Chiave inglese  

In seguito e spesso anche altrove (nella pagina  facebook, ad es.)  si fa riferimento all’icona della chiave 

inglese: attenzione! Fino alla v. 1.9.4 ci sono due icone che rappresentano una chiave inglese (tre in realtà, 
ma due sono identiche), leggermente differenti e che fanno fare cose diverse.  

Una è la Lock sub tool,   , si trova a fianco della miniatura dello strumento (Tool) nella Tool property 
palette e serve per bloccarne le impostazioni.  

 

 
Fig.  9  Icone colore 

 Durante l’uso di CSP, se premo più volte il tasto X alterno tra Colore principale 
(Main color) e Colore secondario (Sub color); se premo più volte il tasto C alterno 
tra la trasparenza (Transparent color) e quello tra Main e Sub color che era 
selezionato precedentemente. 
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Fig.  10 -- Miniatura nella Tool property palette 

 

Una volta bloccato, lo strumento si può modificare 
tranquillamente ma tali modifiche sono temporanee: se si riseleziona 
lo strumento dopo esser passati ad altro, le impostazioni tornano a 
essere quelle impostate quando si è attivata l’icona.  

Si può riconoscere uno strumento in cui è stato attivato il blocco 
dal fatto che la stessa icona appare, più piccola, a fianco della 
miniatura dello strumento  nella Sub tool palette (Fig.  11). 

 
 

 
Fig.  11 

Dalla versione 1.9.5, questa icona è stata sostituita con quella raffigurante un lucchetto aperto nella Tool 

property , e da un lucchetto chiuso quando è attivata, sia nella Tool property che nella Sub tool palette 

 . 
Immagino che inizialmente ci sia un po’ di confusione tra Sub tool palette e Tool property palette; se 

capita basta dare un occhio alla Fig.  4 più sopra. 

La seconda icona con la chiave inglese è la Show [Sub Tool Detail palette],  (nella nuova grafica ), 
si trova nella parte bassa della Tool property palette (Fig.  12): 

 

 
Fig.  12 – Tool property palette; l’icona a chiave inglese è come appare fino alla versione 1.9.4 

Serve ad aprire la finestra Sub Tool Detail (Fig.  13), ovvero l’officina dove si può andare a modificare 
ogni aspetto dello strumento selezionato. Questo è l’antro degli smanettoni! 
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Fig.  13 - Sub Tool Detail palette 

Volendo, tutte le proprietà che appaiono nella Sub 
Tool Detail palette possono essere visualizzate 
direttamente nella Tool property palette, basta attivare 
l’occhio nel quadratino a fianco di ognuna. Può essere 
comodo, ma, se si tratta di proprietà a cui non si fa 
ricorso sovente, si rischia di ingarbugliare inutilmente la 
visualizzazione con comandi poco utilizzati. 

 
La terza icona a chiave inglese è identica alla seconda, 

si trova a fianco del nome del Color set selezionato nella 
Color palette e serve per editare, appunto, il Color set 
(vedi più sotto): 

 

 
Fig.  14 – Icona a chiave inglese del Color set (nuova visualizzzazione) 

Color Palette 

La palette dei colori si trova in basso a sinistra nello schermo. Se non è presente, basta andare sul menu 
Window e selezionare una delle varie opzioni che iniziano con Color, tipo Color wheel; l’utilizzo è 
abbastanza intuitivo. 

Scegliendo la linguetta Color set viene mostrata l’ultima tavolozza di colori utilizzata: ce ne sono diverse 
di default selezionabili tramite il menù a tendina: 

 

 
Fig.  15 

ma è possibile creare le proprie e anche esportarle.  
Per creare una nuova tavolozza (Color set) cliccare sulla chiave inglese a fianco del menu a tendina; si 

apre così la finestra Edit color set: 
 

 
Fig.  16 – Finestra Edit color set 

Poi si seleziona Add new settings, si sceglie un nome e si dà l’ok. Il nuovo set viene aggiunto agli altri e 
adesso è possibile aggiungere nuovi colori con il pulsante a forma di goccia: 
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Fig.  17 

La visualizzazione dei colori può essere modificata: di default il programma mostra una serie di 
quadratini, uno a fianco all’altro (credo sia la visualizzazione tipo Size). 

Cliccando nell’angolo in alto a sinistra della palette colori viene visualizzato il menù a tendina delle 
opzioni: 

 

 
Fig.  18 

Se si seleziona View è possibile scegliere il metodo di visualizzazione; in genere io utilizzo List medium, 
che mi permette di avere una dimensione dell’anteprima decente e anche di poter dare un nome al colore 
(ad es. “Pelle del mostro”).  

I colori, in qualsiasi visualizzazione, possono essere spostati all’interno della tavolozza. Scegliendo 
Change Order è possibile scegliere come spostarli, se solo facendo un drag col mouse oppure se 
contemporaneamente al drag bisogna premere anche CTRL. 

Un’opzione interessante è Auto-register color in eyedropper. Attivandola, quando si utilizza il contagocce 
e si clicca su un colore, questo viene automaticamente registrato nel color set selezionato. 

La tavolozza può essere esportata (e quindi anche importata) e registrata come materiale: nella parte 
alta del menù a tendina si vedono i comandi per poterlo fare. 

La tavolozza di colori può essere esportata nel formato .aco di Photoshop. Se si vogliono unire due 
tavolozze di CSP, operazione che non si può fare direttamente, si possono esportare le tavolozze in formato 
.aco, importarle in PS, unirle (operazione che si può fare in PS), esportare la tavolozza ottenuta e importarla 
in CSP. Vedi anche questo post.  

https://www.facebook.com/groups/mangastudioitalia/permalink/3026116220832691/
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Color Mixing palette 

Dalla versione 1.12.0 è presente una nuova palette, la Color Mixing palette, attivabile da Window > Color 
Mixing. 

In pratica, è la versione digitale di una tavolozza del pittore, su cui si possono mescolare i colori per 
ottenerne di nuovi. 

La Color Mixing palette è disponibile anche sul cellulare quando lo si utilizza in modalità Companion 
(vedi più sotto), anche se la visualizzazione dell'interfaccia e delle funzioni è leggermente differente da 
quella sul PC. 

È presente un'area di lavoro, in cui miscelare i colori, al di sotto della quale si trova una riga con alcuni 
colori, ai quali se ne possono aggiungere degli altri (scorrere col cursore verso dx o allargare la palette 
tirandola per un lato per visualizzare un "+" che permette di aggiungerli). 

Toccando uno dei colori, questo diventa il colore selezionato, visibile nell'apposito riquadro, che è il 
primo spazio della seconda riga. Poi ci sono alcune icone: 

 

 
Fig. 19 – Color Mixing palette nel PC 
 

Nella palette del PC: Clear (cancella); Undo 
(annulla); Redo (ripeti); Brush size 
(dimensione del pennello: piccolo, medio o 
grande); Use the same sub tool as canvas 
(utilizza lo stesso strumento che è selezionato 
per disegnare sul Canvas); Brush (un generico 
strumento pennello, se non si utilizza lo 
strumento già selezionato per disegnare); 
Blend (il miscelatore vero e proprio); 
Eyedropper (il contagocce, per selezionare il 
colore quando si è soddisfatti del mix o per 
aggiungere altri colori).  
 

 

 
Fig. 20 - Color Mixing palette nel cellulare 

 

Nella palette del Companion non ci sono le 
icone Undo, Redo e Use the same sub tool as 
canvas. 

 

In alto a sinistra nella palette per PC e di seguito alle altre icone nel Companion, è presente l'icona 
Display menu (= tre linee orizzontali), per impostare alcuni parametri di base della palette. Le opzioni sono 



Appunti di Manga Studio/ClipStudioPaint   

29 

più numerose nella palette per PC, ma non sto qui a descriverle: sono piuttosto intuitive, basta fare qualche 
prova per prender dimestichezza. 

 

Come si usa la Color Mixing palette? Fondamentalmente si sceglie un colore tra i vari disponibili (o lo si 
preleva dalla Color Wheel, o si clicca sull'anteprima del colore selezionato, aprendo così la finestra Color 
settings), si scarabocchia sull'area di lavoro della palette col pennello, si sceglie un altro colore e si 
scarabocchia nuovamente, vicino o sopra al primo colore; se si vuole si ripete con altri colori. Poi col Blend 
si mescolano fino a ottenere la tinta desiderata e si seleziona col contagocce. Anche qui, la cosa è piuttosto 
intuitiva. 
Se nel programma è selezionato il Main color allora la nuova tinta diventerà il colore principale, se è 

selezionato il Sub color diventerà il colore secondario. 

Quick Access 

La finestra Quick Access si apre cliccando sull’icona           , o da Window > Quick Access. 
Il Quick Access raccoglie alcuni comandi di uso frequente per poterli avere a disposizione velocemente 

senza doverli cercare tra i menù. È possibile organizzare i comandi in più set; l’accesso alle modifiche si può 
fare cliccando su Quick Access Settings, nella stessa finestra. 

Dopo un’iniziale indifferenza, ora utilizzo la Quick Access come modo preferito di accedere agli 
strumenti e ai  comandi che utilizzo maggiormente.  

 

  
Fig.  21 -  Quick Access 

 

 Per aggiungere pulsanti alla Quick Access Palette 
- click su Quick Access Settings (dalle tre lineette in alto a sx o 

dall’icona che si trova tra i comandi del set, nella palette Quick 
Access) > Menu Commands > Edit > Transform > Flip Horizontal o Flip 
Vertical e poi cliccare su Add oppure trascinare il comando nella 
Quick Access palette.  

Spostare le icone nelle varie barre 

Nella Tool palette per spostare le icone basta trascinarle nella posizione desiderata con il cursore. 
Nella Command bar, nella Quick Access palette, nel Selection Launcher per spostare le icone si può o 

intervenire in nelle loro impostazioni (Settings…) oppure tener premuto CTRL e trascinarle nella posizione 
desiderata. 
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Modificare le icone 

Moltissime icone di default  possono essere modicate.  
 

Tool palette 
Se si clicca col tx dx  un’icona nella Tool palette compaiono tre opzioni:  Tool settings…, Delete tool… e 

Add from default. Con Tool settings è possibile cambiare il nome allo strumento; con Delete tool... lo si 
cancella, per cui al momento lascio perdere; con Add from default… è possibile aggiungere uno strumento 
necessario o che si è eliminato per errore. 

 

Sub Tool 
Selezionando col tx dx un gruppo di strumenti nella palette Sub Tool  (es. Pen oppure Airbrush) appare 

l’opzione Sub tool group settings... che permette solamente di cambiare il nome al gruppo di strumenti. 
Se però clicco col tx dx su uno strumento specifico, es. G-pen, compaiono molte opzioni, tra cui Sub tool 

settings… Scegliendo questa, si apre la finestra Sub tool settings (chi l’avrebbe detto?), che è dove si 
possono andare a personalizzare le icone. 

 

 
Fig. 22 

In Name posso cambiare il nome dello strumento; Input process e Output process, non modificabili, 
indicano le caratteristiche dello strumento, ossia a che categoria appartiene e cosa va a fare. 

Si arriva quindi a Tool icon. Viene mostrata l’icona di default, che può essere cambiata cliccando sulla 
finestra a tendina.  

Se si seleziona il radio button sottostante e si clicca User Settings… si apre l’Esplora risorse, col quale si 
può andare a scegliere un’icona personalizzata, preparata precedentemente e salvata in una cartella in uno 
dei formati disponibili: .bmp; .jpg, .png, .tif e targa. 

 

 
Fig. 23 

Spuntando la casella Background color of icon è possibile cambiare il colore di sfondo dell’icona, cosa 
che faccio spesso per ricordarmi quali sono gli strumenti modificati o creati da me oppure quelli che voglio 
rintracciare a colpo d’occhio. Perché il cambio colore di sfondo funzioni anche nelle icone create ex-novo 
bisogna che lo sfondo dell’icona sia trasparente e che sia salvata con un formato che supporti la 
trasparenza. In alternativa, creando l’icona si sceglie un colore di sfondo, che non sarà però modificabile. 

 

 
Fig. 24 

 

 
Fig. 25 

 
Anche le icone della Command bar e del Quick Access possono essere sostituite o modificate, in maniera 

analoga a quanto spiegato qui sopra e più sotto.  
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Preferences 
Un’altra parte del programma con cui è bene familiarizzare è quella relativa alle impostazioni generali 

del programma, Preferences, le preferenze.  
Ho pensato un po’ a dove mettere questo paragrafo, dato che tratta anche impostazioni che forse non 

sono utilizzate fin da subito. Però sono appunto delle impostazioni generali, quelle che in teoria 
bisognerebbe regolare prima di lavorarci. Le metto qui, all’inizio, ma volendo il paragrafo può essera saltato 
e consultato al bisogno. Non tratto tutte le opzioni, ma provo a dare una panoramica di quelle che utilizzo o 
di cui conosco direttamente gli effetti (o che, redigendo il paragrafo, ho scoperto io stesso, mi hanno 
incuriosito e penso valga la pena sapere cosa siano).  

Ricordo che la trattazione è relativa a CSP in ambiente Windows. Alcune delle opzioni possono differire 
in ambiente MacOS o in tablet/cellulari. Nel dubbio, consultare il Manuale, anche se, come diverrà chiaro 
usando il programma, il Manuale non è aggiornato ad ogni release  di CSP, per cui alcune delle opzioni che 
ho trovato in Preferences (al momento in cui scrivo questo paragrafo) non sono ancora state introdotte nel 
Manuale stesso. 

 

La finestra Preferences è attivabile da File > Preferences, oppure con la combinazione CTRL + k, oppure 
ancora portandone l’icona nella Command Bar e lanciandola da lì (vedi più sopra). Sulla sinistra trovo, 
incolonnati, i vari ambiti su cui posso andare a operare, mentre nella parte destra, più ampia, la relativa 
scheda con le opzioni disponibili. 

 

Di seguito, per alcuni esempi indico lo stilo della tavoletta grafica. Ovviamente lo stilo non è l'unico mezzo di input per 
interagire con CSP: c'è il sempiterno mouse e anche le dita, nel caso dei dispositivi touch. Tranne quando escludo l'uso di altri mezzi 
o dove non lo chiarisco esplicitamente, lo stilo va inteso come intercambiabile con il mouse o le dita. 

 

Tool 
 

Switch tool temporarily 
Se la casellina Switch tool temporarily by pressing and holding shortchut key ha la spunta, allora è 

abilitata la funzione che permette di passare a un altro strumento, temporaneamente, tenendo 
premuto un tasto di scelta rapida assegnato a quello strumento [secondo me, per la terminologia usata 
altrove in CSP, più propriamente questi sono i Modifier Key, non delle Shortcuts; per l’assegnazione di 
Shortcuts e Modifier Key vedi più sotto]. 

Length of keypress to switch tools è il tempo necessario per passare allo strumento temporaneo. 
 

Options 
Minum drag distance è la distanza per cui bisogna trascinare il cursore perché il programma capisca 

che si sta effettuando un trascinamento (Drag) 
Auto scroll at edge of Canvas: come si comporta il cursore quando raggiunge il bordo del Canvas: 

spostando il cursore oltre il margine del Canvas, il Canvas sta fermo (None), oppure spostando il 
cursore oltre il Canvas causa il movimento del Canvas in modo da seguire il cursore (Drag e Drag 
with mouse: non trovo differenze tra questi due!),  

Figure tool guidelines: tipo di visualizzazione in anteprima quando si utilizza lo strumento Direct 
draw. 

Handle size: dimensione dei punti di controllo, o maniglie. 
 

Per le altre opzioni basta tradurre quanto scritto o consultare il Manuale alla voce Preferences 
[Windows]. Forse l’unica degna di nota è Preview lines by pressing modifier key (Shift) che, se spuntata, 
permette di far vedere un’anteprima della linea retta che verrà creata quando, con uno strumento di 
disegno, si preme contemporaneamente il tasto Shift. 
 

Tablet 
Queste impostazioni differiscono a seconda che si sia in ambiente Windows o Mac. Utilizzando un PC, mi occupo 

delle opzioni relative a Windows. 
 

Using tablet service 
Sulle differenze tra Wintab e Tablet PC consiglio l’esaustiva risposta di Luca Malisan in questo post. 
In sostanza Wintab e Tablet PC sono due tipi di driver che vengono usati per lo scambio di dati tra il 

computer e tavoletta grafica. Quello che so a riguardo è che a volte certe impostazioni di CSP 

https://www.facebook.com/groups/mangastudioitalia/posts/3444753145635661/
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sembrano saltare ed è utile, in questi casi, provare a passare da uno all’altro per ripristinare la 
piena funzionalità. A esempio, quando il cursore sembra spostato rispetto alla punta dello stilo; 
vedi anche le Domande frequenti, più sopra. 

 

Coordinate detection mode 
Quando Using tablet service è su Tablet PC, qui appare Use more accurate coordinate detection; se 

invece è selezionato Wintab, qui appare Use mouse mode in setting of tablet drive. Togliendo la 
spunta, possono essere attivate le rimanenti opzioni, ma utilizzando Tablet PC, non a cosa si 
riferiscano. 

 

Tablet Settings 
In Input frequency è possibile scegliere la quantità di informazioni da inviare al computer utilizzando 

la tavoletta. Le opzioni sono Prefer speed (velocità) o Prefer quality (qualità). Nel mio CSP questa 
opzione è impostata su Prefer speed, penso sia così di default, perché non l’ho mai toccata. Vedi 
anche più sotto, a proposito della risoluzione di un problema con il segno. 

 

Touch gestures 
Non essendo la mia tavoletta una “touch”, ignoro questa scheda. 
 

Gesture configuration 
Idem come sopra. 
 

Command 
 

Transform 
Se c’è la spunta, il comando Transform agirà solo sui tipi di livelli elencati; se non c’è la spunta può 

essere che alcune trasformazioni non funzionino, a seconda del tipo di livello. Da me  la spunta non 
c’è. 

Paste 
Copiando della grafica da Illustrator a CSP, questa viene convertita in linee vettoriali o in immagini 

raster, a seconda di ciò che è selezionato nel menù a tendina. 
 

Interface 
Impostazioni relative ai controlli IME, ai colori e altri parametri  dell’interfaccia. 
 

IME Control 
IME significa Input Method Editor (Editor del metodo di input ); è un’opzione che riguarda il tipo di 

inserimento del testo e credo regoli l’utilizzo contemporaneo di alfabeti diversi (es. giapponese e 
latino). 

 

Color 
Qui si imposta il “mood” generale dell’interfaccia, se scura o chiara e quanto luminosa (Adjust 

density: sì, si chiama density, ma è come se agisse sulla luminosità dell’interfaccia). Per me, scura a 
bassa densità. 

 

Touch Operations 
Ok, c’è scritto touch, però questo parametro agisce anche se non si ha un dispositivo touch. Se si 

mette la spunta a Adjust interface for touch operation e scegliendo un Interface Scaling (e 
ricordandosi poi di riavviare il programma per rendere effettivo il cambiamento) si modificano le 
dimensioni di icone e palette. Capita che, installando un aggiornamento (vedi più sopra), queste 
dimensioni cambino e qui è dove rimetterle a posto. In realtà, il parametro serve per dare le 
dimensioni  ottimali per lavorare anche con le dita avendo un sistema touch. 

Cambiando le impostazioni in Touch Operations si resetta anche il workspace utilizzato. Prepararsi 
quindi a un’eventuale rottura di scatole per ripristinare le proprie impostazioni; purtroppo non 
serve a nulla scegliere il proprio workspace in Window > Workspace.  

Il percorso descritto esiste per PC, in Mac questa opzione non c’è (vedi questo post). 
 

Layout 
Mettendo la spunta a Switch to tablet interface si passa a un layout del programma ottimizzato per 

tablet; senza spunta il programma è ottimizzato per computer. 
 

https://www.facebook.com/groups/mangastudioitalia/posts/3861315127312792/?comment_id=3861370167307288&reply_comment_id=3861485980629040&notif_id=1624439361080971&notif_t=group_comment&ref=notif
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Performance 
Analogamente ad altri programmi, qui si regolano quante e quali risorse del computer siano destinate al 

funzionamento di CSP. 
 

Memory 
Qui si stabilisce il percorso della memoria virtuale e quanta percentuale  destinarne al programma. 

 

Undo 
Per impostare quanti livelli di undo e quanto tempo, in millisecondi, deve passare tra un’azione e 

un’altra perché il sistema le riconosca come due azioni separate (e quindi l’undo agisca su si loro 
separatamente e non contandole come singola azione: ad esempio, se faccio dei tratteggi veloci, se 
l’intervallo è 0 allora ogni tratto sarà considerato individualmente, ma se aumento l’intervallo, tutti 
i tratti che riesco a disegnare in quel lasso di tempo verrano considerati come una sola azione, e 
l’undo li cancellerà tutti assieme). 

 

Cursor 
Per decidere la forma del cursore.  
 

Shape of cursor 
Il cursore è impostabile per ogni tipologia di strumento: pennello, penna, gomma, figura, 

riempimento, vista, correttore; aprendo il menù a tendina si trova l’elenco dei tipi di cursore 
disponibili, che corrispondono a quelli che si vedono nella prossima immagine (dal Manuale). Non 
tutti i tipi di cursore sono disponibili per ogni tipo di strumento. 

 

 
Fig.  26 -  Possibili tipi di cursore (dal Manuale) 

Additional display when brush-size cursori s small 
Quando la dimensione è troppo piccola e non è possibile visualizzare la grafica scelta, si può scegliere 

il tipo di rappresentazione del cursore. 
 

Display position for reversed cursors 
Qui non capisco molto il nome che hanno dato a questa opzione: non so cosa significhi reversed 

cursor* ma, a ogni modo, l’effetto che si ottiene impostando il radio button su Delay for 
stabilization è un rallentamento della velocità del cursore rispetto alla velocità con cui ci si muove 
realmente sul Canvas, cosicché il cursore segue lo stilo (nel caso si adoperi la tavoletta grafica) con 
un ritardo dipendente dal valore della stabilizzazione. Per le prove che ho fatto, se si disegna col 
mouse questo effetto non è visibile. 
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*cercando un po’ nelle FAQ del supporto Celsys, ho trovato che un fatto noto è che con certe tavolette 
usando nel parametro Angle, nella punta dello strumento, l’opzione Pen tilt, il cursore risulta 
rovesciato. La soluzione a questo problema comunque non riguarda il parametro trattato in questo 
paragrafo, per cui non credo sia questo il significato che si dà qui a reversed cursor. 

 

Cursor details 
 

Cursor Options 
Come cambia l’aspetto del cursore mentre si sta disegnando; di facile traduzione. 
 

Layer/Frame 
Una serie di impostazioni per i livelli e le vignette 
 

Layer 
Name of copies è il nome da dare al nuovo livello quando lo si crea duplicandone uno esistente. 
La spunta Use [Through] blending mode for new layer folders serve a impostare in modo Through (= 

attraverso) ogni nuovo Layer folder creato. Trovo questa opzione molto utile, perché se non si 
imposta una cartella, con dentro dei livelli, con questo blending mode (vedi più sotto) allora 
eventuali blending mode applicati su livelli superiori, al di fuori della cartella, non avranno effetto 
sui livelli contenuti nella cartella stessa. Prima dell’introduzione di questo parametro spesso 
dimenticavo di passare la cartella a Through, ora lo fa in automatico. 

Opacity of selection layers imposta la trasparenza dei livelli selezione. 
Vector path opacity imposta la trasparenza dei tracciati vettoriali, che vengono visualizzati ad 

esempio quando tocco una linea vettoriale con Object. 
How to scale down screentones imposta come visualizzare un’area riempita coi retini quando il 

Canvas è rimpicciolito. Show tone mantiene il retino, ma si può creare del moiré (fenomeno di 
interferenza, vedi più sotto e anche qui e qui); Show gray cambia la visualizzazione a grigio. 

 

Mask 
Imposta colore, trasparenza e visualizzazione dei layer mask (vedi più sotto). 

 

Frame Border 
Imposta gli spazi verticali e orizzontali tra le vignette quando vengono create dividendo lo spazio con 

Divide Frame border / folder (vedi più sotto), e se mascherare o meno l’area attorno alle vignette. 
(vedi più sotto più sotto). 

 

Light table 
Opzione che si usa in animazione. Non usando CSP per animazioni, salto la scheda. Tuttavia, mi pare 

piuttosto intuibile. 
 

Camera path/Camera 
Opzioni che si usano in animazione. Non usando CSP per animazioni, salto la scheda. 

 

Ruler/Unit 
 

Ruler/Grid/Crop mak 
Per impostare il colore dei ruler attivi e non, della griglia, dei segni di taglio, della gabbia e del Safety 

margin, nonché la loro trasparenza. 
When snapping to perspective ruler, reset drawing direction by returning to start point. Mentre si usa 

un ruler prospettico, se questa casella è spuntata allora, tornando con il cursore lungo il ruler verso 
il punto di partenza (con lo stesso tratto, ossia senza staccare lo stilo dalla tavoletta o senza 
sollevare il pulsante sx del mouse), il segno tracciato finora scompare e ricomincia ad apparire, 
sempre dallo stesso punto di partenza, ma nel verso opposto. Incasinato? Meglio fare una prova 
per rendersene conto. Per quanto mi riguarda, questa casellina la lascio senza spunta. 

 

Unit 
Per cambiare l’unità di misura delle lunghezze da px a mm o viceversa, e l’unità di misura dei testi da 

pt (punti) a Q (Quarter) o viceversa. L’effetto più evidente del cambiamento delle unità di misura 
delle lunghezze è che le dimensioni dei pennelli, riportate sotto le anteprime nella palette Brush 
size, si modificano, così come le dimensioni presenti nella Tool property. I righelli laterali non 

https://it.wikipedia.org/wiki/Effetto_moir%C3%A9
https://mathworld.wolfram.com/MoirePattern.html
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cambiano visualizzazione; per far ciò, bisogna impostare l’unità di misura al momento della 
creazione di un nuovo documento oppure, se il documento è già aperto, andare su Edit > Change 
Canvas Size… e scegliere un’altra unità di misura. 

 

Canvas 
 

View 
Display quality. Per aumentare la qualità della visualizzazione. Due opzioni, Default e High quality. 
Transparent. Le aree trasparenti sono indicate da una scacchiera colorata a quadratini bianchi e grigi 

(visibile se il livello Paper è spento): qui si possono modificare questi colori. 
 

Scale 
Sono i valori predefiniti di zoom quando si utilizza per zoomare o il Navigator o con View > Zoom 

In/Out oppure con i comandi zoom del Canvas control.      
Si possono aggiungere, togliere o cambiare i valori. Revert riporta la lista ai valori di default. 
 

Angle 
Incrementi di angolo quando si effettua la rotazione del Canvas col Navigator o con la i comandi di 

rotazione del Canvas control. 
 

 
Fig.  27 -  Canvas control 

Display resolution 
Questo è molto simpatico. Per calibrare la risoluzione del proprio monitor (o tavoletta), cliccare su 

Settings. Nella finestra che appare ci sono una slider e un righello. Prendere un vero righello 
centimetrato e sovrapporlo a quello virtuale nella finestra; con i controlli dello slider far combaciare 
i due righelli. Quando le misure sono le stesse, si scopre a che risoluzione sta lavorando il proprio 
monitor, o la propria tavoletta. 

Questa cosa può non essere importante, ma lo può diventare se sto cercando di capire quanto sarà 
grande, una volta stampato, il mio documento. Ho trovato questo chiarissimo video che spiega la 
cosa; è in inglese, ma si capisce molto bene e inoltre si possono attivare i sottotitoli. 

Analogamente all’esempio del video, se faccio la calibrazione e poi creo un documento e ci disegno 
sopra e infine vado su View > Print size, il documento scala mostrandosi a schermo esattamente 
grande quanto lo sarà la stampa. Utile. Attenzione: valido per lo schermo su cui si fa la calibrazione. 

 

 
Fig.  28 -  Settings of display resolution 

File 
 

Auto-Recovery 
Importante, qui si imposta l’intervallo di auto-salvataggio, in minuti. Utile in caso di crash del 

programma, black-out ecc. 
 

  

https://www.youtube.com/watch?v=i6v4yoIXMDo
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Save 
Se è spuntata la casellina Show save status as pop-up, quando il documento viene salvato appare 

sullo schermo, al centro del Canvas, in alto, un pop up con la scritta Saved. 
 

 
Fig. 29 

La spunta su Use layer cache when exporting permette di velocizzare l’esportazione o il salvataggio 
dei file. 

 

Import IllustStudio document (xpg )/ ComicStudio page file (cpg) 
IllustStudio e ComicStudio sono due vecchi programmi di Celsys, dalla cui unione è nato CSP. Questi 

sono dei parametri per importare documenti realizzati con questi software. Non ci dedico tempo, 
qualcosa si trova sul Manuale, sempre cercando Preferences. 

 

Page Management 
Auto save when switching page. Quando si passa a un altro documento automaticamente salva il 

lavoro sul documento precedente. Credo che funzioni solo con documenti facenti parte della stessa 
pubblicazione (un documento multipagina, quindi), non con due documenti aperti ma che non 
hanno nulla in comune tra loro. 

Always open in a new tab when doble-clicking or tapping to open a page. Se spuntato, passando a 
una nuova pagina (di un documento multipagina), questa viene aperta in una nuova finestra; se non 
è spuntato, la nuova pagina prende il posto della precedente. 

 

Color conversion 
 

Settings of color conversion 
Lo scrivo anche altrove negli appunti, non sono un esperto di colore e l’argomento è piuttosto vasto 

e dibattuto. Qui si impostano i profili colore RGB e CMYK e come deve avvenire la conversione tra i 
due sistemi. Se non si hanno già le idee chiare su questo argomento e non si sa già quali profili 
utilizzare, perché indicati, ad esempio, dall’editore, consiglio di fare una ricerca nel gruppo 
Facebook Clip Studio Italia ed eventualmente chiedere lumi. 

 

Edit text 
Edit text è il nome dato a due insiemi di comandi in CSP, uno presente nelle Preferences, trattato qui, e 

uno nel menù Story (vedi più sotto). Riguardano entrambi la gestione del testo, ma da prospettive 
diverse. 

 

New text 
How to insert new text. Se il nuovo testo va creato su un nuovo livello o aggiunto nel livello 

preesistente. 
New text property. Selected text tool property prende le impostazioni dalla Tool property dello 

strumento testo; Copy from current text invece prende le impostazioni dal testo che è già presente 
nel documento. 

 

Line breaks/Spacing 
Impostazioni relative allo Story Editor (vedi più sotto). 
 

How to show line break. Come visualizzare le interruzioni di riga. Show line break interrompe la riga 
nella posizione indicata; Show symbol only mostra, nello Story Editor, solo un simbolo dove verrà 
interrotta la riga, ma ciò avverrà solo nel testo sul Canvas. 

Paragraph breaks. Come dividere il testo premendo Enter (Invio).  
No paragraph breaks. Il testo non viene diviso premendo Enter.  
Single line space. Premere Enter per dividere il testo.  
Double line space. Premere due volte Enter per dividere il testo.  
Triple line space. Premere tre volte Enter per dividere il testo. 
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View 
Anche queste sono impostazioni relative allo Story Editor (vedi più sotto), e riguardano i testi per 

come appaiono nello SE, non come appaiono sul Canvas (cioè sulla tavola a fumetti). 
 

Direction Horizontal / Vertical. Se nello Story Editor il testo verrà visualizzato orizzontalmente o 
verticalmente. 

Main text font. Carattere principale e sua dimensione. È il carattere con cui si scrive nello Story 
Editor. 

Reading text font. Oh, qui ho picchiato un po’ la testa, perché non avevo idea di cosa fosse un 
reading text.  

Inserisco una parola con lo strumento testo nel Canvas, cioè nella tavola 

 
Fig.  30  

poi seleziono le lettere che la compongono. 

 
Fig.  31 

Vado in Sub Tool Detail > Reading > Reading setting, dello strumento testo 
 

 
Fig.  32 

Si apre una finestra di inserimento 
 

 
Fig.  33 

In Reading string digitare un altro testo 
 

 
Fig.  34 
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e dare l’invio. 
A questo punto, sopra al testo originale appare un secondo testo: quello inserito nella Reading string: 

 
Fig.  35 

Non conoscevo l’esistenza di questa opzione, né so in realtà a cosa può servire (forse per visualizzare 
le pronunce? Boh…); comunque, quanto visto è ciò che accade sul Canvas quando decido di 
visualizzare il reading text. Ma anche nello Story Editor è possibile visualizzare il reading text e, in 
Preferences > Edit text > Reading font, definire come visualizzarlo nello Story Editor stesso. 

 

 
Fig. 36 – File > Preferences > Edit text > View 

  
Fig.  37 – Story Editor 

 

Quindi, File > Preferences > Edit text  > View imposta i caratteri nello Story Editor, mentre i caratteri 
visualizzati nel fumetto possono essere impostati da Story > Edit text > Story Editor (vedi più sotto). 

 

3D 
 

Model settings 
Impostare il modello 3D di default. 
 

Rendering settings 
Use multi-sampling. Aumenta la qualità del render 3D. 
 

Import settings for 3D files 
Import 3D files in format from ver.1.10.13 and earlier. Per importare file 3D nel formato della 

versione 1.10.13 o precedente. 
 

Privacy settings 
Automatically send anonymous usage logs. Se c’è la spunta, vengono automaticamente inviate a 

Celsys informazioni sull’utilizzo del programma, eventualmente utili per risolvere problemi di CSP o 
dei servizi. Non vengono inviate informazioni personali. 

 

Smartphone connection 
Main device settings 

In Port. No. è impostata la porta di comunicazione tra il dispositivo principale e il cellulare. Come dice 
la scritta, se viene cambiata andare sul menù [File, non indicato] e cliccare su Connect to 
smartphone. Io ho lasciato tutto com’è. 
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Impostare le dimensioni del documento 
Per creare un nuovo documento vado su File > New e poi scelgo il tipo di documento con una delle sei 

caselle in Project (ex Use of work; Fig.  38, 1). I tipi possibili di documento sono: Illustration, Webtoon, 
Comic, Printing of Fanzine, Show all comics settings, Animation. Tranne Animation, che ha delle proprie 
caratteristiche, le altre opzioni sono simili e rappresentano dei  casi particolari dell’opzione Show all comics 
settings (2), che io preferisco. 
 

 
Fig.  38 – Attenzione, questa immagine è una composizione di più immagini; in realtà le opzioni non sono tutte visibili 

contemporaneamente 
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Posso dare un nome al file (3; di default il programma inserisce Comic). In corrispondenza della lettera 
(4) si può indicare il percorso dove salvare (Save to; cliccare sull’icona della cartella a lato): questo spazio 
appare se si crea un file multi pagina (Multiple pages, spuntare 30), altrimenti il percorso si decide al 
momento del salvataggio. 
 

Quando creo un nuovo documento posso scegliere un insieme di dimensioni proposte dal programma 
nei Preset (che si trovano in D) oppure impostare delle dimensioni personalizzate. Questo è molto utile 
perché il programma non propone tutte le opzioni esistenti: non ha ad esempio l'A3 tra i set preimpostati;  
non ha i modelli di pagina delle varie case editrici; o semplicemente propone dei modelli che magari 
usiamo, ma non come ce li imposta lui (ad esempio posso preferire, se lavoro su un A3, che la dimensione 
massima del foglio sia effettivamente un A3, e non un A3 più dell'altro spazio che CSP ritiene possa essermi 
utile).  

Attenzione: ciascuno degli Use of work ha un suo insieme di Preset, originali o aggiunti. Se salvo un 
preset personalizzato in Show all comics settings e poi, per un altro lavoro, decido di utilizzare Comic come 
Use of work, non ritroverò quel preset tra le opzioni ma dovrò ricrearlo. 
 

Vediamo quali valori impostare (ricordarsi di settare l'unità di misure in mm in alto a destra, 8): 
 

Canvas (9): le dimensioni dell’area di lavoro vera e propria su cui disegno, come se fosse un grande pezzo 

di carta; continuando con l'analogia dell'A3, non sono le dimensioni dell'A3 (297x420 mm), ma A3 più 
una cornice, come se la tela di un quadro fosse più grande di quella che mi serve (larghezza e altezza, 10 
e 11) per un dipinto; è possibile impostare la risoluzione (12) del documento e se sarà a colori, scala di 
grigi o bianco e nero (13). 

Spuntando la casellina Paper color è possibile scegliere per le pagine un colore diverso dal bianco. 
Spuntando la casellina Template è possibile impostare un modello di gabbia tra i vari a disposizione 

nella libreria dei materiali (Material, vedi più sotto). Nel caso di un documento multi pagina, tale 
modello verrà applicato a tutte le pagine. I template, una volta sul Canvas, possono essere anche 
modificati. 

 

Comic settings (18) [ex Manga draft settings] : 

qui vengono impostate le dimensioni del foglio, Binding (finish) size, e della gabbia, Default border 
(inner) size. 

Binding (finish) size (19), contiene:  
 - Width (20) [larghezza] e Height (21) [altezza] dell'area utile, ad esempio le dimensioni del foglio A3 

(297,00 x 420,00 mm); in seguito mi riferirò a queste dimensioni con Binding; 
 - il valore Bleed width (22), ossia un margine di sicurezza di qualche mm (proposto dal programma, 

ma modificabile), esterno alla dimensione del foglio, su cui si può continuare a disegnare e che 
rappresenta l'incertezza nel taglio tipografico finale delle pagine;  

Default border (inner) size (23): è l'ingombro della "gabbia”, cioè l'ingombro delle vignette; dipende da 
quanto margine si vuole lasciare tra le vignette e il bordo pagina (24 e 25). 

Dalla casellina a fianco della larghezza è possibile scegliere tra varie misure proposte o  delle 
misure personalizzate (opzione Custom): basta digitare le misure desiderate. Vicino all’altezza è 
presente un’altra casellina, che di default è impostata su Set size. L’altra opzione possibile è Set 
margin: selezionandola, anziché impostare le misure della gabbia, si può impostare quanto distante 
dal Binding deve stare ciascuno dei suoi lati (Top, Bottom, Inside, Outside, con Inside il lato della 
rilegatura). 

Con X offset e Y offset (26 in Fig.  38) si può decentrare orizzontalmente e verticalmente la gabbia 
sul Canvas. 

 

Bisogna fare un po' di attenzione quando si impostano i vari valori personalizzati, sembra di far le cose 
giuste ma spesso quando si dà l'ok il risultato non è quello che ci si aspettava.  

 

La cosa migliore da fare è impostare per primo il Binding, ovvero le dimensioni del foglio (nel nostro 
caso dell'A3, 297x420mm). Se va bene il Bleed da 5mm lasciarlo, sennò modificarlo.  

Impostare poi il Default border (inner) size, cioè le dimensioni della gabbia, le cui dimensioni saranno 
minori di quelle del foglio.  
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A questo punto, se non si hanno particolari esigenze, non occorre far altro: CSP aggiunge un po' di mm al 
Binding (aumentato del bleed) e propone delle dimensioni per il Canvas. Se si opta per modificare il Canvas, 
ricordarsi che le sue dimensioni non devono mai essere inferiori alle dimensioni del Binding più 2 volte il 
bleed (una a sinistra e una a destra; una sopra e una sotto). 

 

In soldoni, con l’esempio dell'A3 (297x420 mm) e con bleed da 5 mm, il Canvas dovrà essere almeno:  
 

297+5x2= 307 mm di larghezza (Width 10)  
420+5x2= 430 mm di altezza (Height 11). 

 

Se si imposta il Canvas più piccolo il programma dà un messaggio di errore. 
Il set personalizzato può essere salvato tra i preset con il pulsantino (6) o cancellato col cestino (7). 
Nell'immagine seguente (Fig.  39) si vede il foglio di lavoro impostato con i valori appena visti per il 

Default Border Size, il Binding size e il Bleed; il Canvas è stato lasciato più grande, così da riuscire a vedere i 
contorni di tutti gli spazi: 

 

 
Fig.  39 
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Meglio che il Canvas non sia la semplice somma dei valori appena visti, poiché se voglio aggiungere altre 
informazioni alle tavole, come quelle indicate nella sezione Story Information (vedi più sotto), queste han 
bisogno di un po’ di spazio per essere visualizzate: 

 

È comunque possibile modificare tali parametri dopo aver creato il documento, andando in Story > 
Change basic page settings oppure Story > Change basic work settings. 

 

Ricapitolando, imposto nell'ordine: 
- Binding (foglio: A4, A3, B4, ecc.); 
- Bleed (margine di sicurezza): 
- Default border size (gabbia); 
- se serve, alla fine, aggiusto il Canvas. 
 

Di seguito un altro esempio di impostazioni: 
 

 
Fig.  40 

In questo caso la dimensione del Canvas è pari alla dimensione del Binding size più due volte il Bleed. 

Bleed 
da Wikipedia https://en.wikipedia.org/wiki/Bleed_(printing) 

Bleed è un termine di stampa che si riferisce alla stampa che va oltre il bordo del foglio prima della 
rifilatura [credo che il relativo termine italiano sia “abbondanza”+. In altre parole, il Bleed è l'area in 
cui si può tagliare [cioè la zona di incertezza in cui la lama può fare il taglio]. Il Bleed è la parte 
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laterale di un documento che dà al tipografo un piccolo spazio per tenere conto del movimento della 
carta e delle incongruenze progettuali. La grafica e i colori di sfondo possono estendersi nell'area di 
Bleed. Dopo la rifilatura, il Bleed assicura che nel documento rifilato finale non ci siano bordi non 
stampati. 

 

È molto difficile stampare esattamente fino al bordo di un foglio di carta o cartone, quindi, per ottenere 
questo risultato, è necessario stampare un'area leggermente più ampia di quella necessaria e quindi 
tagliare la carta o cartone fino al formato finale richiesto. Le immagini, le immagini di sfondo e i 
riempimenti destinati a estendersi fino al bordo della pagina devono essere estesi oltre la linea di 
rifilatura per permettere il Bleed. 

 

I Bleed negli Stati Uniti sono in genere eccedono di 1/8 di pollice [3 mm circa] da dove deve essere fatto 
il taglio. I Bleed nel Regno Unito e in Europa sono generalmente da 2 a 5 mm oltre la linea di taglio. 
Ciò può variare da una tipografia all'altra. Alcuni tipografi richiedono dimensioni specifiche; la 
maggior parte delle tipografie pongono i requisiti specifici sul loro sito web o offrono modelli già 
impostati per le impostazioni di Bleed richieste. 

 

Bleed information Le informazioni di Bleed fanno riferimento a elementi esterni al pezzo finito. Spesso 

uno stampatore richiede le informazione di Bleed dei pezzi che hanno il Bleed per consentire il 
"printer bounce" [non ho trovato traduzione, a occhio potrebbe essere il margine di errore della 
tipografia... EDIT Per “bounce” ho trovato una definizione qui; traducendo: “Il bounce è un problema di registrazione 

ricorrente nella fase di stampa della produzione. In altre parole, l'immagine "rimbalza" sul foglio e non viene stampata nello 

stesso punto su ogni pagina. È possibile avere il bounce di un solo colore.”- Probabilmente vuol dire che in ogni foglio la 

posizione della stampa è leggermente diversa, per cui il taglio sarà in posizione relativa differente, ed ecco perché serve il 

Bleed - N.d.M.] quando si fa un lavoro su misura. Se non vengono fornite informazioni sul Bleed e sui 
segni di rifilatura (Crop marks), i pezzi finiti possono presentare una sottile superficie bianca sul 
bordo.  

 

Die-cuts  Le fustellature talvolta richiedono un Bleed da 1/4 di pollice [circa 6 mm] da dove la pagina 
deve essere tagliata; ciò è dovuto al possibile movimento della carta durante la procedura di 
fustellatura. 

 

Full bleed è la stampa da un bordo all'altro della carta senza i bordi standard con cui la maggior parte 
delle stampanti personali sono limitate. Ciò è utile per la stampa di brochure, manifesti e altro 
materiale di marketing. 

 

 
Fig.  41 – adattata da Wikipedia 

  
 
 
 
1. Trim è dove il prodotto verrà tagliato. 
2. Bleed è la zona al di fuori dell'area di ritaglio. 
3. Il margine è la zona all'interno dell'area di 

ritaglio. 
 

[per me quest'immagine è un po' fuorviante: 
credo che vada considerata area di ritaglio la 
zona da 3 a 2, ossia tutta la zona esterna al 
margine, dove può cadere la lama] 

 

E se devo cambiare un progetto in corso d’opera? 

E se devo cambiare qualche parametro quando ho già iniziato a lavorare? O peggio, quando il mio lavoro 
è già ben avviato? 

È possibile modificare i parametri della pagina da Edit > Canvas properties… in cui ritrovo tutti i 
parametri legati alle dimensioni (una specie di finestra New ridotta), che posso andare a modificare. 

https://carterprinting.com/glossary/what-bounce
http://en.wikipedia.org/wiki/Die_cutting_(shearing)
https://en.wikipedia.org/wiki/Bleed_(printing)
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Rimane valida l’osservazione di stare attenti alla somma delle dimensioni della pagina e del bleed: in caso 
eccedesse quelle del Canvas, bisogna modificare anche queste. 

 

 
Fig. 42 – Canvas Properties 

Può essere che la finestra appaia con dimensioni più ridotte, qui l’ho estesa per mostrare tutti i 
parametri.  

Non ho fatto la prova per questa particolare operazione, ma in teoria se si devono modificare molte 
pagine si può avviare un processo in batch da File > Batch process…, che permette di applicare le modifiche 
a più tavole in un colpo solo, senza dover ripetere le stesse operazioni manualmente. Vedi anche più sotto. 

Safety margin 

Dalla versione 1.8.4 (Nov. 2018 ) è presente un’altra impostazione nei settaggi generali del foglio. Si 
tratta del Safety margin (Fig.  43; si imposta in 28 nella Fig.  38). Da quello che ho capito è un bordo di 
sicurezza esterno alla gabbia che garantisce la stampa di ciò che viene disegnato, qualsiasi sia il formato di 
stampa che verrà utilizzato. Quindi, se si esce dalla gabbia, bisogna ricordarsi di tenere le cose importanti 
(es. personaggi, dialoghi) all’interno del Safety margin. 

Vedi anche https://tips.clip-studio.com/en-us/articles/1375#995c99eb. 
 

https://tips.clip-studio.com/en-us/articles/1375#995c99eb
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Fig.  43 - In verde il Safety margin (immagine dal Manuale online) 

Story Information 

La sezione Story Information (34 in Fig.  38) serve a definire alcune informazioni che possono essere 
visualizzate al di fuori dell’area di stampa, al di sotto del riquadro del Bleed. Tali informazioni sono intuitive: 
Story name è il titolo di lavorazione del progetto, Subtitle il sottotitolo, Author l’autore. Per Story name (che 
porta con sé Subtitle) e Author si può decidere la posizione: a sinistra, centrale o a destra.  

Number of stories è, secondo il Manuale, il numero di storie nel progetto. Però, se scelgo ad esempio 3, 
l’informazione riportata poi sulle pagine è 3 story. Mi sembra che questa informazione sia piuttosto il 
numero della storia nella pubblicazione finale, tipo “è la terza storia nel prossimo numero di Topolino”, 
altrimenti non me ne spiego l’utilità. In realtà, tutte le informazioni in Story Information sono facoltative, 
per cui la loro omissione non pregiudica la creazione del documento. 

Ultima casellina che può essere spuntata in questa sezione è Page number, che permette di visualizzare 
il numero della pagina su cui si sta lavorando. È possibile anche qui scegliere la posizione e anche da che 
numero partire con la numerazione.  

Per essere visibili è necessario che le dimensioni del Canvas non siano esattamente la somma del 
Binding e del Bleed, ma un po’ più grandi. 

 

 
Fig.  44 
 

 

 

 
Fig.  45 

Folio 

La sezione Folio (39 in Fig.  38) serve per far apparire il numero di pagina all’interno dell’area di stampa. 



Appunti di Manga Studio/ClipStudioPaint   

46 

Si possono decidere varie opzioni per la formattazione e può essere decisa la posizione del numero nella 
pagina: in alto (Top) o in basso (Bottom) e se a sinistra, al centro o a destra. Anzi, più precisamente, il 
programma propone Top/Bottom inside, Top/Bottom e Top/Bottom outside. Con solo Top o Bottom il 
numero viene messo al centro orizzontale della pagina; con inside (= all’interno) viene messo sul lato della 
pagina dove si trova la rilegatura, mentre con outside (= all’esterno) sul lato opposto al lato rilegatura. 

Con Format si può aggiungere del testo prima e dopo il numero: ricordarsi di lasciare uno spazio dopo il 
primo testo e uno spazio prima del secondo testo, in modo da separare il testo dal numero. 

Blind Folio: quando questa casellina è spuntata, oltre alle altre informazioni della sezione appare il 
numero della pagina (un’altra volta) nella parte inferiore, nel lato della rilegatura. Per il momento non 
comprendo l’utilità di questa cosa, penso che siano convenzioni tipografiche, ma è una mia supposizione. 

Documenti multipagina – Multiple pages 
Ovviamente molto spesso c’è bisogno di realizzare un documento composto da più tavole collegate tra 

loro. CSP consente di creare un unico documento che raccoglie tutte le tavole del lavoro che si sta 
realizzando, una specie di documento “cartella” che contiene i “file” delle tavole.  

Al momento della creazione del fumetto multipagina, le impostazioni relative alle varie dimensioni della 
tavola (Canvas, Comic Settings, Safety margin) si impostano come già visto, e sono valide per tutte le tavole 
del progetto. Spuntando la casellina Multiple pages (30 nella Fig.  38) si può inserire il numero di pagine che 
comporranno il documento: si può inserire il numero manualmente o scegliere tra le possibilità proposte 
cliccando sulla casellina con la freccetta a fianco. 

 

 
Fig.  46 

Binding point permette di scegliere se la rilegatura sarà a sinistra (Left binding - come nei fumetti 
occidentali) o a destra (Right binding - come nei manga). 

Start page si usa per stabilire se la pagina iniziale sarà una pagina a sinistra (From left) oppure a destra 
(From right); nei fumetti occidentali le pagine a sinistra sono quelle pari, quelle a destra le dispari: 
generalmente quindi iniziano con una pagina destra (scegliere cioè From right). 

Spuntando la casella Combine into two-page spreads le pagine sinistre e destre vengono unite in modo 
da poterci disegnare sopra senza soluzione di continuità. Quando si spunta questa casella si rende attiva 
anche la casella Align crop mark (27 nella Fig.  38), che permette di regolare il distanziamento delle due 
pagine a livello della linea di rilegatura. Se il valore è impostato a 0, all’interno, lungo la rilegatura, non 
viene riportato lo spazio di Bleed. 

 

Con Resolution si imposta la risoluzione della copertina, con Basic expression color il metodo colore 
desiderato. 

Con Template si apre la finestra dei materiali relativa ai Framing template (anche se si apre con il solo 
nome Template, sono gli stessi), da cui è possibile scegliere un modello di suddivisione della gabbia. 

 

Una volta impostate tutte le preferenze, premere OK. Dopo alcuni istanti di elaborazione (dipende 
molto dal numero di pagine scelto) si apre il Page Manager: la vista di tutte le tavole che compongono il 
lavoro. Il Page Manager permette di avere sotto controllo tutte le tavole a colpo d’occhio e passare da una 
all’altra in velocità. 
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Fig.  47 – Page Manager –Documento di sei pagine, pagina iniziale destra e opzione “Combine into two-page spreads” attivata  

 
Fig.  48 – Page Manager –Documento di sei pagine, pagina iniziale destra e opzione “Combine…” disattivata  

 
Fig.  49 – Page Manager –Documento di sei pagine, pagina iniziale sinistra e opzione “Combine…” disattivata  

Attivando l’opzione Cover page (33 in Fig.  38), quattro delle pagine verranno destinate alla copertina del 
progetto: due per la copertina esterna, Cover page e Back cover page, e due per l’interno di queste, Cover (inside) e 
Back cover (inside); queste denominazioni vengono visualizzate quando verrà creato il documento, dopo aver 
premuto l’OK.  

Notare che, quando viene  attivata l’opzione Cover page, viene disattivata l’opzione Binding point vista poco fa; 
appaiono invece due miniature per l’opzione Cover page layout (44 in Fig.  38), che permette di decidere se la 
copertina sarà composta da due pagine separate o da una doppia pagina. Se si sceglie questa, si attiva la casella 
Specify spine width, che consente di aggiungere dello spazio relativo allo spessore della costa della pubblicazione. 
 

 

 
Fig.  50 – Cover page layout, primo layout 

 
Fig.  51 – Page Manager – Documento di sei pagine, pagina iniziale destra, opzione “Cover page” attivata con 
il primo layout 

 
Fig.  52 – Cover page layout, secondo layout 
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Fig.  53 – Page Manager –Documento di sei pagine, pagina iniziale destra , opzione “Cover page” attivata con 
il secondo layout 

Per lavorare su una tavola cliccare due volte sulla sua anteprima, si apre la relativa area di lavoro. Sia il 
Page Manager che le tavole hanno riportato in etichetta il nome scelto con Story name (vedi più sopra) ma 
questo non sarà di default il titolo che darò al progetto quando lo andrò a salvare: è più un titolo di 
lavorazione.  

A tal proposito, una cosa che faccio subito è selezionare l’etichetta del Page Manager del progetto e 
salvarlo con Save as… Si apre la finestra Create story folder in cui gli si può dare un nome e scegliere dove 
salvarlo. Il documento che viene creato è un file .cmc, ed è la “cartella” in cui vengono salvati i vari .clip 
relativi alle tavole, chiamati page0001, page0002, ecc. 

La posizione del Page Manager sull’area di lavoro può essere cambiata in Story > Page Manager Layout. 
Se il Page Manager toglie troppo spazio, è possibile o estendere l’area di lavoro delle tavola fino a 

ricoprirlo quasi interamente, oppure spostarlo in un altro punto dello schermo o anche su un altro 
schermo. 

Quando il lavoro su una tavola è terminato, salvarla col nome che viene proposto: se le si cambia il 
nome viene salvata, ma quando riapro l’intero documento verrà caricata la versione originale, quella col 
nome proposto. La tavola con il nome modificato sarà comunque disponibile, però per farla rientrare nel 
progetto devo salvarla sovrascrivendo la tavola originale. È possibile ovviamente lavorare su una tavola 
indipendentemente, senza dover aprire tutto il Page Manager o lavorando su un altro computer; per poter 
essere sicuri che poi entri a far parte del progetto bisogna salvarla col nome relativo alla pagina che 
diventerà, ad es. page0019.clip, e andare a sostituire la 0019.clip originale, creata dal Page Manager nella 
posizione di salvataggio. 

Struttura del documento 
Spunto per questo paragrafo nato leggendo questo post. 
 

Per velocizzare il lavoro, per esigenze del committente, per praticità personale, ecc. può essere 
necessario organizzare i nuovi documenti in modo che abbiano la stessa struttura: dimensioni, divisione in 
vignette, ordine, tipo e nome dei livelli e così via. 

Poter applicare queste impostazioni al momento della creazione del documento senza doverle 
reimpostare ogni volta è decisamente utile, e ci sono diversi modi per farlo. 

 

 Auto Action – Ad es. per la struttura dei livelli. 
Si registra un’Auto Action mentre si crea la struttura dei livelli. Successivamente, dopo aver creato un 

nuovo documento, si fa partire l’Auto Action, che ricrea la stessa struttura. Questo metodo non registra 
eventuali trascinamenti di Framing template dai Material. Per informazioni su come creare un’Auto Action 
vedi più sotto. 

 

 Preset – Ad es. per le dimensioni e la squadratura della tavola (o insieme di tavole). 
Si crea un nuovo documento e si impostano tutti i parametri come visto in Impostare le dimensioni del 

documento. Prima di dare l’OK, salvo queste impostazioni come Preset (Fig.  38, 6), che sarà richiamabile 
quando creerò un altro nuovo documento. La struttura dei livelli e la divisione in vignette non vengono 
impostate a meno di non spuntare la casellina Template e scegliere, appunto, un opportuno template.  

 

 Template – Ad es. per struttura dei livelli e divisione in vignette. 
- Framing template, in un documento appena creato. 

È il metodo più semplice per dividere una tavola in vignette. Nei materiali, in All materials > Manga 
materials > Framing template, sono presenti alcuni modelli di divisione della tavola, basta trascinarne uno 

https://www.facebook.com/groups/mangastudioitalia/posts/4058516944259275
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sul Canvas per ottenere una suddivisione in vignette bell’e pronta*. La suddivisione si adatta alla gabbia 
della tavola. È possibile registrare tra i materiali anche delle vignettature personali, per poterle utilizzare 
successivamente, vedi più sotto. 

 
- Template, alla creazione di un nuovo documento.  

Analogamente ai Framing template, gli stessi modelli possono essere scelti al momento della creazione 
del nuovo documento, quando è ancora presente la finestra New. Basta, infatti, spuntare la casellina 
Template perché si visualizzi un pulsante, premendo il quale si apre la finestra Template dalla quale si può 
scegliere il modello desiderato. La cosa interessante è che è possibile salvare come template (da Edit > 
Register Material > Template…) una stuttura di livelli, con nomi, metodi di fusione, colore del livello, ecc. e 
poi poterla richiamare in questo momento.  

Se una volta creato un nuovo documento, imposto una divisione in vignette* e una struttura dei livelli, e 
infine salvo il tutto come Template, posso creare ulteriori nuovi documenti scegliendo un Preset per le 
squadrature e dimensioni della tavola e, spuntando la casellina Template, aggiungere (se presenti in quel 
template) la divisione in vignette e/o la struttura dei livelli. 

 

 Duplicazione -  Ad es. per storie multipagina con pagine simili. 
Creo il mio documento, imposto tutto quello che mi serve (vignette o vignettona a tutta pagina* pronta 

per essere tagliata successivamente, struttura dei livelli, ecc.), poi vado su Story > Duplicate Page e mi 
ritrovo con due pagine con le stesse impostazioni, raccolte nel Page Manager che viene visualizzato. Se 
seleziono entrambe le pagine nel Page Manager e ripeto il comando Duplicate Page, mi ritrovo con quattro 
pagine identiche, e così via.  

 
*Non è detto che la divisione in vignette sia la stessa per ogni tavola, e forse ha quindi più senso creare una 

predisposizione alle vignette creando una vignettona unica (o importandola dai Template) che occupi tutta la gabbia, 
pronta per essere divisa all’occorrenza con i comandi Figure > Frame > Divide frame folder / Divide Frame border. Vedi 
più sotto. 
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Esportare 

Quando esporto, quali dimensioni del foglio ottengo? 

È la domanda che mi sono posto esportando un disegno che io volevo avesse le dimensioni finali pari al 
Binding size che avevo impostato e che invece risultava avere le dimensioni del Canvas (quindi più grande). 

Quando esporto in .jpg, la finestra di dialogo mi propone di scegliere un Export Range (ex Output Range; 
la finestra per il .png è simile e suppongo che anche per gli altri formati sia analoga; non ho controllato):   
 

 
Fig.  54 

A seconda di quale opzione scelgo, l'immagine finale avrà dimensioni differenti (vedi pagine successive):  
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Opzione "All pages": l'area dell'immagine è quella del Canvas 
 

 
Fig.  55 

Opzione "To offset of crop mark": l'area dell'immagine è quella del Binding size più il Bleed (quindi il 
formato del foglio più il margine di incertezza del taglio tipografico) 

 

 
Fig.  56 
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Opzione "To inside of crop mark": l'area dell'immagine è quella del Binding size (quindi solo il formato 
del foglio) 

 

 
Fig.  57 

Per sapere quanto sarà grande il mio documento stampato, vedi più sopra. 

Esportare più pagine – Batch export 

È possibile esportare più pagine contemporaneamente da un documento multi-pagina (.cmc), cioè 
esportare “in batch”. 

Selezionando File > Export multiple pages > Batch export… si apre la finestra di dialogo Batch export, 
 

 
Fig. 58 

https://www.wordreference.com/enit/batch
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nella quale si impostano percorso, formato, nome del file e intervallo di pagine da esportare, se esportare i 
testi in un file .txt, e se dividere le pagine spread. 

Dando l’OK si apre poi la finestra Export setting vista più sopra, in cui si scelgono le altre impostazioni e 
infine, scegliendo ancora una volta OK, si lancia l’esportazione del batch. 

3D Preview for binding 

Sempre in File > Export multiple pages, selezionando 3D preview for binding… è possibile creare 
un’anteprima interattiva della pubblicazione che si sta realizzando.  

Viene creata una simulazione 3D del volume, ruotabile nello spazio e in cui si possono scorrere le pagine 
e modificare il tipo di rilegatura. Simpatico! 

 

 
 

 

 

 
Fig. 59 
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Batch process 
Come già accennato (vedi più sopra), è possibile effettuare delle operazioni su più documenti aperti 

senza doverle ripetere in ogni documento. Da File > Batch process…  si seleziona l’operazione da compiere, 
a quali documenti applicarla e se salvare e chiudere, o meno, i file modificati.  

Posto che mi sfugge perché si debbano modificare dei lavori per poi chiuderli senza salvarli (devo fare 
qualche esperimento…), in sé Batch process è un comando molto importante, direi quasi salvavita: penso 
soprattutto a chi deve cambiare le dimensioni di svariate pagine e trema al pensiero di doverle ridisegnare! 

 

 
Fig. 60 – La finestra Batch process 

Layer (Livelli)  
Argomento vasto, un po’ alla volta spero di dare un occhio a tutti gli aspetti. 

Come in molti altri programmi, il lavoro su CSP si organizza in livelli (layer). Possono essere immaginati 
come dei fogli trasparenti sovrapposti su cui posso andare a disegnare, colorare, inserire linee guida ecc. 

Tutti i livelli possono essere resi visibili o meno sul Canvas: cliccando sull’occhio che si trova a fianco del 
livello stesso lo si “spegne”, ricliccando nello stesso punto lo si “riaccende”. Segue che se un livello ha un 
occhio a fianco allora è visibile; se non l’ha, non è visibile. Visibilità significa anche, per molti aspetti, 
possibilità di operare nel livello. 

 

 

 
Fig.  61 – Il livello è visibile: c’è l’occhio 

 

 

 
Fig.  62 – Il livello non è visibile: non c’è l’occhio 

 

Il layer editabile (cioè quello che stiamo utilizzando) è contraddistinto dal simbolo di una penna. In altre 
versioni questo simbolo sembra un coltellino (in realtà credo sia una penna stilografica). 

Draft layer  

Un livello può essere impostato come Draft layer (= livello bozza). Quando un livello è Draft, allora certe 
azioni possono essere compiute ignorandolo, come quando si impostano dei riferimenti ad esempio per le 
selezioni. In poche parole, se imposto un livello come Draft, posso all’occorrenza fare una selezione che 
tenga conto del contenuto di tutti i livelli tranne che del Draft, che così risulta essere solo un livello di 
costruzione del disegno. 

Allo stesso modo, al momento di esportare un disegno posso escludere l’esportazione del livello Draft: 
lo vedo sul Canvas su cui ho disegnato ma non nel file esportato.  

Ci può essere più di un livello Draft. 
In genere imposto come Draft il layer con le “matite”, cioè il disegno non ancora inchiostrato. Spesso 

(specie se non ho realizzato il disegno già con una matita blu) cambio il colore del contenuto del layer 
cliccando sull’iconcina Change layer color, nella Property bar della Layer palette, che di default è impostata 
su un ciano (va da sé che anche questo colore può essere personalizzato). Vedi anche più sotto. 
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Per impostare un livello come Draft andare su Layer > Layer Setting > Set as Draft Layer, oppure cliccare, 
nella Property bar della Layer palette, sull’icona con la matita Set as Draft Layer (vedi più sotto).  

Reference layer  

Un livello può essere impostato come Reference layer (= livello di riferimento). Un layer impostato come 
Reference può fungere da riferimento per alcuni strumenti o per le selezioni. Ad esempio, posso fare in 
modo che una selezione fatta su un layer in realtà consideri come limite anche il contenuto di altri layer. È 
utile ad esempio quando si fanno i riempimenti, in cui si lavora su un livello ma riferendosi alle linee che 
stanno su un altro, il Reference appunto. 

Nel Reference layer accanto alla miniature del livello appare l’iconcina di un faro. 
Per impostare un livello come Reference andare su Layer > Layer Setting > Set as Reference Layer, 

oppure cliccare, nella Property bar della Layer palette, sull’icona con il faro Set as Reference Layer (vedi più 
sotto).  

Possono essere impostati come Reference layer più livelli contemporaneamente, basta selezionarli (CTRL 
+ clic sui singoli livelli, oppure Shift + clic sul primo e l’ultimo di una serie di livelli successivi) e cliccare, nella 
Property bar della Layer palette, sull’icona con il faro.  

Livelli raster e livelli vettoriali 

In CSP è possibile disegnare su due tipi di livello: raster e vettoriale.  
Se traccio due linee, una su un livello vettoriale e una su un livello raster, queste sono simili [io qui ho 

disegnato la linea in vettoriale, ho duplicato il livello e ho convertito la copia in raster, per questo sono proprio identiche]: 
 

 
Fig.  63 

Ingrandendo il disegno con lo zoom possiamo vedere che a un certo punto le due linee “sgranano”: 
 

 
Fig.  64 

Questo accade quando ho ingrandito tanto da rivelare la griglia di pixel su cui l’immagine è costruita 
[leggi anche la risposta di Massimo Borri a  questo post, "...CSP è un programma di grafica raster (o bitmap, 
a pixel insomma) e i layer "vettoriali" contengono solo i percorsi del pennello usato, poi vengono disegnati 
comunque i pixel (tanti o pochi a seconda della risoluzione del lavoro)..."]. 

https://www.facebook.com/groups/mangastudioitalia/permalink/5116556745121951
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Torno indietro con lo zoom e ingrandisco le due linee in maniera “fisica” stavolta, cioè andando a 
modificare effettivamente le loro dimensioni.  

Per far ciò per il livello vettoriale creo una selezione attorno alla linea (in realtà per i livelli vettoriali 
potrei usare lo strumento Operation > Object, toccare la linea e trascinare un angolo del rettangolo di 
inviluppo che appare, ma funziona anche con la selezione), poi vado su Edit > Transform > Scale e tenendo 
schiacciato il tasto Shift (per non modificare le proporzioni) trascino la selezione per un angolo fino a 
ingrandirla per bene. CTRL+D per eliminare la selezione e faccio la stessa cosa per la linea sul livello raster 
(in questo caso posso ingrandire solo creando prima la selezione perché lo strumento Object non agisce 
sulle linee dei livelli raster).  

Tornando poi a guardare una piccola zona con lo zoom (Fig.  65), posso vedere come la linea vettoriale 
non è per nulla diversa rispetto a prima di essere stata ingrandita “fisicamente”, mentre l’aspetto della 
linea raster è decisamente peggiorato, perdendo di definizione. 

 
 

 
Fig.  65 

Spiegata a grandi linee ( …), la linea vettoriale è definita da funzioni matematiche che dicono al 
programma come ricostruirla a ogni ingrandimento “fisico”. Il livello vettoriale in pratica immagazzina non 
tanto l’immagine della linea come l’ho disegnata, ma come modificare le proprietà della linea tra vari punti 
chiave ogni volta che la ingrandisco (o rimpicciolisco). La qualità della linea rimane ottimale. 

La linea raster, una volta disegnata, quella è. Se voglio ingrandirla “fisicamente” devo farlo con quello 
che ho: ciò vuol dire che se prima un suo punto qualunque mi occupava un pixel, da ingrandita quello 
stesso punto mi deve bastare per, faccio un esempio, nove pixel. Si crea la cosiddetta pixellatura, ecco 
perché la qualità si deteriora. 

 

Di una linea vettoriale il programma conosce le proprietà di alcuni punti e le relazioni che intercorrono tra un 
punto e un altro, cioè ha un insieme di “… istruzioni e parametri per disegnare l'immagine finale, elemento per 
elemento, a partire da primitive geometriche come linee, curve, poligoni…” (vedi qui). Se ingrandisco la linea, le 
istruzioni per disegnarla rimangono le stesse, varia solo la scala alla quale va disegnata. Tutte queste informazioni 
sono registrate in termini di funzioni matematiche e il programma non deve immagazzinare i dati ogni singolo pixel 
dell’immagine. A qualsiasi dimensione e risoluzione la linea è ridisegnata in maniera ottimale, senza perdite di 
definizione. 

Un’immagine raster è una griglia di punti (i pixel), ciascuno con determinati valori di colore e luminosità;  
disegnando una linea in raster si definiscono le proprietà dei vari pixel che la compongono. Una volta stabilite, 
valgono per l’immagine così come è stata creata, cioè per quelle dimensioni e quella risoluzione. Se ingrandisco 
l’immagine, vengono introdotti dei nuovi pixel che non hanno informazioni sulle proprietà che devono avere e il 
software, in qualche modo, gliele crea ex-novo sulla base di quello che c’è intorno. L’informazione mancante viene 
interpolata, più o meno bene: è a questo punto che si creano le pixellature. 

Qui, qui e qui ci sono degli articoli per approfondire l’argomento (comunque in rete si trovano moltissime altre 
pagine). 

 

CSP non lavora in maniera pura con il vettoriale, ad esempio non permette il riempimento vettoriale di 
forme chiuse da linee vettoriali. Non è possibile cioè disegnare una superficie colorata in un livello 
vettoriale, come ad esempio fa Adobe Illustrator.  

In CSP, i riempimenti si realizzano utilizzando livelli raster. 

https://it.wikipedia.org/wiki/Pixel
https://www.grafigata.com/differenza-raster-vettoriale-grafica/
https://www.grafigata.com/tutorial/che-cosa-e-il-formato-vettoriale/#gref
http://www.didatticaincorso.it/2018/12/13/vettoriale-vs-raster/
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Per aggiungere un livello raster cliccare sull’icona New Raster Layer  nella Command bar della Layer 
palette (di default sopra ai livelli); per aggiungere un livello vettoriale cliccare sull’icona New vector layer 

 . 

Uso dei livelli raster e dei livelli vettoriali 

Personalmente, utilizzo i livelli vettoriali CSP per le linee, o lineart: in sostanza, l’inchiostrazione. I tratti 
realizzati in vettoriale sono gestibili con facilità: sono scalabili (ingrandibili o riducibili) senza perdita di 
dettaglio, correggibili e selezionabili velocemente. Per contro, non è possibile fare una campitura (oddio, si 
può anche riempire con un tratto vettoriale usandolo a mo’ di pennarello, ma con risultati a parer mio 
discutibili e malgestibili). 

Uso i livelli raster per tutto il resto (e quando ho bisogno di effetti sulle lineart, es. color holds, vedi più 
sotto), anche se molti anche se molti li preferiscono anche per le lineart. Questione di gusti. 

Mostra i tracciati vettoriali – Show vector paths 

Si può abilitare o disattivare la vista del tracciato che su cui è costruito un tratto vettoriale. Basta andare  
su View > Show vector paths > Show vector paths on selected layers.  

 

 
Fig.  66 – A sinistra il tracciato non è visibile, mentre a destra sì. 

Sono possibili anche altre opzioni, come visualizzare tutti i tracciati sui livelli vettoriali (Show all vector 
paths on vector layers); mostrare i punti di controllo all’inizio e alla fine del tracciato (Show control points at 
beginning and end) o mostrare tutti i punti di controllo del tracciato (Show all control points). 

Livelli in un nuovo documento 

Quando si crea un nuovo documento, di default questo contiene due livelli: un livello chiamato Paper 
(carta), e un livello raster. 

Il livello Paper sta al di sotto di tutti, ed è anche l’unico livello a non essere trasparente di default. Non 
può essere spostato dalla sua posizione e non può essere messo dentro a una cartella. 

 

 
Fig.  67 

Creando un nuovo file, nella finestra New è possibile togliere la spunta alla casellina Paper color (vedi 15 
in Fig.  38) e così facendo il livello Paper non viene creato, oppure è possibile decidere per un colore diverso 
dal bianco (cliccando nel riquadro 16); il colore del livello Paper potrà essere cambiato anche in un secondo 
momento.  

A questa situazione predefinita posso aggiungere quanti livelli (raster o vettoriali) voglio, a seconda  
della necessità o della complessità del disegno. Per aggiungere un livello raster o vettoriale basta cliccare, 
nella Command bar della Layer palette, l’icona corrispondente. 

Collegare i livelli (spunta) 

Il livello su cui si sta lavorando è quello con il simbolo della matita: 
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Fig.  68 – Livello su cui sto lavorando 

Negli altri livelli in generale non appare nulla. È possibile però collegare più livelli tra di loro, toccando i 
livelli da collegare con il cursore a fianco dell’occhio corrispondente, facendo apparire un segno di spunta: 
 

 
Fig.  69 – Livelli collegati 

È  possibile così spostare il contenuto, modificare la trasparenza, applicare effetti ecc. di tutti compiendo 
queste azioni solo sul livello con la matita. Il collegamento è piuttosto labile: se seleziono un livello che non 
sia quello con la matita, viene perso. Le spunte compaiono anche se seleziono più livelli 
contemporaneamente, tenendo premuto il tasto Shift. 

Layer palette 

La Layer palette è quella parte del programma in cui sono elencati i livelli e da cui si possono controllare 
le loro caratteristiche. Di default, nella sua parte superiore si trovano la Property bar e la Command bar 
della Layer palette. Specifico di default perché io preferisco tenere la Command bar nella parte inferiore. 

Command bar della Layer palette 

 
Fig.  70 - Command bar della Layer palette 

Da sinistra, i comandi: 
Show layers in 2 panels; New Raster Layer; New vector layer; New Layer Folder; Transfer To Lower Layer; 

Combine to layer below; Create layer mask; Apply Mask to Layer; Delete Layer. 
 

Il primo comando serve a dividere la Layer palette in due finestre sovrapposte, uguali tra loro, con tutti i 
layer. Può essere utile se si sta lavorando alternativamente in due layer distanti tra loro, per evitare di fare 
lo scroll di tutta la palette per passare da uno all’altro.  
 

Di base i livelli sono indipendenti uno dall’altro, ma è possibile rendere un livello dipendente dal 

contenuto del livello sottostante, con l’icona Clip to Layer Below     (per l’utilizzo di Clip to Layer Below 
vedi anche i paragrafi sui Color holds, più sotto, e su come colorare senza sbordare, più sotto). 
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Property bar della Layer palette 

 
Fig.  71 - Property bar della Layer palette 

Riga superiore, da sinistra i comandi: 
Change palette color; Blending mode; Opacity; 
 

Riga inferiore, da sinistra i comandi: 
Clip to Layer Below; Set as Reference Layer; Set as Draft Layer; Lock Layer; Lock Transparent pixels; Enable 

Mask; Set showing area of ruler; Change layer color. 
 

Cliccando su Change palette color si può contrassegnare il layer su cui si sta lavorando con un colore, per 
renderlo riconoscibile. 

 

 
Fig.  72 

 

 

 

 

Merge visible to new layer 

Utilizzando questa opzione viene creato un nuovo layer raster che ha il contenuto dei layer visibili ma 
non li elimina, lasciandoli quindi ancora disponibili. 
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Clip Studio SHARE e Foil layer 

Tra le opzioni elencate quando si crea un nuovo livello troviamo, alla fine, Clip Studio SHARE > Foil layer. 
 

 
Fig.  73 - I vari tipi di livello 

Ho cercato un po’ e ho scoperto che Foil 
layer (funzione della versione EX di CSP) 
permette di riempire una selezione con un 
effetto “foglio di alluminio”, quindi una 
superficie metallica riflettente, del colore 
che si desidera (non trasparente), che poi 
potrà essere stampata. Può servire ad 
esempio per fare delle scritte con effetto 
metallico nella copertina di un fumetto, o 
simulare l’applicazione di una foglia d’oro in 
un’illustrazione.  

Ovviamente una normale stampante 
casalinga non riprodurrà l’effetto metallo, 
per cui se si ha intenzione di pubblicare in 
cartaceo la propria opera con questa 
particolare caratteristica, bisognerà prima 
sentire la propria tipografia o il proprio 
editore per capire come realizzarla. 
 

Fino alla conferma tipografica, l’effetto aggiunto è quindi visibile solo utilizzando il servizio Clip Studio 
SHARE (CSS, vedi qui), che permette di condividere le proprie creazioni online, ad esempio tramite Twitter.  

Per creare una zona metallizzata è necessario: 

 prima creare una selezione (nel caso, ad esempio, di un testo selezionare la parte 
occupata dalle lettere); 

 selezionare, o dalla Layer palette con tasto destro su un layer, o dal menù Layer: New 
Layer > Clip Studio SHARE > Layer foil; 

 si apre la finestra New foil layer, in cui si può cambiare il colore dell’effetto metallico, 
decidere che tipo di effetto generale creare (di tipo “emboss”, sbalzo), ma 
soprattutto con un visualizzatore 3D con cui vedere l’effetto all’opera; 

 dare l’ok; 

 viene creato un nuovo livello con maschera, chiamato “_SH Shiny Layer”, a cui non 
bisogna cambiare nome, pena l’annullamento dell’effetto una volta caricato su CSS; 

 infine cliccare sull'occhio per spegnere il livello. L'informazione dell’effetto metallico 
verrà conservata. 

Per condividere su CSS aprire Clip Studio e cliccare su Showcase your work nel menù a sinistra; su CSS si 
può condividere qualsiasi lavoro, non necessariamente qualcosa di “metallizzato”. 

Altri consigli per creare una pubblicazione con CSP possono essere trovati qui (in inglese). 

Layer Property palette 

Sopra la palette dei livelli si trova la palette Layer Property. Contiene alcuni comandi, che variano in base 

al tipo di layer selezionato. 

  

https://share.clip-studio.com/en-us/
https://share.clip-studio.com/en-us/help#making_book
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Search Layer palette 

Dietro la palette Layer Property si trova la palette Search Layer, che permette di visualizzare o meno solo 
i layer con certe caratteristiche. Crea quindi un elenco di layer simile a quello della Layer palette, ma in cui 
vengono filtrati i layer visualizzati. L’uso è piuttosto intuitivo. 

 

 
Fig.  74 
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Item bank palette 

Dietro alle palette appena viste si trova la palette Item bank, la quale serve a gestire vari file come 
immagini di riferimento, modelli 3D, filmati, file audio o altri file .clip. 

 

 
Fig.  75 – Item bank vuota 

 

 
Fig.  76 – Item bank con un’immagine e un file video 

In sostanza, ci posso creare un magazzino di file utili che possono essere trascinati sul Canvas se 
necessario, senza dover rovistare nel pc quando ne ho bisogno. 

Per aggiungere un file all'Item bank si deve cliccare sull'iconcina a forma di foglio in basso a sx: si apre 
una finestra di dialogo che permette di cercare il file nel pc. Una volta aggiunto il file all'Item bank, è 
possibile cambiargli nome cliccando sull'iconcina a forma di chiave inglese.  

Per aggiungere il file al Canvas basta fare un drag&drop, cioè trascinarlo sull'area di lavoro. 

Selection layer 

Il Selection layer è un layer che permette di salvare la forma di una selezione.  
Se ho una selezione, magari complessa e composta da più parti, che al momento non mi serve ma che 

vorrei richiamare più tardi, allora posso convertirla in un Selection layer andando in Select > Convert to 
Selection layer.  Sopra al layer su cui stavo lavorando  compare un nuovo livello, chiamato Selection 1 che 
contiene la forma della selezione, riempita di verde al 50% di opacità, e la selezione in sé scompare.  

 

Questo livello, all’occorrenza, può essere riconvertito in selezione, andando in Select > Convert Selection 
layer to Selection, oppure, dalla Layer palette, tasto destro sul Selection layer > Selection from layer. Vedi 
anche più sotto. 

Modificare una selezione 

Utilizzando il Selection layer si può anche modificare, indirettamente, una selezione. 
 Se si disegna all’interno del Selection layer con uno strumento colorato, si aggiunge della superficie 

verde (indipendentemente dal colore utilizzato); se si disegna con la trasparenza, si sottrae superficie.  
Oppure, posso applicare tutti i modificatori che servono a modellare una forma (Scale/Rotate, Free 

Transform, Mesh Transformation, ecc.). 
Una volta modificato il Selection layer, lo riconverto in selezione con Convert Selection layer to Selection. 
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Layer Mask 

Il Layer Mask è uno strumento che serve a mascherare (= nascondere) una parte del contenuto di un 
livello. Non è un  livello vero e proprio, nel senso che quando viene creato non va ad aggiungersi agli altri 
nella Layer palette; viene visualizzato invece all’interno del livello in cui viene creato, diventando una sorta 
di “modificatore” di quel livello. 

Per creare un Layer Mask devo innanzitutto creare una selezione sul livello che voglio mascherare (in 
realtà si può partire anche senza selezione, lo spiego più avanti). 

 

 

 
Fig.  77 

Dopodiché: 

 menù Layer > Layer Mask > Mask Selection / Mask Outside Selection, a seconda di ciò che voglio 
mascherare; 
oppure 

 tasto dx sul livello  che voglio mascherare > Layer Mask > Mask Selection / Mask Outside Selction. 
Qui ho seguito la seconda strada. 
 

 
Fig.  78 
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Ho cliccato su Mask Selection e ho ottenuto questo: 
 

 
Fig.  79 

Per capire meglio ciò che succede, creo un altro livello, sotto al primo, e ci disegno una linea. 
 

 
Fig.  80 

Il primo livello, quello dove ho applicato il Layer Mask, sembra bucato, come se ne avessi cancellato una 
parte. In realtà non è così, il contenuto del primo livello c’è ancora tutto, ma il Layer Mask mi permette di 
vedere quello che c’è sotto all’area mascherata. 

Noto  che nella Layer palette accanto alla minatura del livello mascherato si è affiancata la miniatura del 
Layer Mask. 

 

 
Fig.  81 

Altra cosa che noto è che la miniatura del Layer Mask ha una cornicetta bianca, il che significa che in 
questo momento, nel  livello, è selezionato il Layer Mask. 

Ciò è importante perché se voglio modificare il Layer Mask devo assicurarmi che sia selezionato questo, 
altrimenti si va a operare sul contenuto del livello. Questa cosa mi ha fatto imprecare un po’ prima di 
capirla, dato che il Manuale taglia via piuttosto sbrigativamente. Per passare dal Layer Mask al contenuto 
del livello e viceversa basta cliccare sulla miniatura relativa. 
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Con il Layer Mask selezionato, posso operare alcune modifiche. Se ci disegno sopra con uno strumento 
da disegno impostato con il colore trasparente posso aggiungere alla maschera altre zone, in pratica bucare 
ulteriormente il livello. 

 
Fig.  82 

Se invece lo strumento di disegno ha un colore diverso dal trasparente, allora rimuovo aree alla 
mascheratura, rivelando nuovamente il contenuto del livello. 

 

 
Fig.  83 

Poco più sopra dicevo che si può partire a creare il Layert Mask senza selezione. Se non creo la selezione 
e seguo ugualmente i passaggi visti più su, si crea ugualmente un Layer Mask, vuoto se utilizzo Mask 
Selection, o che ricopre totalmente il livello se utilizzo Mask Outside Selection. 

 

 
Fig.  84 
 

 

 
Fig.  85 
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Restando all’esempio iniziale, con Mask Selection, la miniatura del Layer Mask è completamente bianca. 
 

 
Fig.  86 

Per creare la mascheratura ora si può disegnare, come appena visto, con il colore trasparente (se avessi 
utilizzato Mask Outside Selection ora lavorerei con il pennello colorato anziché trasparente, per rimuovere 
la mascheratura). 

 

 
Fig.  87 

Variando l’opacità dello strumento da disegno varia anche l’opacità della maschera.  Tuttavia, non posso 
utilizzare un gradiente per  ottenere una mascheratura sfumata con Layer Mask, cosa che posso invece 
ottenere in altro modo (vedi più sotto). 
 

 
Fig.  88 

Sempre da tasto destro > Layer Mask o da menù Layer > Layer Mask, si possono scegliere altre opzioni: 

 con Delete Mask si cancella il Layer Mask e rimane solo il livello com’era all’inizio; 

 con Apply Mask to Layer si rende reale il buco che  il Layer Mask sembrava aver creato. Il livello e il 
Layer Mask vengono uniti e il nuovo contenuto del livello diventa ciò che si vedeva quando era 
presente il Layer Mask; 

 Enable Mask permette di visualizzare o meno il Layer Mask; 

 Show Mask Area colora di viola semitrasparente la zona occupata dal Layer Mask; 

 Link Mask to Layer vincola il Layer Mask al livello, così  quando si utilizza Move layer uno segue 
l’altro. Quando questa opzione è attiva, tra le due miniature appare un segno di spunta. 
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File object 

I File object sono livelli particolari, molto interessanti e di cui ancora non ho compreso appieno le 
potenzialità. In pratica sono dei livelli in cui si possono inserire immagini, altri file .clip o anche video, ma 
che possono essere editati solo parzialmente nel file in cui si sta lavorando: possono essere trasformati con 
Edit > Transform, ma non se ne può cancellare una parte o disegnarci sopra, ad esempio. 

Se importo come File object un altro file di tipo .clip, di quest’ultimo vedo solo il suo aspetto ma non 
posso andarlo a modificare. Vedo, in pratica, un’istanza di quel file. Per modificare il file inserito devo 
aprirlo, fare le modifiche e, una volta salvato, le variazioni appariranno anche nella sua istanza all’interno 
del file in cui sto lavorando. Lo stesso per un’immagine o un filmato, devo modificarli esternamente al file in 
lavorazione. 

Come si crea un livello File object?  

 Convertendo  un livello esistente, facendo tasto destro > Flie object > Convert layer to file object…; si 
apre una finestra in cui viene chiesto se  tenere come riferimento l’area dell’intero Canvas, solo 
l’area occupata dal contenuto del livello che sto convertendo oppure, se è presente una selezione, 
l’area della selezione.  

Ci sono inoltre altre opzioni: copiare o meno le impostazioni del livello Paper (copy paper 
settings), le impostazioni del Canvas (indicatori di taglio e impostazioni dei bordi, Copy crop 
mark/default border settings,opzione disponibile solo se in Area è selezionato Canvas Size), e la 
possibilità di mantenere il livello originale (Keep original layer). 

 

 
Fig.  89 

Quando do l’OK si apre la finestra di salvataggio, in cui si può notare che il File object verrà salvato 
come file .clip, esterno al file in lavorazione.Accanto alla miniatura del livello viene aggiunta una 
piccola icona che indica la trasformazione in File object, e il livello assume il nome di 
ObjectLayer_001 (oppure ..._002, …_003, ecc.). 
 

 
Fig.  90 

 Da File > Import > Create file object…, si apre la finestra di dialogo dalla quale è possibile scegliere un 
file in uno dei formati supportati (.clip, .bmp, .jpg, .png, .tif, .psb, .psd,.pdd) e importarlo. La sua 
istanza verrà collocata in un livello col nome del file importato. 

 Da File > Import > Movie…, si apre la finestra di dialogo dalla quale è possibile scegliere un file in uno 
dei formati supportati (.clip, .avi, .mp4, . mov) e importarlo. La sua istanza verrà collocata in un 
livello col nome del file importato e con l’icona caratteristica.  

Se è abilitata la Timeline (Window > Timeline) allora il filmato vi viene aggiunto come traccia; 
posso posizionarmi in un suo punto qualsiasi pur non potendolo, come già detto, modificare più di 
tanto.  Attenzione: anche se in uno dei formati supportati, è possibile che il filmato non venga 
importato: dipende dai codec presenti nel S.O. 

 

Vantaggi del File object? Al momento penso soprattutto alla possibilità di inserire ad esempio una 
vignetta (o un titolo) che immagino potrà essere modificata o sostituita in futuro senza dover metter mano 
per forza al file principale. Oppure, dato che l’origine del File object è modificabile (File object > Change file 
of file object…), poter cambiare al volo un dettaglio (ad esempio una immagine importata) senza apportare 
modifiche al file principale. Sperimenterò. 

https://it.wikipedia.org/wiki/Codec
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Duplicare un livello 

Per duplicare un livello posso: 

 cliccare il tasto desto sul livello e scegliere Duplicate Layer; 

 trascinare il livello sull’icona New Raster Layer nella Command bar della Layer palette. Funziona sia 
con livelli raster che vettoriali (ottenendo rispettivamente duplicati raster e vettoriali), ma entrambi 
i tipi di livello vanno trascinati sull’icona New Raster Layer (strano, ma è così); 

 con lo strumento Move layer, tenere premuto Alt e trascinare il cursore sullo schermo; 

 col livello selezionato, usare la combinazione di tasti Alt + L [impostazione personale]; 

 col livello selezionato, andare nel menù Layer > Duplicate Layer; 

 da File > Command Bar Settings… estrarre un’icona per il comando, posizionarla sulla Command bar 
e poi utilizzarla, avendo prima selezionato il livello da duplicare. 

Svuotare un livello 

Si può voler cancellare il contenuto di un livello, mantenendo però il livello stesso. Un modo veloce è 

quello di selezionare il livello e poi cliccare l’icona Delete nella Command bar   . 

Eliminare un livello 

Selezionare il livello e, in alternativa: 
- dal menù Layer > Delete Layer; 
- cliccare  sul’icona del cestino nella Command bar della Layer palette; 
- trascinare il livello nel cestino della Command bar della Layer palette; 
- tx dx sul livello > Delete Layer. 

Move layer 

Nella Tool property dello strumento Move layer ci sono varie opzioni; oltre al tipo di oggetto da spostare, 
trovo alcune casellina di spunta: 

- senza selezionare nulla nella Tool property, clicco in un punto qualsiasi del Canvas e muovo: si sposta il 
contenuto del livello selezionato in quel momento; 

- seleziono Move the object at the clicked position: indipendentemente dal livello selezionato, muovo 
tutto il contenuto di un livello toccandone almeno una parte (quindi non basta toccare ovunque nel Canvas, 
ma bisogna toccare dove c'è qualcosa di disegnato);  

- seleziono Move layers in the selected area: dopo aver fatto una selezione, clicco al suo interno e 
muovo. Si sposta il contenuto di tutti i livelli racchiuso dalla selezione, mantenendo la gerarchia tra i livelli; 

- in entrambi i casi, se metto la spunta anche a Moved layers become selected, allora i livelli che sono 
stati interessati dal movimento vengono automaticamente selezionati nella Layer palette; 

- se spunto sia Move the object at the clicked position che Move layers in the selected area, è come se 
avessi cliccato solo Move layers in the selected area. 

 

Se muovendo la selezione con Move layers in the selected area mi posiziono sopra altre parti di disegno 
e poi nuovo nuovamente la selezione, le nuove parti di disegno non vengono spostate: continuo a spostare 
le parti selezionate al momento della creazione della selezione. 

History palette, Auto Action palette 
Nascoste dalla palette dei layer ci sono le palette History e Auto Action.  
History riporta cronologicamente tutti le operazioni effettuate dall’apertura del file.  
Auto Action permette di eseguire delle operazioni automaticamente: è possibile utilizzare degli 

automatismi di default o crearne dei nuovi (vedi Auto Action). 
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Vignette (Frame borders) 
Fermo restando che ognuno trova la sua via per disegnare le proprie tavole, CSP dà la possibilità di usare 

alcuni strumenti per creare le vignette. Queste  possono essere create con lo strumento Figure, utilizzando 
il subtool Direct draw o il subtool dedicato Frame, oppure usando i modelli presenti tra i materiali (Framing 
template). 

 Vignette con Direct draw 

Dire che Direct draw è uno strumento per disegnare le vignette è un po’ improprio; in realtà con questo 
metodo si disegnano niente più che delle forme, che poi, se si vuole, possono essere utilizzate come 
vignette.  

 

1) Selezionare, dallo 
strumento Figure, il subtool 
Direct draw:  
 

 
Fig.  91 

 2) Scegliere il tipo di forma desiderata. 
 

Attenzione! 
A seconda del subtool selezionato, l’icona dello 

strumento Figure cambia: 
 

 
Fig.  92 

 Non solo, per alcuni subtool, l’icona di Figure cambia 
anche a seconda della forma che si utilizza; tenere a mente 
questa cosa se non si trova l’icona: 
 

 
Fig.  93 

 
 

Se si vogliono inserire delle vignette con delle misure precise, vedi più sotto.  
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Vignette con Frame 

Frame (vignetta) è lo strumento dedicato alla creazione di vignette e fa parte sempre del gruppo Figure. 
Selezionandolo vengono visualizzati le varie opzioni di disegno, che vanno dalle figure semplici 
all’impostazione a mano libera. 

 

 
Fig.  94 
 

 

Creando un Frame border viene creato un layer [Frame border 
folder].  

All'interno vengono creati un livello raster, se è spuntata la 
casellina Raster layer nella Tool property, e un livello di sfondo, se 
è spuntata la casellina Fill inside the frame.  

Inoltre l'area attorno alla vignetta creata si colora in violetto. 
 

 
Fig.  95 

 

Quando si usa il metodo [Polyline frame], il bordo verrà chiuso cliccando sul punto iniziale o facendo 
doppio click. Per nascondere l'area violetta [Layer mask] settare [Enable mask] sulla Property bar della 
palette dei Layer, oppure cliccare sulla miniatura della maschera (quella con sfondo nero, nel Frame border 
folder) tenendo premuto Shift. 

Per disegnare una vignetta: 
- selezionare  il tool Figure e il subtool Frame; 
- selezionare l’opzione per la creazione del bordo della vignetta: Rectangle, Polyline, ecc.  
 

 
Fig.  96 

- selezionare la forma che si desidera nella Tool property: Rectangle frame ad esempio permette di 
disegnare anche altre forme oltre al rettangolo; è possibile anche decidere quanti lati deve avere una 
vignetta poligonale ed eventualmente se avere gli angoli arrotondati; 

- configurare il bordo della vignetta, sempre nella Tool property; 
- disegnare la vignetta 

Vignette con Framing template 

Esistono anche dei modelli (Framing template) di pagine già suddivise in vignette, in Material > All 
materials > Manga materials > Framing template.  

Per utilizzare uno dei modelli è sufficiente trascinarlo sula Canvas: si adatterà automaticamente alle 
dimensioni della gabbia. 

È anche possibile salvare un template proprio: dopo aver modificato un template o aver creato una serie 
di vignette con i metodi sopra descritti, andare su Edit > Register Material > Template…; quando si apre la 
finestra dargli un nome e scegliere una posizione di salvataggio. Infine dare l’OK. 
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Dividere le vignette 

Quando si utilizza lo strumento Frame per creare la propria tavola si può partire col disegnare una 
grande vignetta che ha come estensione le dimensioni della gabbia e successivamente dividerla in vignette 
più piccole. Creando la vignetta grande, il programma crea un layer (di fatto è una cartella) che si chiama 
Frame folder, con all’interno un altro layer, di tipo raster.  

Per dividere la vignettona in vignette più piccole si utilizzano due sub tool che si trovano sotto a Frame: 
Divide frame folder e Divide frame border. Il primo a ogni divisione crea un’ ulteriore cartella (folder) tra i 
layer, strutturata, se si vuole, come la genitrice. Il secondo si limita a dividere solo il bordo della vignetta, 
non creando alcuna ulteriore suddivisione nei layer.  

Quello che ci sarà all’interno delle vignette ritagliate viene stabilito dal Dividing method, opzione che si 
trova nel Sub Tool Detail del Sub Tool scelto. 

Metodo di divisione  (Dividing method) 

(dal Manuale) 
Configura come dividere il layer folder delle vignette quando viene tagliato il frame border (quando creo 

due vignette più piccole tagliandone una più grande). 
 

 Divide frame folder and duplicate inside layer 
Divide la cartella della vignetta e duplica i layer contenuti 
Crea tante nuove cartelle quanti sono i frame border creati. Ogni cartella include una copia dei layer 
esistenti prima della divisione;  
 

 Divide frame folder and create empty folder 
Divide la cartella della vignetta e crea una cartella vuota 
Crea tante nuove cartelle vuote quanti sono i frame border creati. 
 

 Divide not folder but frame border 
Divide il frame border ma non crea nuove cartelle 
Non viene creata né una nuova cartella né un layer raster quando divide il frame border: divide solo 
il bordo. 

Divide frame folder / Divide frame border 

Non riuscivo a capire qual è, in pratica, la differenza tra Divide frame folder e Divide frame border. Si può 
dividere la vignetta ricreando la struttura dei layer per ogni nuova vignetta, oppure no, con entrambi gli 
strumenti, così come con entrambi gli strumenti è possibile dividere una vignetta in modo che sia solo il 
bordo a essere diviso, ma non la continuità tra le due nuove vignette create (a seconda di come si imposta il 
Dividing method).  

Allora perché esistono due strumenti distinti? Ho resettato entrambi gli strumenti e ho scoperto che, in 
effetti, sono lo stesso strumento. 

La differenza sta nelle opzioni che il programma visualizza in partenza:  

 Divide frame folder mostra i vari Dividing method e di default è settato su Divide frame folder and 
duplicate inside layer;  

 Divide frame border non visualizza di default i Divide method ed è settato su Divide not folder but 
frame border (basta aprire la finestra Sub Tool Detail con la chiave inglese per rendersene conto).  

La divisione tra i due strumenti è quindi solo formale; io, che voglio aver sotto controllo le varie opzioni, 
probabilmente avevo alla fine visualizzato le stesse per entrambi, ottenendo uno strumento doppio. 

Dividere una vignetta in parti uguali 

Ad esempio per creare una striscia con vignette di ugual larghezza. Creare la vignettona, selezionare il 
Frame border folder, poi andare nel menù Layer > Ruler - Frame > Divide frame border equally. Nella 
finestra di dialogo che si apre scegliere le opzioni. La spaziatura tra le vignette che risulta è quella impostata 
nelle preferenze: Preferences… > Layer/Frame > Frame Border. 
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Interrompere il bordo di una vignetta  
http://www.pauljholden.com/ 

Ad esempio per lasciare la vignetta aperta oppure per fondere i balloon con lo spazio bianco attorno alle 
vignette. 

Paul J. Holden lo spiega(-va) nel suo blog [ora non più disponibile, ma ho trascritto l’articolo più sotto]. Si tratta in 
pratica di applicare una pecetta sul bordo della vignetta, in modo da nasconderlo; ha anche creato un tool 
(partendo dal Polyline frame) che ha chiamato "Remove Panel Border" e che velocizza l'operazione*.  

Attenzione: Holden taglia le vignette con il  "Divide frame border", il che permette di tagliare il bordo 
anche di più vignette con la stessa pecetta. Se le vignette vengono tagliate con il "Divide frame folder" 
funziona solo con una vignetta. 

Negli Assets è disponibile uno strumento, Comabout Ending Pen o Komabuchi removal pen [in tempi 
diversi ho trovato traduzioni diverse], che ha la stessa funzione, lo si trova qui.  
 
Sullo stesso argomento (dal gruppo Facebook): 
23 marzo 2017 

Matteo Paolelli 
Non riesco a capire qual è, in pratica, la differenza tra "Divide frame folder" e "Divide frame 

border". Si può dividere la vignetta ricreando la struttura dei layer per ogni nuova vignetta, 
oppure no, con entrambi gli strumenti (a seconda di come si imposta il Dividing method). Allora 
perché esistono due strumenti distinti? 

Manuel Bruno 
Semplicemente, frame folder crea una cartella tra i layer dove quando disegni si limita alla sola 

vignetta. Frame border crea solo la vignetta ma il tratto prosegue anche nelle altre vignette :) 
Matteo Paolelli 

Non è così. La linea continua nelle altre vignette se come metodo di divisone utilizzo "Divide 
not folder but frame border" sia con uno strumento che con l'altro, così come la linea si blocca se 
utilizzo come metodo di divisione "Divide frame folder and duplicate inside layer" e "Divide 
frame folder and create empty folder". Comunque credo di aver risolto l'inghippo. Ho resettato 
entrambi gli strumenti e ho scoperto che, in effetti, sono lo stesso strumento! La differenza sta 
nelle opzioni che il programma visualizza in partenza. Mi spiego:  
1) "Divide frame folder" mostra i vari Dividing method, e di default è settato su "Divide frame 

folder and duplicate inside layer";  
2) "Divide frame border" non visualizza di default i Divide method ed è settato su "Divide not 

folder but frame border" (basta aprire la finestra "Sub Tool Detail" con la chiave inglese per 
rendersene conto).  

La divisione tra i due strumenti è quindi solo formale; io, che voglio aver sotto controllo le varie 
opzioni, probabilmente avevo alla fine visualizzato le stesse per entrambi, ottenendo uno 
strumento doppio. 

 

11 aprile 2017 

Federica Di Meo 
Negli ultimi giorni sull'asset è spuntato un nuovo bellissimo strumento, il "cancellatore di 

frame" (poi gli diamo un nome figo, ora teniamo questo). 

Serve per far fuoriuscire dalle gabbie gli elementi senza dover per forza spostare la lineart fuori 

dalla vignetta (come è consigliato nella guida ufficiale :D) è davvero molto comodo, dateci 
un'occhiata, basta andare sul livello vignetta (non sul livello lineart all'interno della vignetta) e 
girare intorno all'area da rendere visibili, come se fosse il lazo. 

Ovviamente può esserci anche un elemento che sborda tra una vignetta e l'altra, in quel caso 
ovviamente la vignetta deve essere stata divisa in precedenza dalla linea "divide frame BORDER" 

Ecco lo strumento, se volete potete prenderlo da qui o dall'asset: 
https://assets.clip-studio.com/en-us/detail?id=1693525 

 
 
/continua 

http://www.pauljholden.com/
https://assets.clip-studio.com/en-us/detail?id=1693525
https://www.facebook.com/groups/mangastudioitalia/permalink/1164781630299502/
https://www.facebook.com/toongsteno?hc_ref=ARQrXXV3G4pQyMXjysIJ3BXrh3Upi-LTmUMtGy1un2537oVTzg_UqYsBqOMmA5s-iYQ&fref=nf
https://www.facebook.com/meinherzbrennt.1994?fref=ufi
https://www.facebook.com/toongsteno?fref=ufi
https://www.facebook.com/groups/mangastudioitalia/permalink/1181013492009649/
https://www.facebook.com/akafededm?hc_ref=ARSFjnY-b7Ugc7TchH4p-LNChjo3m-gviVcvRz9wlU9ypkWl0N4Ex42wJ7yWaQ0tCU8&fref=nf
https://assets.clip-studio.com/en-us/detail?id=1693525
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Patrizia Mandanici 
Io ricordavo di aver linkato tempo fa un post di PJ Holden che aveva creato un tool simile (e 

che io ho e uso da tempo), lo ha chiamato Remove Frame Border (ma facendo una ricerca nel 
gruppo non risulta, boh)* 

http://www.pauljholden.com/.../panel-borders-in-manga.../ [link non più esistente*] 
PatriziaMandanici 

L'ho trovato! 
 https://www.facebook.com/groups/mangastudioitalia/permalink/844376099006725/?match

=Ym9yZGVycyxwYW5lbA%3D%3D [link al gruppo FB  funzionante, ma il successivo link alla 
pagina di PJ Holden non esiste più] 

Patrizia Mandanici ha condiviso un link nel gruppo:MangaStudio e Clip Studio Paint. 
Metto in rilievo il secondo tutorial di Holden sui Panel Border (anche se già linkato da Alberto 

Lingua) perché magari a qualcuno potrebbe sfuggire il tool creato da Holden (scaricabile 
liberamente) che serve a tagliare il panel (è in pratica un Polyline modificato); molto comodo (ne 
parlavamo qui non molto tempo fa). https://l.facebook.com/l.php… *idem…+ 

Federica Di Meo 
Perfetto, grazie!  
Mi ero persa quel post 

Patrizia Mandanici 
Proverò a vedere se ci sono differenze, ma credo di no. 

Matteo Paolelli  
C'è qualche differenza, anche se portano a (quasi) risultati simili. Ho studiacchiato un po' lo 

strumento di PJ Holden qualche giorno fa, perché mi serviva: lui lo fa derivare dallo strumento 
"Polyline frame", sempre nel Sub Tool "Frame", da cui ne eredita lo schema delle impostazioni 
(vedi Sub Tool Detail). Ho dato un'occhiata veloce ma non ho capito da quale strumento deriva 
questo (forse dalla "Frame border pen", ma non corrisponde tutto; magari è originale), ma la 
differenza più lampante è che lavora con un tratto "a mano libera".  

Sia con il "Remove Panel Border" di PJ Holden, sia con questo "コマブチ抜きペン" (Comabout 
Ending Pen, dalla traduzione), per disegnare senza soluzione di continuità nei varchi che si 
creano tra due vignette adiacenti la divisione tra le vignette deve essere fatta però con "Divide 
frame border". Se si dividono con il "Divide frame folder" si può uscire solo dalla vignetta in cui è 
applicato il tool e bisogna riprendere il disegno nella vignetta successiva selezionandone la 
cartella. 

*[Lo strumento Remove Panel Border di PJ Holden non è più disponibile, ma ne ho copia. Preferisco non linkarlo direttamente qui 

ma, se dovesse servire, puoi contattarmi e posso girartelo]. 

Unire le vignette 

Se si vogliono unire due vignette dopo aver creato un vignettone con Frame e averlo suddiviso con 
Divide frame border, bisogna selezionarle con lo strumento Object, poi andare in Layer > Ruler/Frame > 
Combine Frames (per selezionare solo due vignette basta selezionare un vertice di una e un vertice 
dell’altra).  

Se le vignette sono state create dividendo un vignettone con Divide frame folder, oppure sono state 
disegnate una a una (non dividendo una più grande, ma rettangolo dopo rettangolo), o il  template ha le 
vignette divise in folder separati, questo metodo non funziona; se le vignette stanno su folder differenti: 

 

 si possono spostare i vertici  (strumento Object) di una vignetta fino ad andare a ricoprire l’altra (o le 
altre), eventualmente aggiungendo control point nel caso di vignette con forme particolari. 
Terminata la modifica, la vignetta eccedente può essere cancellata eliminando il layer 
corrispondente; 

 disegnare la nuova vignetta con uno degli strumenti di disegno delle vignette, ad es. Polyline frame, 
al di sopra delle vignette che dovrebbero essere unite e poi cancellare queste ultime. 

https://www.facebook.com/patrizia.mandanici?fref=ufi
http://www.pauljholden.com/.../panel-borders-in-manga.../
https://www.facebook.com/patrizia.mandanici?fref=ufi
https://www.facebook.com/groups/mangastudioitalia/permalink/844376099006725/?match=Ym9yZGVycyxwYW5lbA%3D%3D
https://www.facebook.com/groups/mangastudioitalia/permalink/844376099006725/?match=Ym9yZGVycyxwYW5lbA%3D%3D
https://www.facebook.com/groups/mangastudioitalia/permalink/844376099006725/?match=Ym9yZGVycyxwYW5lbA%3D%3D
https://www.facebook.com/patrizia.mandanici?hc_ref=ARST2Rl0YH5RFxYTiAqNVIFCaOw_Lpp_mbxaMQk46ceUOVP_kXSwIlsN8zYKmbcXZtE
https://www.facebook.com/groups/mangastudioitalia/permalink/844376099006725/
https://www.facebook.com/groups/mangastudioitalia/?hc_ref=ARST2Rl0YH5RFxYTiAqNVIFCaOw_Lpp_mbxaMQk46ceUOVP_kXSwIlsN8zYKmbcXZtE
https://www.facebook.com/alberto.lingua?fref=mentions
https://www.facebook.com/alberto.lingua?fref=mentions
https://www.facebook.com/alberto.lingua?fref=mentions
http://www.pauljholden.com/blog/2016/02/01/panel-borders-in-manga-studio-part-2/
https://www.facebook.com/akafededm?fref=ufi
https://www.facebook.com/patrizia.mandanici?fref=ufi
https://www.facebook.com/toongsteno?fref=ufi
mailto:info@paolelli.com
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Altre impostazioni per le vignette 

Spazio tra le vignette 

Come impostare quanto spazio lasciare tra le vignette? Come faccio a calcolarlo se i righelli sono 
impostati ad es. in pixel e io so che lo spazio orizzontale tra due vignette deve essere di tot mm? Vedi dpi e 
mm per sapere come calcolare lo spazio in mm.  

Editare un Frame border 

1) Selezionare il Frame border folder; 
2) Nella palette Tool  selezionare Operation (cubo o piano con freccetta); 
3) Selezionare il SubTool "Object "(cubo con freccetta); 
4) Trasformare il Frame border. Sul bordo sono visualizzate le maniglie, che possono essere trascinate 

per modificare la vignetta. 
 

Trascinando un control point si può modificare la forma della vignetta. 
Possono essere modificati più control point assieme (cerca Select Multiple Control Points sul Manuale). 
Lo strumento [Correct 
 line] permette di editare control point e  linee (cerca Editing with the Correct line Tool sul Manuale). 

Cambiare spessore e colore del Frame border  
- domanda sulla pagina FB -  16 marzo 2017 

dalla palette [Tool property]: 
Lazzaro Losurdo - Salve a tutti! Come si inspessiscono le linee delle vignette una volta tagliate? 
Matteo Paolelli - Intendi tagliate con il Divide frame folder/border? Se selezioni il layer "Frame" e attivi 

lo strumento Object, nelle Tool property c'è Brush size, con il quale puoi controllare lo spessore della 
vignetta. 

Lazzaro Losurdo - Si esatto, grazie mille! :) 

Vignette con angoli arrotondati  

Se disegno le vignette con lo strumento Figure > Direct draw, dalla palette [Tool property] selezionare la 
chiave inglese in basso a destra (non quella inclinata vicino all'anteprima del tipo di bordo, ma quella in 
verticale più in basso): si apre la palette [Tool settings],  selezionare Figure e abilitare la vista dell'opzione  
Roundness of corner. 

 

  
Fig.  97       

Sotto lo slider c’è l’opzione How to specify che permette di scegliere se arrotondare secondo una 
percentuale delle dimensioni della vignetta (Specified ratio): 

 

 
Fig.  98 

oppure con una dimensione stabilita (Specify length): 
 

https://www.facebook.com/groups/mangastudioitalia/permalink/1158962790881386/
https://www.facebook.com/groups/mangastudioitalia/permalink/1158962790881386/
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Fig.  99 

Nel primo caso, allungando la vignetta gli angoli tendono a deformarsi, a stiracchiarsi: 
 

 

 
Fig.  100  

 
 
 
 

 
 

Nel secondo caso, qualsiasi dimensione darò alla vignetta, questa manterrà costante l’arrotondamento 
dell’angolo: 

 

 

 
Fig.  101 

 
 
 
 

 
 

Vignette con un solo angolo arrotondato  

Posso voler arrotondare solo un angolo e lasciare gli altri ad angolo vivo. La procedura è simile per le 
vignette col Direct draw e con il Frame, ma differisce lievemente. 

 
Se disegno con Direct draw, 

ingrandisco l’angolo e seleziono il 
bordo con l’Object tool; 

 
Fig. 102 

 

Devo aggiungere due nuovi control point, uno sulla linea orizzontale della vignetta, l’altro sulla 
verticale, cliccando con il tasto destro e selezionando Add control point; 

 
Fig. 103 

 
Fig. 104 

 
Fig. 105 
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Poi vado sul control point 
dell’angolo e, sempre con il tasto 
destro seleziono Switch corner; 

 
Fig. 106 

 

L’angolo assumerà una forma 
curvilinea che bisogna aggiustare 
trascinando opportunamente il 
control point. 

 
Fig. 107 

 
Fig. 108 

 
Se disegno invece con Frame, ingrandisco l’angolo (Fig.  109), seleziono con l’Object tool il suo control 

point, col tasto destro, seleziono Switch corner. L’angolo assumerà una forma curvilinea (Fig.  110) che 
bisogna aggiustare trascinando opportunamente il control point (Fig.  111). In questo caso non devo 
aggiungere i due control point perché ci sono già. 

 

 
Fig.  109 

 

 
Fig.  110 

 
Fig.  111 

 

Vignetta con doppio tratto e riempimento bianco all'interno 
da un quesito posto da Silvio Camboni nel gruppo Facebook, a cui ho trovato questa soluzione. Non era quella che lui 

cercava ma, per ottenere delle vignette col doppio tratto e bianche dentro, funziona. Per la discussione completa vai qui. 

Silvio Camboni 
Buongiorno amici, piccola domanda: vorrei trovare un modo rapido per ottenere un frame con 

doppio tratto e riempimento bianco all'interno, per sovrapporre vignette in inserto come 
nell'esempio. 

Al momento lo devo fare manualmente, ma perdo troppo tempo. 
Qualche idea? 

Matteo Paolelli  
Col Border effect. Porti il template sull'area di lavoro, poi, tenendo selezionata la cartella che 

contiene i frames, selezioni il pulsante col Border effect, scegli un colore e uno spessore per il 

https://www.facebook.com/groups/mangastudioitalia/permalink/1384278425016487/
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bordo, ad esempio nero, e infine cambi il colore principale della linea per ogni frame, 
impostandola bianca (Object tool). Dovrebbe funzionare. 

 

Osservazioni a mente fredda: se faccio questa cosa con un template di vignette e voglio ottenere una sola di 
quelle vignette con  l'effetto voluto, non ci riesco: o tutte o nessuna, nel senso che riesco a fare l'interno bianco 
per una sola, ma per poter mantenere l'effetto "bianco all'interno" devo aumentare lo spessore del bordo per 
tutte le vignette; non lo fa fare singolarmente. Inoltre, man mano che aumento lo spessore del bordo gli angoli 
delle vignette tendono ad arrotondarsi, perdendo l’angolo vivo. Per ovviare a questi problemi posso, dopo aver 
portato nell'area di lavoro il template, disegnare dove mi serve, ma in un layer sopra la cartella del template 
importato, una nuova vignetta con lo strumento Figure > Frame > Rectangle frame (o con altra forma, se 
serve). Per poter poi usufruire dell'effetto Effect > Edge color, devo creare una cartella e inserirci tale vignetta: 
l'effetto non funziona se la vignetta è al di fuori della cartella, non compare nemmeno tra le opzioni del Layer 
property. 
Si creano poi alcuni piccoli problemi con lo sfondo della vignetta, ma di facile soluzione per cui non li tratto. 

Inserire vignette particolari 

Edmond Dantes, membro del gruppo FB , ha scovato negli Assets di CS un’azione molto interessante, 
che permette di inserire delle vignette con forme particolari all’interno di una tavola. L’azione si chiama 
Outer white Action e  si può trovare qui.  

Purtroppo i commenti e le spiegazioni a corredo dell’azione sono in giapponese, per cui  io ed Edmond ci 
siamo messi a cercare di capirne il funzionamento, che illustro di seguito. La discussione nel gruppo si può 
leggere qui. Per utilizzare l’Auto Action: 

- dopo aver scaricato Outer white Action,  scaricare e installarla; 
- su un documento nuovo, appena aperto, cliccare sull'Auto Action. Questa genera una vignettona a 

tutta pagina e una struttura di cartelle e layer, che si possono vedere nel primo filmato associato 
all’action sugli Assets; 

- selezionare il layer コマ( Koma, credo voglia dire vignetta) e, con il Divide frame border tagliare la 
vignettona grande in vignette più piccole; 

- con lo strumento Frame, selezionare la forma, ad es. ellittica, spuntando Draw border e togliere la 
spunta a Fill inside the frame. Come Brush shape usare ad es. una G-Pen con Brush size a 48.  

 

 
Fig. 1 

https://assets.clip-studio.com/en-us/detail?id=1680320
https://www.facebook.com/groups/mangastudioitalia/permalink/2573560246088293
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-  disegnare un cerchio (tenendo 
premuto Shift perché sia 
circolare); 

 

 
 

 
Fig.  112 

- per spostare il cerchio, 
selezionarlo  con l'Object tool e 
spostarlo. Attenzione a non 
selezionare anche i control 
point delle vignette, sennò si 
deforma tutto. 

 

 

 
Fig.  113 
 

 
Fig.  114 

 

 

Se con l'Object tool si selezionano i control point del cerchio (anche uno solo) e poi si va a modificare il 
valore di Brush size, si può vedere in tempo (quasi) reale lo spessore che varia e quindi fermarsi quando si 
vuole, senza perder tempo in tentativi. L’operazione sembra non essere velocissima, per cui armarsi di 
pazienza (il mio PC ha attualmente 32 GB di RAM, ci mette comunque qualche secondo). 

 

 
Fig.  115 
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Un fastidioso bordo viola 

A volte mi capita che il bordo di una o più vignette abbia in semitrasparenza un fastidioso alone viola, 
che non riesco a togliere. Nell’immagine metto un dettaglio con sfondo grigio, perché talvolta uso uno 
sfondo grigio per capire dove ho già effettuato dei riempimenti. Con lo sfondo grigio il bordo viola mi 
sembra più evidente. 

 

 
Fig.  116 

 

 

La linea viola appare perché inavvertitamente ho reso 
visibile il ruler che sta sotto al bordo della vignetta. Per 
nascondere il bordo viola basta cliccare col tasto destro 
sull’icona del ruler accanto alla miniature della vignetta e 
deselezionare Show Ruler. 

 

 
Fig.  117 
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Estrarre le lineart, cioè le linee 

Estrarre le lineart dallo sfondo in un disegno importato 

Metodo 1: Importare il disegno, convertire il layer in Raster e poi andare in Edit > Convert Brightness to 

Opacity. 
 

Metodo 2:  Importa il disegno, converti il layer in Raster, Gray e spunta il quadratino nero. 

Poi se si vuole si può riconvertire il layer in Raster, Color.  
In un videotutorial di Rob Torres Art, prima di convertire il layer si va su Edit > Tonal Correction > 

Binarization e si mette il valore di Threshold a 127, però parte da lineart nere, non a matita. 
In un altro videotutorial, di J Thunder Draws!, si dice di cambiare il tipo di Layer da Normal a Multiply, 

ma non capisco bene cosa intende perché parla troppo velocemente. 
 

Metodo 3: forse il più chiaro. In questo video, dal canale Youtube ufficiale di CSP, viene spiegato passo 

passo come fare. Riporto i passaggi. Attenzione: il video ha qualche anno (2018), alcuni comandi 
hanno cambiato nome o sono stati aggiunti. 

 

Per avere un file monocromatico (ossia senza toni intermedi tra neri e bianchi), dopo aver scansionato la 
tavola e importato l’immagine in CSP, nella Layer Property palette cambio l’Expression color da Color a 
Monochrome. Nella Layer Property appaiono degli slider: muovere Color threshold per regolare l’aspetto 
delle linee.  

 

 
Fig.  118 

 

 Premendo poi il quadratino nero, la parte bianca 
dell’immagine viene resa trasparente. 

Se tutto sembra ok, allora premere il pulsante Apply 
expression color of preview per rendere definitiva la 
modifica: ho così estratto le linee, in modalità Monochrome. 

Un file monocromatico non permette però gradazioni tra 
zone bianche e zone nere, gli antialias e le ombreggiature 
saltano. Per evitare ciò, dopo aver importato l’immagine 
evito il passaggio a Monochrome e invece opero in altra 
maniera. 

Dal menù Layer scelgo New Correction Layer > 
Brightness/Contrast e muovo gli slider finché il foglio appare 
bianco e le linee risultano accettabilmente visibili, dare l’OK. 

Gli stessi passaggi sono fattibili anche cliccando col tasto destro sul livello del disegno e selezionando le 
stesse opzioni. 

Poi selezionare Layer > New Correction Layer > Level Correction… Si apre una finestra con l’istogramma 
dei toni dell’immagine. 

 

 
Fig.  119 

 

 Muovo i cursori alla base dell’istogramma per regolare lo 
spessore delle linee. 

Infine, vado su Layer > Merge visible layers (ex Merge 
layers) per ottenere un unico livello “aggiustato”, oppure 
seleziono Merge visible to new layer (non esistente nel 2018) 
se si voglio tenere anche i livelli di lavorazione.  

A questo punto lo sfondo del livello è bianco ed eventuali 
livelli sottostanti non sono visibili. Per rendere trasparente lo 
sfondo andare in Edit > Convert brightness to opacity: ho 
estratto le linee in modalità Color oppure Grayscale.  

Se si vuole, aggiungere un livello Paper, bianco, da Layer > 
New Layer > Paper… 

  

https://www.youtube.com/watch?v=ejnsdui5GLI
https://www.youtube.com/watch?v=VpJAmarV1jI
https://www.youtube.com/watch?v=vR239Wx6i-w&t=34s
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Estrarre le linee da una fotografia importata 
 

 
Fig.  120 

 Per estrarre le linee da una fotografia si possono 
usare gli stessi metodi oppure, meglio, usare l’apposita 
funzione Extract line nella palette Layer Property.  
 

Convert to lines and tones… 
 

 
Fig.  121 

 Un altro metodo per estrarre le lineart è utilizzare LT 
conversion of layer…, selezionabile dal menu della Layer 
palette o con tasto destro > Convert to lines and tones…(ex 
LT conversion of layer…) 

 

Convert to lines and tones… separa il contenuto del  
livello selezionato in una serie di livelli contenuti in una 
cartella: il livello Outline, ovvero le linee, e tre livelli Tone 
(retini), ciascuno con una diversa densità a seconda della 
luminosità della parte di immagine che vanno a sostituire.  

 

Quando si clicca su Convert to lines and tones… si apre 
una finestra di dialogo, simile a quella di Extract Line, in cui 
è possibile impostare alcuni parametri e le soglie di 
luminosità per i retini. 
 

 

Togliere il fondo bianco di un'immagine  
Domanda su pagina facebook 

Diogo Lopes - Come si toglie il fondo bianco di un'immagine? 
Patrizia Mandanici - Vai al menu > Edit > Convert brightness to opacity. 
 

Sullo stesso argomento vedere questa pagina del blog di Patrizia Mandanici.  

Convert Brightness to opacity 

Edit  > Convert brightness to opacity converte i valori di luminosità di un’immagine in zone più o meno 
trasparenti: più una zona dell’immagine è chiara e più trasparente sarà il risultato in quella zona, mentre 
più una zona è scura e più opaca sarà, in quell’area,  l’immagine. Dato che in genere le matite si realizzano 

https://www.facebook.com/groups/mangastudioitalia/permalink/1163756823735316/
https://patriziamandanici.blogspot.com/2017/04/estrarre-la-linea-da-un-disegno.html?fbclid=IwAR13NX4IZ10C-Z1zPkcxxYfHhXa6v_MQ6BidBtx2mu-4-CidIKOsuarLC8Q
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su un foglio bianco (= maggior luminosità) con una matita più scura (= minor luminosità), operando con 
Convert brightness to opacity, magari avendo prima convertito l’immagine in Gray, si rende trasparente la 
parte bianca (+ bright) e opaca la parte scura (- bright), di fatto isolando le lineart dal resto del foglio. 

Consigli/aiuto per la scansione di sketch in B/N e colorazione. 
http://forum.runtimedna.com/showthread.php?97090-Advice-help-scanning-in-a-Black-and-White-paper-sketch-and-

colouring&p=896000#post896000 [--> non più disponibile,  il forum di RuntimeDNA ha chiuso :( ] 
 

Hawkangel  
Consigli/aiuto per la scansione di sketch in B/N e colorazione. 
Sono Glenn, dall’Australia. 
Sono un tipo da carta, matita e inchiostro e disegnare con il tablet non mi dà la 

precisione che vorrei. 
Mi piace molto disegnare con la penna stilografica. Ho deciso di provare MS5 per 

scansionare e colorare i miei fumetti fatti in A3. Non ho avuto molto successo e non 
sono sicuro di come fare. Riesco a importare l'immagine, ma non so come colorarla e 
in che formato inserirla. 

Qualcuno può darmi delle istruzioni o indirizzarmi nella giusta direzione? 
Il meglio che riesco a fare è usare lo strumento Magic wand per sbarazzarmi delle aree 

bianche e renderle trasparenti, ma rimane sempre una alone frastagliato grigiastro 
attorno alle linee nere, che rimane anche dopo aver aggiunto un layer ed aver 
colorato. 

Capisco che MS sia stato ideato per poterci disegnare direttamente, ma non sono un 
granché con il disegno digitale. So come fare in PS e in Gimp. In MS non riesco a 
capire. Qualsiasi suggerimento o risposta è bene accetta. 

garlam  
metti la tua scansione nel layer più in alto. Imposta il layer come Multiply (di default è su 

Normal). 
Colora su di un layer sottostante. 
Oppure puoi andare su Edit > Convert Brightness to Opacity. Ciò farà piazza pulita dei 

pixel bianchi e lascerà solo pixel neri e pixel semitrasparenti sul layer delle lineart. 

 
gaelster  

Ciao, permettetemi di rispondere a questo vecchio thread, dato che ho avuto lo stesso 
problema e ora sono al passo successivo. 

Ho scansionato un disegno (tiff a 2 colori, a 400dpi), ho applicato Edit > Convert 
Brightness to Opacity, che è uno strumento straordinario. 

Ora, sebbene le linee sono inchiostrate chiaramente sul mio disegno, ho dei pixel bianchi 
o trasparenti nelle linee stesse. Non pixel di antialiasing attorno alle linee, ma puntini 
bianchi dentro le linee. 

Credevo di aver sbagliato qualcosa scansionando (non so cosa, proverò altre 
impostazioni), ma mi piacerebbe sapere se MS ha un qualche strumento per 
correggere questa cosa. 

Avete qualche idea se si può, e come, fare? 
garlam  

Prova ad andare sul Layer Property Palette e cambia il l'Expression color da Gray a 
Monochrome. Quindi clicca sul quadratino nero lasciando il quadratino bianco 
deselezionato. Questo dovrebbe nascondere i pixel bianchi alla vista. 

gaelster  
Grazie mille garlam. Comunque non riesco a trovare qualcosa chiamato Layer Property 

Palette. 
Allego uno screenshot, spero vada bene. Credo che il mio layer sia già in nero o in 

grayscale, non ho alcuna icona a fianco del nome. 
Continua a mostrare il problema, pixel vuoti dentro le linee, che non sono proprio 

bianchi ma trasparenti ora che ho applicato Edit > Convert Brightness to Opacity. 
 

http://forum.runtimedna.com/member.php?97016-Hawkangel
http://forum.runtimedna.com/member.php?87734-garlam
http://forum.runtimedna.com/member.php?99345-gaelster
http://forum.runtimedna.com/member.php?87734-garlam
http://forum.runtimedna.com/member.php?99345-gaelster
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Fig.  122 

garlam  
Trovi la Layer Property Palette sotto Window. 

bradsho  
Sembra che ci siano i punti nelle tue linee perché è un'immagine monocromatica in cui le 

parti grigie delle tue matite non sono scure abbastanza da venir considerate nere, e 
quindi vengono rese come bianche. È la tua scansione originale che produce una tiff 
in B/N? In tal caso potresti utilizzare il filtro Blur di MS. Se la tiff è in toni di grigio e i 
puntini fossero grigi, potresti applicare il filtro Binarization (Edit > Tonal Correction) e 
regolare a un valore di soglia a cui i punti scompaiono, prima di applicare Edit > 
Convert Brightness to Opacity. 

Nota che la Layer Properties Palette è giusto sopra la palette dei Layer, ma potrebbe 
essere stata nascosta da un'altra tab, tipo Action o History. 

garlam  
Se non ho capito male, non stai dicendo che ci siano pixel bianchi accanto ai pixel neri 

dopo aver eseguito Edit > Convert Brightness to Opacity, stai dicendo che ci sono dei 
pixel trasparenti "vuoti" casuali all' interno della tua linea nera. 

Bradsho probabilmente ha ragione sui toni di grigio non abbastanza scuri da essere neri. 
Per rendere i toni di grigio abbastanza scuri da essere neri, è necessario aumentare la 
soglia di colore delle linee prima di eseguire l'Edit > Convert Brightness to Opacity. Ci 
sono alcuni modi per farlo. Bradsho ne ha suggerito uno con Tonal Correction. 
Un'altra opzione è quella di utilizzare Layer Property Palette e i cursori di soglia Color 
treshold e Alpha treshold. 

Da lì, facendo clic sul quadrato nero (e deselezionando il bianco) si esegue la stessa 
funzione di Edit > Convert Brightness to Opacity (e si possono comunque utilizzare i 
cursori di soglia senza compromettere i pixel trasparenti). Fare tutto questo 
all'interno della Layer Property Palette colloca tutto il necessario all'interno di una 
palette piuttosto che andare avanti e indietro dal menu Edit. 

Se hai già applicato l'Edit > Convert Brightness to Opacity, potresti provare ciò che 
Bradsho ti ha suggerito circa la sfocatura delle linee (aggiungendo alcuni grigi nei 
punti vuoti) o puoi importare l' immagine di nuovo e ricominciare da capo. Se i punti 
vuoti provengono da una scansione bitmap, potrebbe essere necessario comunque 
eseguire il filtro sfocatura. 

bradsho  
Ecco un altro modo, forse il migliore, per sbarazzarsi di questi punti. 
Fallo prima di Edit > Convert Brightness to Opacity. 
Vai al menu Edit > Tonal Correction > Reverse Gradient... questo rende le linee bianche 

su sfondo nero; i punti bianchi ora assomigliano a polvere nera. 
A questo punto, utilizza lo strumento Garbage cleaner per rimuovere la polvere.... Trovi 

il Garbage cleaner sotto l'icona dello strumento Correct Line. È necessario utilizzarlo 
in Mode > Delete point in white background. 

Quindi tornare al menu Edit e invertire nuovamente il gradiente per creare linee nere su 
sfondo bianco 

garlam  
Questo è piuttosto intelligente. 

rkneefisherman  
ACCIDENTI! Ha funzionato! Mi dispiace interrompere, ma ho avuto un problema simile 

con una scansione in B/N. Queste informazioni mi hanno aiutato enormemente a 
convertire il mio cervello dalle funzioni di PS. 

http://forum.runtimedna.com/member.php?87734-garlam
http://forum.runtimedna.com/member.php?99339-bradsho
http://forum.runtimedna.com/member.php?87734-garlam
http://forum.runtimedna.com/member.php?99339-bradsho
http://forum.runtimedna.com/member.php?87734-garlam
http://forum.runtimedna.com/member.php?93149-rkneefisherman
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doukkali001@yahoo.com  
Durante la colorazione con il secchio è possibile utilizzare l'opzione Area scaling, si 

sovrappone i bordi dei tratti neri e quindi copre quei bordi grigi frastagliati. 

Scansione di disegni già inchiostrati 

Appunti risalenti a qualche tempo fa, non relativi a CSP ma che si possono adattare con le dovute 
differenze. 

I Metodo 

 Scansiono a 1200 dpi, bitmap o testo; 

 Porto a greyscale; 

 Porto a 300 dpi con tutte le spunte; 

 Duplico il livello di bkgr; 

 Vado su Canali, premo CTRL e clicco sulla miniatura del canale (così 
facendo seleziona i bianchi); 

 Torno sul livello duplicato e cancello; 

 Nuovo livello sotto la copia del bkgr; 

 Trasformo il file in CMYK senza unire i livelli; 

 Blocco i px trasparenti del livello duplicato , seleziono tutto (CTRL+A), 
riempio col secchiello con il colore nero, (o uso l'azione espandi e 
riempi*) > così coloro solo i pixel non trasparenti del livello duplicato. 

Questo metodo ha lo svantaggio di ingrossare leggermente le linee, e quindi modifica leggermente la 
scansione. 

 
II Metodo 

 Scansiono a 1200 dpi, bitmap o testo; 

 Porto a greyscale; 

 Duplico il livello sfondo; 

 Bacchetta magica sul bianco; 

 Cancella; 

 Porto a 300 dpi; 

 Porto a CMYK 

 Creo il nuovo livello intermedio su cui lavoro. 
Meglio usare il metodo II 

 
Per creare effetti speciali (aloni, spada laser) usare un livello in modalità Luce Intensa (in CSP ci sono vari 

blending mode che si prestano, bisogna fare qualche prova). 
Per creare delle ombre che diano volume (quindi non ombre normali portate) usare un pennello molto 

grande e sfumato, su di un livello in modalità Moltiplica; scegliere come colore con il contagocce il colore 
originale dell'oggetto e poi spostarsi, nel selettore colori, verso un colore analogo ma più scuro e 
desaturato. 

 
* L’azione “espandi e riempi” è un’azione creata (non da me) per Photoshop che espande di qualche pixel la selezione e 

poi la riempie con il colore selezionato. Questo permette di estendere l’area colorata anche sotto le lineart, per evitare che 
nelle zone di antialias delle linee si creino superfici non colorate, molto fastidiose. Con CSP non è necessario creare 
un’azione simile, perché sia gli strumenti di selezione sia quelli di riempimento permettono di aggirare il problema andando 
a lavorare su un paio di parametri:  

- il primo è l’Area scaling (vedi Area scaling): mettendo la spunta e impostandolo ad esempio a 2-3 (a piacere), al 
momento della selezione o del riempimento l’area su cui si lavora viene automaticamente allargata di 2-3 pixel in ogni 
direzione. Ciò permette di andare a colorare fin sotto le lineart. Sono possibili anche valori negativi, per cui si può decidere 
di fermare l’area di selezione/riempimento qualche pixel prima della lineart; 

- il secondo parametro su cui si può agire è Fill up to vector path (vedi Fill up to vector path): se le lineart sono su un 
livello vettoriale, la selezione o il riempimento si fermeranno proprio in corrispondenza della mezzeria della linea, 
includendola se si spunta Include vector path, oppure no . 

  

http://forum.runtimedna.com/member.php?99474-doukkali001-yahoo-com
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Pulire la tavola dallo sporco indesiderato: Garbage cleaner 
Nello stesso video visto per estrerre le linee (questo) è spiegato come ripulire la tavola da piccole tracce 

di sporco. Attenzione: Funziona solo con livelli raster. 
Selezionare il livello del disegno e dalla Layer Property palette cliccare su Border effect; cambiare il 

colore bianco di Edge color in un colore più visibile (es. rosso). Tutti i segni del livello verranno contornati di 
rosso e verrà evidenziato anche quello “sporco” che è più difficile da individuare, come punti o piccole 
linee. 

Ora, con lo strumento Correct Line > Garbage cleaner (ex Remove dust) è possibile fare delle selezioni 
attorno ai “granelli di polvere” ed eliminarli. Nella Tool property dello strumento è possibile impostare le 
dimensioni massime dei granelli da cancellare, oltre le quali i granelli viene lasciato sul disegno.  

Dopo aver rimosso lo sporco, cliccare nuovamente su Border effect per rimuovere i contorni dalle linee: 
ho ripulito la tavola. 

 

Vedi anche questo post di Patrizia Mandanici  
(il post esiste ancora, ma non riesco a salvarlo da Facebook per mettere qui il link, tuttavia si trova 
facilmente nel gruppo FB con parole chiave “Garbage cleaner”; non esiste più invece il il forum del post a 

cui fa riferimento Patrizia. Se ne vede un’anteprima nel suo post, ma è irraggiungibile) : 
 

Una soluzione a un problema riguardante la scansione di disegni in bianco e nero trovata sul 
forum inglese di MS/CSP: spesso se la linea non è omogenea, con un nero profondo, è possibile 
che in monocromo poi rimangano dei puntini bianchi in mezzo alla linea nera. 

Se si vogliono togliere questi puntini una procedura possibile è questa: andare in Edit Menu, 
Tonal corrections, scegliere Reverse gradient: adesso i puntini bianchi diventeranno neri. A questo 
punto si può usare lo strumento Garbage Cleaner per rimuovere la "polvere" (questo tool lo 
trovare nel gruppo di tool con il Line correction e il Control point), dovete scegliere l'opzione 
"Delete point in white background". 

Fatto questo si torna di nuovo in Edit menu per scegliere di nuovo Reverse gradient e fare 
tornare "normale" il nostro disegno. 

Io non l'ho provato ancora, ditemi se funziona. 
Parole chiave: scansione, scansionare, segno, puntini, linea. 

Gli altri strumenti in Garbage cleaner 

Fill leftover: può capitare che in aree colorate rimangano dei puntini trasparenti, piuttosto fastidiosi. Fill 
leftover (= riempi gli avanzi) permettere di riempire questi puntini con il colore dominante attorno ad essi. 

Select garbage: a seconda del Mode indicato nella Tool Property palette, questo strumento non cancella 
nulla, ma seleziona lo sporco presente su sfondi trasparenti o su sfondi bianchi, oppure seleziona i piccoli 
puntini trasparenti nelle aree colorate. 

Controllare il contrasto  
Domanda su pagina facebook a MangaStudio e Clip Studio Paint - 15 aprile 2017 

Nastasia Kirchmayr   
Esiste un modo per avere un livello di "verifica" che posso settare su bianco e nero per verificare i 

contrasti? per dire, su ph facendo cntrl-alt-shift-e e crea un livello che è la somma di tutti i livelli 
presenti nel documento, che poi converti in b/n. con clip studio c'è un modo svelto per farle una 
cosa del genere? anche che fosse converti tutto in scala di grigio. che non avrei voglia ogni volta di 
salvare un jpg, aprirlo e smanettare su quello, altrimenti dovrei continuare a salvarne ogni volta 
che faccio una correzione. 

Patrizia Mandanici 
Sì, in cima crei un New Correction Layer (tasto destro sul livello), Gradient map, Effect, White and 

Black. Quando non ti serve lo disattivi. 
  

Vedi anche Visualizzare il disegno in scala di grigi. 

https://www.youtube.com/watch?v=vR239Wx6i-w&t=34s
https://www.facebook.com/groups/mangastudioitalia/permalink/1184420791668919/
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Controllare il lavoro allo specchio 
Uno dei trucchetti base per vedere se qualcosa non torna in ciò che si è disegnato è osservare il foglio in 

trasparenza, mettendolo davanti a una finestra o a una lavagna luminosa, oppure mettere a fianco del 
foglio uno specchio: le imperfezioni risaltano immediatamente. Se la via dello specchio non è impossibile 
con il disegno digitale, è però un po’ difficile mettere un monitor in trasparenza… In realtà è possibile 
vedere la propria tavola in maniera speculare mentre si sta disegnando in modo normale. 

Aprire una seconda finestra del file in lavorazione (Window > Canvas > New window), trasferirla sul 
secondo monitor e metterla in modalità "Flip horizontal" [pulsante nel Navigator – N.d.M.] permette di 
disegnare e contemporaneamente controllare come viene il lavoro guardato allo specchio. Ma magari lo 

sapevate già :-)   
[Tip di Roberto Zaghi su gruppo Facebook] 
  

In pratica, agendo sui comandi del Navigator per applicare il Flip (vedi più sotto), questo agisce solo sulla finestra 
selezionata, non su entrambe.  

https://www.facebook.com/groups/mangastudioitalia/permalink/1162984083812590
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Balloon (nuvolette o “fumetti”) 
Per disegnare un balloon andare su strumento Text, scegliere il tipo di balloon e trascinare il cursore 

sulla pagina. 
Per la pipetta selezionare Baloon tail (è nel tool Text), scegliere il tipo di pipetta (se la si vuole curva 

usare la Spline con più punti) e disegnarla partendo dall'interno del Baloon. 

Balloon collegati tra loro 

Se voglio due balloon collegati tra loro basta mettere entrambi i balloon nello stesso livello e collegarli 
con una pipetta.  

 

 
Fig.  123 

Cambiare le proprietà di un balloon 

Per cambiare le caratteristiche del balloon (spessore o colore della linea, colore del fondo, ecc.), basta 
selezionare il balloon con lo strumento Object e poi modificare le proprietà nella Tool property. Oppure 
utilizzare il Tool navigation della Layer property. 

 

Quando si aggiunge un testo, nella Layer property che si trova sopra alla Layer palette compare la 
sezione Tool navigation, con due icone: Text e Balloon. Quando si aggiunge anche il balloon compaiono 
altre tre icone, Balloon tail , Control point e Adjust line width.  

 

 
Fig. 124 

Sono gli stessi strumenti che posso trovare nella palette Sub Tool. Particolarmente utile, per me, è 
Control point, poiché selezionandolo e poi portando il cursore sopra al balloon, ne vengono evidenziati i 
punti di controllo senza passare per Object, che talvolta non è immediato nel visualizzarli.  

 
Fig. 125 

A seconda del radio button selezionato nella Tool property, posso operare diverse azioni sui punti di 
controllo. 
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I vari tipi di balloon 

Nella Sub Tool palette dello strumento Text  trovo: 
 

 
Fig.  126 

Text serve a scrivere il testo delle nuvolette; 
 

 
Fig.  127 

Ellipse 
balloon 

crea un balloon ellittico. Mentre lo si disegna si possono decidere le 
dimensioni e l’appiattimento. 

Veloce da disegnare, può risultare un po’ asettico per la sua geometria 
perfetta; inoltre si deve giungere a qualche compromesso per far stare il testo 
in più righe, tale da risultare non proprio piacevolissimo alla vista; 

 
Fig.  128 

Balloon tail con Ballon tail si aggiunge la “pipetta”, che può essere curva se si 
aggiungono dei punti  mentre la si disegna. Se la curva è troppo accentuata la 
linea si sfalda un po’; 
 

 
Fig.  129 

Thought 
balloon tail 

altro tipo di pipetta, quella che indica il “pensiero”. Non mi piace, preferisco 
disegnarla diversamente; 
 

 
Fig.  130 

Ballon pen il balloon può essere disegnato con la Balloon pen, che con un tratto a 
mano libera permette di creare un balloon esteticamente più dinamico. Ho 
disegnato anche la pipetta con Balloon pen: basta disegnare una “V”, più o 
meno curva (a gusto), partendo e finendo all’interno del balloon; 

 
Fig.  131 

Curve 
balloon 

il balloon viene creato con una curva, in maniera simile  a quanto si può fare 
per disegnare una forma con Direct Draw. Si può scegliere tra Straight line (una 
spezzata), Spline (una linea curva con maniglie intermedie; è quella con cui ho 
diegnato questo esempio), Quadratic Bézier e Cubic Bézier, a parer mio poco 
controllabili e quindi per me non interessanti; anche qui ho disegnato la pipetta 
con la Balloon pen;  

 
Fig.  132 

Rectangle 
balloon 

ok, questo strumento non c’è di default, ma se si guarda nella Tool property 
dell’Ellipse ballon si vede che si può scegliere anche di disegnare con altre 
forme, oltre all’ellisse:  rectangle e polygon (se non si vedono bisogna renderle 
visibili dalla Sub Tool Detail). Ho duplicato lo strumento Ellipse balloon, ho 
cambiato la forma  base a rettangolo e gli ho cambiato il nome. Pipetta 
aggiunta con Balloon pen; 

 
Fig.  133 

Rectangle 
balloon con  
angoli 
arrotondati 

stesso strumento, ma nella Tool property ho attivato Roundness of corner, 
che mi permette di arrotondare gli angoli. 
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Sotto allo strumento Text c’è lo strumento Rounded balloon, che contiene solo il Sub Tool Rounded 
Balloon. Perché si trova qui e non, come gli altri balloon, dentro a Text? Boh. Forse, come in altri casi, in 
Celsys hanno pensato che poteva essere più comodo averlo direttamente nella Tool palette senza dover 
andare a cercarlo in Text. 

 

  
Fig. 134 

Rounded 
balloon 

Questo strumento è esattamente come il Rectangle balloon con angoli 
arrotondati che mi sono creato io, però con il parametro Figure > Roundness of 
corner impostato su Specify ratio con un valore 100%. Pipetta aggiunta con 
Balloon pen. 

 

Nella Tool property dei balloon ci sono, tra le altre,  le proprietà Line color e Fill color, che regolano il 
colore del contorno e del riempimento del balloon. L’icona a sinistra imposta il colore principale (Main 
color) selezionato in quel momento;  l’icona centrale imposta il colore secondario (Sub color); l’icona a 
destra consente di impostare i colori (in genere utilizzo nero per il contorno e bianco per il riempimento) 
con cui disegnare sempre il balloon, indipendentemente dai colori selezionati come Main e Sub in quel 
momento. 

 

 
Fig. 135 
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Creare un balloon 

Nei Material ci sono molti modelli di balloon che è possibile utilizzare semplicemente trascinandoli sul 
Canvas. Ma posso aver bisogno di un balloon particolare. Ad esempio, i balloon fatti a nuvoletta per 
rappresentare un pensiero: ci sono dei balloon a nuvola, ma per me sono troppo articolati; oppure i piccoli 
balloon di collegamento con la testa pensante: ci sono anche questi, il subtool Thought balloon tail, ma 
questi invece sono troppo semplici… 
 

 
Fig.  136 

Il balloon non si aggancia al testo 

Generalmente creo prima il testo e poi, con uno degli strumenti balloon o trascinando una forma dai 
Material, creo il balloon. Normalmente, con lo strumento balloon, la nuvoletta si aggancia e si integra al 
livello del testo, formando un insieme in un solo livello, anche se le sue parti (il balloon e il testo) possono 
essere modificate separatamente, toccandole con lo strumento Object. 

Trascinando invece la forma dai Material succede a volte che la forma venga inserita in un livello 
differente da quello del testo. Mi par d’aver capito che bisogna fare attenzione, quando si trascina il 
balloon, a toccare con il cursore una parte del testo così da permettere l’integrazione nello stesso livello. 

Balloon tagliato 

Devo tagliare un balloon in modo che non risulti sopra il bordo della vignetta come in Fig.  137: 
 

 
Fig.  137 

 

Se il balloon è all'interno del folder della vignetta dovrebbe farlo da solo; se invece metto tutti i balloon 
al di sopra dei layer delle vignette,  faccio così:  

 

Per creare un nuovo balloon da inserire poi tra i Material e poterlo 
riutilizzare, si può semplicemente disegnare sul Canvas un  balloon con 
lo strumento Text > XX balloon (dove XX può essere uno dei vari tipi di 
balloon a disposizione: Ellipse balloon, Curve balloon, Balloon pen) e poi 
salvarlo tra i Material da Edit > Register material > Image…, dargli un 
nome, una posizione tra i Material (ricordarsi, se serve, di creare una 
cartella nella finestra dei Material prima della registrazione, perché non 
è possibile farlo mentre si registra) e dei tag. 

Posso utilizzare il mio nuovo balloon come uno degli altri 
preimpostati, trascinandolo sul Canvas all’occorrenza, modificarne le 
caratteristiche, aggiungerci la pipetta ecc.. 
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 edito i Control point del balloon (con lo strumento Object, cubo con freccetta),  e aggiungo due 
Control point ai due capi della linea di taglio (Fig.  138 e Fig.  139): 

 

 
Fig.  138 

 
Fig.  139 

 seleziono i Control point al di sopra della linea di taglio (punti in rosso) e li elimino (Fig.  140): 
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Fig.  140 

 poi con lo strumento Correct line imposto il SubTool Control point in Switch corner e tocco i due 
Control point ai capi del taglio (Fig.  141); oppure seleziono il balloon con l'Object tool, tocco il punto 
che mi serve e clicco tasto destro > switch corner): 

 
Fig.  141 

 se serve, muovo  un pochino questi  Control point per ripristinare la curvatura (Fig.  142). 
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Fig.  142 
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Ruler  
Maggiori info sui Ruler --> cercare sul Manuale Explanation: Ruler 

 
I ruler sono delle guide, delle specie di binari che indirizzano il tratto in quelle situazioni in cui si 

preferisce non affidarsi alla mano libera. Sono di diversi tipi: i semplici Ruler , gli Special ruler, il Symmetrical 
Ruler  e i Perspective Ruler. Il Manuale (almeno nella v. 1.8.4) sui ruler non è molto coerente, perché prima 
introduce il Symmetrical e il Perspective Ruler tra gli Special, poi li tratta separatamente da questi. 
Comunque poco importa. 

I Ruler semplici sono: Linear ruler, Curve ruler, Figure ruler, Ruler pen. 
Gli Special ruler sono: Parallel line, Parallel curve, Multiple curve, Radial Line, Radial curve (ex Focus line 

e Focus curve), Concentric circle, Guide. 
I Symmetrical ruler ripetono un tratto disegnato da un minimo di due fino a un massimo 16 volte, 

secondo assi radiali di simmetria. 
I Perspective ruler permettono di aggiungere al disegno dei punti di fuga e relative linee prospettiche, 

che possono essere utilizzati per costruire dei disegni in prospettiva; oppure  apportare modifiche a ruler 
propettici già presenti.  È possibile inserire nel disegno anche dei ruler prospettici già impostati a 1, 2 o 3 
punti di fuga, secondo quanto scritto poco più avanti, vedi Ruler prospettico. 

In più, ci si può agganciare anche alla Grid (non propriamente un ruler) e utilizzarla come guida. 
Gli Special ruler si possono attivare e disattivare, credo perché potendo agire "a distanza" anziché solo 

disegnandoci esattamente sopra come i ruler "Ruler", si può evitare di influenzare il tratto in zone del 
quadro in cui non voglio la loro azione e anche nel caso in cui ho più  Special ruler sullo stesso livello, per 
farli agire separatamente.  

Se i ruler Special, Symmetrical e Perspective sono attivi sono di colore viola, se non sono attivi sono 
verdi.  

Per attivare o disattivare questi ruler cliccare con il Sub Tool Object (Operation Tool > Object) sul ruler e 
cliccare sul rombo che appare accanto.  

 

 
Fig.  143 

 Di recente la grafica dei modificatori dei ruler 
è stata notevolmente migliorata e ora sono più 
visibili. Nelle prossime pagine sono presenti 
immagini realizzate con la vecchia 
visualizzazione: mi riprometto di aggiornarle in 
futuro. 
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Linear ruler 

Il Linear ruler di default permette di disegnare un ruler lineare, di lunghezza finita. Se nella Tool property 
la casellina Create at editing layer è spuntata, allora il ruler viene creato nel layer selezionato in quel 
momento, altrimenti viene creato in un proprio livello raster. Questo ruler ha un raggio d’azione, oltre il 
quale il disegno è libero. 

 

 
Fig.  144 

 
Lo snap è attivato/disattivato dall’icona Snap to Ruler  
(vedi anche più sotto). 
 

   

Nella Tool property c’è la casellina Step of angle che, se spuntata, forza debolmente a disegnare il ruler 
ad angoli prefissati rispetto alle direzioni verticale e orizzontale, con incrementi stabiliti dal valore 
impostato. La forzatura può essere superata insistendo un po’.  

 

Un’altra casellina mooolto interessante che può essere attivata è Scale, che aggiunge delle divisioni sul 
ruler. Le unità di misura delle divisioni possono essere pixel (px), cm, mm, pollici (in), punti (pt), Q (Quarter 
un’unità di misura tipografica corrispondente a 0,25 mm, cioè un quarto di mm o circa 0,71 pt), e anche la 
suddivisione in parti uguali (il cui numero si può impostare) e una divisione secondo il rapporto aureo. 

 
Fig.  145 

Con il Linear ruler si possono costruire ruler curvi secondo curve di Bézier quadratiche o cubiche 
(Quadratic Bézier e Cubic Bézier). 

 

 
Fig.  146 

  
Anche con le curve di Bézier si può attivare 
l’opzione Scale. 
 

 
Fig.  147 
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Curve ruler 

Il Curve ruler è molto simile al Linear, con la differenza che possono essere aggiunti più punti di seguito, 
cosicché la linea disegnata può essere una spezzata (Straight line) e si possono creare delle curve di Bézier 
con più “gobbe”. Esiste anche un ulteriore curva, chiamata Spline, che è una linea curva che passa per i 
punti di costruzione (le Bézier non passano per tali punti, tranne che all’inizio e alla fine). 

 

 
Fig.  148 

È possibile inoltre decidere se la curva disegnata sarà chiusa, spuntando Close line. In tal caso, anche se 
l’ultimo punto segnato sarà distante dal primo, automaticamente la linea andrà a chiusura. 

Scale attivabile, snap con Snap to Ruler. 
 

Disegnare con le curve di Bézier per me non è immediato, ho scritto quindi qualche riga per ricordarmi i 
passaggi per utilizzarle per disegnare i ruler; analogamente si possono usare le curve di Bézier anche con lo 
strumento di disegno Direct draw, pur con alcune differenze; vedi più sotto. 

 

Per disegnare un Curve ruler con Quadratic Bézier: 
 

 
Fig.  149 

 segno il primo punto, dove inizia la curva, toccando la 
tavoletta con la penna (o clicco col tasto sx del mouse); 

 
Fig.  150 

 
 

stacco la penna dalla tavoletta e vado fino al secondo 
punto (o mi sposto col mouse), che sarà il punto di 
controllo della curva; tocco nuovamente la tavoletta o 
clicco col tasto sx del mouse per fissarlo (qui differisce 
dalla Bézier nel Direct draw, dove il secondo punto è il 
punto finale della curva); 

 
Fig.  151 

 
 

stacco nuovamente la penna dalla tavoletta e mi 
sposto fino al terzo punto (o mi sposto con il mouse), 
facendo bene attenzione a non fare ulteriori movimenti 
che altrimenti prolungherebbero la curva con un altro 
arco (beninteso: se la curva è complessa, ovviamente 
continuare…). Con il mouse è più semplice, posso già 
cliccare sul punto; 

 
 Fig.  152 

 

Do l’Invio per confermare l’arco.  

 
Fig.  153 

 

Toccando il ruler con lo strumento Operation > Object 
è possibile modificarlo, agendo anche sulla maniglia (...il 
secondo punto…) che appare. Se il ruler è la successione 
di più archi, per ognuno di essi apparirà un punto di 
controllo. 
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Per disegnare un Curve ruler con  Cubic Bézier: 
 

 
Fig.  154 

 segno il primo punto, dove inizia la curva, toccando la 
tavoletta con la penna (o premo il tasto sx del mouse, 
senza rilasciarlo); 

 
Fig.  155 

 senza staccare la penna dalla tavoletta (o senza 
rilasciare il tasto sx del mouse), trascino fino al secondo 
punto, che serve a costruire la curva (qui differisce dalla 
Bézier nel Direct draw, dove il secondo punto è il punto 
finale della curva); 

 
Fig.  156 

 

stacco la penna dalla tavoletta (o rilascio il tasto sx del 
mouse) e mi sposto fino al punto dove voglio il secondo 
punto: per fissare il punto tocco la tavoletta con la 
penna (o faccio click col tasto sx);  

 
Fig.  157 

 

 

dopodiché, se voglio che il ruler termini qui, do 
l’Invio… 

 
Fig.  158 

 

…altrimenti il punto appena segnato sarà il punto 
iniziale di un altro tratto di ruler, da completare 
analogamente a quanto fatto finora. 

 
Fig.  159 

 

Toccando il ruler con lo strumento Operation > Object 
è possibile modificarlo, agendo anche sulle maniglie che 
appaiono. 

Figure ruler 

Con il Figure ruler si creano ruler geometrici: rettangoli, ellissi, poligoni. Per scegliere il tipo selezionare 
l’icona appropriata in Figure, nella Tool property: nel caso di un poligono, è possibile scegliere il numero dei 
lati (da 3 a 32: non di più, ma comunque  a 32 è difficile distinguerlo da un cerchio). Per ottenere un 
quadrato, un cerchio perfetto o un poligono regolare, tenere schiacciato il tasto Shift durante la creazione. 

I vertici delle figure possono essere arrotondati, analogamente a quanto visto per le vignette, e si può 
decidere se disegnare la figura dal centro. Scale attivabile, snap con Snap to Ruler. 

Ruler pen 

Con Ruler pen si disegna un ruler a mano libera, come se fosse uno strumento di disegno.  Nella Tool 
property è presente la casellina Post correction, che permette di ammorbidire le asperità del tratto. 
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È possibile lo Scale, ma la casellina deve essere resa visibile dalla Sub Tool Detail. 

Special ruler 

Special ruler non è un singolo strumento ma raccoglie alcuni tipi di ruler con funzioni interessanti. Nella 
maggior parte di questi ruler la rappresentazione è a tripla linea più, talvolta, qualche linea accessoria. Non 
è presente la possibilità di usare la funzione Scale. 

Per selezionare il tipo di special ruler, sceglierlo nella Tool property col menù a scomparsa Special ruler. 
 

 
Fig.  160 

 Gli Special ruler sono: 
- Parallel line 
- Parallel curve 
- Multiple curve 
- Radial line 
- Radial curve 
- Concentric curve 
- Guide 

Lo snap si attiva/disattiva con Snap to Special Ruler   . 

 

  



Appunti di Manga Studio/ClipStudioPaint   

99 

Parallel line 

Parallel line è un ruler lineare, infinito, che obbliga il tratto a essergli parallelo. Come risultato si 
ottengono una serie di linee parallele al ruler. 

 

 
Fig.  161 

Parallel curve 

Parallel curve è analogo ma permette di creare delle curve parallele. Il tipo di curva che si può 
selezionare dalla Tool property è una spezzata (Straight line), una Spline o una curva di Bézier quadratica 
(Quadratic Bézier), in maniera simile a Curve ruler. 

 

 
Fig.  162 

Anche se, una volta disegnato, questo ruler ha un inizio e una fine, i suoi effetti sul tratto si possono 
considerare “infiniti”. Infatti, se disegno oltre a questi due punti, il segno rimarrà parallelo alla direzione del 
ruler nella sua ultima porzione, su tutto il Canvas. 

 

 
Fig.  163  
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Multiple  curve 

Multiple curve è veramente molto simile al Parallel curve, ma ha la particolarità di dare una sorta di 
tridimensionalità alle linee parallele disegnate: con il Multiple curve in alcune zone le linee sono distanziate, 
in altre ravvicinate, creando un effetto “nastro”.  
 

 
Fig.  164 

Creando il ruler non è semplice capire dove le curve saranno più distanti e dove più vicine; in genere 
nella zona iniziale, dove il ruler comincia, le linee sono più distanziate, ma a seguito di alcune prove devo 
dire di non esserne certo.  

Tuttavia, selezionando il ruler con lo strumento Object, appare una maniglia che serve a modificare la 
direzione di distanziamento delle linee. Disegnando dopo aver ruotato tale direzione, le linee cambiano 
comportamento. 

 

 
Fig.  165 

 

 
Fig.  166 

Radial line 

Con Radial line si posiziona un punto, individuato da una serie di piccole linee convergenti, verso il quale 
convergeranno  le linee disegnate successivamente,  

 

 
Fig.  167 
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Radial curve 

Con Radial curve si disegna una linea (spezzata, spline o Bézier quadratica); una volta terminata, attorno 
al punto iniziale appariranno le piccole linee convergenti già viste con Radial line.  Tutte le linee che si 
disegneranno seguiranno l’andamento della linea disegnata e saranno convergenti al punto radiale.  
 

 
Fig.  168 

Concentric circle 

Serve a disegnare ellissi e cerchi concentrici (o archi di questi). Disegnando il ruler sul Canvas si ottiene 
un’ellisse generica, inclinabile a piacere (o a passi angolari prestabiliti nella Tool property); per ottenere dei 
rapporti determinati tra le lunghezze dei due assi bisogna spuntare la casellina Keep aspect ratio e inserire i 
valori desiderati. Inserendo  per entrambi il valore 1 si ottiene un cerchio. Un altro modo per ottenere un 
cerchio è tenere premuto Shift mentre si disegna il ruler. 

 

 
Fig.  169 

È possibile modificare la lunghezza (a spanne…) dei due assi selezionando il ruler con Object e agendo 
sulle maniglie lungo la circonferenza. Anche l’inclinazione è modificabile, agendo sulle maniglie lungo la 
linea che passa per le ellissi, oppure modificando il valore nella Tool property (sempre con lo strumento 
Object selezionato). 

 

 
Fig.  170 

Per muovere il ruler nel Canvas la cosa più semplice è, con lo strumento Object attivo, posizionare il 
cursore tra le ellissi e trascinarlo. Alternativamente si possono inserire i valori di X e Y del centro del ruler 
nella Tool property. Ricordare che tali valori sono in px, ma nei righelli potrebbe essere visualizzata un’altra 
unità di misura (es. mm; per cambiarla: Edit > Change Canvas Size… e modificare ). 
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Guide 

Lo Special ruler Guide permette di creare delle guide, esclusivamente verticali o orizzontali, che 
vincolano il tratto solo se si inizia a disegnare sufficientemente vicino a esse.  Sono “infinite”, nel senso che 
sbordano dal Canvas e non se ne vedono le estremità . L’unico controllo che si ha su questi ruler è la 
possibilità di crearli su un layer a sé stante oppure sul layer sul quale si sta disegnando, spuntando la 
casellina Create at editing layer. 

 

 
Fig.  171 

Alle Guide appartengono anche le linee guida che si possono far apparire dai righelli superiore e laterale: 
posizionando il cursore su un righello (le scale graduate che stanno a lato e sopra al Canvas; attenzione: in 
inglese si chiamano anche questi ruler, ci si può confondere) e trascinando sull’area di lavoro, creo una 
linea guida (verticale o orizzontale).  In questo caso, la guida viene creata in un proprio livello raster. 

 

 
Fig.  172 

 

 

 
Fig.  173 

 

 
Fig.  174 

Queste guide “catturano” ( Snap) il tratto se ci si disegna sufficientemente vicino, lasciandolo  invece 
libero se si disegna più distante. Il raggio d’azione dipende dalla risoluzione e dall’ingrandimento con cui si 
sta lavorando: credevo di aver scoperto che a 600dpi è di 5 mm (120 px), ma poi ho notato che cambiando 
ingrandimento tale valore muta e ancora non ho capito con quale criterio. 

L’attivazione/disattivazione dello snap è data dall’icona Snap to Special Ruler  . 

Guide (di nuovo?) 

In CSP ci sono diverse caratteristiche che si ripetono: nomi, icone, strumenti; talvolta non se ne può fare 
a meno, poiché lo stesso nome può effettivamente indicare due cose diverse (es. appena visto: ruler, che 
indica sia i ruler di questo paragrafo che i righelli che stanno ai lati del Canvas), ma spesso sono ripetizioni 
“per comodità”, come nel caso del ruler Guide. 

In effetti, Guide è l’esatta riproposizione dello Special ruler, impostato però già di default su Guide. Non 
sono visualizzate alcune opzioni presenti in Special ruler ma che servono per gli altri strumenti del gruppo, e 
se si va a guardare la Sub Tool Detail di Special ruler e di Guide ci si rende conto immediatamente della 
cosa. Probabilmente, pensando che potesse essere uno strumento molto utilizzato, gli sviluppatori hanno 
pensato di renderlo disponibile a colpo d’occhio nell’elenco dei vari ruler oltre che nascosto all’interno di un 
sottogruppo, più laborioso da raggiungere. 

In sostanza: Guide = Special ruler > Guide. 
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Perspective ruler 

Un ruler prospettico può essere aggiunto o usando lo strumento Ruler/Frame dalla Layer palette (vedi 
Ruler prospettico, più avanti), o aggiungendo i singoli PdF dal Perspective ruler, che trovo tra gli Special 
ruler. 

Il Perspective ruler permette inoltre di compiere alcune operazioni sul ruler prospettico, comunque 
venga creato. Tali operazioni sono stabilite dalla scelta nel menù Process:  

- aggiunta di un punto di fuga (Add vanishing point); se non ho già un ruler prospettico nel Canvas, 
questa operazione lo crea; 

l’aggiunta di un PdF a un ruler prospettico (già esistente)  a uno o due PdF, dà risultati diversi a seconda 
che la casellina Change perspective drawingh method sia spuntata o no. 

Se Change perspective drawingh method non è spuntata l’aggiunta di un PdF non modifica il tipo di 
prospettiva già presente (ovvero a uno o due Pdf). 

Se Change perspective drawingh method è spuntata, l’aggiunta di un PdF a un ruler prospettico a un PdF 
lo trasforma in un ruler a due Pdf, così come l’aggiunta di un PdF a un ruler a due PdF lo trasforma in un 
ruler a tre. 

- la rimozione di un punto di fuga (Delete vanishing point); 
- aggiunta di una linea guida (Add guide), che punterà verso uno dei PdF presenti sul Canvas; per 

scegliere quale è sufficiente indirizzare il tratto verso il PdF scelto; 
- la rimozione di una linea guida (Delete guide); 
- bloccare/sbloccare la posizione di un PdF (Fix vanishing point; il PdF bloccato diventa grigio); 
- mandare all’infinito un PdF e rendere di conseguenza parallele le sue linee guida (Infinitize). 

 

Utilizzando lo strumento Object su un Perspective ruler si attivano altre funzionalità, come Horizontalize 
eye level, che rende orizzontale la linea d’orizzonte su cui giacciono i PdF, e l’attivazione delle griglie 
prospettiche (Grid), dei supporti visivi al ruler (vedi più sotto). Lo snap si attiva/disattiva con Snap to Special 

Ruler   . 

Symmetrical ruler 

Symmetrical ruler pone sul Canvas delle linee che partono da un punto, le quali riflettono il tratto 
disegnato. Il numero minimo di linee impostabile in Number of lines, nella Tool property, è 2, e il numero 
massimo è 16. Al numero di linee corrisponde anche il numero di ripetizioni dell’immagine che avrò alla 
fine.  
 

 
Fig.  175 

 

 

Se nella Tool property è spuntata la casella Line symmetry, la 
riflessione è simile a quella di uno specchio. 

 

 
Fig.  176 

 

 
 

 

 
Fig.  177 

 

 Se la casella Line symmetry non è spuntata, il ruler funziona in 
maniera centrosimmetrica rispetto al punto di origine delle linee 
(CSP la chiama simmetria di rotazione). 

  

 
Fig.  178 
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Se si nota, nel caso di un Number of lines pari e l’opzione Line symmetry attivata, ogni immagine che si 
ottiene è il riflesso speculare di quella che la precede o la segue.  

 

 
Fig.  179 

 Questo ovviamente non è 
possibile nel caso di un numero di 
linee di simmetria dispari (un 
tratto dovrebbe essere il riflesso 
contemporaneamente del tratto 
disegnato e del suo speculare) e 
infatti, con Number of lines 
dispari, Line symmetry viene 
disattivata. 
 
 

 
Fig.  180 

Lo snap si attiva/disattiva con Snap to Special Ruler   ; il Symmetrical ruler agisce anche quando si fanno 

dei riempimenti. 

Snap sul ruler 

Si può attivare lo snap sui ruler con CTRL+1 per lo Snap to Ruler, +2 per lo Snap to Special Ruler, +3 per lo 
Snap to Grid; oppure cliccando sulle corrispondenti icone nella Command bar: 
 

 
Fig.  181 

Io ho aggiunto (Fig.  182) anche l’icona Change Special Ruler Snap, , che serve per alternare tra vari 
Special ruler quando ne sono presenti più d’uno; per aggiungerla andare su: File > Command Bar Settings > 
View e scendere fino a Change Special Ruler Snap; selezionare un comando sulla Preview in corrispondenza 
del qual si vuole aggiungere il nuovo pulsante e cliccare su Add . 

Al Change Special Ruler Snap corrisponde la shortcut CTRL+4. 
 

 
Fig.  182 – Icone per gli snap 
ai ruler  

   

    

 
Fig.  183 – Snap to Ruler, 
CTRL+1 

 
Fig.  184 – Snap to Special 
Ruler, CTRL+2 

 
Fig.  185 – Snap to Grid, 
CTRL+3 

 
Fig.  186 – Change Special 
Ruler Snap, CTRL+4 

Cambio livello, scompare il ruler 

Per utilizzare un ruler anche su un livello diverso dal ruler stesso ed evitare che scompaia quando 
seleziono un altro livello: 
 

 
Fig.  187  

dal menù a tendina con il simbolo del ruler  (Set 
showing area of ruler) seleziono Show in All Layers 
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Ruler prospettico 

Per inserire un ruler prospettico selezionare un Layer nella palette dei Layer, tx dx e dal menu che si apre 
sceglier Ruler/Frame > Create Perspective Ruler…; poi selezionare le opzioni opportune.  

Con questo strumento si possono creare ruler prospettici a uno, due o tre punti di fuga (PdF). 
Attenzione: si può attivare il vincolo a ciascuno dei PdF o a tutti e alle linee verticali. Si deve cliccare sul 

simbolo a rombetto. 
 

 
Fig.  188 

Nomi e funzioni delle varie parti del Ruler prospettico  
(Traduzione dal Manuale, paragrafo Names and Functions of Parts of a Perspective Ruler) 

Questa sezione descrive nomi e funzioni di ogni parte quando un ruler prospettico è selezionato con 
subtool [Object]. 

La seguente descrizione è per il caso di un ruler prospettico a un punto. 
 

 
Fig.  189 

 
A. Maniglia dell’intero ruler prospettico 

Permette di spostare la maniglia dell’intero ruler prospettico o attivare/disattivare lo snap  
Sposta [Whole perspective ruler handle],  cioè sposta la maniglia dell’intero ruler 
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Fig.  190 – Trascinando (1) si può cambiare la posizione della maniglia 

(1) Spostare il ruler prospettico 
Trascinando (2) si sposta tutto il ruler prospettico 

 
(2) Attivare/disattivare lo snap al ruler prospettico 

Attiva/disattiva lo snap al ruler. Quando è attivato si può disegnare agganciati al ruler prospettico 
 

B. Eye Level  - Linea dell’orizzonte 
È una linea che rappresenta l’altezza alla quale è posto l’Eye Level [livello dell’occhio: è cioè la linea 

dell’orizzonte - N.d.M]. Un punto di fuga orizzontale [punto principale – N.d.M.] è posto proprio davanti 
all’occhio. 
 

C. Linea ortogonale alla linea dell’orizzonte 
È una linea ausiliaria ortogonale alla linea dell’orizzonte. Questa linea è mostrata per il ruler a 1 un 

punto e per quello a due punti, non per quello a 3. 
 

D. Maniglia per la linea ortogonale alla linea dell’orizzonte 
Quando lo snap è attivo, permette di disegnare perpendicolarmente alla linea dell’orizzonte. 

 
E. Maniglia della linea dell’orizzonte 

Permette di spostare e ruotare la linea dell’orizzonte. 
 

 
Fig.  192 – Prospettiva a un punto 

 
(1) Sposta la linea dell’orizzonte 

Trascinando (1) si sposta la linea dell’orizzonte 
 

(2) Ruota la linea dell’orizzonte 
Trascinando (2) si ruota la linea dell’orizzonte 

 
(3) Attiva/disattiva lo snap alla linea dell’orizzonte (per la prospettiva a un punto) 

Attiva/disattiva lo snap alla linea dell’orizzonte. Questa caratteristica è disponibile solo per la 
prospettiva a un punto. [disattivando tutti gli altri snap e lasciando attivo questo si disegnano linee 
parallele alla linea dell’orizzonte – N.d.M.] 

 
 

 
Fig.  191 Prospettiva a due o tre punti 
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F. Vanishing point - Punto di fuga 
Punto di riferimento per un disegno in prospettiva 

 
G. Linee guida 

Linee che partono da un punto di fuga a cui ci si può riferire disegnando con un ruler. 
 

H. Maniglia delle guide e del punto di fuga 
Permette di manovrare le guide o il punto di fuga. 

 
Fig.  193 – Maniglie delle guide e del punto di fuga 

 
(1) Sposta la guida 

Trascinando (1) si muove solamente la guida. Il punto di fuga non si muove. 
 

(2) Sposta il punto di fuga 
Trascinando (2) si cambia l’orientamento della guida e il punto di fuga si sposta seguendone la 

direzione. 
 

(3) Attiva/disattiva lo snap al punto di fuga 
Attiva/disattiva lo snap al punto di fuga. Quando è attivo si disegna agganciato al punto di fuga di 

questa guida [le linee convergono al punto di fuga – N.d.M]. 
 

Lo strumento di disegno non si aggancia al ruler 

Andare nel menù [View] e selezionare una delle opzioni dello Snap al Ruler, oppure cliccare su una delle 
icone della Command bar (Fig.  182). 

Cambiare direzione 

Se l'opzione [Decide direction again if coming back to start point while snapping perspective ruler] è 
attivata in [Ruler/Frame/Unit] nelle [Preferences], tornando al punto di partenza, mentre si sta disegnando 
con lo snap attivo a un ruler prospettico, si può cambiare direzione al segno. 

Aggiungere un punto di fuga 

Quando si lavora coi ruler prospettici si possono aggiungere dei PdF.  
Per far ciò selezionare lo strumento Figure, selezionare il sub-tool Perspective ruler e assicurarsi che 

“Process” abbia come opzione attivata “Add vanishing point”.  Disattivare “Change perspective drawing 
method”. 

A questo punto si va sul Canvas e si tracciano due linee guida, che individueranno il nuovo PdF. 

Griglie prospettiche 

È possibile visualizzare delle griglie prospettiche (Grid), che possono aiutare a costruire il disegno in 
prospettiva. Per attivare le grid bisogna prima avere il ruler prospettico su un livello, dopodiché lo si 
seleziona con l'Object tool e allora tra le opzioni compare la possibilità di visualizzarle (vedi prox figura, B). 
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 Considerando la larghezza sull’asse X, l’altezza sull’asse Y e la profondità sull’asse Z, premendo i tasti 
vengono visualizzate: la griglia frontale (piano XY), la griglia laterale (piano YZ) e la griglia basale (piano XZ). 
È inoltre possibile stabilire le dimensioni della maglia variando il parametro Grid size. 

 

 
Fig.  194- Attenzione: questa subtool si attiva selezionando Object tool 

Fix eye level 

In Fig.  194  si vede dove è possibile mettere la spunta a Fix eye level (A).  
Sel’opzione è deselezionata, è possibile spostare ogni PdF in ogni direzione (Fig.  195) 
 

 
Fig.  195 

Con più d’un PdF la linea d’orizzonte può inclinarsi (Fig.  196).  
 

 
Fig.  196 
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Se l’opzione è selezionata, allora si obbliga il PdF a muoversi solo lungo la linea d’ell’orizzonte (Fig.  197), 
mantenendo quest’ultima fissa.  
 

 
Fig.  197 

È possibile rendere orizzontale la linea d’orizzonte premendo su Horizontalize eye level (Fig.  198). 
 

 
Fig.  198 
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Utilizzo del Four Point Perspective (e del Five PP) Ruler di Doug Hills 

Doug Hills fornisce i due ruler come file apribili da CSP. Sono, in realtà, un insieme di ruler lineari e 
curvilinei che possono essere utilizzati complessivamente come ruler per prospettive a quattro e cinque 
PdF. 

La cosa migliore da fare è salvare il contenuto di questi due file nei Material per poi poterli utilizzare al 
bisogno e anche per tenersi il file originale per riserva.  

Quando apro uno dei file mi trovo questa situazione: 
 

4 punti di fuga  5 punti di fuga 

 
Fig.  199 

 

 
Fig.  200 

 

(consiglio di fare un Alt+Stamp dello schermo di CSP, poi CTRL+N e CTRLr+V in Photoshop o equivalenti, per creare un’immagine 
da poter poi utilizzare come anteprima dei materiali oppure per fare degli appunti come questi ). 

 

Con il ruler aperto, andare su Edit > Register Material > Template, dare un nome e scegliere una 
posizione nella finestra dei Material, e anche delle parole chiave. A questo punto i ruler sono utilizzabili 
semplicemente trascinandoli dai Material al Canvas, attivandoli e disattivandoli con i pulsanti di Snap sulla 
Command Bar. Se si vuole intervenire direttamente sui tracciati, ricordarsi di togliere il lucchetto ai layer 
dove sono contenuti. 

Doug Hills fornisce questo link per youtube in cui visualizzare una sua guida sull’utilizzo dei ruler. 
 
------------------ 

Quanto segue è la mia prima spiegazione sull’utilizzo di questi ruler. Devo ammettere che adesso queste righe 
suonano un po’ incomprensibili anche per me. Le tengo perché non si sa mai, magari mi viene in mente cosa volevo 
dire… 

 

Il ruler è a 300 dpi; se devo usarlo per realizzare un'immagine che è a 600 dpi devo creare un 
nuovo Canvas, utilizzando come preset il FPPR, cambiare l'unità di misura da px a in, e inserire come 
W e H, 7, ricordando di cambiare poi la Resolution a 600. Ora posso disegnare l'immagine su questo 
Canvas e poi copiarla sul Canvas definitivo, oppure posso copiare la cartella (nei layer) e incollarla sul 
documento definitivo. Devo capire ancora per il passaggio dai millimetri.  

------------------ 

  

https://www.youtube.com/watch?v=KUJN6psP3P8
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Salvare un Ruler 

È possibile salvare un ruler creato per poterlo utilizzare più volte: una volta creato il ruler e selezionato, 
salvarlo come materiale, come spiegato qui sopra per i ruler di Doug Hills. 

Modificare un Ruler (e anche i segni vettoriali) 

Per modificare un Ruler (o un segno vettoriale) senza selezionarlo con l'Object tool premere il tasto CTRL 
e toccarlo con il cursore, verrà così selezionato. 

Manga Studio Rulers Help (888toto su DeviantArt) 
(traduzione di un post di 888toto su DeviantArt: http://888toto.deviantart.com/art/Manga-Studio-Rulers-
Help-261908842) 

 
Fig.  201 

Per iniziare… 

[Queste  indicazioni si riferiscono a una versione precedente alla 5 di MS, forse la 4 - N.d.M.] 
Quando si inizia facciamo tutto in maniera semplice, cliccando sul ruler group (6) che apre un 

popup in cui si seleziona la creazione di un ruler layer. Metti il tuo ruler in questo layer e metti 
un solo ruler in ogni ruler layer. Nascondi il ruler layer quando non lo utilizzi. Mostra il ruler 
layer quando vuoi utilizzarlo e cancellalo quando non ti serve più… semplice! I ruler nel ruler 
group (6) controlleranno tutti i layer di disegno in cui i ruler sono attivi e visibili. 

Utenti avanzati… 

Se si adopera un ruler che è un sublayer o all'interno di un layer in cui si trova il disegno, influisce 
solo su quel layer ( e solo quando il ruler è attivo e visibile). Se si continua a tenere il ruler 
nascosto all'interno di un layer allora si può visualizzare o nasconderlo con il checkbox (7). 

http://888toto.deviantart.com/art/Manga-Studio-Rulers-Help-261908842
http://888toto.deviantart.com/
http://888toto.deviantart.com/
http://888toto.deviantart.com/art/Manga-Studio-Rulers-Help-261908842
http://888toto.deviantart.com/art/Manga-Studio-Rulers-Help-261908842
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Le strane regole dei Ruler 

a) Un ruler è attivo quando la sua icona (2) è circondata da un box. Si può rendere il ruler attivo (o 
inattivo) cliccando l'icona, oppure automaticamente se si clicca sul ruler con il selection tool (ad 
esempio se si muove il ruler). 

b) Un ruler funziona solo se è visibile e attivo. 
c) Solo un ruler alla volta può essere attivo… se un secondo ruler diventa attivo allora il primo 

diventa inattivo. 
d) I pattern brush e la brush pen ignorano i ruler simmetrici (Non so perché). 
e) Il text tool, il vector line tool, i tool riempimento e gradiente ignorano tutti i ruler. I tool fusione e 

bruciatura non funzionano per nulla se è attivo un ruler. 
f) Il tool gomma [eraser] è particolarmente strano: il suo movimento non è controllato dal ruler 

attivo ma funziona solo se per caso lo utilizzi nella stessa direzione del ruler ;-(. 

Cancellare i ruler 

Questa cosa ha confuso molte persone… se in un qualche modo selezioni un ruler e premi delete… 
non succede nulla. Se clicchi col tasto destro su un ruler non c'è un delete da scegliere… 
Neanche nel ruler menu non c'è un delete… Come ce ne sbarazziamo? 

a) Se hai messo un solo ruler per ruler layer allora basta cancellare il layer… semplice. 
b) In caso contrario, seleziona il nodo sul ruler (8) per evidenziare in rosso il ruler, quindi cliccare col 

tasto destro… c'è un'opzione  chiamata "Cut Layers"… cliccala e verrà spostata sulla clipboard…. 
basta non incollarla da nessun'altra parte 

 
Non lasciarti demoralizzare… I ruler sono veramente utili e non difficili se segui il metodo 

sopraindicato. 
 
Lascio i dettagli per regolare i ruler prospettici per un'altra volta ma dico qualcosa sul ruler linee 

parallele, che è semplicemente solo un ruler per fare linee dritte, semplice e utile ma 
apparentemente difficile da usare, ma in realtà facilissimo. 

Non preoccuparti cercando di muovere il ruler dove vuoi o tentando di regolarne l'angolo. Prendi il 
tuo strumento di disegno e quando sei pronto tieni premuto il tasto CTRL. L'icona del cursore 
diventa il puntatore e puoi trascinare il puntatore nella direzione che vuoi. Appare una linea a 
elastico e puoi facilmente tirarla esattamente nella direzione voluta; rilascia il tasto CTRL e 
torna il tuo strumento di disegno. Ora, quando disegni il tuo tratto seguirà sempre la stessa 
direzione. Quando vuoi cambiare l'angolo premi il tasto CTRL nuovamente e regola la direzione. 
Così è veramente semplice. 

Una volta salvato il file, dopo la riapertura il Perspective ruler tool sembra non 

funzionare 
https://forum.smithmicro.com/topic/1500/once-file-is-saved-perspective-ruler-tool-doesn-t-seem-to-work-upon-re-

opening 

storn  
Ho sia Clip Studio Art  [Paint?] che Manga Studio 5 (uno è al lavoro, l'altro a casa) ed entrambi non 

ri-aprono file nativo con lo strumento Perspective ruler in una modalità utilizzabile. Lo 
strumento è ancora presente sul suo livello, ma una volta attivato e visibile, non consente lo 
Snap su alcun livello. 

C'è qualcosa da fare a riguardo? Devo fare qualcosa per riattivare il Perspective tool? (cliccandoci 
sopra non diventa verde o mostra nessuna delle maniglie o punti particolari). 

cartoonMike  
Ho avuto lo stesso problema.  Accertarti che Snap to special ruler sia attivo (è nella barra dei 

comandi, vedi l'immagine sotto). Se funzionava prima del salvataggio e della chiusura del CSP, 
fai clic sul pulsante Change Special Ruler Snap  (sempre nella barra dei comandi, non sono 
sicuro se per default o no [non lo è, bisogna tirarselo fuori da File > Command Bar Settings > 
View e scendere fino a Change Special Ruler Snap; selezionare un comando sulla Preview in 
corrispondenza del qual si vuole aggiungere il nuovo pulsante e cliccare su Add - N.d.M]) e 
dovrebbe funzionare. 

Assicurarsi che l'opzione Snap nello strumento sia attivata. A volte l'opzione Snap è disattivata e lo 
strumento è impostato in modo da non conservare alcuna modifica, quindi anche se si rende 
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attivo lo snap, nel momento in cui si cambiano gli strumenti o si esce dall'applicazione e si 
riapre il file, lo strumento tornerà al suo stato salvato. Per questo motivo ho sempre aperto la 
tavolozza delle proprietà dello strumento e ho l'opzione Snap visibile. Vai nel Sub Tool Detail 
per lo strumento e nella categoria Correction clicca sulla casellina alla voce Able to Snap. Quindi, 
se lo strumento è esattamente come lo desideri, fai clic sul pulsante Register to Default Settings 
[è Register all settings to initial settings - N.d.M] e lo strumento è ora impostato per lo snap 
insieme a qualsiasi altra modifica apportatagli. 

Se si disegna su un livello separato, assicurarsi che la modalità per il righello prospettico sia 
impostata su All layers o layers within a folder [è Show in All Layers o Show in Same Folder - 
N.d.M], a seconda del flusso di lavoro. Ma dalla tua descrizione sembra che non sia questo il 
problema. Ma potrei sbagliarmi. 

 

 
Fig.  202 

Una cosa importante è che quando si tratta di Punti di Fuga diagonali o speciali (ad esempio per 
fare le cose con la stessa larghezza in prospettiva, tetti, ecc), è creare i PF speciali su livelli 
diversi (assicurandosi di dar loro un nome significativo) e poi si può passare da uno all'altro 
facendo clic sul pulsante Change Special Ruler Snap  (oh, i nomi che utilizza CSP...). Poiché 
questi layers e ruler per i Punti di Fuga Speciali sono solo di riferimento, li faccio in scala di grigi 
e imposto il layer su cui coloro come Color, con colori che non sto usando quando faccio il 
pencilling (come Fragola e Cantaloupe usando la tavolozza di colori MacOS Crayon) in modo di 
fare la costruzione su quei livelli e poi sul mio layer di pencilling faccio il disegno reale. Uso 
Cantaloupe per quello che normalmente sarebbe il Bianco, cioè il Sub-color, mentre uso Fragola 
per il Nero, il Layer color [credo si riferisca al fatto di passare all'Effect > Layer color su quei 
layer che usa per la costruzione: invece di usare l'azzurro e il bianco (tipo effetto matita blu) 
imposta i due colori su Fragola e Cantaloupe - N.d.M]. Ho mappato la tastiera per passare tra 
colore normale e colore Layer al tasto Asterisco (*) sulla mia tastiera estesa, poiché CSP capisce 
che il tasto Asterisco si trova nel tastierino numerico della tastiera e non shift-8 [qui precisa che 
ha impostato il toggle tra il colore normale e l'Effect > Layer color sull'asterisco nel tastierino 
numerico e non usando Shift + 8 con la tastiera inglese - N.d.M.].  

https://forum.smithmicro.com/uploads/files/1485533664538-persp_buttons.png
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Trasportare un oggetto da un documento a un altro 
Mi è capitato di disegnare un oggetto su un nuovo documento e poi doverlo utilizzare in un altro.  
Disegno l'oggetto in vettoriale, poi lo seleziono, copio e incollo nel nuovo documento, lo riseleziono, ad 

es. con il rettangolo di selezione, e solo ora posso modificarlo. Se lo rasterizzo prima, o lo trasformo in un 
qualche altro tipo di layer, mi è capitato di non poterlo modificare (es. cancellare parti al di fuori della 
vignetta); anche cercando di modificarlo senza selezionarlo, ad esempio solo con l'Operation > Object (Cubo 
con freccetta). 
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Testo e Font 
La gestione del testo in CSP è sempre stata un po’ carente. Dalla versione 1.9.1 (luglio 2019) è stata 

introdotta la possibilità di ruotarlo, inclinarlo e rifletterlo; dalla versione 1.12.0 (maggio 2022) il testo può 
essere esportato come livello modificabile in Photoshop (vedi più sotto). 

 

CSP non installa dei font propri ma utilizza quelli presenti nel sistema operativo. Se si desidera utilizzare 
un font particolare bisogna prima installarlo nel S.O. (poi, per sicurezza, meglio riavviare il pc).  

 

Ci sono diversi siti da cui è possibile scegliere e scaricare font: blambot, myfonts, dafont, 
1001freefonts, solo per citarne alcuni, ma una veloce ricerca sicuramente ne troverà altri. 
Alcuni font sono utilizzabili liberamente, altri sono gratis per uso personale ma a pagamento 
per uso professionale, per altri serve una licenza, ecc.  

Ad esempio, un bel font da fumetto, Anime Ace 2, ha un prezzario vario e, secondo l’uso 
che se ne vuole fare, va dall'essere gratis fino ad arrivare a 400€.  

In genere nei siti di font accanto all'anteprima c'è, da qualche parte, l'indicazione del tipo di 
licenza richiesta. Meglio non fermarsi a quell’informazione però, perché spesso è 
approssimativa (specialmente in quei siti che sembra abbiano tutti i font gratis): una volta 
scaricato il font, tipicamente come archivio .zip o .rar, controllare se è presente un file di testo, 
ad es. readme o license, poiché è lì che l'autore del font stabilisce chiaramente i limiti di 
utilizzo, a cui attenersi. 

Scegliere un Font 

Per aggiungere un testo o modificarne uno già presente bisogna dover scegliere un font tra i numerosi a 
disposizione, talvolta centinaia. Io per prima cosa divido i vari font in famiglie, secondo l’affinità o l'utilizzo 
che ne devo fare, selezionando il menù a tendina col nome del font nello strumento "Text" e poi cliccando 
sull'ingranaggio in basso a destra nella finestra che compare. Posso creare una nuova famiglia selezionando 
"New font list" in basso a sinistra (l'iconcina con l’A) e poi selezionando i vari font che ne faranno parte 
spuntando le caselline accanto al nome. 

Scrivo poi un testo sul Canvas, anche a caso, con il primo dei font della famiglia scelta. Seleziono il testo 
e, per modificare il font, posso percorrere due strade: la prima, scomoda, è selezionare il font successivo 
aprendo il menù a tendina dei font; la seconda più pratica, è mettere il cursore sopra il menù a tendina e 
scorrere i vari font scrollando con la rotellina del mouse. 

Wrap text at frame 

Tra le opzioni della Tool property c’è Wrap text at frame. Quando la casellina è selezionata, appena si 
inizia a digitare un testo sul canvas appare una cornice azzurrina che lo racchiude e che rimane di 
dimensioni costanti.  

 

 
 
 
Fig. 203 

 Quando, scrivendo, si raggiunge il 
bordo a destra, il testo va a capo (senza 
alcuna regola grammaticale) e quando si 
raggiunge il bordo inferiore, il testo 
continua a poter esser scritto, ma al di 
sotto di tale bordo, senza essere visibile. 

 Bisogna quindi ridimensionare la 
cornice con le sue maniglie e adattare il 
testo al nuovo spazio 

 
 Fig. 204 

 

Quando la casellina è 
deselezionata, la cornice adatta le 
sue dimensioni al testo digitato, e 
si può decidere quando andare a 
capo. 
 

 

 
Fig. 205 

https://blambot.com/
https://www.myfonts.com/
https://www.dafont.com/it/
https://www.1001freefonts.com/
https://blambot.com/collections/all-fonts/products/anime-ace-2?variant=20494081097782
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Come ottenere un testo curvo. 
Post di  Patrizia Mandanici 16 settembre 2014 sul gruppo FB Manga Studio [come si chiamava allora] 

Tra le funzioni che mancano in Manga Studio rispetto a programmi come Photoshop e Illustrator c'è la 
gestione avanzata del testo, in particolare la possibilità di usare il testo in maniera più libera - ad esempio 
seguendo un andamento curvo, o tondo, ecc. 

Sul forum inglese di MS ho letto un suggerimento su come ovviare un pochino a questa mancanza. 
Si scrive la frase che ci interessa con lo strumento Text, la si rasterizza (Convert Layer), la si seleziona e si 

"registra" come Image Material avendo cura di scegliere "Brush tip material" come opzione (date un nome 
e scegliete una tag personale per trovarla subito dopo). 

Si sceglie un pennello (o lo si crea duplicandone uno), si va nelle impostazioni "Sub Tool Detail", si carica 
il nostro brush con il testo in "Brush Tip", poi bisogna scegliere tra le varie opzioni la direzione Verticale e 
nella finestra "Stroke" selezionare "Ribbon".Un esempio nella foto. 
 

 
Fig.  206 

https://www.facebook.com/groups/mangastudioitalia/permalink/608402475937423/?match=dGVzdG8gY3Vydm8%3D
https://www.facebook.com/photo.php?fbid=10204711300333092&set=gm.608402475937423&type=1
https://www.facebook.com/photo.php?fbid=10204711300333092&set=gm.608402475937423&type=1
https://www.facebook.com/photo.php?fbid=10204711300333092&set=gm.608402475937423&type=1
https://www.facebook.com/photo.php?fbid=10204711300333092&set=gm.608402475937423&type=1
https://www.facebook.com/photo.php?fbid=10204711300333092&set=gm.608402475937423&type=1
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 Testo con bordo  

Si può dotare un testo di un “filo” di colore diverso rispetto a quello del corpo del carattere utilizzando 
l’effetto Border effect presente nella sezione Effect della Layer property palette: 

 

 
Fig.  207 
 

  
 
 
 
Mantenendo selezionato il 

livello del testo, cliccare 
sull’icona Border Effect nella 
Layer property, quella col 
cerchio: appaiono le opzioni 
per questo effetto. 

 

 
Fig.  208 
 

  

 
 

Quando si clicca sulla barra 
del colore (Edge color) del 
bordo appare la finestra Color 
settings in cui scegliere il 
colore. 
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Fig.  209 
 

  
 
 
 
 
 
Cliccando su Thickness of 

edges si può giocare con lo 
spessore del filo. 

Attenzione: se il testo è in un balloon, il filo verrà applicato al balloon e non al testo. 

IME control 

Tra i parametri che si possono impostare nelle Preferences, sotto Interface c’è IME control. IME significa 
Input Method Editor  (Editor del metodo di input ); è un’opzione che riguarda il tipo di inserimento del testo 
e credo regoli l’utilizzo contemporaneo di alfabeti diversi (es. giapponese e latino). 

Edit text 
 

Edit text è il nome dato a due insiemi di comandi in CSP, uno nel menù Story, trattato qui, e uno 
presente nelle Preferences (vedi più sopra). Riguardano entrambi la gestione del testo, ma da prospettive 
diverse.  

Qui seguo più o meno il Manuale. 
Edit text è una funzione di CSP che permette di gestire in batch parte delle caratteristiche dei testi 

presenti in un progetto, sia esso mono o multi pagina. 
In particolare si possono aggiungere nuovi testi, cancellarli, formattarli, fare delle ricerche di parole ed 

eventualmente sostituirle.  

Story Editor 

Edit text si trova nel menù Story; da esso si può aprire lo strumento Story Editor, SE  (da Story > Edit text 
> Open story editor), che permette di visualizzare i vari testi presenti nel progetto. Usando questo 
strumento insieme al Page Manager si può velocizzare il processo di lettering.  

Attenzione: aprendo lo SE si cancella la cronologia presente nella History palette, e al suo posto 
vengono registrati i passi compiuti con lo SE aperto. Chiudendo lo SE viene cancellata anche la sua 
cronologia nella History palette. 

 

Eventuali testi già presenti nel documento aperto, ovvero nel Canvas, vengono visualizzati nello SE. Il 
carattere in uso per visualizzare i testi nello SE e la sua dimensione, nonché il carattere del Reading text 
visualizzato nello SE (per sapere cos’è il Reading text vedi più sopra) e relativa dimensione, si possono 
impostare in File > Preferences > Edit text > View (vedi più sopra). Queste impostazioni nelle Preferences 
sono slegate dai caratteri usati nel fumetto, riguardano i caratteri visualizzati nello Story Editor (da Story > 
Edit text > Story Editor). 

Ripeto, File > Preferences > Edit text  > View imposta i caratteri nello Story Editor, mentre i caratteri 
visualizzati nel fumetto possono essere impostati da Story > Edit text > Story Editor. 
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In questa figura, presa dal Manuale, si vede come appare lo SE e vedo i testi presenti nella pagine 1 e 2 
del fumetto, più una riga, tagliata, della pagina 3.  

 
Fig.  210  

Page area e Text area 

Il Manuale dice che si può passare a lavorare in una delle pagine cliccando nell’area della pagina 
interessata, tenendo premuto CTRL o Shift. Non è così immediato, bisogna cliccare negli spazi intorno alle  
righe di testo o, più facilmente, nello spazio dove c’è il numero di pagina (chiamata page area, area della 
pagina). Se si clicca su una riga di testo (chiamata text area, area di testo) viene selezionata quella riga. Sia 
per le pagine che per le righe è possibile la selezione multipla, tenendo premuto CTRL per selezionare aree 
non successive, oppure Shift, toccando la prima e l’ultima area interessata, per aree successive. 

 

Quando nel documento non è presente nessun testo, lo SE si presenta con una sola riga vuota, pronta 
ad accogliere del testo 

 

 
Fig. 211 

ci digito dentro 
 

 
Fig. 212 

sul Canvas apparirà l’inviluppo del testo, con dentro il testo digitato (qui ho spostato e allargato il 
rettangolo di inviluppo, che era nell’angolo in alto a sinistra) 
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Fig. 213 

Se si vuole aggiungere dell’altro testo, non nella stessa text area ma nella stessa page area, tenendo 
visibile lo SE vado in Story > Edit text > New text, oppure fare tx dx nella text area già esistente e scegliere 
New text (o premere i); appare una nuova riga e lì si può digitare il nuovo testo 

 

 
Fig. 214 

che apparirà sul Canvas (anche in questo caso ho stiracchiato l’inviluppo) 
 

 
Fig. 215 
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Se col cursore cancello il testo digitato nello SE, la text area viene cancellata e il cursore passa alla 
precedente. Per cancellare la text area posso anche tener premuto CTRL o lo Shift e cliccare all’interno della 
text area stessa, dopodiché tx dx > Delete text. Con lo Shift bisogna stare attenti nel caso si selezionino più 
text area, perché il comportamento della selezione può non essere intuitivo. Comunque, nulla di 
trascendentale. Ah, ovviamente è possibile selezionare la text area e andare in Story > Edit text > Delete 
text. 

Formattare il testo con lo Story Editor 

Si può formattare il testo direttamente dallo SE, e questo può essere molto comodo quando ad esempio 
devo cambiare il font di tutta la pagina o differenziarlo a seconda di chi pronuncia la frase, ecc. 

Seleziono la text area di cui voglio cambiare il font, faccio le modifiche nella Tool property, infine o vado 
in Story > Edit text > Apply tool property to text oppure tx dx nella text area e clicco su Apply tool property 
to text. 

Purtroppo, a quanto ho visto finora, non è possibile formattare velocemente solo una parte del testo in 
una text area dallo SE; questo è piuttosto seccante, poiché capita spesso di dover mettere in grassetto, ad 
esempio, una parola all’interno di una frase. Spero di non aver capito io come si fa o, se non è così, che 
venga implementata al più questa funzionalità. Ma c’è un trucchetto che permette di aggirare l’ostacolo, 
vedi (più sotto). 

Utilizzando lo Story Editor, a ogni inserimento di un testo, la formattazione che verrà assunta dipende da 
quanto impostato in Preferences > Edit text > New text. Se nella casellina New text property è impostato 
Selected text tool property allora verranno utilizzate le proprietà scelte di volta in volta nella Tool property. 
Se è impostato Copy form current text allora manterrà le impostazioni dell'ultimo testo inserito. 

Una cosa particolare che accade è che, se è impostato Copy form current text, il primo testo scritto con 
lo Story editor è formattato con la direzione del testo in verticale, posto in alto a destra nel foglio, con un 
carattere scelto dal programma (nel mio caso Tahoma, non so se sia così per tutti). Non so perché faccia 
così: forse essendo il primo testo e non avendo nulla da cui copiare, inserisce dei valori di default, 
probabilmente tentando di adattare una formattazione nipponica, ma è solo una mia supposizione. 

Cercare e sostituire 

Con lo SE aperto, andare in Story > Edit text > Find and Replace oppure tx dx su una text area > Find and 
Replace, permette di trovare una testo ed eventualmente sostituirlo. 

 

 
Fig. 216 

Find what è dove inserire il testo da cercare con il tasto Find; 
Replace with è il testo con cui verrà sostituito se si preme il tasto Replace, Replace all fa sostituire tutte 

le occorrenze del testo; 
Ignore case fa in modo che venga ignorato se le lettere in Find what siano minuscole o maiuscole (se 

metto la spunta e in Find what cerco Gigi, troverà Gigi, gigi, GIGI, GigI, ecc.); 
Search direction ha *aveva…+ un piccolo bug, che ho trovato anche in altre parti del programma: se 

seleziono il radio button Next, in teoria dovrebbe trovare l’occorrenza successiva, così come se il radio 
button selezionato è Previous dovrebbe trovare l’occorrenza precedente. È in realtà vero il contrario, non 
so per quale motivo, e il bello che i programmatori si autodenunciano pure! Infatti accanto a Next c’è la 
shortcut P (p…revious) e accanto a Previous c’è la shortcut N (n…ext). L’ho segnalato a Celsys (30/10/2021), 
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vediamo se sortirà effetto [Aggiornamento 2/11/2021: pare di sì, hanno controllato e mi han risposto che lo correggeranno  

- Aggiornamento 4/01/2022: riesco a verificare, purtroppo, solo oggi: l’hanno sistemato!]. 
 

Se in Preferences > Edit text > View > Direction scelgo Vertical, le righe risultano ruotate di 90 gradi, nel 
caso dovessi utilizzare lo schermo in verticale. 

 

 
Fig. 217 

Spostare una text area 

È possibile muovere una text area in un’altra posizione, anche in un’altra page area. Basta selezionare 
una text area (cliccando col cursore tenendo premuto CTRL) e trascinarla dove si vuole. 

 Ovviamente è possibile selezionare più text area e trascinarle (tenedo premuto CTRL e cliccando sulle 
singole text area o tenendo premuto Shift e cliccando la prima e l’ultima delle text area che si vogliono 
spostare).  

Se si muove una text area all’interno della stessa page area, la posizione del testo selezionato, nel 
documento, rimane invariata: vedo lo spostamento nello SE ma non nella pagina di fumetto. 

Se invece la text area è spostata in un’altra page area, nel fumetto apparirà vicino al testo che si trova 
vicino nello SE. Spesso, più che “vicino” sarà “sopra” . 

 

Dividere una text area 

Mettere il cursore nella posizione in cui si vuole dividere la text area, tener premuto Shift e premere 
Enter. Viene creata una nuova text area. Non è possibile dividere una text area vuota. 

Unire due text area 

Mettere il cursore all’inizio della text area che si vuole unire con la precedente e premere il tasto 
Backspace. Le due text area vengono unite e ognuna delle parti mantiene la formattazione che aveva prima 
dell’unione.  

 

Questo è il trucchetto con cui si può formattare un testo in maniera differente all’interno della stessa 
text area: si isola, dividendo la text area, il testo che si vuole formattare diversamente e, una volta 
riformattato, si uniscono le diverse text area fino a formarne una nuovamente. Forse è un po’ laborioso e 
magari si fa prima andando a lavorare direttamente sul Canvas, però si può fare.  
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Materiali (Material) 
Sulla parte destra dell’area di lavoro di CSP [nel Workspace di default] si trovano i Material, cioè la 

libreria dei materiali, che sono di vario tipo: pennelli o parti di essi, manichini, oggetti 3D, fondali, set di 
colori, ruler, ecc.  

Aggiungere un materiale alla libreria 

CSP è fornito di una libreria di materiali di default ma nuovi materiali possono essere aggiunti alla 
libreria in vari modi. Si possono scaricare dagli Assets di Clip Studio (vedi Assets) o possono essere creati ex-
novo. 

Alcuni dei materiali presenti nella libreria appaiono con un’iconcina in un angolo, una nuvoletta con una 
freccina: significa che il materiale non è ancora realmente nella libreria, ma bisogna scaricarlo.  

 

 
Fig.  218 

 

 Per far ciò, trascinare il materiale sul Canvas; si apre una finestra con cui CSP 
chiede se si vuole scaricare. Se si dà la conferma, si avvia CS che procede al 
download, al termine del quale il materiale sarà disponibile. 

 

  
Fig.  219 

Aggiungere un disegno ai materiali 

 Fare un disegno; 

 Creare una selezione attorno al disegno. Questo passaggio non è sempre necessario perché se sullo 
spazio di lavoro c'è solo il disegno che voglio inserire nei Material, il programma prende gli estremi 
del disegno come spazio in cui racchiudere il Material. Se invece voglio che ci sia dello spazio da 
qualche parte (sopra, sotto, a dx, a sx) con la selezione posso aggiungere lo spazio desiderato.  

 Registrare il materiale: Edit > Register Image as Material. 
 

Ricordare che se si vuole creare come materiale una punta di un pennello a cui si possa successivamente 
cambiare colore, il disegno del materiale va fatto su un layer con Expression color convertita a Gray 
(vedi anche più sotto) 

Aggiungere un pennello ai materiali 

Selezionare il pennello che si vuole aggiungere ai materiali, poi  Tasto dx > Register sub tool as material…  

Aggiungere un ruler ai materiali 

Per aggiungere un ruler ai materiali, seguire quanto scritto più sopra, appena sotto alle immagini. 

Aggiungere un workspace ai materiali 

Anche un workspace può essere salvato tra i materiali (e quindi poi pubblicato negli Assets). Cliccare su 
Window > Workspace > Register workspace as material… 
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Creare una cartella personalizzata di materiali 

Per comodità e ordine preferisco mettere i miei materiali in cartelle personalizzate. La creazione delle 
cartelle va fatta prima di registrare il Material. 

Dalla Finestra Material, posizionarsi dove si vuole creare la cartella, poi txdx > Create new. 
 

 
Fig.  220 

Icone dei materiali scaricati 

Quando scarico un materiale dall’Asset di Clip Studio, è automaticamente collocato nella cartella 
Download nella finesta Material (attenzione: devo controllare meglio, ma questo mi sembra che valga per i 
materiali cercati nell’Assets, non per quelli presenti “virtualmente” nei materiali, con l’iconcina a nuvoletta, 
di cui ho parlato più sopra). 

Passando il cursore su un’icona di un materiale scaricato, in alto a destra appare un quadratino con una 
freccina: 

 

  
Fig.  221 

Sul Manuale non ho trovato nulla a proposito, per cui sembra che l’unica funzione che ha sia quella di 
riaprire gli Assets di Clip Studio in corrispondenza della pagina di download del materiale stesso.  

Pubblicare un materiale negli Assets 

Vedi la procedura indicata più sotto. 
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Retini (Tone) 

Aggiungere e modificare un retino 

Una selezione può essere riempita con un retino, aggiungendolo in due modi: 
- cliccando l’icona New Tone del Selection Launcher sotto alla selezione (vedi anche più sotto): 

 

 
Fig.  222 

si apre una finestra con i vari parametri da modificare;  
 

 
Fig.  223 

 e si dà l’ok per applicare il retino; 
 

- Trascinando nella selezione un retino dai materiali Material > All materials > Monochromatic 
pattern. I parametri del retino selezionato si possono modificare nel detail information, la zona 
sotto ai materiali,  in cui  dovrebbe apparire l’anteprima del retino. Accanto a questa, la casellina 
Toning (che dovrebbe avere la spunta) e il pulsante Setting of toning, che apre la finestra appena 
vista. Meglio lavorare su una copia, comunque.  
Se non si vede l'anteprima, cliccare la seconda icona Switch show and hide of detail information of 
material al di sotto dei materiali: 
 

 
Fig.  224 
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Usare i retini con lo strumento pennello 

Per utilizzare i retini utilizzando un pennello creo una selezione su un layer,  trascino nella selezione un 
retino dalla palette Material oppure riempio la selezione dal Selection launcher che appare sotto la 
selezione. La forma della selezione verrà riempita di retino e la selezione scomparirà. Il layer si chiamerà 
ora Fill in mono 1 e, utilizzando il pennello su quel livello, il segno sarà riempito col retino selezionato. 

N.B.: una volta riempita la selezione col retino si può anche cancellare il contenuto del layer con il 
tastino Delete sulla Command bar, ma si continuerà a disegnare col retino.  

 

 
Fig.  225 - Il tastino Delete 

 

Più velocemente, su un livello trascino un retino dai Material, poi cancello tutto con il tastino Delete e 
poi posso disegnare su quel livello con un pennello, ottenendo un tratto a retino. 
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Pennelli  (Brushes) 
Per pennello intendo uno strumento da disegno, non un pennello in senso stretto. Quindi questo 

paragrafo riguarda i pennelli propriamente detti (Brush), ma anche le varie Pen, le Pencil, gli Airbrush e i 
Decoration. Anche la gomma (Eraser) funziona come un Brush. Ciò che segue vale per tutti questi 
strumenti. 

Colore Pennello 

Colore di un pennello appena creato (o scaricato) 

Dopo aver creato vari pennelli mi sono accorto che alcuni rimanevano neri (o più in generale del colore 
in cui erano quando li ho creati) nonostante tentassi di cambiarne il colore. Quando si setta il materiale che 
ne diventerà la punta (tip) bisogna prima selezionare il layer in cui si trova il disegno della punta (nella 
palette dei Layer), cliccare col tasto dx e selezionare Convert Layer: nella finestra che si apre cambiare 
"Expression color" da "Color" a "Gray". 

 
Devo quindi modificare il pennello creando una nuova punta realizzata in modalità “Gray”, sostituendo 

la punta precedente con quella nuova.  

 Cerco nei Material il materiale con cui ho creato la punta del pennello e lo trascino sul Canvas.  
A tal proposito è utile ricordare di dare sempre dei tag ai materiali che creiamo per facilitarne la ricerca: se il mio pennello 

serve per fare esagoni, il materiale lo etichetto, ad esempio, con “esagono” , “punta”, “pennello”. 

 Faccio la conversione dell’ Expression color del layer in cui si trova il materiale da “Color” a “Gray”; 

 Registro il nuovo materiale:   
Edit > Register Image as Material; 
selezionare la spunta Use for Brush Tip Shape; 
aggiungere le parole chiave (tag); 
salvare. 

 Sostituisco la vecchia punta con la nuova in “Brush tip” 
 

Se la punta è composta da più materiali bisogna fare questa cosa per ognuno di essi. 
 

Il nuovo pennello funzionerà se il layer su cui si disegna è settato su "Color". 
 

Il cambio di colore funziona solo se il materiale è utilizzato come punta di un pennello; diversamente, ad 
es. se trascino il materiale sul Canvas, non riesco a cambiarne il colore. 

Cambiare colore alle linee (lineart)  e  “Color holds” 

Presupposto: le linee (lineart) stanno su un livello diverso rispetto ai riempimenti. 
Consiglio: duplicare il livello e lavorare sulla copia, spegnere il livello originale e tenerlo come riserva. 
 

Cambiare il colore di tutte le linee su un livello, raster o vettoriale  
- seleziono il livello nella Palette dei livelli; 
- seleziono il nuovo colore nella Tool bar; 
- vado su Edit > Convert to drawing color (ex Change color of line to drawing)                . 

 

Con questo metodo, le linee diventano tutte del colore selezionato. In effetti, sui layer raster cambia 
colore a qualsiasi cosa ci sia dentro, linea o meno. 

Vedi anche il Manuale (per la versione 1.8.0 di CSP a pag 186). 
 

Oppure: 
- selezionare il livello; selezionare lo strumento Select > Object; scegliere il colore desiderato. È un 

metodo molto veloce ma non funziona con i layer raster. 
 

Posso anche utilizzare il Layer color (Errore. L'origine 
iferimento non è stata trovata.) 
 

- a) dopo aver selezionato il layer con le linee (meglio se la copia…), sulla palette Layer Property 
seleziono  Effect > Layer color; 
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- b) clicco sulla freccia della barra (Set Layer colors);  
- c) si apre la palette dei colori dove scelgo il colore opportuno, do l’ok;  
- d) la linea cambia colore. 

 

 
Fig. 226 

Notare che quando seleziono Set Layer Colors  (b) la linea assume il colore che è già presente nella barra 
del colore.   

Posso anche scegliere il colore prima di cliccare su Layer color; quando appare la barra, se ci passo sopra 
il cursore questo si trasforma nel secchiello: basta cliccare sulla barra per farle assumere il nuovo colore e di 
conseguenza modificare anche il colore delle linee. 

 

Posso voler  cambiare in maniera differenziata il colore delle linee, ad esempio perché voglio che la 
tonalità si accordi con quello che c’è nei diversi riempimenti (voglio realizzare cioè i color holds):  

 

Cambiare il colore solo di alcune linee su un livello vettoriale: 
- con Operation > Object seleziono le linee di cui voglio cambiare il colore; 
- Nella Tool property palette dell’Object vado su Main color e clicco sul riquadro Set color of line; si 

apre la finestra Color settings e lì seleziono il colore che voglio; do l’OK. Posso anche sceglier il colore 
nella palette dei colori, o da un Color Set, ecc. Attenzione: se è selezionato il Sub color il colore della 
linea non cambia! 

Se si vuole utilizzare un colore specifico, meglio annotarsi uno dei codici colore (RGB, HSV, ecc.) 
prima dei passaggi indicati, per poi inserirlo nella corrispettiva mascherina in Color settings. 

 

Cambiare il colore solo di alcune linee su un livello raster: 
 

Metodo 1 - bloccare i pixel trasparenti: 
 

- duplicare il livello linee; 
- rasterizzare il nuovo livello se non è già raster 
- bloccare i pixel trasparenti cliccando su Lock transparent pixels; 
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Fig.  227 

- scegliere un colore e passare con uno strumento di disegno sulla linea. 
 

 
Fig.  228 

 

Metodo 2 - usare un Clipping layer: 
 

- creo un nuovo livello raster sopra il livello delle linee; 
- clicco su Clip to Layer Below (Clip at Layer Below nelle versioni più datate): 

 

 
Fig.  229 
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A fianco del layer “clippato” appare una linea colorata che ricorda il suo stato: 
 

 
Fig.  230 

in questo modo, di quello che disegno sul nuovo layer visualizzo solo ciò che sta sopra le zone 
disegnate sul layer delle linee: 

- scegliere un colore e passare con uno strumento di disegno sulla linea. 
 

 
Fig.  231 

 

 

Metodo 3 – usare ancora Clip to Layer Below, ma in maniera differente: 
L’utilizzo di un metodo piuttosto di un altro dipende anche da come si sta realizzando il disegno. 
I riempimenti possono essere fatti in modo che si estendano completamente al di sotto delle linee, 

specie da chi usa un approccio più pittorico. 
Se i riempimenti si spingono fino al bordo esterno delle linee, posso utilizzare il Clip to Layer Below in un 

altro modo: 
 

- duplico il livello del colore (se ne ho più di uno li duplico tutti e li unisco tra loro) e duplico il livello 
delle linee; 

- sposto il nuovo livello colore sopra il nuovo livello linee e clicco su Clip to Layer Below: a questo 
punto il livello colore viene “ritagliato” sul livello linee, cioè del livello colore ora vedo solo ciò che sta 
sopra alle linee; 

- abbasso la luminosità del livello colore in Edit > Tonal Correction > Brightness/Contrast agendo sul 
cursore Brightness; 

- Unisco i due livelli con Merge with layer below dal livello colore: ottengo un nuovo livello delle linee 
raster che in alcune zone non sarà soddisfacente, perché risulterà ad esempio più chiaro del 
riempimento adiacente; 
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- Sposto questo livello immediatamente sopra al livello colore originale (ricordarsi di cliccare ancora 
Clip to Layer Below quando è nella posizione definitiva), cosicché i vari livelli di ombreggiatura ed effetti 
soprastanti influiscano anche su questo. 

Color Jitter 

Per cambiare “dinamicamente” il colore del pennello, nella Sub Tool Detail c’è la funzione Color Jitter. 
Ne parlo un po’ più sotto, in nel paragrafo Impostazioni dei pennelli. 
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Impostazioni dei pennelli 

Le opzioni che permettono di modificare un pennello sono molte; una delle cose migliori da fare per 
imparare a gestirle è selezionare un pennello, duplicarlo (piccola icona con rettangolo bianco sotto la 
palette dei Sub Tool "Create copy of currently selected su tool") e modificare i parametri per vedere cosa 
accade.  Per modificare i parametri si deve cliccare sulla chiave inglese nella palette Tool property (non 
quella nell'anteprima del pennello ma quella più sotto, "Show [Sub Tool Detail palette] and edit hidden 
parameter value and displayed status"). I vari parametri possono essere resi visibili o meno nella Tool 
property, accendendo o spegnendo l'occhio. 
 

Brush Size 
Una delle variabili che utilizzo di più è la Brush Size. Generalmente imposto la variazione delle 

dimensioni con la pressione della penna sulla tavoletta.  
Una volta spuntata la casellina Pen pressure si può andare a modificare la risposta del pennello alla 

pressione agendo sul grafico sotto. Come va letto? In ascissa c'è la pressione (Pen pressure), in ordinata 
l'output, ossia la dimensione del pennello in risposta. Volendo, si possono aggiungere dei punti di modifica 
semplicemente cliccando all'interno del grafico per modificarlo in modo più complesso (per eliminare i 
punti aggiunti basta trascinarli all'esterno del grafico stesso). 

Di seguito, il primo grafico indica una risposta lineare: più premo e più grosso è il pennello, meno premo 
e più il pennello è sottile: 
 

 
Fig.  232 

Il secondo grafico indica una risposta meno intuitiva. La dimensione aumenta (e diminuisce) molto 
quando premo poco, mentre anche se premo molto la dimensione, già vicina al massimo, non varia di 
molto: 
 

 
Fig.  233 



Appunti di Manga Studio/ClipStudioPaint   

133 

 
Un errore da evitare è pensare che il grafico rappresenti a sinistra l'inizio del tratto e a destra la fine. In 

realtà, generalmente alla fine del tratto, specie se si disegna in velocità,  la pressione applicata è minima e 
quindi rientriamo nella parte sinistra del grafico.  

Si potrebbe poi immaginare che il grafico rappresenti grossomodo la metà del reale andamento della 
pressione mentre disegniamo (con ovvie differenze a seconda dello stile e della mano del disegnatore), cioè 
che mentre disegno un tratto il grafico rappresenti lo spessore fino a metà circa della sua lunghezza, per poi 
comportarsi simmetricamente per la restante parte. Non è corretto vederla nemmeno in questi termini: il 
tratto nella sua interezza può essere modulato, con più o meno pressione, e il grafico riporta l'aspetto del 
segno in base alla pressione, non in base alla parte del segno in cui ci troviamo.  

 

Si possono fare divertenti esperimenti aggiungendo più punti: 
 

 
Fig.  234 

Con la barra "Minimum value" (Change scale (%) when pressure is minimum) è possibile definire la 
dimensione minima del pennello quando la pressione applicata è minima: più alta è la percentuale e più 
grossa sarà la punta quando la pressione applicata sulla punta è bassa. È interessante vedere come questo 
parametro agisca in accoppiata con i parametri "Starting and ending" presenti più sotto nel Sub Tool Detail. 
------------------------ 
 

 
Fig.  235 – Un buon diagramma per il tilt 

Piccole differenze nel grafico della pressione possono riflettersi in decise differenze nel comportamento 
del pennello. 

Trovando troppo "morbido" un mio pennello (un G-pen modificato), ho provato a correggere il grafico 
della pressione per avere una risposta più "rigida". Come si vede nelle immagini che seguono, i due grafici 
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della pressione non sono molto diversi, ma determinano una risposta del pennello apprezzabilmente 
differente. 

 

 
Fig.  236 – Grafico della pressione “morbido” 

 

 
Fig.  237 – Grafico della pressione “rigido” 

Dimensioni del pennello e unità di misura 

Se in Preferences  > Ruler/Unit l’unità di misura delle lunghezze (Unit of length) è impostata in px, la 
scala delle dimensioni dei pennelli arriva a 2000; se impostata in mm arriva a 100. Le dimensioni a schermo 
non variano, cioè al massimo un pennello è di 2000 px o 100 mm. 

 

Oltre alla dimensione, allo stesso modo possono essere regolate altre caratteristiche dello strumento 
che sto utilizzando, ad esempio Amount of paint o  Density of paint quando si lavora con acquerelli o colori 
a olio. 
 

Ink 
Opacity 

Il parametro Opacity regola la quantità di inchiostro che si lascia passando sopra allo stesso punto 
staccando il cursore dal foglio: se il cursore non viene staccato, passando per lo stesso punto la tinta 
rimane costante (simile al parametro Opacity di Photoshop). Per vederne bene gli effetti il valore 
deve essere basso. 

 

Blending mode 
Con il Blending mode si decide come un segno modifica, dove è tracciato, la visibilità di ciò che è 

già presente nel disegno. Ciò che si vede dove il contenuto si sovrappone viene determinato da varie 
funzioni matematiche tra i valori dei pixel sovrapposti, così da dare vari effetti. 

Molti pennelli di default sono in Normal, che significa che i valori dei pixel esistenti vengono 
sostituiti dai valori dei pixel dello strumento che sto utilizzando; esempio molto semplice: se ho una 
G-Pen blu e scarabocchio sopra un acquerello rosa, il tratto dove è passata la G-Pen diventa blu. La 
situazione inversa, acquerello (in Normal) rosa su tratto blu, può portare ad altri effetti (es. di 
sfumatura), che però non dipendono dal Blending mode. 

Il Blending mode esiste anche per i livelli, vedi più sotto. 
In APPENDICE 003 – I Blending mode ho messo un elenco dei vari Blending mode e di come agiscono 

(traduzione del manuale). 
 

Density 
Il parametro Density regola la quantità di inchiostro che si lascia ogni volta passando sopra allo 

stesso punto senza staccare il cursore dal foglio: ogni volta che si passa la tinta si rafforza (simile al 
parametro Flow di Photoshop). Per vederne bene gli effetti il valore deve essere basso.  

 

Queste due note le avevo scritte in base a qualcosa che avevo letto, non sono sicuro che facciano proprio riferimento ai due 
parametri presenti in Ink; anche se ad esempio per Opacity funziona, per Density non trovo più l’esatta corrispondenza tra il 
comportamento descritto e il parametro per cui l’avevo annotato. 
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Color Jitter 
Quello che appare come un tratto continuo in molti strumenti di disegno è in realtà l’apposizione 

ravvicinatissima di immagini della punta, che nell’insieme dà l’illusione di un’unica linea.  
Color Jitter permette di far variare casualmente le proprietà del colore (Hue, Saturation, Luminosity, 

Blend with sub color) in modo che il colore di ogni immagine della punta sia differente da quella che la 
precede (Change brush tip color), oppure di far variare, nello stesso modo, tratti diversi fatti con lo stesso 
strumento (Randomize per stroke). 

Per valori intorno a 0 dei primi tre parametri la variazione è minima, ma aumentando la distanza da 0 (in 
più o in meno) l’effetto è molto evidente. 

Per il parametro Blend with sub color (= mescolare con il colore secondario) è un po’ diverso, 0 
rappresenta il colore principale, 50 una mescolanza a metà tra il colore principale e il secondario, 100 è solo 
colore secondario, e l’utilizzo a 100 maschera gli effetti delle impostazioni dei primi tre parametri. 

Color Jitter, utilizzato ad esempio per far variare leggermente il colore delle pennellate (quindi 
Randomize per stroke) utilizzando strumenti pittorici, può dare un tocco di realismo in più. 

 

Brush shape 
Nella sezione Brush shape si possono impostare i vari parametri che controllano la forma e il tipo di 

punta del pennello utilizzato. Tra queste, la forma del tipo di tratto che il pennello lascerà (vedi immagine 
seguente). 

 

 
Fig.  238 

 In Brush shape si trovano alcune sottosezioni: 
- Brush tip: per controllare le proprietà della 

punta; 
- Spraying effect: per applicare un effetto spray 

alle parti che compongono la punta; 
- Stroke: regola le proprietà del tratto; 
- Texture: per aggiungere un’immagine alla linea in 

modo che appaia come una trama, una proprietà 
intrinseca della linea stessa. 

 

Brush Tip 
Controlla vari parametri della punta: Tip shape (forma della punta),Hardness (durezza), Thickness 

(spessore, ma non inteso come dimensione della punta, ma come schiacciamento lungo una direzione), 
Angle (angolo di inclinazione), Flip (ribaltamento, orizzontale o verticale), Brush density (opacità della 
punta).  

Tip Shape 

Se si parte da un pennello già presente in CSP si tratta di andare a sostituire le immagini nelle 

proprietà del pennello,  chiave inglese  (Show [Sub Tool Detail palette]) > Sub Tool Detail > Brush 
tip, con altre immagini presenti nei Material. 

Quando registro un nuovo materiale, è meglio aggiungere anche dei tag, cioè delle parole chiave 
(in Search tag, nelle finestra Material property che si apre quando stai registrando un nuovo 
materiale), in modo da trovarlo più facilmente dopo. 

Una volta nelle proprietà del pennello, in Brush tip > Tip shape aggiungo con Add brush tip shape 
(icona a forma di foglio), le nuove immagini: si apre la finestra Select brush tip shape, che 
sostanzialmente è quella dei Material, e da lì si possono scegliere le immagini da importare nel 
pennello. Se sono stati aggiunti i tag allora basta scrivere una parola chiave in Type search keywords. 
Selezionare l'immagine o le immagini e dare l'OK. 
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Infine cancellare da Brush tip le immagini che non servono, cioè quelle del pennello di partenza: 
selezionarle e le cestinarle. 

 

Schematicamente 
per registrare un Material: 
 

- Fare un disegno che rappresenti l'unità da replicare;  
- Edit > Register Image as Material; 
- selezionare la spunta Use for Brush Tip Shape; 
- aggiungere le parole chiave; 
- salvare. 

 

per creare un pennello con una nuova punta: 

- Duplicare un pennello esistente, poi entrare nelle opzioni di modifica (chiave inglese ); 
- nella finestra che si apre selezionare Brush tip; 
- nella tendina con l'immagine selezionare l'immagine salvata in precedenza richiamandola con le 

parole chiave, oppure aggiungere altre immagini cliccando sull’iconcina a foglio di carta (Add 
brush tip shape)*; 

- cancellare l’immagine del pennello di partenza. 
-  Ora si può usare il pennello con la nuova punta.  

 

*Se il pennello da cui si parte non ha la Brush tip realizzata con un materiale, ma ha l’opzione Tip 
shape Circle attivata, allora prima di aggiungere materiali bisogna attivare l’opzione Material, a fianco 
di Circle: 
 

 
Fig.  239 

Thickness 
Non pensandoci troppo, avevo in mente che Brush Size e Thickness fossero in qualche modo 

sinonimi; ma allora perché due controlli diversi? 
In realtà Thickness controlla lo schiacciamento, orizzontale o verticale, della punta del pennello. 
In condizioni di default il valore è 100 e il pennello, se non è un pennello particolare, ha la forma base 

circolare. Alterando il valore la punta si comprime nel verso stabilito dal parametro Direction of 
applying. Cliccando sul quadratino a fianco del valore di Thickness si apre una finestra che permette di 
impostare ulteriori controlli, in analogia con quanto si può fare con Brush Size. 

 

 
Fig.  240 

Angle 
Associato al parametro Thickness c’è il parametro Angle: questo ruota la punta del pennello del 

valore che si sceglie (da 0° a 360°) e ovviamente la rotazione si nota solo se il pennello non è 
perfettamente circolare.  

È possibile associare una dinamica a questo parametro, ossia una variazione sulla base del tipo di 
input (direzione della penna, intendendo credo il verso, es. se sto tracciando da un punto verso l’alto o 
verso il basso;  inclinazione della penna; direzione del tratto, es. se traccio una linea che cambia di 
direzione, avrò uno spessore differente in base alla direzione;  casuale; oppure nessuno di questi) che si 
può scegliere cliccando sul quadratino a destra dello slider.  

Devo dire che non è sempre facile riconoscere questi effetti. 
 

Correction 
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Taper 
Taper cambia la lunghezza della parte finale di un tratto, man mano che la pressione dello stilo sulla 

tavoletta (se la si utilizza) decresce. Più alto è il valore e più lungo è il tratto finale. 
Vector magnet 

Se attivato, disegnando due linee vicine in uno stesso livello vettoriale queste verranno sovrapposte 
(la seconda sarà sovrapposta alla prima). Il raggio d’azione  dell’effetto magnete si può modificare con 
lo slider (o l’indicatore, dipende da come si è scelto di visuallizarlo). 

Utilizzando lo strumento Figure > Direct draw > Curve e abilitando Vector magnet, premendo Shift è 
possibile “snappare” e unire i control points di linee diverse mentre si disegna. 

 

 
 
Starting and ending 

Questo è un parametro del quale faccio molta fatica a riconorscere gli effetti. Le uniche evidenze le ho 
trovate facendo delle prove con  il pennello Opacity watercolor (acquerello opaco), mentre con un normale 
G-pen percepisco qualcosa solo usando diametri molto grandi, cosa che non faccio mai. Al momento penso 
che difficilmente rientrerà tra le cose che utilizzerò.  

Ad ogni modo, con Starting and ending  si dovrebbero poter modificare le parti iniziale e finale di un 
tratto (la Tool Setting Guide dice che modifica la “forza del tratto all’inizio e alla fine”), secondo varie 
caratteristiche. Le impostazioni che si trovano nella Sub Tool Detail sono tra loro collegate, nel senso che 
non basta modificare qualcosa  nel menù a tendina Starting and ending (in Starting and ending c’è un menù 
a tendina che si chiama Starting and ending), ma contemporaneamente dovrò andare a modificare anche le 
voci How to specify, Starting e Ending (vedi immagine). 

 

 
Fig.  241 

Nel menù a tendina Starting and ending (a),  si possono modificano alcune caratteristiche (anche più 
d’una, oppure nessuna). Accanto a ogni caratteristica è presente uno slider in cui impostare un valore 
minimo di una cosa che la Tool Setting Guide chiama ratio of the minimum strength value, ossia rapporto 
del minimo valore della forza, o proporzione del minimo valore della forza (questo se il mio inglese non mi 
inganna: probabile). Ora, io messa così non capisco molto cosa voglia dire, credo che in realtà significhi 
semplicemente che il minimo valore che quella caratteristica assumerà all’inizio e alla fine del tratto sarà il 
tot percento del valore massimo che ho impostato per quella caratteristica. In effetti, anche la breve 
spiegazione che appare nella Sub Tool Detail sembra confermare. 
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Faccio un esempio: se sto disegnando con un pennello a cui ho impostato una dimensione di 80px (con 
variazione alla pressione abilitata) e in Starting and ending ho impostato lo slider a 16, mi aspetto che il 
valore minimo che assumerà il tratto all’inizio e alla fine sia il 16% di 80, ovvero circa 13 px.  Ho provato con 
una G-pen a mettere lo slider del Brush Size sia al minimo che e al massimo, ma non noto nessuna 
differenza: riesco a modulare comunque il tratto come voglio. Boh. 

Nel menù a tendina How to specify (b) posso scegliere tra tre opzioni: 
- Specify length. Il tratto inizia al valore minimo del rapporto appena visto e aumenta per la lunghezza 

specificata in Starting (c),  fino ad arrivare al 100%. Terminando invece la lunghezza in cui il tratto 
diminuisce il suo spessore fino a quello impostato nello slider è quella indicata in Ending. 

- By percentage: idem come sopra, ma la lunghezza utilizzata è la percentuale della lunghezza totale 
della linea indicata in Starting e in Ending. 

- Fade. Con Fade la voce Starting è disabilitata e la linea varia il valore della caratteristica scelta per la 
lunghezza indicata in Ending, fino al minimo dello slider, dopodiché tale valore viene mantenuto fino 
alla fine del tratto. 

 

L’ultima voce, Starting and ending by speed (e; disabilitata di default quando How to specify è su Fade), 
fa variare l’effetto di Starting and ending a seconda della velocità con cui viene disegnato il tratto: in teoria, 
se si disegna lentamente l’effetto è meno evidente. In teoria, perché personalmente, con le impostazioni  
che metto qui di seguito, non riesco ad apprezzare granché (provando con alcuni  tratti disegnati 
lentamente e altri velocemente). Ho anche cambiato la punta della G-pen, che avevo sostituito con 
un’immagine (un disco nero), tornando alla Circle originale. 

 

 
Fig.  242 

Anti-overflow 
Do not cross  lines of reference layer 

Do not cross lines of reference layer (ex Do not exceed line of reference layer) è un’opzione che si 
trova nella Tool property degli strumenti di disegno (anche della gomma).  

Se attivata, fa in modo che se il centro dello strumento che si sta utilizzando è da una parte di una 
lineart i suoi effetti non oltrepassino la lineart stessa. 
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Esempio 1 

Ho aperto una tavola per fare delle modifiche. Voglio aggiungere dei tratti con il Soft Airbrush. Creo 
un layer raster per l'operazione, inizio a disegnare ma non vedo nulla. Spengo tutti i livelli tranne 
quello nuovo e ripeto l'operazione: il segno viene disegnato. Riaccendo i livelli e riprovo: nulla. Creo 
allora un livello  raster sopra a tutti i livelli, ma anche così non succede nulla se non spengo tutti i livelli. 
Noto che lo strumento che sto utilizzando ha l'opzione Do not exceed line of reference layer  attivata. 
La disattivo e tutto funziona normalmente. 

Esempio 2 

Devo fare un'ombra all'interno di uno sferoide, tipo l'ombra a un pianeta. Seleziono lo sferoide per 
colorare solo al suo interno e procedo. Se tengo l'opzione Do not cross lines of reference layer attivata, 
non riesco a disegnare nulla finché il centro del pennello non supera la lineart di riferimento 
 

 
Fig.  243 

Se invece l'opzione Do not cross lines of reference layer è disattivata, riesco a disegnare all'interno  
anche col centro al di fuori della selezione 

 

 
Fig.  244 

Esempio 3 

Voglio riempire di colore o di nero dei piccoli spazi tra le lineart, oppure aggiungere dei piccoli 
tocchi di pennello, tipo la lieve ombra sotto un labbro inferiore, ecc.  I piccoli spazi non si riempiono e 
la lieve ombra modifica la propria forma subito dopo averla creata.  
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Controllo:  al pennello è attivata l’opzione Do not cross lines of reference layer; disattivo e posso 
disegnare. 

 

In alternativa posso disattivare l’impostazione di Reference layer alle lineart. 
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Applicare diversi tipi di pennello alla stesso disegno 

 da un post di Patrizia Mandanici del 27 Febbraio 2017 

Nota: Nel post di Patrizia c’è il link a un post in Tumblr che ora (ottobre 2021) sembra non esistere più.  Nella 
sostanza, come si vede dall’immagine sotto, in quel post una scena era disegnata con un tipo di pennello nella 
prima vignetta e via via con altri nelle successive. Cristiano evidenzia che la scena è in tutte le vignette troppo 
simile per pensare che sia stata ridisegnata ogni volta con un pennello diverso e intuisce che ci deve essere un 
modo per cambiare il tratto al volo. Federica infine indica come può essere realizzato il passaggio da un tratto 
all’altro. 

 

Cristiano Corsani  
Dovrebbe essere certamente utile quando si usano i ruler. Ma: qualcuno sa come si fa ad applicare brush 

al rendering di oggetti 3D? 
Patrizia Mandanici 

Eh, non ho capito. 
Cristiano Corsani  

Quando il sistema renderizza oggetti 3D (nell'esempio del brush che hai condiviso c'è l'aula di una classe 
che fa parte degli environment 3D in dotazione di CSP) deve usare per forza un brush. Altrimenti il 
creatore di questo brush come ha fatto a renderizzare quell'oggetto con il suo pennello? 

 

 
Fig.  245 

Patrizia Mandanici  
Non ho visto il brush, ma non è che ha estratto la linea con la conversione LT? E poi ha usato il disegno 

come base per il pennello? 
Patrizia Mandanici  

Ah, adesso ho capito: secondo me l'ha ricopiato, non mi sembra ci sia altro modo per usare l'LT 
inserendogli un nostro pennello. 

https://www.facebook.com/groups/mangastudioitalia/posts/1143729535738045
https://www.facebook.com/cristiano.corsani?fref=ufi
https://www.facebook.com/patrizia.mandanici?fref=ufi
https://www.facebook.com/cristiano.corsani?fref=ufi
https://www.facebook.com/patrizia.mandanici?fref=ufi
https://www.facebook.com/patrizia.mandanici?fref=ufi
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Federica Di Meo 
in realtà c'è un metodo velocissimo,  
1 aggiungo il ruler ai miei pennelli base tramite il menu con la chiave inglese (vedi immagine sotto) 
2 prendo un'immagine rasterizzata dell'oggetto, anche solo in jpg da sketchup, e poi dal menu base 

faccio layer > convert layer e la converto in vettoriale. (oppure fate LT conversion da un modello 
interno a Clip, come preferite) 

3 vado nel comando Operation (il mitico quadratino bianco con la freccia nera nei tool), seleziono tutte 
le linee vettoriali dell'oggetto e poi in basso, nel brush shape, converto le linee da linea nera standard 

al pennello che ho aggiunto prima in quelli personali e voilà <3  
 

 
Fig.  246 

Cristiano Corsani  
URCA! Mitica. 

 
Traduco:  

1) Aggiungo il brush ai preset, cioè seleziono il pennello con il quale voglio modificare le linee, vado in 
Brush shape entrando nel Sub Tool Detail con la chiave inglese e clicco su Register to preset; 

2) Se le mie linee sono già in vettoriale tralascio questo punto, sennò seguire quanto scritto; 
3) Seleziono le linee che voglio modificare (Object tool); nella Tool property clicco sulla freccetta accanto 

a Brush shape: mi compaiono le varie forme del pennello e seleziono quella appena registrata (cuore 
è minore di 3), oppure seleziono, nel Sub Tool Detail, la Brush shape appena registrata e clicco su 
Apply brush shape. 

 
Nota: questo sistema funziona se lo scambio è fatto tra pennelli appartenenti alla stessa categoria, a 

esempio entrambi del Sub Tool “Pen” (ho provato e funziona). Non sono riuscito a farlo funzionare se 
lo scambio è fatto tra un “Pen” e un “Oil paint” ad esempio il pennello “Pointillism”. Devo 
approfondire, suppongo si tratti qualcosa legato alle texture o ai materiali delle punte. 

 
Scartabellando tra i vecchi post, ho trovato anche questo. 

https://www.facebook.com/akafededm?fref=ufi
https://www.facebook.com/photo.php?fbid=10212744576316012&set=p.10212744576316012&type=3
https://www.facebook.com/photo.php?fbid=10212744576316012&set=p.10212744576316012&type=3
https://www.facebook.com/photo.php?fbid=10212744576316012&set=p.10212744576316012&type=3
https://www.facebook.com/cristiano.corsani?fref=ufi
https://www.facebook.com/groups/mangastudioitalia/posts/710252832419053/
https://www.facebook.com/photo.php?fbid=10212744576316012&set=p.10212744576316012&type=3
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Modificare caratteristiche del tratto già disegnato 

Gruppo Facebook 24 Novembre 2017 
Angela Parmisano   

buonasera a tutti... Ho appena reato un disegno con penna e anti-aliasing attivo al massimo.... è 
possibile "convertire" questo settaggio oppure devo rifare impostando il valore dall'inizio? Spero di 

essermi spiegata :D 
Madeleine Verdessini 

 intendi se è possibile salvare queste impostazioni in un nuovo pennello? 
Patrizia Mandanici  

Credo intenda se si può sostituire il segno del disegno con lo stesso segno ma con antialiasing diverso 
(presumo sia disegnato in vector layer). Credo di no, ho fatto una prova e non credo si possa fare. 

Bruno Olivieri 
Se il tratto è in vettoriale, lo selezioni con Select Object, poi vai nelle impostazioni (icona chiave inglese) 

e dal menù "Anti-aliasing", cambi l'aliasing. 
 

 
Fig.  247 

 
  

https://www.facebook.com/photo.php?fbid=10214494114293908&set=p.10214494114293908&type=3
https://www.facebook.com/photo.php?fbid=10214494114293908&set=p.10214494114293908&type=3
https://www.facebook.com/photo.php?fbid=10214494114293908&set=p.10214494114293908&type=3
https://www.facebook.com/photo.php?fbid=10214494114293908&set=p.10214494114293908&type=3
https://www.facebook.com/photo.php?fbid=10214494114293908&set=p.10214494114293908&type=3
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Creare un pennello con materiali diversi 

Serve ad esempio per disegnare velocemente oggetti simili ma non uguali (es. schegge di vetro, persone 
tra la folla, ecc.). 

Si segue la normale procedura per creare un pennello, ma quando si decide il "brush tip" si aggiungono 
vari "Material", tanti quanto si vuole diversificato il disegno. Per aggiungere cliccare sul simbolo del foglio, 
sotto le preview a destra.  In più se si vuole che i materiali si alternino in maniera casuale impostare "Brush 
shape > Stroke > Repeat method > Random" 

 

 
Fig.  248 

 

 
Fig.  249 

 

Attenzione al risultato che si vuole ottenere: nel caso di schegge di vetro può non essere importante la 
dimensione relativa delle varie schegge, anche perché assegnando una rotazione casuale a ogni elemento, 
se anche ogni scheggia è circa grande come le altre, può non notarsi molto (e se si assegna la dimensione 
della punta al variare della pressione si nota ancora meno). 

Ci sono dei casi in cui però le dimensioni relative tra gli oggetti che compongono il pennello contano, 
perché se non ne tengo conto il pennello risulterà poco "dinamico". Se voglio disegnare in velocità una 
libreria oppure una mensola con delle bottiglie, posso creare un pennello "Libri" o un pennello "Bottiglie" 
che mi disegna una serie di elementi ripetuti (in modo ordinato o casuale). I singoli elementi vanno 
comunque disegnati, ma può essere comodo se so di doverne disegnare veramente molti. In tal caso posso 
creare un certo numero di elementi diversi tra loro e poi usare un pennello per stendere in velocità la mia 
libreria o la mia enoteca. 

Disegno i singoli elementi uno a uno e li salvo come materiali (ricordandomi di unire i livelli se l'ho 
disegnato in più livelli e di convertire il livello ottenuto in Type > Raster layer e Expression color >  Gray).  

Se non uso una piccola accortezza, il mio pennello risulterà però come nell'esempio 1: 
 

 
Fig.  250 

Le bottiglie sono tutte alte uguali, una 

condizione non realistica e con un forte 

peso visivo. 
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Io vorrei una situazione come quella dell'esempio 2, più realistica e "snella": 
 

 
Fig.  251 

Il modo per ottenere questo risultato è di usare dei riferimenti quando si salvano i materiali. 
Se disegno su un foglio di lavoro (Canvas) le mie bottiglie e le salvo una a una dalla mia area di lavoro 

così come sono, il programma, nel salvataggio, uniforma la loro altezza a un livello massimo, uguale per 
tutte, anche se io non disegno su tutta l'altezza del foglio: 

 

 
Fig.  252 - Il brandy che crea un'atmosfera 

Se invece prima di salvare il nuovo materiale creo una selezione attorno al disegno e tale selezione la 
faccio alta uguale per tutti gli elementi che andranno a comporre il pennello, allora sarà l'altezza della 
selezione a essere presa come massima; bottiglie che hanno diverse altezze all'interno della selezione 
manterranno le relative proporzioni: 
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Fig.  253 

Per dimensionare correttamente la selezione ho utilizzato in questo caso come riferimento le linee che  
definiscono la gabbia (Default border), il Binding e il Bleed (per sapere di cosa sto parlando guarda 
Impostare le dimensioni del documento). Ho usato, come linea dove appoggiano sul piano le bottiglie, la 
linea del Binding, come altezza massima della bottiglia più alta la linea superiore della gabbia e come limite 
superiore e inferiore della selezione le corrispondenti linee del Bleed. 

Meglio circoscrivere attentamente la selezione anche a destra e a sinistra dell'oggetto, arrivando a pochi 
pixel dal bordo sia da una parte che dall'altra. Questo farà in modo che lo spazio occupato da ogni bottiglia 
in larghezza sia solo lievemente più largo della bottiglia stessa, evitando poi eccessive spaziature tra una 
bottiglia e l'altra. Tale spazio sarà possibile poi controllarlo con la variabile Stroke > Gap nella finestra Sub 
Tool Detail del pennello che andrò a creare. 

Ovviamente ci si può creare il riferimento che si desidera, avendo cura di mantenere l'altezza della 
selezione costante per tutti gli elementi che comporranno la punta del pennello. 

  

Le mie bottiglie sono bianche, ma se le volessi di un altro colore? Due modi: avendo convertito 
l'Expression color in Gray ora posso utilizzare il secondo colore della toolbar come colore del riempimento. 
Funziona, ma in questo caso può essere poco comodo: bottiglie tutte dello stesso colore. Alternativamente, 
una volta sicuro dell'aspetto della mia cantinetta converto il layer su cui ho disegnato la serie (o le serie) di 
bottiglie in Raster (se non avevo già disegnato in Raster, ma non  lo faccio mai) e poi posso usare il 
secchiello e andare a riempire ciascuna bottiglia con il colore che voglio. 

Impostare la direzione di un pennello 

Se creo un pennello che disegna degli oggetti, posso volere che la direzione degli oggetti segua la linea 
del segno: a esempio, voglio che le bottiglie appena viste siano coricate lateralmente e non in piedi e 
parallele. Per impostare in modo che succeda questo, vado in SubTool > Brush shape > BrushTip > Angle e 
imposto un valore adeguato, a esempio 90. Ulteriori aggiustamenti si possono ottenere cliccando sulla 
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casellina alla destra dello slider, Adjust this setting with dynamics such as pen pressure or stroke speed; si 
apre la finestra Angle Dynamics, in cui poter intervenire su altri parametri.  
 

 
Fig.  254 

Dopodiché, se si vuole evitare la sovrapposizione delle singole immagini che compongono la punta, 
bisognerà modificare la distanza “di rilascio” agendo sul parametro Brush shape > Stroke > Gap. 
 

*questo paragrafetto è errato in tutte le precedenti versioni degli appunti. Non me ne sono mai accorto…+ 

Dual brush 

Nella versione 1.10.10 (27 maggio 2021) è stata introdotto un insieme di impostazioni per gli strumenti 
di disegno: si tratta della possibilità di trasformarli in dual brush, letteralmente “pennello doppio”. 

Nella Sub Tool Detail è stata aggiunta una sezione, contraddistinta dal numero 2, che duplica i 
modificatori della sezione Brush shape.  
 

 
Fig.  255 

Spuntando la casellina Dual brush, in 2-Brush shape, si aggiunge una seconda punta allo stesso pennello, 
che può essere controllata al pari della prima. La prima punta è anche chiamata main brush, pennello 
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principale. Analogamente al pennello principale, per la seconda punta è possibile scegliere la forma anche 
utilizzando un materiale. 

È possibile poi impostare un metodo di fusione (Mode) con la prima punta, per potere creare ulteriori 
effetti.  Con la spunta Apply RGB value, il valore RGB della seconda punta viene utilizzato per il calcolo 
relativo al metodo di fusione; se non è spuntata, il valore viene ignorato ed è come se il metodo di fusione 
fosse Normal (almeno da quello che ho capito finora). 

La dimensione della seconda punta può essere impostata separatamente e, attivando la spunta Link to 
main brush size, vincolata alla dimensione del pennello principale. 

 
Questo articolo (in inglese) offre una buona panoramica su questo strumento. In esso viene detto 

inoltre che la funzione Dual brush non è disponibile nella versione Debut di CSP; inoltre non è retroattiva, 
ossia un dual brush realizzato con la v. 1.10.10 o successive non può essere utilizzato con versioni 
antecedenti del programma, e non è possibile modificare file nelle versioni precedenti se sono stati 
utilizzati dual brush in bordi delle vignette, balloon o livelli vettoriali.  

Problemi col segno 

Nel gruppo FB Clip Studio Paint Italia capita spesso che qualcuno riporti dei problemi di linearità del 
segno, ad esempio dei tremolii non voluti in alcune parti del tratto. Questo tipo di problemi sono piuttosto 
frequenti; a volte si tratta di capire bene come impostare le varie caratteristiche del pennello nella Sub Tool 
Detail dello stesso, altre dipendono da conflitti tra i driver della tavoletta grafica utilizzata e il sistema 
operativo. In genere si suggerisce di ricercare nel gruppo con parole chiave tipo “pressione” [intesa come 
rilevamento della pressione della penna sulla tavoletta grafica], “linea”, “segno; in altre occasioni vengono 
suggerite operazioni di modifica delle impostazioni o sostituzioni di driver. 

È interessante questo post di Vittorio Garofoli in cui viene lamentato il tremolìo del segno all’inizio del 
tratto, apparentemente senza soluzione anche dopo una ricerca tra i vari post.  

 

 
Fig.  256 – Un tremolìo non cercato 

Dopo qualche prova però, Vittorio ha notato che, andando in File > Preferences > Tablet > Tablet 
Settings  e impostando quest’ultima su Prefer speed, il problema rientra.  

Invece la combinazione  Tablet Settings > Prefer quality e spunta attiva su Coordinate detection mode 
(più sopra, sempre nella scheda Tablet), genera il fastidoso tremolìo. 

Pennelli e gomme 

Lo strumento gomma (Eraser) è strutturato a tutti gli effetti come un pennello e i suoi modificatori 
funzionano nello stesso modo.  

 

A questo proposito, bisogna fare attenzione ad alcuni comportamenti che CSP adotta quando vengono 
attivate o meno certe funzioni. Ad esempio, può sembrare strano ma anche con un pennello è possibile 

https://tips.clip-studio.com/en-us/articles/4845?fbclid=IwAR33sVO2Cff3mi8aFtK5Bk5hrWdQMoUwfNfCd-livO8OJw5bf0kQyyEYGuc
https://www.facebook.com/groups/mangastudioitalia/permalink/4524137851030513
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cancellare delle linee. Questo perché molti strumenti di CSP sono costruiti sulla medesima ossatura, e ciò 
che li rende uno strumento piuttosto che un altro è l’insieme delle funzioni attive e inattive.  

 

Se analizzo un pennello, ad esempio l’usatissimo G-pen, e vado ad aprire la Sub Tool Detail palette (da 

qui l’abbrèvio in STDp; clicco sulla chiave inglese  sotto la Tool property palette), vedo che sulla sinistra 
sono elencate delle voci, che corrispondono alle varie impostazioni del pennello. Se apro la STDp di una 
gomma, ad es. Vector Eraser, vedo che è strutturata allo stesso modo: 

 

 
Fig.  257 - Sub Tool Detail palette della G-pen 

 

 
Fig.  258 - Sub Tool Detail palette del Vector Eraser 

 

Se si provano a selezionare le varie voci sia per il pennello che per la gomma si vede che anche la 
struttura dei vari modificatori è la medesima. 

 

Queste analogie tra strumenti si ripetono varie volte nel programma: alcuni strumenti possono 
condividere la stessa base e, talvolta sorprendentemente, si possono andare a modificare le opzioni di uno 
per ottenere un duplicato, o quasi, di un altro. 

 

Così come accennato, se nella STDp della G-pen seleziono la voce Erase posso andare a giocare con delle 
opzioni che mi permettono di cancellare, quando disegno in vettoriale, altre linee vettoriali sullo stesso 
livello. Se metto la spunta a Vector eraser, quando col tratto incrocio altre linee queste vengono cancellate, 
in modo diverso a seconda dell’opzione selezionata con le icone accanto: 

 

 
Fig.  259 
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Strumento Eraser (gomma) 

Sotto lo strumento Eraser (gomma) si trovano sumerosi sottostrumenti, ognuno con la sua particolarità: 
Hard, Soft, Block, Multiple layers, Snap, Vector, Kneaded. A proposito di quanto detto più su, tra di loro 
questi sottostrumenti differiscono solo per qualche impostazione nella Sub Tool Detail palette; qualche 
differenza è minima (es. la Snap, di default, si aggancia a ruler, alla griglia ecc., le altre no; in effetti non 
capisco perché abbiano scelto di farne uno strumento a sé stante), qualche altra è un po’ più di sostanza. 
Kneaded è la gomma-pane. Ha una texture e il suo effetto è simile al passaggio della gomma-pane sul 
foglio, cancella il tratto un po’ alla volta, irregolarmente. 

 

Quelli che uso di più sono il Vector e l’Hard eraser. 
 

Vector è utile se si stanno disegnano linee vettoriali: se nella STDp imposto Erase > Vector eraser > Erase 
up to intersection e anche Refer all layers allora quando tocco un tratto vettoriale questo viene cancellato 
fino a dove questo incrocia un altro tratto vettoriale, anche se in un livello differente. Io lo trovo utile, ma si 
può impostare ovviamente secondo le proprie preferenze. Attenzione a tenere la dimensione della Vector 
paragonabile a quella del tratto da cancellare: se troppo piccola infatti si fa più fatica a farla agire. Se 
utilizzata con > Erase touched areas allora cancella solo dove passa, ma non mi piace molto l’effetto che dà, 
perché i frammenti del tratto dopo la cancellazione mostrano a volte degli “spuntoni” piuttosto brutti. Se 
utilizzata su un livello raster, Vector cancella solo dove passa, ossia per la Brush size impostata (a meno di 
controlli della pressione). Anche il livello di Anti-aliasing influisce sul risultato del passaggio delle gomme. 

 

Lo stesso tipo di “spuntoni” a cui mi riferivo talvolta appaiono anche usando > Erase up to intersection, e 
qui spesso intervengo utilizzando l’Hard eraser. Questo Sub Tool è forse più indicato per i livelli raster; si 
tratta di una gomma “manichea” che asfalta ciò che incontra al suo passaggio. La utilizzo anche sui tratti 
vettoriali per correggere appunto “spuntoni” o bozze nel tratto. 

 

Da poco (mentre scrivo questo paragrafo è Aprile 2020, tempi di coronavirus…) ho fatto una 
scoperta che mi ha un po’ scioccato, dato che è da molto tempo che utilizzo questo strumento.  

Di recente c’è stata la release 1.9.9 di CSP, che come spesso accade si è portata dietro qualche 
bug che è stato risolto nel giro di pochi giorni da Celsys, pubblicando la successiva release 1.9.10. 
Disegnando con la nuova versione e utilizzando l’Hard eraser ho notato che, andando a cancellare 
parte di un tratto vettoriale e successivamente selezionandolo con Object, nella selezione compariva 
qualcosa che, per me, non avrebbe dovuto esserci: la traccia vettoriale della gomma.  

In diversi anni di utilizzo di CSP non mi ero mai accorto di questa cosa, tanto che ho pensato 
subito a un altro bug. Ho controllato su un PC dove ho una versione precedente di CSP e quello che 
ho visto sembrava darmi ragione: nessuna traccia della traccia. Ho scritto subito sul gruppo FB per 
chiedere conferma del bug, anche se ormai ero più che convinto di aver scovato qualcosa. Non solo, 
subito dopo aver scritto su FB ho scritto anche al supporto tecnico di CSP, chiedendo lumi.  

Nel giro di qualche ora su FB mi hanno fatto notare (grazie Federica Di Meo!) che, se Hard eraser 
non ha la spunta Vector eraser attivata allora il suo comportamento è simile a quello di un pennello 
vettoriale con colore trasparente: sembra che cancelli ma in realtà rende solo trasparente la zona 
dove passa, mantenendo la sua identità vettoriale. Se seleziono con l’Object  la traccia della gomma 
e la muovo un po’, allora vedo che muovo anche la “cancellatura”. Con la spunta Vector eraser 
attivata Hard eraser diventa in sostanza una gomma Vector (strumenti differenti costruiti sulla stessa 
struttura…).  

La rivelazione è avvenuta di notte; la mattina dopo, un po’ mesto, ho scritto nuovamente al 
supporto tecnico di CSP, dicendo di non tenere conto della mia richiesta di chiarimenti e scusandomi. 
Ho preso un bell’abbaglio! Qui il mio post fu FB. 

 

Anche le gomme in realtà sono dei pennelli, impostati con Blending mode > Erase nella Tool property. 
Pure la gomma Vector è un pennello con Blending mode > Erase, ma a cui è stata attivata la spunta Vector 
eraser nella Sub Tool Detail palette > Erase. 

Gomma e ruler simmetrico 

Da notare: usando un Symmetrical ruler per disegnare e passando temporaneamente alla gomma per 
alcune correzioni, se questa funziona solo sulla parte del disegno in cui la adopero, non nella sua 

https://www.facebook.com/groups/mangastudioitalia/permalink/2705180039592979/
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controparte simmetrica, è perché bisogna attivare la spunta Enable snapping (ex Able to snap) nelle Tool 
property. 

Importare pennelli da Photoshop 

Dalla versione 1.10.5 si possono importare in CSP i pennelli di Photoshop. Vedi più sotto. 
Non è al momento possibile esportare i pennelli di CSP verso Photoshop. 

Sull’inchiostrazione (note sparse, per ora) 
Ho seguito online un corso di inchiostrazione di Robert Marzullo. Dopo aver finito il livello delle chine, 

Marzullo lo duplica; al duplicato dà un leggero blur (4) e gli abbassa l’opacità. Secondo lui aiuta a rendere il 
segno meno impattante e più naturale. 
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Creare un nuovo Tool Group 
Per creare un nuovo Tool Group, trascinare un SubTool, ad esempio una nuova penna, tra le icone dei 

Tool Group esistenti. 
Creating a Tool Group To create a tool group, drag and drop a [Sub tool] to the empty space next to the tool group icons. A new tool group is 

created. [Cerca sul Manuale Customizing the Sub Tool Palette] 

 

 
Fig.  260 
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Ruotare il foglio - Rotate Canvas  
Per ruotare comodamente il foglio mentre si sta lavorando si può usare la combinazione di tasti Shift + 

Spacebar e muovendo il cursore trascinandolo sullo schermo con la penna oppure ruotando la rotellina del 
mouse.  Per settare il passo dell’angolo di rotazione selezionare il tool "Move" con il subtool "Rotate" e 
impostare a piacimento. 
 

 
Fig.  261 

Zoom del foglio 
Analogamente, con la combinazione di tasti CTRL+Spacebar e muovendo il cursore con la penna sullo 

schermo, si ottiene lo zoom del Canvas.  Se si utilizza il mouse è sufficiente ruotare la rotellina. 

Flip (Riflessione) 

Flip reale di tutto il documento 

Per avere un flip “fisico” del documento Edit > Rotate/Flip Canvas > Flip Horizontal o Flip Vertical. 

Flip della visualizzazione 

Si possono utilizzare i pulsantini       presenti nella Command bar o nel Navigator, ottenendo un 
flip solo di visualizzazione, cioè non la  riflessione reale del documento ma solo di come viene visualizzato. 

 Me ne posso rendere conto osservando il contenuto del Navigator: quando la riflessione è “reale” allora 
anche la visualizzazione del Navigator si riflette. Quando invece la riflessione è solo della visualizzazione, il 
contenuto del Navigator non si riflette.  

È anche quello che si ottiene operando il flip dal menù View > Rotate/Flip > Flip Horizontal o Flip Vertical 
(non a caso si trova sotto il menù View…) 

Flip reale del contenuto di un layer 

Seleziono il layer, poi Edit > Transform > Flip Horizontal… o Flip Vertical…; ho assegnato a queste due 
opzioni le shortcut F e S, che funzionano sia in questo caso che nel successivo.  

Flip di un dettaglio 

Voglio riflettere solo un dettaglio all’interno del contenuto di un layer, ad esempio copio e incollo un 
sopracciglio e voglio che la copia sia la riflessione dell'originale.   

Traccio una selezione attorno al dettaglio da riflettere, poi vado su Edit > Transform > Flip Horizontal… o 
Flip Vertical…. Le shortcut F e S che ho assegnato funzionano anche in questo caso.  
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Se la parte è vettoriale ed è selezionata con l’Object tool, queste trasformazioni non funzionano: bisogna 
fare una selezione con uno strumento del gruppo Marquee. 

 

Un altro modo per ottenere il flip di un dettaglio è, una volta fatta la selezione, andare in Edit > 
Transform > Scale/Rotate; a questo punto nella Tool property palette appaiono una serie di settaggi, tra cui 
le icone del Flip Horizontal e Flip Vertical che servono. Queste icone però sono le stesse del flip “visuale”, 
anche se operano diversamente. 

 

Per il Flip di un layer o di un dettaglio, mi sono creato delle icone, modificando leggermente quelle dei 
Flip normali del programma in modo da non confonderle: 

 

 
Flip Detail Horizontal I nomi sono solo per comodità, poiché CSP visualizzerà questi comandi 

sempre come Flip Horizontal e Flip Vertical  [nella Tool Property palette purtroppo non 

riesco a cambiarle, per cui rimangono quelle di default]. 
 

  

 
Flip Detail Vertical 

Se interessati, le icone si possono scaricare qui; per aggiungerle alla Command bar o alla Quick Access 
Palette seguire questi punti: 
Command Bar 
- tx dx sulla Command bar , quindi Command Bar Settings… > Menu Commands > Edit > Transform > 

Flip Horizontal o Flip Vertical e poi cliccare su Add. A questo punto viene aggiunta l’icona generica

, che va cambiata; 
- tx dx sull’icona, scegliere Icon settings…, cliccare su Specify image file… e scegliere l’icona desiderata 

dal percorso in cui la si è salvata. 
Quick Access Palette 
- click su Quick Access settings (dalle tre lineette in alto a sx o dall’icona che si trova tra i comandi del 

set, nella palette Quick Access) > Menu Commands > Edit > Transform > Flip Horizontal o Flip Vertical 
e poi cliccare su Add oppure trascinare il comando nella Quick Access palette. Se si sono già 
cambiate le icone nella Command Bar, allora le stesse nuove icone appaiono nella Quick Access 
palette. 

 

Ovviamente queste procedure valgono per la personalizzazione anche di altre icone. Per altre 
informazioni sulla modifica delle icone vedi più sopra.  

 

____ 
 

Attenzione: nel caso di un pennello che disegna oggetti (vedi Creare un pennello con materiali diversi) 
utilizzare un livello raster o rasterizzare il livello vettoriale, altrimenti l’applicazione del Flip dà risultati 
strani: se si utilizza un livello vettoriale, in effetti quello che viene riflesso è il tracciato vettoriale, su cui il 
programma appone le immagini degli oggetti. A seconda del Flip applicato, il tracciato cambia 
orientamento e gli oggetti che vengono applicati possono risultare ribaltati in maniera non intuitiva. 

Flip di un’immagine importata 

Se importo un’immagine e devo rifletterla, allora devo prima “rasterizzarla”, selezionando il livello in cui 
si trova, poi tasto dx > Rasterize. Poi vado su su Edit >Transform > Flip Horizontal… o Flip Vertical… [se 
l’immagine è rasterizzata, le shortcut che ho impostato, F e S, funzionano anche in questo caso]. 

Ridurre le dimensioni 
Per ridurre le dimensioni del file: creare un nuovo documento, copiare i layers dalla layer palette primo 

(CTRL + C) e incollarli nella layer palette del nuovo (CTRL + V). Si ottiene una notevole riduzione del peso del 
file (es. con un mio file: 350.400 kb  85.200 kb). 

  

https://www.paolelli.com/Risorse/CSP/Icone/FlipDetailIcons.rar
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Unità di misura 

 dpi e mm 

Dpi significa dots per inch, ovvero punti per pollice, ed è una unità di misura utilizzata in stampa che si 
riferisce al numero di punti che una stampante rilascia in una lunghezza di 1 pollice, cioè circa 2,54 cm. 

Nelle imagini digitali teoricamente si dovrebbero usare i ppi, points per inch, poiché fanno riferimento al 
numero di pixel allineati in un pollice di un’immagine, ma nell’uso comune i ppi vengono assimilati ai dpi, 
anche se non sono la stessa cosa. Anche CSP utilizza questa semplificazione.  

Vedi anche l’articolo Differenza tra DPI e PPI. 
 

Spesso mi ritrovo a dover capire a quanti pixel deve corrispondere, a una data risoluzione, una misura 
che ho in cm o mm, oppure a quanti mm o cm corrisponde un dato numero di dpi, sempre a una certa 
risoluzione. Ecco un paio di esempi. 

 

- A 600 dpi quanto deve misurare in pixel lo spazio tra le varie vignette, considerando che utilizzo 
5mm tra le righe e 4 mm tra le colonne? 
 

600 dpi = 600 punti per pollice = 600 punti ogni 2,54 cm = 600 punti ogni 25,4 mm.  
Quindi, in ogni mm ho 600/25,4 = 24 punti circa, arrotondando. 
Per 5 mm ho 24x5= 120 punti (px); sarebbero 118 se non arrotondassi; 
Per 4 mm ho 24x4= 96 punti (px); sarebbero 94 se non arrotondassi. 
 

 La formuletta, in pratica, è:  
misura cercata (in pixel)  =  risoluzione  x spazio (in mm)  =  risoluzione  x spazio (in cm) 

25,4                                                   2,54 
 

- Ho un'immagine di dimensioni 946x1409 px a 300 dpi. Quanto grande è in centimetri? 
 

A 300 dpi in un pollice ( 2,54 cm) ci sono 300 punti; quindi: 
per la larghezza: 

946 pixel sono 946/300 = 3,153 pollici, ovvero 3,153 x 2.54 = 8 cm (arrotondando); 
per l'altezza: 

1409/300 = 4,7 pollici, quindi 4,7 x 2,54 = 12 cm (arrotondando). 
 

 Qui la formuletta è:  
misura cercata (in cm) = dimensione  immagine (in pixel) x 2,54 

risoluzione 
 

Ho creato un piccolo foglio di calcolo per fare questi semplici trasformazioni, si può scaricare qui. 

Divagazioni sul tema 

Una domanda interessante è stata posta nel gruppo Fb CSP Italia (questo post): è possibile 
sapere quanto misura, in cm, un carattere con un dato valore di grandezza?  

I caratteri si misurano in punti (pt); il punto tipografico ha un valore ben definito: 1 pt = 
0,0352778 cm = 0,352778 mm (ed è pari a 1/72 di pollice, cioè 2,54 cm / 72). Grossomodo 1/3 di 
mm, quindi (e da cui 1 cm = 28,3465 pt). Una successiva richiesta nello stesso post era se si debba 
convertire in pixel questa quantità. Curiosità: la risoluzione per le immagini più diffusa nel Web è 72 dpi, per cui 
ogni pixel è grande esattamente quanto 1 pt; sarei curioso di sapere se si tratta di una coincidenza o se c'è una qualche 
relazione. 

 

Nei programmi di grafica, in genere, si lavora molto con i pixel, ma chiedersi quanto grande è, 
in pixel, un carattere con una data dimensione in punti ha però poco senso se non so (di nuovo!) 
la risoluzione del documento su cui sto lavorando. Posso cioè effettivamente ricavare la 
corrispondenza tra le dimensioni in pt del carattere (il corpo) e i cm, ma una volta dentro al file 
questa corrispondenza perde di significato se non tengo conto della risoluzione del file stesso. 

 

Il pixel, infatti, è un'entità "variabile", nel senso che le sue dimensioni effettive dipendono dalla 
risoluzione che sto utilizzando: un ipotetico righello in plastica di 10 pixel potrebbe essere lungo 

https://www.retorica.net/2018/01/31/differenza-tra-dpi-e-ppi/
https://www.paolelli.com/Risorse/Varie/Dimensioni_Risoluzione.xlsx
https://www.facebook.com/groups/mangastudioitalia/permalink/4104144993029803
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un millimetro oppure quattro centimetri (dico numeri a caso), perché il pixel come unità di misura 
è significativo solo se inserito in un contesto di risoluzione, cioè se questa viene specificata.  

Dire cioè “questa linea è lunga 523 px” ha senso solo in relazione alle dimensioni in px 
dell’intera immagine, ma non dice nulla delle sue effettive dimensioni in cm o in mm. Non 
conoscendo la risoluzione dell’immagine può voler dire che la linea è piuttosto lunga oppure 
brevissima. Ad esempio, 10 pixel a 300 dpi hanno un senso: di questi dieci pixel posso sapere qual 
è la misura (nello specifico 10 px a 300 dpi sono 0,085 cm, o 0,85 mm). 

Ecco che una linea lunga 523 px a 300 dpi è lunga 4,4 cm; la stessa linea di 523 px a 100 dpi è 
lunga invece 13,3 cm, una discreta differenza. Nel primo caso i px sono lunghi ~ 0,084 mm, nel 
secondo ~ 0,25 mm, tre volte più grandi (notare: lo stesso rapporto tra le risoluzioni…) 

Così, potrebbe assumere significato un righello in pixel a 300 dpi, ad esempio. 
 

Per esemplificare, provo a immaginare che invece del sistema imperiale si utilizzi, per la 
risoluzione, il sistema metrico: concettualmente non cambia nulla, ma è più facile fare i calcoli. 

Una possibile risoluzione potrebbe essere, ad esempio, 100 punti per centimetro, li chiamo dpc 
(dot per centimeter). Quale sarebbe la dimensione di un pixel? Semplice: 1/100 di cm (o 1/10 di 
mm), dato che in un centimetro ci starebbero 100 px. Ma a una risoluzione di 300 dpc, un pixel 
sarebbe 1/300 di cm (o 1/30 di mm), tre volte più piccolo. Trasferendomi nel sistema imperiale la 
cosa è analoga, solo che la mia unità base è il pollice (circa 2,54 cm). 

Le dimensioni “fisiche” dei pixel dipendono dalla risoluzione a cui stiamo operando, non c'è 
una corrispondenza diretta tra cm e pixel. 

 

Rispondendo alla domanda iniziale: è possibile sapere quanto misura in cm un carattere con un 
dato valore di grandezza (in pt)? 

La conversione da pt a cm è veloce, visto che c'è una corrispondenza diretta tra pt e cm, 1 
pt = 0,0352778 cm (0,352778 mm). 

Un testo a corpo 12 misurerà 12 x 0,0352778 = 0,4233335 cm.  
 

Se si vuol vedere a quanto corrisponde in px in un documento, deve entrare in gioco la 
risoluzione; per cui: 

misura in px = 12 pt = 0,4233335 cm = 0,4233335 x risoluzione / 2,54;  
a 300 dpi sarà: 
misura in px = 12 pt = 0,4233335 cm = 0,4233335 x 300 / 2,54 = circa 50 px 

 

Andando a fare la prova del nove su CSP, tutto questo discorso sembrava doversi dissolvere.  
Ho scritto una "T" in Arial a corpo 12 in un documento a 300 dpi e sono andato a misurare col 

righello laterale l'altezza effettiva in px. Risultato: un po' meno di 40 px. Cavoli, credevo di aver 
fatto un bel ragionamento...  

Poi però mi son ricordato che in Edit > Change Canvas Size... è possibile modificare l'unità di 
misura dei righelli, e l'ho cambiata in... pt! È risultato che il mio carattere in corpo 12 pt è in realtà 
poco più di 9,5 pt: ancora qualcosa non torna. Evidentemente nel computo totale del corpo di un 
carattere vengono compresi anche degli spazi, che ne riducono l'effettiva grandezza: si dice 12 pt, 
ma in realtà sono un po' meno.  

L’avevo immaginato, ma ho voluto andare a controllare: effettivamente è così. La dimensione 
del corpo non è la dimensione della lettera ma include anche dello spazio riservato agli accenti, 
alle parti ascendenti o discendenti di alcune lettere e così via (se non fosse così, maiuscole e 
minuscole, oppure lettere come la "a", la "g" e la "f", ad es., avrebbero tutte la stessa altezza), e 
corrisponde alla dimensione del blocchetto di metallo su cui, un tempo, veniva fusa la lettera in 
rilievo.  
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Fig.  262 – Il corpo e le altre misure di un carattere – dal blog Giò Fuga Type 

Sul corpo del carattere non mi dilungo oltre, se si vuol approfondire leggere qui. 
Ho voluto fare un'ultima verifica: ho tracciato due linee orizzontali distanti tra loro 12 pt, ho 

ricambiato l'unità di misura, portandola a px, e ho constatato che effettivamente le due righe 
distano tra loro 50 px:  yesss! Quindi è possibile sapere quanto grande è un carattere, in cm o in 
px, tenendo presente però che la misura è riferita all’ingombro totale, spazi “di servizio” inclusi, 
non al solo segno. 

 

 
Fig.  263 – A sx misura in pt, a dx misura in px 

Righelli 

In CSP l’unità di misura (Unit), che verrà visualizzata sui righelli, viene decisa al momento della creazione 
del file, selezionandola nella parte alta della finestra di dialogo: 

 

 
Fig.  264 

Per cambiarla in corso d’opera, quando il file è già stato creato, bisogna andare su Edit > Change Canvas 
Size… e selezionare l’unità desiderata. Volendo, anche questo comando è trasportabile sulla Command bar. 

Zero pagina 

È possibile muovere lo zero dei righelli con lo strumento Move Layer > Move Grid.  
 

https://blog.giofugatype.com/?p=346
https://blog.giofugatype.com/?p=346
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Fig.  265 

Posizionarsi nei pressi nel punto in cui si vuol stabilire lo zero; andare su View e metter la spunta a Grid; 
utilizzare lo strumento Move layer > Move grid per muovere la griglia sul Canvas e far combaciare l'origine 
(0, 0) con il punto desiderato. Più si ingrandisce la vista, più preciso è il posizionamento. Non sempre è 
possibile far combaciare l’origine esattamente con il punto voluto. 

 

 
Fig.  266 

Prima di scoprire il Move grid pensavo che l'unico modo per muovere lo zero-griglia fosse un altro, più 
complesso: 
- ingrandire il foglio al massimo in corrispondenza del punto in cui si vuole fissare l'origine; selezionare 

uno strumento che abbia la visualizzazione a croce o a puntino (si può cambiare la visualizzazione in 
File > Preferences > Cursor); portare il cursore sul punto e prendere nota dei valori di X e Y nella 
finestra Information (se non è visibile, abilitarla sotto Window); 

- andare su View > Grid Settings..., selezionare Custom e inserire i valori  annotati in W e H, poi dare l'ok.  
Adesso l'origine è fissata sul nuovo punto. Per chi si vuole male. 

Trovare il centro esatto del foglio 

Con un brush circolare fare un punto ovunque sul Canvas. Poi tagliare il livello (CTRL + X), fare un Reset 
Display (CTRL + ò) e poi andare in Edit > Paste to shown position (CTRL + Shift + V): così si incolla il punto 
esattamente al centro orizzontale e verticale del Canvas. 

Se non si fa il Reset Display, il punto viene incollato al centro della Canvas window (che è la finestra del 
programma che contiene il Canvas), ovvero al centro della vista che si ha in quel momento. 

Centrare un’immagine nel Canvas 

Analogamente, si può posizionare un’immagine (o un tratto, o una parte di disegno) facendo un Reset 
Display e incollandola con CTRL + Shift + V per centrarla nel Canvas, o senza fare il Reset Display per 
centrarla nella Canvas window. 
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Forme e dimensioni 

Può essere necessario disegnare una forma che abbia delle dimensioni precise; pur non essendo il 
programma più adatto per lavori di fino (almeno per ora), si possono inserire delle misure abbastanza 
accurate anche con CSP, cosa che ho scoperto grazie alla risposta di Massimiliano Bergamo in questo post. 

Disegnando con lo strumento Figure > Direct draw, in molti dei Sub tool appare nella Tool property la 
casellina Aspect type (se non c’è, attivarla da Sub Tool  Detail > Figure; attenzione: come già detto, non è 
disponibile per tutte le forme). 

 

 
Fig.  267 

Con questa casellina si attiva la possibilità di disegnare la forma o con uno specifico rapporto tra i lati del 
poligono di inviluppo (Specified ratio) o con l’effettiva misura in pixel di tali lati (Specify length). 
  

https://www.facebook.com/groups/mangastudioitalia/permalink/3779652245479081/?comment_id=3780505108727128&reply_comment_id=3782182018559437
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Direct draw 
Figure > Direct draw mette a disposizione una serie di strumenti “di precisione”, per così dire, che 

consentono cioè di disegnare dei tratti aventi un’accuratezza geometrica che non si può ottenere (o è 
molto difficile ottenere) a mano libera. 

Gli strumenti di questo subtool funzionano perlopiù in maniera intuitiva, perciò per il momento mi 
soffermo su quelli che mi creano qualche problemino, forse perché sono proprio i meno ovvii: le curve di 
Bézier (qui informazioni sulle curve di Bézier). Integrate come modificatori del tipo di curva in altri 
strumenti di Direct draw, ad aprile 2020 sono state “promosse” anche a strumento a sé stante, tuttavia il 
funzionamento è sempre quello. 

Disegnare con lo strumento Bézier curve 

Ogni volta che uso lo strumento di Bézier divento idrofobo: non ricordo mai quando va staccata la penna 
(o rilasciato il mouse) e ottengo curve chiuse o non riesco a controllare le maniglie.  Quanto segue illustra 
come disegnare le curve di Bézier con lo strumento Direct draw; con i ruler è simile ma leggermente 
diverso, vedi più sopra. 

 

Per disegnare la curva con Quadratic Bézier: 
 

 
Fig.  268 

 segno il primo punto, dove inizia la curva, toccando la 
tavoletta con la penna (o premo il tasto sx del mouse, senza 
rilasciarlo); 

 
Fig.  269 

 
senza staccare la penna dalla tavoletta (o senza rilasciare il 

tasto sx del mouse), trascino fino al secondo punto, che sarà il 
punto finale della curva; 

 
Fig.  270 

 stacco la penna dalla tavoletta (o rilascio il tasto sx del 
mouse) e mi sposto fino al punto dove voglio la maniglia: per 
fissare il punto tocco la tavoletta con la penna (o faccio click col 
tasto sx); 

 
Per disegnare la curva con  Cubic Bézier: 

 
Fig.  271 

 segno il primo punto, dove inizia la curva, toccando la 
tavoletta con la penna (o premo il tasto sx del mouse, senza 
rilasciarlo); 

 
Fig.  272 

 

senza staccare la penna dalla tavoletta (o senza rilasciare 
il tasto sx del mouse), trascino fino al secondo punto, che 
sarà il punto finale della curva; 

 
Fig.  273 

 
stacco la penna dalla tavoletta (o rilascio il tasto sx del 

mouse) e mi sposto fino al punto dove voglio la prima 
maniglia (per evitare strane contorsioni del tratto, metterla 
dalla stessa parte del primo punto): per fissare la maniglia 
tocco la tavoletta con la penna (o faccio click col tasto sx); 

https://www.google.com/search?rlz=1C1CHBF_itIT909IT909&sxsrf=ALeKk02aw_FqfeQ6eMY2APM85yooNHlFmw%3A1612261853408&ei=3SkZYOq_GO6bjLsPqJW70Ak&q=curva+di+b%C3%A9zier&oq=curva+di+b%C3%A9zier&gs_lcp=CgZwc3ktYWIQAzICCAA6BwgAELADEA06CQgAELADEA0QHjoLCAAQsAMQDRAFEB4
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Fig.  274 

 

sposto la penna, staccata dalla tavoletta, fino al al punto 
dove voglio la seconda maniglia (o sposto il mouse, senza 
tener premuto il tasto sx), e qui tocco la tavoletta con la 
penna (o faccio click col tasto sx del mouse). 

 Se disegno in un layer vettoriale, successivamente posso modificare i vari punti toccando la linea con lo 
strumento Operation > Object . 
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Velocizzare i comandi  Shortcut e Modifier Key 
CSP è altamente personalizzabile: si possono impostare tasti e combinazioni di tasti (Shortcut e Modifier 

Key) per effettuare determinate operazioni o passare da uno strumento all'altro, anche temporaneamente. 
Se le Shortcut sono più note, vale la pena imparare a impostare anche le Modifier Key.  

 

Ad esempio, supponiamo che a un certo punto diventi importante poter passare dalla penna alla 
gomma in velocità, solo per correzioni puntuali e velocissime, e il dover cambiare strumento cliccando le 
varie iconcine per poi tornare alla penna sia diventato scomodo.  

 

Ci sono anche delle Shortcut già impostate, tipo E per la gomma e P per la penna (che funzionano anche 
con la tastiera italiana). Il problema è che mentre disegno non guardo la tastiera, uso alcune combinazioni 
di tasti comode perché tutte nell'angolo in basso a sinistra, a portata della mia mano corrispondente 
(Space+Shift, Space+CTRL ecc.). Premere E ma ancor più P significa dover distogliere gli occhi dal lavoro per 
cercare le lettere (tra l'altro la mia tastiera scivola sotto il piano della scrivania, per cui estrai tastiera > 
cerca lettere > lavora > cerca lettere > spingi tastiera...).  

 

Con il Modifier Key Settings (sotto il menu File, o premendo CTRL+Shift+Alt+Y), si possono impostare 
delle scorciatoie, anche temporanee, cioè che attivano un dato strumento solo per il tempo per cui 
vengono premuti, per i tasti CTRL, Alt, Shift e Space, il mouse, la penna e le Gesture,  o loro combinazioni.  

 

Tale modifica può essere impostata per un singolo strumento (es. la penna) se metto il pallino a Tool-
specific settings (ex Settings for each process of tool,vedi immagine più sotto), oppure per tutti gli strumenti 
se imposto General settings (ex Common settings, vedi immagine più sotto). Imposto la combinazione di 
tasti CTRL+Shift+Alt per il passaggio temporaneo alla gomma: mentre sto disegnando, se devo correggere, 
premendo CTRL+Shift+Alt si attiva la gomma; quando rilascio torna la penna. Senza guardare. Potrei anche 
semplicemente girare lo stilo della tavoletta, ma… 

 

 
Fig.  275 
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Come detto, con la shortcut  E si passa alla gomma in generale (Eraser), ma è possibile impostare un 
determinato tipo di gomma (es. Vector).  

 

Se si assegna la stessa shortcut a più strumenti allora, premendo più volte sullo stesso tasto, i vari 
strumenti si alternano; nel mio caso, ho impostato il tasto E a più Sub Tool dello strumento gomma. 

 

Attenzione: impostando solo Shift+Alt si va a generare un piccolo conflitto con Windows. Se sono 
impostate più lingue nel sistema operativo, ad esempio italiano e inglese, premendo tale combinazione di 
tasti si alternano anche le lingue scelte (conseguenze: la tastiera viene mappata diversamente ). Per ovviare 
a questo bisogna cambiare combinazione di tasti o disattivare le altre lingue di Windows.  

 

In APPENDICE 005 - Scorciatoie da tastiera ho inserito delle tabelle con le shortcut più utilizzate e uno 
schema della tastiera italiana con le corrispondenti scorciatoie. 

Problemi 

Un’impostazione a me molto comoda è l’attribuzione della gomma al secondo tasto laterale della penna 
della tavoletta grafica.   

Non pensando troppo alla cosa, nelle impostazioni della penna nel programmino di controllo della 
tavoletta (Wacom Desktop Center, WDC), ho impostato il secondo tasto laterale, STL, su “Tavoletta > 
Cancella” 

 

 
Fig.  276 

 e, nelle impostazioni di CSP,  Modifier Key Settings…  > Common settings > Pen/Gesture > Tail switch > 
Eraser. 

 

 
Fig.  277 – Lo stilo Wacom Pro Pen 2; immagine presa da Amazon.it, modificata 

Con gli strumenti del gruppo Direct draw però queste impostazioni non funzionano: se cerco di 
cancellare premendo il STL mentre è attivo, ad es., Straight line o Ellipse, la penna continua a disegnare la 
linea o l’ellisse. 

Posto che non ho ben capito perché per alcuni strumenti le impostazioni nel WDC funziona e per altri no 
(forse qualche conflitto? boh…), un primo problema è che il secondo tasto laterale NON è il Tail swich (= 
pulsante di coda), ma è appunto il secondo Side switch (= pulsante laterale). Quindi, modificare le 
impostazioni di Tail switch non comporta alcun effetto nel premere il STL. Che la gomma funzioni con gli 
altri strumenti è dovuto al fatto che è impostato Cancella per il STL nel WDC.  
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Il secondo problema è che, con queste impostazioni, anche utilizzando la Tail switch non cambia nulla: 
se voglio cancellare una Straight line o un’Ellipse con la gomma posteriore, girando semplicemente la penna 
durante l’utilizzo di questi strumenti, continuo a disegnare una linea o un’ellisse. 

La prima modifica che ho effettuato per risolvere il problema è stata modificare l’impostazione del STL 
sul WDC: da “Tavoletta > Cancella” sono passato a “Tastiera > Tasto > e”. “E” è infatti la shortcut di CSP 
che fa attivare la gomma (Eraser): attribuendola al tasto, ogni volta che lo premo trasmetto a CSP l’ordine 
di passare a “e” e, di conseguenza, di passare alla gomma. Essendo l’effetto della pressione del tasto per 
sua natura transitorio, rilasciandolo si dovrebbe tornare allo strumento selezionato in precedenza. Si 
dovrebbe, ma non sempre succede; per evitare di rimanere sulla gomma fare attenzione a tenere premuto 
il tastino e non fare un semplice click: ho notato che con il solo click lo strumento passa a gomma e lì 
rimane. Bisogna prendere un po’ di mano. 

 

 
Fig.  278 

La seconda modifica è analoga alla prima, ma fatta per il Tail switch. Nel WDC, invece di selezionare 
“Penna” seleziono “Gomma”, e applico la stessa modifica. In questo modo qualsiasi strumento abbia 
attivato, girando la penna e usando il Tail switch utilizzerò la gomma. 

 
 

 
Fig.  279 



Appunti di Manga Studio/ClipStudioPaint   

165 

  



Appunti di Manga Studio/ClipStudioPaint   

166 

Colore del layer di riferimento 
Il colore blu del layer di riferimento è 142 197 140. 
Il colore azzurro che si dà ad esempio alle matite per tenerle sotto è 62 140 236. 

Rifilare l’area di lavoro - Crop 
Per rifiiare l’area di lavoro, fare una selezione (che sarà anche l’area che rimarrà dopo il ritaglio) e 

andare in Edit > Crop. 
Il programma suggerisce la shortcut Z, ma di default, con la tastiera italiana, non sembra funzionare  

Quindi l’ho impostato come shortcut personalizzata, sempre sul tasto Z (quanto scritto nelle precedenti 
versioni degli appunti riguardo a questa funzione sembra non essere vero: avevo scritto che Z, con la tastiera italiana, 
imposta il colore principale Nero e il colore secondario Bianco, ma non è così, neanche in versioni datate e neanche 

con Photoshop. Non so perché l’ho scritto, mah...). 
Se si sceglie di usare una selezione non rettangolare (es. un cerchio o di forma irregolare), l’area di 

lavoro è ritagliata sempre a forma rettangolare, con i lati tangenti alle massime estensioni della forma 
utilizzata. Il contenuto non è ritagliato in corrispondenza dei bordi della selezione scelta, ma rimane  tutto 
quello che c’è nel rettangolo di inviluppo. 

Alternativamente, dopo aver fatto la selezione, cliccare sull’icona Crop nel Selection Launcher (la 
seconda da sinistra). 

Penna configurazione iniziale 
Tasto in alto: doppio clic. 
Tasto in basso: Tasto dx. 
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Selezioni (Marquee) 

Selezionare insieme oggetti di tipo diverso 

Voglio selezionare nello stesso momento oggetti appartenenti a layer di tipo diverso, o dello stesso tipo 
ma su layer diversi. 

È  possibile farlo solo con lo strumento selezione (Marquee), non con l’Object tool. 
 

Metto i diversi layer (raster e vettoriali) con gli oggetti da selezionare all'interno di una cartella e poi, 
tenendo selezionata la cartella, vado a fare la selezione che mi interessa con il Marquee tool (quindi un 
rettangolo, un cerchio, o a mano libera ecc.). 

 

Non è molto pratico, perché mettendo nella stessa cartella i layer, porto nella stessa posizione (quella 
della cartella) layer che per costruzione del mio disegno devono stare in posizioni differenti nella Layer 
palette, anche separati da numerosi altri layer. 

 

Per mantenere la separazione dei layer è possibile selezionare i layer interessati nella Layer palette 
prima di usare il Marquee e poi effettuare la selezione degli oggetti con il Marquee. 

Mettere un contorno a una selezione 

Traccio una selezione, in questo caso rettangolare, che racchiuda la parte di disegno che mi interessa, 
poi vado su Edit > Outline Selection. Si apre una finestra (Fig.  280) che chiede se voglio che la linea che 
verrà creata sia dalla parte esterna della selezione (Fig.  281, a), a cavallo della linea di selezione (Fig.  281, 
b) o dalla parte interna (Fig.  281, d). Si può impostare lo spessore della linea e il tipo di comportamento 
della linea agli angoli (angoli vivi o arrotondati; attivo solo su layer raster); infine viene richiesta una spunta 
se si vuole che, nel caso la selezione termini proprio sul bordo del Canvas, la linea venga disegnata su tale 
bordo o meno (Fig.  281, c).  

L’ultima opzione, Anti-aliasing (l’entità della “sfumatura” della linea) è attiva solo se il layer su cui si sta 
lavorando è vettoriale. 

 

 
Fig.  280 

 

 
Fig.  281 

Reselect 

L’ultima selezione utilizzata rimane nella memoria del programma. Se faccio una selezione e poi 
deseleziono, successivamente posso richiamarla andando su Select > Reselect oppure premendo i tasti CTRL 
+ Shift + D. 

Salvare una selezione 

E’ possibile salvare una selezione, come si fa ad esempio con Photoshop? 
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Nella sostanza sì. È possibile convertire una selezione in un layer, con il comando Selection > Convert to 
Selection Layer . La selezione si trasforma nel contenuto, verde, di un layer con trasparenza al 50%. In 
seguito, per richiamare la selezione dal Selection Layer è sufficiente cliccare col tasto dx sul layer, scegliere 
“Selection from Layer” e cliccare su una delle opzioni che vengono visualizzate. Trovando questa cosa utile, 
mi sono creato due shortcut nella Command bar. Vedi anche più sopra. 

Creare una selezione dal contenuto di un layer 

Analogamente, la procedura di trasformazione del contenuto di un layer è valida con qualsiasi layer: si 
clicca sul layer col tasto dx, si sceglie “Selection from Layer” e si clicca su una delle opzioni che vengono 
visualizzate. 

Selection Launcher 

Il Selection Launcher (SL) è una barra simile alla Command bar che appare sotto a una selezione appena 
questa è stata creata. Anche il SL si può personalizzare, aggiungendo comandi che di default non sono 
presenti. Di seguito, la configurazione del mio SL, lievemente differente da quello di default perché ho 
aggiunto dei comandi (Mesh Transformation, Free Transform e Gradient): 

 

 
1            2            3           4            5            6            7            8            9          10          11          12          13         14          15              16 

Fig.  282 – Il Selection Laucher 

L’ultima icona sulla destra (16) è quella che apre la finestra di configurazione “Selection Launcher 
Settings”, in cui è possibile apportare le modifiche. 

 

Le altre icone, da sinistra, sono: 
 

1 Deselect Deseleziona > toglie la selezione. 
2 Crop Ritaglia (o meglio, rifila) > elimina tutto quello che c’è al di fuori della 

selezione; agisce su tutti i livelli e sull’area di lavoro stessa (vedi più sopra). 
3 Invert selected area Inverte la selezione > quello che c’è all’interno viene deselezionato e viene 

selezionato tutto il resto. 
4 Expand selected area Espande la selezione. 
5 Shrink selected area Restringe la selezione. 
6 Delete Cancella ciò che c’è all’interno della selezione (nel layer selezionato). 
7 Delete outside selection Cancella ciò che c’è all’esterno della selezione (nel layer selezionato). 
8 Cut and paste Taglia e incolla > taglia ciò che c’è all’interno della selezione nel layer 

selezionato, crea un altro layer e incolla all’interno ciò che ha cancellato. 
9 Copy and paste Copia e incolla  > copia ciò che c’è all’interno della selezione nel layer 

selezionato, crea un altro layer e incolla all’interno ciò che ha copiato. 
10 Mesh Transformation Crea un reticolo con delle maniglie nella selezione, muovendo le quali è 

possibile distorcere il contenuto della selezione stessa. Il numero delle 
maniglie puo essere modificato nella Tool property quando appare il 
reticolo. 

 11 Free Transform Crea un inviluppo esterno con delle maniglie che permettono  di distorcere 
il contenuto della selezione. Sembrerebbe analogo ma più limitato della 
Mesh Transformation, in realtà serve a fare cose diverse. 

12 Scale/Rotate Ingrandisce/Rimpicciolisce/Ruota il contenuto della selezione nel layer 
selezionato. 

13 Fill Riempie con il colore selezionato, nel layer selezionato. 
14 New Tone Riempie con un retino. Crea un nuovo layer. Se si aggiunge un ulteriore 

retino con le stesse proprietà, utilizza lo stesso layer, diversamente ne crea 
un altro. 

15 Gradient Riempie con l’effetto gradiente. Quando si selezione questa icona si attiva 
lo strumento Gradient, e appaiono i vari SubTool. 

 

Per spostare le icone del SL si può operare dalle sue impostazioni (icona Selection Launcher Settings) o 
tenere premuto CTRL e trascinare le icone nella posizione desiderata. 
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Sebbene sia utile, il SL a mio avviso ha il problema di essere di intralcio. Non appena si crea la selezione 
appare al di sotto della stessa, ma se sto effettuando una selezione multipla, con la bacchetta magica ad 
esempio, l’apparizione del SL ostacola le ulteriori selezioni, perché è sempre a ridosso della selezione più in 
basso nel Canvas. Fino a quando non verrà risolto questo piccolo problema da parte dei programmatori (è 
stato fatto presente, tra altre cose, con una lettera al supporto Celsys a nome della pagina FB Clip Studio 
Paint Italia) si può ovviare, se lo si ricorda, iniziando a selezionare dall’elemento che sta più in basso nel 
Canvas.  

 

Perché il SL non sia d’intralcio si può disegnare un dettaglio, che poi verrà rimosso, più sotto dell’ultimo dettaglio che invece 
serve, cosicché il SL appaia più in basso e sia meno invasivo. Ovvio che questa soluzione non è sempre applicabile. 

Un modo più scaltro per aggirare la questione è disattivare la visualizzazione del SL con View > Selection Launcher  togliendo la 
spunta (mi pare che qualcuno l’abbia suggerito sul gruppo FB, ma non riesco a trovare il post). Ho attribuito a questo comando la 
shortcut Shift + V.  

Select Ovelapping Vectors e Select Vectors Within Area 

Quando si utilizzano livelli vettoriali, si possono utilizzare due strumenti, abbinati alle selezioni, che si 
trovano nel menu Select: Select Overlapping Vectors e Select Vectors Within Area. 

Faccio una selezione che copra, in parte o totalmente, dei tratti vettoriali in un livello. Dopo aver fatto la 
selezione vado in Select > Select Overlapping Vectors : vengono evidenziati i tracciati vettoriali toccati dalla 
selezione come se fossero stati toccati con lo strumento  Operation > Object.  Più precisamente, lo 
strumento passa proprio a Object. 

Se invece, dopo aver fatto la selezione, utilizzo Select > Select Vectors Within Area, allora ottengo lo 
stesso tipo di risultato, ma solo per quei tracciati che sono completamente coperti dalla selezione: se anche 
una minima parte è al di fuori, quel tratto non viene selezionato. 

Volendo, si possono estrarre le icone relative a questi due comandi per posizionarle nella Command Bar 

o nel Quick Access; entrambe hanno questo aspetto:  (se si voglio estrarre entrambe, si possono 
differenziare cambiandone, ad esempio, il colore di sfondo). 

Selezionare un determinato colore – Select Color Gamut 

Se voglio creare una selezione con tutte le aree di un determinato colore nel mio documento utilizzo 
Select > Select Color Gamut… 

Si passa così automaticamente a uno strumento contagocce con cui selezionare il colore, i cui parametri 
possono essere modificati con la finestrella che appare:  

 

 
Fig.  283  

 con Error margin of color si imposta la tolleranza (per selezionare anche colori che differiscono 
da quello su cui si punta il contagocce); 

 con Selection type la selezione può essere unica (se si toccano punti diversi ogni volta si crea una 
selezione differente, sulla base del colore toccato), additiva (si aggiunge nuova superficie a ogni 
tocco) o sottrattiva (la superficie viene rimossa da una eventuale selezione già presente);  

 se si spunta Refer multiple si può scegliere a quale livello far riferimento; di default, se non è 
spuntata, il livello di riferimento è quello selezionato; 

 con Reset si annulla la selezione e si ricomincia. 
Una volta ottenuta la selezione voluta, dare l’OK: la finestrella scompare e appare il Seelction Launcher. 
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Selezionare il contenuto di più livelli 

In un vecchio post che ho trovato per caso cercando altro (eh, la serendipità…) si chiedeva, appunto, se 
fosse possibile selezionare contemporaneamente il contenuto di più livelli, evitando di andare a toccare 
con la bacchetta magica i vari dettagli, uno alla volta. 

L’unico modo che son riuscito a trovare è mettere i livelli interessati in una cartella, poi cliccare 
sull’icona della cartella tenedo premuto il tasto CTRL. Non sempre è possibile, purtroppo, fare così, perché 
magari i livelli son già in altre cartelle. 

 
  

https://www.facebook.com/groups/mangastudioitalia/permalink/1118703238240675
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Maschere Veloci:  
- da post su FB: 

 

Francesca Delfino 
Ciao a tutti, qualcuno potrebbe spiegarmi in maniera basilare cosa sono e a cosa servono 

le maschere (MS5EX)? Ho spulciato un po' il manuale ma non capisco in che modo possono 
essere utili/comode per velocizzare il lavoro! 

Grazie come sempre!! 
Patrizia Mandanici  

Qui ci vuole Luigi Coppola! 
Luigi Coppola 

Eh, lo so, ma ora mi risulta complicato fare un video esplicativo. Tuttavia la maschera veloce è 
molto pratica e trova intuitivi utilizzi maggiormente con la cintiq, dato che usare la penna a 
schermo è più semplice. Immagina di dover creare selezioni complesse, con la maschera veloce 
la disegni, usi i pentools, il secchiello, i righelli. Una volta finita ci clicchi su (sul selettore 
maschera veloce) e diventa selezione. A questo punto può essere riempita con pattern, retini o 
colore, come si vuole. Nella barra in alto si deve personalizzare per aggiungere il tasto maschera 
veloce. Un esempio del suo utilizzo per creare le varie zone retinate. 
 

 
Fig.  284 

 

Francesca Delfino  
ok grazie mille, domani provo a usarla e ti dico!! 

Utilizzo la Maschera veloce - Quick mask 

- per prima cosa vado su File > Command Bar Settings e aggiungo alla barra di comando il pulsante Quick 
Mask (si trova in Main Menu > Selection); 

- clicco sul pulsante per aggiungere un Layer Quick Mask. Posso quindi disegnare sul layer con i vari 
strumenti (pennelli, selezioni, secchiello, ecc.); 

- alla fine riclicco sul pulsante Quick Mask, e la maschera si trasforma in selezione. In questa selezione 
posso trascinare ad esempio i retini e comunque posso utilizzarla come una selezione normale. 

https://www.facebook.com/francesca.delfino?fref=nf
https://www.facebook.com/francesca.delfino?fref=nf
https://www.facebook.com/patrizia.mandanici?fref=ufi
https://www.facebook.com/luigi.copp?hc_location=ufi
https://www.facebook.com/luigi.copp?fref=ufi
https://www.facebook.com/photo.php?fbid=1271943679516373&set=p.1271943679516373&type=3
https://www.facebook.com/photo.php?fbid=1271943679516373&set=p.1271943679516373&type=3
https://www.facebook.com/photo.php?fbid=1271943679516373&set=p.1271943679516373&type=3
https://www.facebook.com/photo.php?fbid=1271943679516373&set=p.1271943679516373&type=3
https://www.facebook.com/francesca.delfino?fref=ufi
https://www.facebook.com/photo.php?fbid=1271943679516373&set=p.1271943679516373&type=3
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Effetto dissolvenza di un layer (raster) con la maschera veloce 

Il metodo funziona, ma è efficace solo con i layer raster. Raggruppo prima in una cartella i layer che mi 
interessa trattare e creo il layer di regolazione al di sopra della cartella. 

 

La mia immagine: 
 

 
Fig.  285 

Creo il layer Quick mask cliccando sull’icona: 
 

 
Fig.  286 
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Riempio con un gradiente del tipo Foreground to transparent: 
 

 
Fig.  287 

Cancello il layer Quick mask ricliccando  l’icona (il rettangolo di selezione appare da solo): 
 

 
Fig.  288 
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Cancello con il tastoCanc:  
 

 
Fig.  289 

Deseleziono; risultato finale: 
 

 
Fig.  290 

Come si può vedere i layer raster (colore e neri) hanno subito l'effetto che volevo, mentre il layer 
vettoriale (inchiostrazione) sono tagliati di netto. L'unica soluzione che mi viene in mente per ora è di 
duplicare il livello degli inchiostri e rasterizzarlo prima di applicare la procedura e di farlo alla fine, quando 
sono sicuro di non dover rimetter mano al disegno (in ogni caso ho l'originale).  
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Colorare le parti bianche 
Quando si colorano dei dettagli bianchi e anche il colore della carta è bianco, si può cambiare 

temporaneamente il colore della carta e, una volta colorate le parti interessate, tornare al bianco; oppure si 
può fare anche così: 

 sul layer di colorazione attivo, clicco i quadratini colorati del Change layer color (questo cambia ciò 
che è nero in azzurro) 
 

 
Fig.  291 

 nalla Layer Property > Effect, espando il + a sinistra e do un colore al Sub color, diverso dal bianco: ad 
esempio rosso; 
 

 
Fig.  292 

 Vado a colorare; scelgo come colore primario il nero e come secondario il bianco (i due quadratini 
delle icone colore nella Tool palette) 
 

 
Fig.  293 

  siccome è attivo l'Effect sul layer,  le aree in cui uso il nero appariranno azzurre, quelle in cui uso il 
bianco appariranno rosse*. Una volta terminato, disattivo l'Effect e le parti rosse appariranno, come 
dovuto, bianche. 
 

 
Fig.  294 

 

 

 

*attivando Layer Property > Effect nella Layer Property palette,  Layer color è il colore con cui apparirà il segno se uso il nero puro, 

mentre Sub color è il colore che assume usando il bianco puro. 
 

Per aggiungere ombre e alte luci solo dove serve impostare il lavoro in modo da avere separate le varie 
aree colorate (es. pelle, vestito, ecc). 

Colorare senza sbordare 
Devo colorare all’interno di una forma con un pennello, ad esempio acquerello o colore a olio (ma 

funziona anche con gli altri strumenti di disegno). 
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Dando le pennellate non riesco a stare all’interno della forma ed esco dal contorno; per ovviare a ciò 
esistono alcuni metodi, ossia: utilizzare il Clip to Layer Below, usare le selezioni, bloccare i pixel trasparenti, 
o utilizzare un Reference layer. Il Clip to Layer Below è analogo, per chi le conosce un po’, alle Clipping mask 
di Photoshop; in CSP esiste poi il Layer Mask, che è una cosa leggermente diversa. 

 

Con riferimento allo sketch sul quale costruisco l’immagine definitiva, disegno accuratamente su un altro 
livello (meglio se raster) il contorno esterno con un colore vivace, ad esempio rosso (solo per poterlo 
vedere bene); chiamo questo livello, ad es., “forma”.  

Attenzione: il contorno sarà quello definitivo: se ci saranno modifiche non è che non si potranno fare, 
solo che sarà un po’ laborioso.  

Riempio l’area delimitata dal contorno con lo stesso colore (ecco perché ho scritto di mettere il 
contorno su un livello raster: per evitare di avere due livelli differenti, contorno e riempimento. Ma è 
questioni di gusti, io ad esempio tendo a disegnare tutto ciò che è composto da linee su un livello 
vettoriale, perché mi trovo meglio per fare modifiche; poi magari alla fine lo duplico, per averne copia, lo 
rasterizzo e lo riempio). 

Se mi serve ancora il livello sketch come guida, posso metterlo sopra a tutti i livelli, magari in Multiply; se 
non serve più lo spengo (Multiply è un Blending mode, vedi pag. 183). 

 

I metodo: Clip to Layer Below 

Creo il livello raster su cui andrò a colorare (lo chiamo “colore”) e lo metto sopra al livello “forma” 
(quello rosso). Lo aggancio a quest’ultimo con il Clip to Layer Below e posso cominciare a colorare. Le mie 
pennellate non escono mai dal contorno, o meglio: anche se escono, ciò che si trova al di fuori della forma 
non si vede. 

Svantaggio: se svincolo il livello “colore”dal livello “forma” (ricliccando Clip to Livello Below)  si rende 
visibile anche tutto ciò che è esterno alla forma. 

 
Esempio: voglio colorare solo all’interno del cerchio rosa (Fig.  295). 

 
Fig.  295 

 

 
Fig.  296 

 

 
Fig.  297 

 

- Creo un nuovo livello “forma” nel quale riempio l’area del cerchio con un colore ben visibile (Fig.  296, a 
seconda di come è costruito il mio disegno e del mio livello di confidenza con la tecnica, questo passaggio può 
anche essere omesso); 

- creo un livello raster “colore” immediatamente sopra a “forma”, nel quale posso colorare (Fig.  297,  
nell’immagine non ho ancora attivato il Clip to Layer Below); 
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Fig.  298 

 

 
Fig.  299 

 

 
 

Fig.  300 – situazione finale dei 
livelli 

 

- attivo il Clip to Layer Below sul livello “colore”: la parte che esce dalla forma rossa non si vede (Fig.  298); sto 
utilizzando una maschera data dal livello “forma”; 

- sposto il livello “forma” in modo che immediatamente al di sotto del livello “colore” si trovi il livello col 

cerchio rosa (Fig.  299); in questo modo il layer colore risulterà agganciato con il Clip to layer below al livello 
del cerchio rosa, ma avendo quest’ultimo la stessa forma del livello “forma” non si noteranno differenze. 

 

Questi passaggi possono differire lievemente in base a come è costruito il disegno. In questo caso ho un livello per 
il rettangolo azzurro e uno per il cerchio rosa, su cui creo un livello cerchio rosso e un livello di colorazione. 

II metodo: selezione 

Mi accerto che il livello “forma” sia l’unico visibile; creo una selezione con la bacchetta magica cliccando 
su un punto all’esterno della forma. Quando la selezione è definitiva, invertirla (CTRL+SHIFT+I). 

Creo il livello “colore” su cui vado a colorare e spengo il livello “forma”.  
Le pennellate sono delimitate dalla selezione stessa. Se non si vuole vedere il bordo della selezione si 

può disattivarne la visibilità in View > Selection border. Consiglio di salvare la selezione in modo da poterla 
richiamare se accidentalmente la si cancellasse; la cosa più facile da fare è usare il Convert Selection to 
Layer (vedi). Dal layer che viene creato poi è possibile richiamare la selezione con Convert Selection Layer to 
Selection. 

III metodo: Lock transparent pixels 

Nella Command bar dei Layer c’è un’icona con un lucchettino al di sopra di un piano a scacchiera: 
cliccandolo si attiva il Lock transparent pixels. 

Quest’opzione blocca la possibilità di disegnare su aree trasparenti dei layer Raster. Permette di 
disegnare su aree già disegnate senza disegnare su aree trasparenti. Ricliccando si disabilita. 

 

 
Fig.  301 

IV metodo: Reference layer 

Se la forma è delimitata da linee (vettoriali o raster) in un Reference layer (vedi più sopra), attivando la 

casellina Do not cross lines of reference layer nella Tool property dello strumento che si usa per colorare, 

allora finché il centro dello strumento rimane all’interno della forma la colorazione non oltrepasserà le 

linee (vedi più sopra)  
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Visualizzare il disegno in scala di grigi 
Per controllare il bilanciamento generale dell’immagine una regola è quella di convertire l’immagine in 

scala di grigi e analizzarne quindi i valori tonali. 
Posso velocemente dare un occhio a questa cosa in due modi, partendo in entrambi i casi da un livello 

raster che metto in cima alla palette dei livelli. 
 

 
Fig.  302 

Nel primo caso riempio 
questo livello di nero o di 
bianco e poi imposto come 
Blending mode del livello 
Color, Hue o Saturation. 

Tenendo visibile il livello, il 
disegno sottostante 
appartirà in scala di grigi, 
spegnendolo tornerà a 
colori. 
Esiste anche un’Auto Action 
che fa la stessa cosa, 
scaricabile dagli Assets, qui. 
 

 Nel secondo caso clicco col tasto destro sul livello e 
clicco poi su New Correction Layer >  

Hue/Saturation/Luminosity… 
(Tinta/Saturazione/Luminosità) 

Si apre una finestra con tre slider, muovo quello della 
saturazione tutto a sinistra, fino al valore -100. Anche in 
questo caso, tenendo il livello visibile l’immagine apparirà 
in scala di grigi; spegnendolo, a colori.  
 

 
Fig.  303 

 

Vedi anche Controllare il contrasto, più sopra. 
 

  

https://assets.clip-studio.com/en-us/detail?id=1921494&fbclid=IwAR3OhqZVMUid1eUW2v2g6xegY8o144IcW0v7aW0O923or-W_WFqjHFNLZso
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Strumenti (Tool e SubTool) 
A sinistra dell'area di lavoro c'è una colonna di icone, la Tool palette, che contiene iTool (strumenti). Qui 

sono elencati quali SubTool (sottostrumenti) di default appartengono a ogni Tool. 
 

Zoom 
Zoom in 
Zoom out 

Move 
Hand 
Rotate 

Move layer 
Move layer 
Move tone pattern 
Move grid 

Select (Operation) 
Object 
Select layer 
Light table 
Edit timeline 

Marquee 
Rectangle marquee 
Ellipse marquee 
Lasso marquee 
Polyline marquee 
Selection pen 
Clear selection 
Shrink selection 

Magic wand 
From current layer 
From all layers 
From reference layer 

Eyedropper 
Color picker 
Pick up from layer 
 

Pen 
Pen 
Marker 

Pencil 
Pencil 
Pastel 

Brush 
Watercolor 
Oil paint 
India ink 

Airbrush 
Decoration 
Effect 
Hatching and sad pattern 
Cloth pattern 
Pattern 
Flower 
Vegetation 
Artificial scene 
Natural scene 
Ruled line 

Eraser 
Blend 
Blend 

Blend 
Blur 
Finger tip 
Blur by fiber 
Soothing watercolor 
Copy stamp 

Liquify 
 

Fill 
Contour line paint 

Gradient 
Figure 
Direct draw 
Frame 
Ruler 
Stream line 
Saturated line 

Text 
Text 

Text 
Curve Balloon 
Balloon pen 
Balloon tail 
Thought balloon tail 
Ellipse balloon 

Flash 
Beta flash 
Flash 
Dense Flash 
Sea urchin flash 
Firework 

Rounded balloon 
Correct line 
Vector control 

Control point 
Pinch vector line 
Simplify vector line 
Connect vector line 
Correct line width 
Redraw vector line 
Redraw vector line width 

Garbage cleaner 
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È sparito uno strumento! 

Capita a volte che per errore si compia qualche azione che fa scomparire uno strumento. Per 
ripristinarlo:  

- andare nel menù della barra degli strumenti, in altro a sinistra sulla toolbar: 
 

 
Fig.  304 

- selezionare Add from default…: 
 

 
Fig.  305 

- selezionare lo strumento da ripristinare e dare l’OK: 
 

 
Fig.  306 

In alternativa, avviare il programma tenendo premuto il tasto Shift: così facendo  appare una finestra da 
cui è possibile ripristinare gli strumenti e altro. 

Può capitare che spariscano, per qualche motivo, diversi strumenti , magari tra quelli personalizzati o 
scaricati, e questa procedura può risultare noiosa o insufficiente. È consigliabile effettuare ogni tanto un 
backup sul cloud di Clip Studio; in teoria un ripristino del programma, sempre da cloud, o la copia della 
cartella CELSYS nel pc, dovrebbero risolvere il problema. Vedi come fare più sotto. 
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Forme chiuse con angoli acuti 
Se disegno un poligono con uno strumento penna mi arrotonda gli angoli e anche quando scelgo delle 

impostazioni nel Sub Tool Detail palette Pen > Correction > Sharp angles (ex Make corner pointed), questo 
funziona (e non bene) solo se modifico la traiettoria della linea mentre sto disegnando e non se utilizzo lo 
Shift per fare linee rette (Fig.  307). 

Posso utilizzare un Curve ruler, andando poi la disposizione dei control point e a correggere con lo Switch 
corner in corrispondenza degli angoli (seleziono un punto con Operation > Object e poi clicco col tx dx; o 
con la penna della Cintiq), e quindi tracciare la linea come di consueto, Se gli angoli "sparano" o sono 
ancora tondi bisogna verificare attentamente la disposizione dei control point.  

Per forme poligonali (non curve) posso utilizzare il Sub Tool Figure > Direct draw > Polyline per ottenere 
l'effetto voluto (Fig.  308).  

 

 
Fig.  307 

 

 
Fig.  308 

 
Per praticità spesso utilizzo Straight line, eccedendo leggermente con la lunghezza di ogni tratto per poi 

tagliarlo via con la gomma Vector. Tuttavia, tagliando gli eccessi agli incroci tra due linee disegnate con 
Straight line, talvolta bisogna ancora metter mano ai tracciati vettoriali.  

 

 
Fig.  309 

 Qui, a esempio, disegno un poligono con vari tratti di Straigt line. 
Eccedo leggermente per poi tagliar via le parti in più con la gomma 
vettoriale. 

 

 
Fig.  310 

 Seleziono i tratti con Operation > Object, per vedere dove sono i 
control point della linea. 
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Fig.  311 

 Taglio via l’eccedenza di una delle linee; il tracciato della linea 
tagliata cambia direzione in corrispondenza del taglio; viene aggiunto 
un secondo control point al termine della linea 

 

 
Fig.  312 

 Taglio la seconda eccedenza. In questo caso devo aver tagliato 
qualcosa di troppo, anche dell’altra linea: l’angolo mi si presenta 
così. 
Annullo l’operazione e riprovo. 

 

 
Fig.  313 

 Cambiando l’angolazione con cui taglio la seconda linea, il risultato 
è decisamente migliore ed è quello che mi aspettavo. In questo caso 
credo di non aver tagliato il control point finale della prima linea. 

Non sempre mi va così di lusso. In altre prove, per avere il risultato 
voluto, ho provato a spostare entrambi i control point finali della 
prima line tagliata oltre la seconda e a ripetere l’operazione di taglio. 

Dovrei utilizzare di più il Polyline… 
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Blending mode (Metodo di fusione) 
Con il Blending mode si decide come un livello soprastante gli altri influisce sulla visibilità di questi.  
Il metodo di fusione può riguardare i rapporti tra interi layer differenti o solo la sovrapposizione di 

riempimenti in una zona delimitata da una selezione in uno stesso layer. 
Il metodo di fusione si decide nell’apposito menù a discesa nella Layer palette, per i rapporti tra layer 

diversi: 
 

 
Fig.  314 

oppure in Edit  > Advanced Fill… che aprirà la seguente finestra, per i riempimenti su selezione: 
 

 
Fig.  315 

Volendo, si può provare a fare una selezione su un layer vuoto e riempirla con l’Advanced Fill… ma in 
questo modo non funziona: il layer su cui ho fatto il riempimento si comporta come se avesse un 
riempimento normale. Per ottenere l’effetto allora devo andare a cambiare il Blending mode del layer. 

 

Il metodo con la selezione funziona solo se il riempimento con l’Advanced Fill…  è fatto sullo stesso layer 
in cui già ci sono delle zone colorate.  

 

Di default, i livelli sono in Normal, che significa che agiscono intuitivamente: se nel livello sottostante c’è 
ad esempio un’area colorata di rosso, disegnando nel livello soprastante con un tratto blu, dove il tratto 
passa sopra all’area rossa vedo il segno blu. 

Utilizzando altri metodi di fusione, la visibilità dei livelli dove il contenuto si sovrappone viene 
determinato da varie funzioni matematiche tra i valori dei pixel sovrapposti, così da dare vari effetti. 
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Prove delle varie impostazioni di Blending mode 

A seconda di quale Blendig mode si imposta su di un layer, i layer sottostanti vengono visualizzati in 
varie maniere. 

Nell'immagine che segue ho raccolto alcune prove realizzate per ottenere un effetto di luminescenza.  
Cerca anche “Setting the Blending Mode” sul Manuale. 

 

 
Fig.  316 

Il Blending mode esiste anche per i pennelli, vedi tra le impostazioni dei pennelli, più sopra . 
In APPENDICE 003 – I Blending mode ho messo un elenco dei vari Blending mode e di come agiscono 

(traduzione del manuale). 

Mantenere il Blending mode se si sposta un layer in una cartella: Blending mode "Through"  

Ho notato che spostando uno o più  layer con dati Blending mode all'interno di una cartella (o creandola 
con Create folder and insert layer) gli effetti dei vari blending vengono modificati ( persi!). Bisogna 
impostare la cartella a sua volta con Blending mode "Through" (che appare nell'elenco solo quando viene 
creata la cartella). 
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Cosa interessante: in File > Preferences > Layer/Frame si può selezionare la spunta Use [Through] 
blending mode for new layer folders, che automaticamente fa assegnare il blending mode “Through” a tutte 
le cartelle create nella layer palette. 

Cambiare il mood di un’immagine 

Metto un  livello posto sopra agli altri e gli attribuisco il Blending mode Overlay. Andando a modificare il 

colore di questo layer cambia il mood dell’intera immagine. 

Applicare un bordo 
Con il Border effect si può applicare un bordo al contenuto di qualsiasi layer. 
I passi per applicare un bordo sono gli stessi visti inel paragrafo Testo con bordo, a cui si rimanda. 
 Attenzione: cambiando il metodo di fusione (Blending mode) del livello, si otterrano per il Border effect 

effetti differenti perché, di fatto, l’effetto è una superficie espandibile (il parametro Thickness of edges), 
che sta sopra a ogni elemento del layer e da cui sborda per minimo un pixel. Cambiando il metodo di 
fusione, il colore (Edge color) del bordo, e quindi della superficie di cui fa parte, andrà a combinarsi con ciò 
che sta nel layer secondo il metodo selezionato, modificandone il colore. 
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Creare un goniometro 
https://forum.smithmicro.com/topic/1719/protractor-or-triangle-tool  
 

Protractor or Triangle Tool 
Abe32  
C'è un Goniometro o uno Strumento triangolo in CSP? O uno strumento specifico per calcolare i gradi di 

un angolo in una forma? Sarebbe davvero utile perché ne ho bisogno di frequente. 
Grazie mille. 
garlam  
Creare un Figure ruler > Ellipse con l'opzione Scale attivata (mm, Q, px o qualsiasi altra). Disegna la figura 

dal centro [Start from center selezionato - N.d.M.] e tieni premuto MAIUSC per fare un cerchio. Clicca 
sul [vertice del] tuo angolo [ossia dove i due lati dell'angolo si intersecano] e trascina fuori il cerchio. 
Seleziona lo strumento Object. Cambia le unità di scala in qualcosa che funzioni per la dimensione 
desiderata, ad esempio px per qualcosa di piccolo, mm per qualcosa di più grande. Afferra la maniglia 
di rotazione e ruota l'ellisse in modo che lo 0 sia sulla linea [cioè sul lato dell'angolo da dove vuoi 
misurare l'angolo - N.d.M.]. Quindi fare clic su una maniglia d' angolo e poi fare clic e tenere premuto 
ALT e SHIFT mentre si scala l'ellisse fino a quando 360 si sovrappone allo 0. Boom - goniometro. 

 

 
Fig.  317 

Ora puoi ingrandire e vedere l'angolo esatto.  
 

[Ho provato, non è facilissimo far combaciare i il 360 e lo 0] 

https://forum.smithmicro.com/user/abe32
https://forum.smithmicro.com/user/garlam
https://forum.smithmicro.com/uploads/files/1489191194396-protractor.jpg
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Fig.  318 

  

https://forum.smithmicro.com/uploads/files/1489191369430-protractor2.jpg
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Colore 
Argomento che meriterebbe da solo un manuale. Raggruppo alcune considerazioni, non esaustive. 

CSP non gestisce realmente il metodo CMYK. 
Estratto da 
https://www.facebook.com/groups/mangastudioitalia/permalink/1000403913403942/?comment_tracking=%7B%22tn%22%3A%2

2O%22%7D - 5 ottobre 2016 

Cristiano Corsani  
Il discorso è diverso. A CSP manca la gestione CMYK - ho capito che è necessaria - e questo è una 

mancanza. Non è però uno strumento per lavorare in vettoriale. Quindi non ha senso voler 
esportare in vettoriale perché CSP nasce per fare altro. Il fatto che internamente memorizzi i dati 
in forma vettoriale ha i suoi vantaggi: puoi "ritoccare" le linee, occupa meno memoria e così via, 
ma è fine all'obbiettivo: produrre tavole raster manga. Per fare cose in vettoriale c'è illustrator o 
inkscape. 

Carlo Sandri  
Non gestisce la quadricromia? Ma nel pannello preferenze c'è la voce "color conversion" e sotto view 

c'è color profile. A che servono se non per una conversione colore? 
Patrizia Mandanici  

A quanto pare il CMYK in Clip studio non è proprio quello "reale", è una specie di forzatura, di 
approssimazione - non so bene, comunque qui se ne parla: http://www.annukka.info/rgb-to-
cmyk-coloring-in-manga.../ 

Cristiano Corsani  

Tu l'hai detto meglio di me :-) 
Patrizia Mandanici   

Parli con Annukka credo  
 

Di seguito, due articoli di Annukka sull'argomento (il secondo, più sotto, è quello a cui fa riferimento 
Patrizia Mandanici, ma il primo è necessario alla comprensione del secondo; non ho numerato le immagini): 

CMYK e Manga Studio [Annukka I] 

http://www.annukka.info/cmyk-and-manga-studio/ 
Aggiornamento 23.10.2017: Alcune persone su Twitter sospettano che siccome questo è un 

articolo scritto nel 2015, le cose in CSP potrebbero essere cambiate e che siano stati apportati 
alcuni miglioramenti. Nessuna paura! ;) L'ho testato oggi e il programma gestisce le cose come 
prima (ovvero piuttosto male). 

 
Clip Studio Paint (Manga Studio 5) non supporta nativamente la gestione del colore [in CMYK - 

N.d.M.] e se si vogliono eseguire lavori di stampa professionali che richiedono CMYK come spazio 
colore, è bene essere consapevoli di questa limitazione. Non sono un esperto in questo campo; 
questo articolo riguarda come io affronto Manga Studio, e mi piacerebbe ricevere commenti su 
come gli altri affrontano il problema. Ci sono soluzioni migliori? 

 
Nota per i lettori finlandesi/Suom suomalainen lukija: Tämä artikkkeli su käännös, voit lukea 

jutun suomeksi tästä [non si sa mai - N.d.M.]. 
 
È possibile fare alcuni test da soli, se si possiede anche per esempio Photoshop [--> PS]. 

Iniziare impostando le opzioni colore di entrambi i programmi nello stesso modo. Queste sono 
anche delle buone impostazioni generali se si desidera eseguire lavori di stampa con i programmi. 
(-> qui in Europa. Ma chiedete sempre al vostro tipografo - potrebbe chiedervi di utilizzare un 
profilo diverso o un proprio profilo). 

 
In MS vai a File/Preferences/Color conversion 
[di default è RGB profile: sRGB IEC61966-2.1; CMYK profile: Japan Color 2001 Coated; 

Rendering intent: Perceptual; Library to use: Icc Library - N.d.M.] 
 

https://www.facebook.com/groups/mangastudioitalia/permalink/1000403913403942/?comment_id=1000915656686101&comment_tracking=%7B%22tn%22%3A%22R4%22%7D
https://www.facebook.com/cristiano.corsani?fref=gc&dti=509226542521684
https://www.facebook.com/carlo.sandri?fref=gc&dti=509226542521684
https://www.facebook.com/patrizia.mandanici?fref=gc&dti=509226542521684
https://l.facebook.com/l.php?u=http%3A%2F%2Fwww.annukka.info%2Frgb-to-cmyk-coloring-in-manga-studio%2F&h=ATOXSz3FCDrttvnOepeACWnDtzZCcyi9Nu5eoPj57tzUH1USd79iwFoOJ4CLLWJdpiFXmmyS7oVphtcact9fpQjxwDnYPvX4-tgGfDJYdOIdlNbxCJiP9fEl4J2sb8cVx6oopZIeSw
https://l.facebook.com/l.php?u=http%3A%2F%2Fwww.annukka.info%2Frgb-to-cmyk-coloring-in-manga-studio%2F&h=ATOXSz3FCDrttvnOepeACWnDtzZCcyi9Nu5eoPj57tzUH1USd79iwFoOJ4CLLWJdpiFXmmyS7oVphtcact9fpQjxwDnYPvX4-tgGfDJYdOIdlNbxCJiP9fEl4J2sb8cVx6oopZIeSw
https://www.facebook.com/cristiano.corsani?fref=gc&dti=509226542521684
https://www.facebook.com/patrizia.mandanici?fref=gc&dti=509226542521684
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E in PS Edit/Color settings 
 

 
 

[Questo è il mio default su Photoshop: 

 - N.d.M.] 
 
In MS il Rendering intent è per impostazione predefinita Perceptual. In PS Tendo a usare 

Relative colorimetric (Colorimetrico relativo) perché mantiene più colori originali che Perceptual. 
Ma non c'è alcuna possibilità di impostare il Black point compensation [compensazione del punto 
del nero - N.d.M.] in MS di cui ha bisogno il Relative colorimetric, quindi mi accontenterò di 
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Perceptual in entrambi i programmi (e la differenza di solito non è così grande, quale dei due 
Intent venga utilizzato). 

 
Se si apre un'immagine in MS e non ci si assicura che il profilo allegato sia in anteprima, i 

colori appariranno sbagliati. Date un' occhiata alle due immagini qui sotto. La prima è aperta in 
PS (l'immagine ha il profilo AdobeRGB) e i colori sono come dovrebbero. L'immagine successiva è 
aperta in MS senza attivare il profilo di anteprima. I colori appaiono chiaramente fangosi e troppo 
scuri. 

 

 
 

 
 
È necessario attivare l'anteprima del profilo colore ogni volta da View > Color profile > 

Preview. 
Da Preview settings sopra, è possibile impostare il profilo desiderato. Saprete che tale profilo 

è in uso nella vostra immagine se potete vederne il nome nel titolo. 
 

http://www.annukka.info/wp-content/uploads/2015/02/photari.jpg
http://www.annukka.info/wp-content/uploads/2015/02/csp.jpg
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Ed ecco  la nostra immagine con Color profile > preview in MS. Sembra meglio: 
 

 
 
Se l'intenzione è quella di colorare in MS utilizzando valori CMYK precisi, tenere presente che i 

valori di colore cambiano nelle immagini fatte e poi esportate da MS. Cambiano anche se si 
utilizzano i valori CMYK per colorare, si usa un certo profilo colore CMYK in anteprima e si esporta 
con quel dato profilo CMYK. Ad esempio un ciano puro (100,0,0,0,0) riceve altri valori quando 
viene esportato. 

 
MS non può gestire i colori CMYK. Se si apre un' immagine CMYK realizzata in Photoshop in 

MS, verrà sempre convertita in RGB (viene visualizzata una finestra di avviso in MS). Se si 
desidera convertirlo in CMYK, è necessario esportare l'immagine. Questo non fa mai bene per i 
colori della vostra immagine. 

 
In PS non c'è mai miscelazione dei valori cromatici, i valori cromatici vengono mantenuti come 

sono stati creati, se si lavora in modo coerente con un determinato profilo CMYK. Personalmente 
coloro le illustrazioni direttamente nello spazio CMYK usando le mie schede colorimetriche 
Pantone. E così facendo devo potermi fidare del fatto che un programma non cambi quei valori 
da solo in modo casuale. 

 
Ho quasi consigliato di usare il programma gratuito Krita (- Krita -) per la colorazione, ma ho 

notato che ha il problema che non è possibile impostare i valori CMYK in percentuale (come 
fanno i libri di riferimento del colore) ma su una scala da 0-255, dove ciano puro è 255 e altri 
valori 0. Convertire ogni colore da questi valori a % è un lavoro troppo grande e lento. Il che è un 
peccato, perché le immagini esportate da Krita mantengono i loro valori di colore. Il ciano 
menzionato è ancora ciano puro quando viene aperto in PS. 

 
Le alternative in Manga Studio 
Se volessi assolutamente fare la mia colorazione in CMYK con MS, non cercherei nemmeno di 

usare i colori con dei valori CMYK predefiniti. (Puoi provarlo tu stesso: fai un semplice magenta 

http://www.pantone.com/pages/products/product.aspx?pid=1003
http://www.pantone.com/pages/products/product.aspx?pid=1003
http://www.pantone.com/pages/products/product.aspx?pid=1003
http://www.annukka.info/krita-esittely-ja-asennus/
https://krita.org/en/
http://www.annukka.info/wp-content/uploads/2015/02/profiili-kayttoon-csp.jpg
http://www.annukka.info/wp-content/uploads/2015/02/csp-ja-profiili.jpg


Appunti di Manga Studio/ClipStudioPaint   

192 

0/100/0/0/0 o Cyan 100/0/0/0/0/0 ed esportalo. Poi controlla quei valori in Photoshop e ti 
accorgerai che per esempio il ciano è ora un mix di ciano e magenta.... Quindi, no. Dipingerei "a 
occhio" (cioè solo usando i colori che mi piacciono sullo schermo) e poi cercherei di metterci 
mano con PS o qualche altro programma affidabile nella gestione del colore e controllerei i 
risultati per almeno un paio dei primi lavori. 

 
Una buona, se non migliore, soluzione è fare la colorazione in MS nello spazio RGB ed 

esportare l'immagine come CMYK. Utilizzando questo metodo, non c' è differenza in Photoshop o 
in Manga Studio. Sarebbe comunque bene avere un monitor calibrato e ricordare che non è 
possibile stampare tutti i colori RGB con il processo CMYK. Evitare per esempio i colori molto 
saturi, che saranno probabilmente smorzati. 

 
Ecco un' immagine RGB realizzata in Photoshop 

 
 
Ed ecco le versioni CMYK realizzate. A destra si trova la versione MS e a sinistra la versione PS 

(una schermata in CMYK di ognuna): 
 

 
 
Esattamente lo stesso se misurato con il Color picker. 
 

Colorazione da RGB a CMYK in Manga Studio [Annukka II] 

http://www.annukka.info/rgb-to-cmyk-coloring-in-manga-studio/ 
Il mio ultimo articolo era la teoria alla base di ciò che faremo in questo articolo, quindi 

potresti desiderare di leggerlo prima e fare le tue impostazioni, ecc. Coloreremo un'illustrazione 
in RGB ed la esporteremo come CMYK. Non andrò a fondo nella gestione del colore e suppongo 
che abbiate un monitor calibrato e conosciate le cose di base per fare un lavoro per la stampa. 

 
Prima di iniziare a colorare, impostare Preview > Color profile come nell' immagine 

sottostante. 
 

http://www.annukka.info/wp-content/uploads/2015/03/rgb.jpg
http://www.annukka.info/wp-content/uploads/2015/03/rgb-cmyk.jpg
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Fate anche attenzione che l'anteprima sia accesa e si veda il nome dei profilo colore nel titolo 

della vostra immagine 
 

 
 
E se non avete ancora impostato il profilo CMYK da utilizzare nell'esportazione al momento 

opportuno, fate anche questo adesso da File/Preferences/Color conversion. 
 
I tipografi professionisti qui in Finlandia mi chiedono di utilizzare i profili Fogra praticamente 

sempre. Coated o uncoated o a seconda della carta. Accertarsi di conoscere il profilo che il 
tipografo desidera utilizzare, in quanto questi elementi variano da un tipografo all'altro, da paese 
a paese. 

Poi la colorazione: 
 

 
 
Come indicato nell'articolo precedente, la colorazione in modalità CMYK in MS non è buona. 

Ecco due schermate di prova in CMYK. La prima è fatta in PS, dove tutto funziona e il secondo in 
MS, dove ovviamente non funziona. I colori sono diventati più scuri e smorzati di quanto non lo 
siano effettivamente: 

 

 
 

http://www.annukka.info/wp-content/uploads/2015/03/preview-rgb.jpg
http://www.annukka.info/wp-content/uploads/2015/04/preview.jpg
http://www.annukka.info/wp-content/uploads/2015/03/v%C3%A4ritetty-kuva.jpg
http://www.annukka.info/wp-content/uploads/2015/03/cmyk_preview_ps.jpg
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Un'altra immagine di confronto. Ho fatto i colori a sinistra in MS usando lo spazio di 

anteprima Coated Fogra. Ho esportato l'immagine come .tif con lo stesso profilo Fogra. Quando 
utilizzo quei colori con gli stessi valori in PS, usando lo stesso profilo Fogra, ottengo un risultato 
diverso (i colori sul lato destro). Come potete vedere, soprattutto i magenta prodotti in MS sono 
stati gravemente influenzati. 

 

 
 
È stato riportato in internet che MS mixa il nero in tutti i colori CMYK anche se non si utilizza il 

canale K. Qualunque cosa faccia, lo fa male. Il colore magenta nella mia immagine nell' angolo 
superiore sinistro è stato fatto con 75% M e 0% C, Y e K. Ma quando l'ho aperto e misurato in PS 
ho ottenuto un mix di M, C e Y! 

 

 
 
Ma torniamo alla nostra illustrazione. Quando si è pronti, appiattire l'immagine e File-

> Export (Single layer) come TIF. 
Ecco le mie impostazioni per l'esportazione (MS utilizzerà il profilo CMYK impostato in Color 

conversion (Preferences) per l' Expression color): 
 

http://www.annukka.info/wp-content/uploads/2015/03/cmyk_preview_csp.jpg
http://www.annukka.info/wp-content/uploads/2015/03/csp_ps_cmyk.jpg
http://www.annukka.info/wp-content/uploads/2015/03/muutos.jpg
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Ho anche convertito una copia dell'illustrazione in CMYK in Photoshop e ho confrontato i 

risultati. PS a sinistra, MS a destra. Sembra bene! 
 

 
 
Commenti 
Kris: 
2017/08/30 13:37 
Mi piace CSP perché i pennelli sono impressionanti, onestamente preferisco PS ma quando 

voglio disegnare in uno stile tradizionale come la pittura a olio, PS non funziona bene, CSP ha la 
capacità  di mescolare i colori come se si utilizzasse l'acqua (spessore di pittura) nel mondo reale. 

Il problema è che io sono un amante del CMYK, non dell'RGB, e ho capito che la colorazione di 
CSP ha un cattivo profilo colore CMYK, e non sono sicuro lavorando con RGB. 

È strano perché Manga Studio/CSP è fatto per creare manga, in cui il CMYK è importante. 
Annukka Leppänen: 
2017/08/30 14:08 
Kris, sono totalmente d' accordo con lei. Spero quindi che CSP lo correggerà nel prossimo 

aggiornamento del programma. La stampa non è morta :) 
Annukka Leppänen: 
2017/10/05 03:59 
Grazie per il suo commento Kris e mi dispiace per la risposta in ritardo. Sono totalmente 

d'accordo con lei sulla questione CMYK ma, se possiede PS, potete portare i suoi dipinti in RGB in 
PS e fare la conversione CMYK lì. 

Spero anche che possano risolvere questo problema nel prossimo importante aggiornamento 
di CSP. 

 

http://www.annukka.info/wp-content/uploads/2015/03/asetukset1.jpg
http://www.annukka.info/wp-content/uploads/2015/03/hipit-cmyk1.jpg
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Differenza di tonalità riscontrate dopo il salvataggio 

Pierfrancesco Stenti 
https://www.facebook.com/groups/mangastudioitalia/permalink/851638154947186/ 

18 febbraio 2016 
Chiedo aiuto... 
Perchè i colori che utilizzo in Manga Studio, una volta esportati in jpg, cambiano tonalità? 
È una questione solo di formato file, oppure ci sono dei settaggi che devo fare affinche i colori 

utilizzati, rendano nella stessa tonalità una volta esportati? 
Premetto che per disegnare utilizzo una Cintiq 24hd e un mac... 
Ringrazio chi volesse aiutarmi! 

 

 
Fig.  319 

 
Elena Toma  

Potrebbe essere che durante l'exporting in jpeg venga cambiato il metodo colore dell'illustrazione da 
RGB a CMYK. O almeno questa è l'unica cosa che mi viene in mente, altrimenti non potrei sapere 
da cosa può dipendere... 

Fabio D'Auria  
Prima di tutto apri la jpg in manga studio per capire se davvero ha cambiato il profilo colore oppure è 

il programma anteprima che non legge bene la scala colori. 
Pierfrancesco Stenti  

Se apro il jpg, con manga studio, i colori sono gli stessi.... 
Fabio D'Auria  

gli stessi di anteprima o gli stessi del file originale? 
Pierfrancesco Stenti  

Scusa.... del file originale 
Fabio D'Auria  

e allora non cambiano tonalità, vengono visualizzati in modo diverso da Anteprima. Prova ad aprire la 
jpg in altri programmi (anche chrome, opera o altro) e vedi come li visualizzi. 

Jacopo Mistura  

https://www.facebook.com/pierfrancesco.stenti?fref=gs&hc_ref=ARQhVd-tWib2gJ-3RSYQRnNxs0sm3NLQJE1pZlhzVchm5c7Sq_hYppxUSgyU-eWcalI&dti=509226542521684&hc_location=group
https://www.facebook.com/groups/mangastudioitalia/permalink/851638154947186/
https://www.facebook.com/photo.php?fbid=10207353838798258&set=gm.851638154947186&type=3&ifg=1
https://www.facebook.com/photo.php?fbid=10207353838798258&set=gm.851638154947186&type=3&ifg=1
https://www.facebook.com/photo.php?fbid=10207353838798258&set=gm.851638154947186&type=3&ifg=1
https://www.facebook.com/tonkipappero?fref=gc&dti=509226542521684
https://www.facebook.com/cOMIFAB?fref=gc&dti=509226542521684
https://www.facebook.com/pierfrancesco.stenti?fref=gc&dti=509226542521684
https://www.facebook.com/cOMIFAB?fref=gc&dti=509226542521684
https://www.facebook.com/pierfrancesco.stenti?fref=gc&dti=509226542521684
https://www.facebook.com/cOMIFAB?fref=gc&dti=509226542521684
https://www.facebook.com/CapitanTriplomalto?fref=gc&dti=509226542521684
https://www.facebook.com/photo.php?fbid=10207353838798258&set=gm.851638154947186&type=3&ifg=1
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Prova ad esportare in altri formati. Prova col tif che è uno dei più fedeli e vedi se anteprima fa lo 
stesso scherzo 

Pierfrancesco Stenti  
ok!!!!! Grazie mille!!!!! 

Jacopo Mistura  
Comunque il png è preferibile al jpg come formato file 

Pierfrancesco Stenti  
Ho aperto il nuovo file png, con chrome, ed i colori sono gli stessi di Manga Studio.... 
Quindi si tratta solo di "Anteprima" 

Pierfrancesco Stenti  
Grazie comunque per la Vs. disponibilità!!!!! 

Athos Boncompagni  
includi sempre il profilo icc quando esporti 
 

 
Fig.  320 

Pierfrancesco Stenti Grazie 
 

Su questo argomento consiglio vivamente questo video di Luca Malisan sulla gestione del colore da 
parte dei vari programmi e dispositivi. 

Il Nero vero 
https://www.facebook.com/groups/mangastudioitalia/permalink/1135035543274111/?comment_tracking=%7B%22tn%22%3A%2
2O%22%7D 

Mattia Bulgarelli 
Domanda su ESPORTAZIONE FILE IN CMYK: 
Esiste un metodo per avere la certezza di avere, nel file esportato, almeno un colore che diventi nero 

standard CMYK 0/0/0/100? 
Patrizia Mandanici  

Mi sa di no, ho anche provato a fare un nero come dici tu con la slide in CMYK che c'è in CSP, ho 
riempito di questo nero una selezione, l'ho misurata con contagocce e mi veniva fuori un altro 
colore con altre percentuali! Quelle che poi legge Photoshop se esporto il disegno che penso sia 
realizzato in nero puro. Il colore in CSP è un casino, specialmente se lo si vuole utilizzare in 
rapporto a Photoshop. 

Mattia Bulgarelli  
Il fine ultimo è avere file di stampa con un nero che finisca su una sola piastra di stampa in CMYK. 
Nel lettering di fumetto molti stampatori consigliano il nero standard perché se le piastre non si 

allineano alla perfezione il testo viene un po' sfocato. Con il colore su una piastra sola, se anche di 
sposta di poco non succede nulla. 

Patrizia Mandanici  
Non so che dirti, a me sembra che da CSP non esca un nero al 100%, poi non so, bisognerebbe 

portare un file in tipografia e vedere che dicono. 

https://www.facebook.com/pierfrancesco.stenti?fref=gc&dti=509226542521684
https://www.facebook.com/CapitanTriplomalto?fref=gc&dti=509226542521684
https://www.facebook.com/pierfrancesco.stenti?fref=gc&dti=509226542521684
https://www.facebook.com/pierfrancesco.stenti?fref=gc&dti=509226542521684
https://www.facebook.com/athos.boncompagni?fref=gc&dti=509226542521684
https://www.facebook.com/photo.php?fbid=804533506345513&set=p.804533506345513&type=3&ifg=1
https://www.facebook.com/photo.php?fbid=804533506345513&set=p.804533506345513&type=3&ifg=1
https://www.facebook.com/photo.php?fbid=804533506345513&set=p.804533506345513&type=3&ifg=1
https://www.facebook.com/pierfrancesco.stenti?fref=gc&dti=509226542521684
https://www.youtube.com/watch?v=GGzOZ7QjMZw
https://www.facebook.com/groups/mangastudioitalia/permalink/1135035543274111/?comment_tracking=%7B%22tn%22%3A%22O%22%7D
https://www.facebook.com/groups/mangastudioitalia/permalink/1135035543274111/?comment_tracking=%7B%22tn%22%3A%22O%22%7D
https://www.facebook.com/profile.php?id=100009566720797&fref=gs&hc_ref=ARQLAkJudq8K67F82xGMPkgZP9hv7YaAohhKnjDWeCPWdC3CQx-rvrGcUgw0Ez5bwgM&dti=509226542521684&hc_location=group
https://www.facebook.com/patrizia.mandanici?fref=gc&dti=509226542521684
https://www.facebook.com/profile.php?id=100009566720797&fref=gc&dti=509226542521684
https://www.facebook.com/patrizia.mandanici?fref=gc&dti=509226542521684
https://www.facebook.com/photo.php?fbid=804533506345513&set=p.804533506345513&type=3&ifg=1
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Mattia Bulgarelli  

Se photoshop e CSP leggono un altro valore contenuto nel file esportato, quello è, temo. :/ 
Patrizia Mandanici  

Qui in pratica si parla della stessa cosa, anche se nel secondo commento Garlam parla di esportare il 
testo in Tiff duotone, ma ribadendo poi che il testo sarà in "rich black" lo stesso (boh, non ho 
capito allora cosa cambia esportarlo in Tiff): https://forum.smithmicro.com/.../in-ms5-does-
anyone-know... 

Mattia Bulgarelli  
Se tanto mi dà tanto, la domanda al link che hai messo qui l'ha posta il mio Cliente per cui mi serviva 

la risposta... XD  
Credo che consiglino il TIFF perché è un formato che include dei metadati sul colore, permette di 

salvare in CMYK, può essere impostato senza compressione, e può includere i livelli, pur non 
essendo un formato leggibile solo da certi software (nel senso che è uno standard trasversale, 
anche se non è, tecnicamente, un formato aperto). 

Patrizia Mandanici  
Che ne pensi della recente risposta di Garlam che suggerisce un metodo (però ci vuole sempre l'aiuto 

di un altro programma dopo) https://forum.smithmicro.com/.../in-ms5-does-anyone.../4 
 
In MS5, qualcuno sa come cambiare il colore del testo a “nero standard”? 

https://forum.smithmicro.com/topic/1640/in-ms5-does-anyone-know-how-to-change-the-text-color-to-standard-black 
B 

boylord  
10 months ago 

Ho fatto un intero fumetto con gli slider CMYK di default per il testo impostati come “Rich Black”, che 
significa che C,M,Y, e K sono rispettivamente 70%, 70%, 70%, 89%. Per una stampante ha 
funzionato bene. Ma una nuova stampante dice che i font dovrebbero essere “standard black” 
(0%, 0%, 0%, 100%). Ogni volta che ho provato a cambiare i valori, MS5 me lo lasciava fare, in 
teoria, ma poi per qualche motivo gli slider tornavano indietro al Rich Black. In altre parole, il mio 
testo è piantato su questi valori di CMYK, che non possono essere cambiati. Ho provato a 
selezionare il testo e poi ad andare sulla palette dei colori, e anche selezionando tutto il box del 
testo e poi andando alla palette dei colori. 

Qualcuno sa come impostare il testo al valore 100% nero, senza altri colori? 
Inoltre, come si cambiano i valori di default per un nuovo testo? 
Grazie! 
-Nate 

 
garlam  

10 months ago 

Dovresti esportare il testo come TIFF duotone 
Non c’è lo spazio colore CMYK in CSP. È uno spazio colore RGB che è convertito in CMYK usando il 

profilo CMYK selezionato. Le lineart e il lettering dovrebbero essere sempre esportati come 
bitmap e quindi impostati come 0,0,0,100 nel programma di impaginazione *“…in the page layout 
program.”…?+ 

Puoi impostare il testo al nero nella palette Sub Tool Detail (le opzioni sono Main, Sub, e User Defined 
*principale, secondario e definito dall’utente+), ma sarà sempre un nero RGB convertito a “Rich 
Black”  CMYK se utilizzi un profilo colore CMYK quando esporti. 

 
boylord  

10 months ago  

@garlam  grazie per l’aiuto e la pronto risposta. Ho un problema con l’esportazione bitmap, non mi 
crea il testo da solo, aggiunge uno sfondo bianco, il che significa che non posso metterlo su un 
layer sopra il disegno nel programma di impaginazione. Posso comunque esportare il testo e i 
disegni in un file PSD, che funziona bene in Photoshop. Comunque, il color picker di Adobe PS non 
lo mostra come 0,0,0,100. 

https://www.facebook.com/profile.php?id=100009566720797&fref=gc&dti=509226542521684
https://www.facebook.com/patrizia.mandanici?fref=gc&dti=509226542521684
https://l.facebook.com/l.php?u=https%3A%2F%2Fforum.smithmicro.com%2Ftopic%2F1640%2Fin-ms5-does-anyone-know-how-to-change-the-text-color-to-standard-black&h=ATOK8n6lnq6FJl47POlxL3pV33vYObJXxd5iE0QTaU3auolk7DM2clb1Ee7jXbAj7SgLkwZw9njJ7I0KnWiyyEbab76XBOpF0cMqlRFbKnRxBJyzKXpaSVTLZwH5Iy893bdxhUiBmA
https://l.facebook.com/l.php?u=https%3A%2F%2Fforum.smithmicro.com%2Ftopic%2F1640%2Fin-ms5-does-anyone-know-how-to-change-the-text-color-to-standard-black&h=ATOK8n6lnq6FJl47POlxL3pV33vYObJXxd5iE0QTaU3auolk7DM2clb1Ee7jXbAj7SgLkwZw9njJ7I0KnWiyyEbab76XBOpF0cMqlRFbKnRxBJyzKXpaSVTLZwH5Iy893bdxhUiBmA
https://www.facebook.com/profile.php?id=100009566720797&fref=gc&dti=509226542521684
https://www.facebook.com/patrizia.mandanici?fref=gc&dti=509226542521684
https://l.facebook.com/l.php?u=https%3A%2F%2Fforum.smithmicro.com%2Ftopic%2F1640%2Fin-ms5-does-anyone-know-how-to-change-the-text-color-to-standard-black%2F4&h=ATNxUk4fYdW8j5I9yJZFCc0OBnWZknZzWWRV5rjVQAcPExgDmfNA95-Ep9TbcBPQSTP-KgXV4lCoTPyYLzd9O2vPep6iJu38O2gsbxQFFUTInMbxRw27Hxea0psz16j7U5xOJSpxkQ
https://forum.smithmicro.com/user/boylord
https://forum.smithmicro.com/user/boylord
https://forum.smithmicro.com/user/boylord
https://forum.smithmicro.com/user/boylord
https://forum.smithmicro.com/post/15450
https://forum.smithmicro.com/user/garlam
https://forum.smithmicro.com/post/15451
https://forum.smithmicro.com/user/boylord
https://forum.smithmicro.com/post/15520
https://forum.smithmicro.com/uid/138
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garlam  

10 months ago 

Il TIFF di CSP non supporta la trasparenza. Alcuni programmi di impaginazione permettono di 
impostare un colore come trasparente e tu potresti selezionare il bianco, ma c’è un modo 
migliore. 

Primo, dato che CSP non produce gli ESP di cui avresti bisogno per fare il trapping del lettering [per 
trapping (abbondanza) vedi qui, qui e qui] nello stesso modo in cui lo fai per le lineart. I 
programmi vettoriali permettono di impostare il knockout dei riempimenti [bucatura, vedi qui] e 
la sovrastampa, ma ciò è necessario perché chi fa il lettering lavora in una catena di montaggio e 
deve unire le linee del lettering con le lineart dei disegni, così come i colori del lettering con i 
colori dei disegni. 

Se fai il lettering da solo questo non è necessario. Puoi fare il trapping dei colori del lettering e 
aggiungerlo al file dei colori, e puoi invece unire il nero del lettering al nero delle lineart . 

Ciò che accade è questo: 
Le lineart e il lettering nero devono essere impostati su 0,0,0,100 e impostati per la sovrastampa. Il 

layer dei colori dovrebbe includere le informazioni di colore dal layer di lettering e dovrebbe avere 
un trapping adeguato. Come esempio, i bianchi dei balloon e i riempimenti degli effetti speciali 
dovrebbero essere inclusi nel layer colore e diffondersi sotto le linee nere del lettering per 
qualche pixel. 

Quindi, le lineart e il lettering vengono esportati in un file (andranno nella lastra dei neri) e i colori e il 
lettering colorato in un altro. 

Le lineart e il lettering si possono esportare in un PNG per mantenere la trasparenza, ma bisogna che 
sia le lineart che il lettering siano stati convertiti in monocromo e masterizzati nelle dimensioni di 
stampa prima dell’esportazione. Suggerirei di fare una copia delle lineart e del lettering uniti e 
impostati su monocromo con solo la casellina nera selezionata. Quindi rasterizzare. Quando si 
esporta come PNG, selezionare Choose Best Color Choice [non ricordo le parole esatte [forse Auto 
detect appropriate color depth]) e poi esportare. 

Per i colori, porta la parte colorata e il lettering colorato alla risoluzione di stampa (imposta la 
risoluzione a 300 dpi) e fai una prova colore a monitor [soft proof, vedi qui] con il corretto profilo 
CMYK per correggere i colori. Quindi esporta come TIFF CMYK senza inglobare il profilo colore 
(sembra che il file vada direttamente alla stampante, quindi se si utilizza il profilo corretto quando 
si esporta va bene) 

Nel programma di impaginazione, importa il PNG sopra le lineart e modifica il layer del PNG in CMYK 
scegliendo  0,0,0,100 pe il colore. In prestampa, assicurati che il nero sia impostato su 
sovrastampa. 

Immagino che tu consegni il tuo file alla tipografia in formato PDF. Quando lo fai, il layer PNG 
diventerà un file TIFF CMYK con solo inchiostro nero. 

Ancora su CMYK e nero 

Sulla difficoltà a impostare il nero in modalità CMYK leggere: 
-  questo post sul gruppo FB Clip StudioPaint Italia che, alla data in cui scrivo (gennaio 2022), 

taglia definitivamente la testa al toro ; 
- questo post. 

 
----------------------------- 

- Un articolo interessante sulla gestione del colore e il passaggio da RGB a CYMK: clicca QUI.  

https://forum.smithmicro.com/user/garlam
https://forum.smithmicro.com/post/15537
https://helpx.adobe.com/it/indesign/using/adjusting-ink-options-trapping.html
http://www.safedata.altervista.org/grafica/33-il-trapping
http://www.boscarol.com/blog/?p=4097
http://www.boscarol.com/blog/?p=2167
https://www.facebook.com/groups/mangastudioitalia/permalink/4483388451772120
https://www.facebook.com/groups/mangastudioitalia/permalink/4972403356203958
https://www.clipstudio.net/how-to-draw/archives/156866?fbclid=IwAR2hNTIjD21HoKg-Abv9bmwMVF5bI_qvx-DCk9j3GDqO-W3ri_NInlPAlp8
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Riempimenti (Fill) 

Riempiendo delle forme delimitate da linee sono incappato in due problemi, uno lavorando con linee 
raster, l'altro con linee vettoriali, in entrambi i casi con l'opzione Antialias attivata. 

Per le linee raster, utilizzando anche l'opzione Area scaling ho notato che il riempimento non andava ad 
appoggiarsi per bene al contorno, non occupando i pixel sfumati dell'antialias (1). Verificando, ho visto che 
l'opzione How to zoom nell'Area scaling era impostata su "To darkest pixel"; l'ho modificata in "Rectangle" 
e così l'Area scaling fa bene il suo lavoro (2) e riempie bene la superficie. 

Utilizzando le linee vettoriali ho pensato di utilizzare l'opzione “Fill up to vector path” [ex "Stop filling at 
center line of vector"], ma disattivando il layer vettoriale ho visto che al di sotto della linea vettoriale 
rimaneva una linea di un pixel senza riempimento (3). Non mi ero accorto che si può attivare anche 
l'opzione “Include vector path” [ex "Include center line"]. Attivandola, due riempimenti adiacenti arrivano a 
toccarsi (4). Nel caso delle linee vettoriali non ho utilizzato il fill con l'Area scaling. 
 

 
Fig.  321 
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Di seguito si può vedere come agiscono le opzioni "Area Scaling" e "Stop filling  at center line of vector" 
sul riempimento quando le loro spunte siano (SI) o meno (NO) attivate. La parte in grigio è la linea sul layer 
vettoriale, con opacità attorno al 40% per far vedere attraverso; nell'angolo in basso a desta di ogni 
immagine c'è un ingrandimento. Per il riempimento ho usato l'opzione Antialias attivata. 

 

Nel primo caso (SI-SI), il riempimento arriva alla linea centrale del vettore, e si fa sentire l'effetto 
dell'antialias; 

Nel secondo caso (NO-SI), il riempimento arriva ancora al centro del vettore, ma non c'è effetto 
antialias. 

In questi due casi è evidente che l'istruzione "Stop filling..." prevale  su "Area scaling", portando 
comunque il riempimento alla linea centrale del segno vettoriale. 

Nel terzo caso (SI-NO), si vede come agisce l'Area scaling, in questo caso impostato a 2 px: c'è un 
parziale riempimento (di 2 pixel appunto) dell'area occupata dal segno vettoriale. 

Nel quarto caso (NO-NO) il riempimento non sopravanza il segno vettoriale e anzi, dato che sia 
riempimento che segno vettoriale hanno impostato un antialias, si genera una linea semitrasparente al 
contatto tra le due parti. 
 

 
Fig.  322 
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L'effetto finale dipende anche dallo spessore del segno vettoriale e dal valore dell'Area scaling. Di 
seguito si vede come tali parametri possano influire. Per il segno ho usato un pennello con diametro 10 
pixel, impostato con Antialias "Middle", premuto bene dove c'è il tratto spesso, mentre ho tenuto la penna 
leggera dove il tratto è sottile. Così, da una parte ho il tratto pieno a 10 px, dall'altra no. Riempimento con 
Anti-aliasing "Middle". Come nell'esempio precedente, il primo SI/NO è riferito all' "Area scaling", il 
secondo allo "Stop filling..."  

 
Fig.  323 

 
 
Riempimento senza Anti-aliasing. 

 
Fig.  324  
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Close and fill 

Con Close and fill si può tracciare velocemente una linea attorno a una superficie chiusa (da linee o da 
altre superfici) per riempirla con il colore selezionato. È particolarmente utile quando la superficie è 
difficilmente selezionabile con All layers o Current layers perché, ad esempio, è troppo piccola. 

 

 
Fig.  325 – Superficie tra superfici 

 

 
Fig.  326  

 

Prendendo come riferimento la figura sopra, se il riempimento è da fare su un layer (raster) diverso da 
quello dove ci sono le altre superfici colorate, allora prima di procedere bisogna contrassegnare il layer con 
le superfici già colorate come layer di riferimento. Bisogna cioè selezionarlo e cliccare in alto nella Layer 
palette sull’iconcina con il faro Set as Reference Layer.  

Lo stesso si deve fare se ho delle lineart in un livello raster, se voglio tenere i riempimenti in un livello 
separato. 

 

 
Fig.  327 – Lineart raster = Reference layer 

 

 
Fig.  328 – Riempimento su un altro livello 

 

Se la superficie è racchiusa tra lineart vettoriali è obbligatorio fare i riempimenti su un altro livello, 
raster. Anche in questo caso però bisogna rendere il livello con le lineart un reference layer. 

 
Fig.  329 – Lineart vettoriali = Reference 
layer 

 

 
Fig.  330 – Riempimento su un altro livello 

 

Tuttavia il Close and Fill è uno strumento che sembra essere più adatto a colorare aree molto piccole, 
difficilmente raggiungibili con il classico secchiello; anche il manuale ne consiglia l’utilizzo in questi casi. 
Personalmente, nelle aree più ampie trovo difficoltà a utilizzarlo: mi sembra che quando ci sono diverse 
linee che si trovano nei pressi di una superficie da colorare, lo strumento vada un po’ in confusione e non 
funzioni. 
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Contour line paint 

Nella barra degli strumenti è presente il Contour line paint, con questa icona:  . 
Questo è uno strumento di riempimento, ma la sua caratteristica è che se l’area da riempire ha il 

contorno di due colori diversi, automaticamente il riempimento viene creato con un gradiente cha va da 
uno dei due colori all’altro. 

 

 
Fig.  331 

 

 
Fig.  332 

 
Il Manuale dice che se le due linee colorate sono tracciate con l’antialias lo strumento potrebbe non 

funzionare. Ciò è vero, ma agendo sui parametri dello strumento, ad esempio aumentando il Color margin, 
si riesce a farlo agire ugualmente. 

Gradienti (Gradient) 

Un gradiente è un riempimento con due o più colori,  in cui si passa da un colore all’altro con un effetto 

più o meno sfumato. Se clicco sull’icona Gradient nella Tool palette, , appaiono nella Sub Tool diverse 
barre colorate con i gradienti proposti di default dal programma. In genere ne uso solo alcuni, Foreground 
to transparent e Foreground to background per lo più (da colore principale a trasparente e da colore 
principale a colore secondario), e loro inversi, ma ognuna di essi è modificabile e si possono aggiungere 
anche più colori. Va da sé che per utilizzare Foreground to transparent e Foreground to background bisogna 
prima selezionare, appunto, i colori con cui si vuole operare. 

Il gradiente differisce da un riempimento tradizionale (Fill): non rispetta i Reference layer e se si vuole 
riempire una zona circoscritta e non tutto il canvas  bisogna prima delimitare quella zona con una 
selezione. 

Come tutti i riempimenti, opera su un livello raster; nella Tool property è possibile specificare, alla voce 
Where to create, se colorare nel livello –raster appunto- in cui si sta lavorando o se creare un nuovo livello 
dedicato. 

A disposizione ci sono tre tipi di gradiente: uno lineare (Straight line) e due radiali (Circle ed Ellipse), 
selezionabili nell’opzione Shape. Non so perché abbiano messo sia Circle che Ellipse, dato che usando Ellipse 
e tenendo premuto Shift si ottiene un gradiente di tipo Circle; forse avanzava posto per un’icona… 

 

 
Fig. 333 

Per riempire con un gradiente, si seleziona una delle Shape e si traccia una linea con il cursore, che nel 
caso di Circle e di Ellipse farà visualizzare il diametro del cerchio o l’asse maggiore (poi orientabile) 
dell’ellisse. 

Al di sotto della voce Shape è presente la voce Edge process, che permette di impostare il 
comportamento del riempimento oltre la lunghezza della linea tracciata col cursore. 

 

 
Fig. 334 

Le varie opzioni sono: 
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Do not repeat tutta la selezione viene riempita con il gradiente, anche oltre la lunghezza della linea (o il 
diametro/asse maggiore) tracciata con il cursore. Prima del punto di partenza della linea 
il riempimento sarà con il colore di partenza del gradiente, dopo il punto il finale della 
linea sarà con il colore finale del gradiente; 

 

 
Fig. 335 

 
 

Fig. 336 

 
Repeat  oltre a punto finale della linea il gradiente verrà ripetuto, mantenendo la lunghezza della 

linea come unità di ripetizione; 
 

 
Fig. 337 

 
 

Fig. 338 

 
Reverse  oltre a punto finale della linea il gradiente verrà ripetuto, mantenendo l’unità di 

ripetizione ma alternando il verso di riempimento; 
 

 
Fig. 339 

 
 

Fig. 340 

 
Not Draw il gradiente non viene ripetuto e la sua estensione sarà pari alla lunghezza della linea 

tracciata.   
      

 
Fig. 341 

 
 

Fig. 342 

 
Un’altra voce presente nella Tool property è Dithering (se non è visibile vuol dire che non è attivato nella 

Sub Tool Detail palette), che permette di “ammorbidire” il passaggio da un colore all’altro introducendo un 
“rumore” elettronico. 

Gradienti e Mappe gradiente 

In CSP esistono due strumenti che utilizzano il nome gradiente: i gradienti (Gradient), appunto, e le 
mappe gradiente (Gradient map). Pur condividendo parte del nome, sono due tipi di strumenti diversi, non 
è immediato l'uso delle Gradient map se non si ha già idea di cosa siano. Le Gradient map fanno parte dei 
Correction layer. 

Correction Layer 

Un Correction layer è un livello che serve a modificare la luminosità generale dell’immagine (brightness), 
la tonalità (hue), la saturazione (saturation), la luminosità di un colore (luminosity) o attuare la 
posterizzazione (posterization) dei livelli sottostanti. Si crea a partire da un livello, cliccando su questo col tx 
dx > New Correction Layer (oppure dal menù Layer > New Correction Layer) e scegliendo una delle varie 
opzioni. 

 

Il vero utilizzo di un Correction layer non è una mera sostituzione diretta dei colori, ma una correzione, 
appunto (yeee, ci sono arrivato anch’io!), dell’aspetto generale dell’immagine o di una sua parte, peraltro 
con il vantaggio di non modificare permanentemente i pixel dell’immagine stessa: se non voglio più 
quell’aspetto, tolgo l’occhiolino al livello e la modifica scompare.  

Nella pratica, si crea un New Correction Layer, si sceglie di che tipo lo si vuole e gli si cambia il metodo di 
fusione in modo che venga, appunto, unito, mescolato con il livelli sottostanti. 

 

Ho scoperto il corretto utilizzo dei Correction layer grazie a questo video di Francesca Urbinati, che mi ha 
letteralmente aperto gli occhi su di essi. Faccio partire il video nel punto in cui lei comincia a spiegarne 
l’utilizzo; attenzione: Francesca utilizza Photoshop, ma quello che fa si applica perfettamente anche a CSP. 
Attenzione 2: nel video, Francesca dà molto spazio alla parte disegnata, senza parlarci sopra. Dato che il 
video è velocizzato (rallenta quando dà le spiegazioni) e fatto su un programma che non è CSP, può 

https://youtu.be/VC1HxzA7HcE?t=350
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sembrare poco comprensibile, ma non appena Francesca chiarisce quello che vuole fare e lo spiega, i dubbi 
cadono. In questo caso, più che le azioni sono i concetti che aiutano la comprensione. 

Gradient map 

Ad esempio, mi sono imbattuto nelle Gradient map perché stavo cercando di dare a un dettaglio la 
sensazione che fosse realizzato in metallo. Poi ho lasciato perdere, ma dopo aver provato a ottenere 
l’effetto desiderato mi son detto che forse qualcuno ha già creato un riempimento gradiente che simula i 
riflessi metallici, quindi sono andato sull’Asset e ho cercato gradient. Ho trovato un paio di effetti che 
potevano andare e li ho scaricati. Uno dei due sono riuscito a trascinarlo nello strumento Gradient, l’altro 
proprio no. Ho controllato, riscaricato, ma nulla. Ho letto meglio e ho scoperto che non si trattava di un 
gradiente, ma di una mappa gradiente (almeno così riportava la traduzione dal giapponese).  

Ho cercato sul Manuale ed effettivamente esiste il Gradient map. In pratica si tratta di un Correction 
layer che, sulla base del valore tonale in un’immagine (ombre, mezzitoni, luci; ossia quanto sia chiaro o 
scuro un punto) associa i colori presenti nella mappa gradiente. Viene creata cioè una associazione univoca 
tra un valore tonale e un colore, e quel dato valore tonale nell’immagine viene fatto corrispondere con un 
dato colore della Gradient map (dato che il valore tonale è una caratteristica indipendente dal colore, 
l’applicazione della Gradient map funziona sia con immagini in scala di grigio che con immagini a colori).  

 

Come detto però, l’utilizzo dei Correction layer e quindi delle Gradient Map non è però quello che 
credevo fino alla v. 8 di questi appunti (cfr. le versioni precedenti), in cui pensavo che l’associazione tra 
valore tonale dell’immagine e colori associati dalla ramp della Gradient map si dovesse utilizzare così 
com’è, cioè una pura sostituzione dei valori dell’una coi valori dell’altra. Cioè, si possono utilizzare anche 
così e se questo è risultato che si cerca, va benissimo! Così facendo però si possono ottenere dei risultati 
non molto sensati e/o non voluti, come nell’immagine seguente (effetto Predator!). 

 

 
Fig.  343 – Una Gradient map e l’attrice Doris Duranti 

In teoria, avendo un'opportuna Gradient map si può anche colorare un disegno in scala di grigi, o una 
foto in bianco e nero, ma dubito che il processo risulti alla fine veloce, per via degli aggiustamenti che  si 
dovrebbero fare alle corrispondenze (e che dire di valori tonali uguali da far interpretare come colori 
differenti?). EDIT > conferma di ciò mi viene data da una risposta di Federica di Meo a questo post nel 
gruppop FB : “Non è solo un modo per tonalizzare un'immagine finita, ma sono uno strumento iper potente 
per la colorazione in scala di grigi! usando un gradiente diverso per ogni parte del disegno (uno pelle, uno 
capelli, uno per ogni macro"colore") non si vede la differenza con una immagine colorata da zero a mano”. 
Quello che indica Federica, a cui io non avevo pensato, è di utilizzare non una sola mappa gradiente, ma 
tante mappe gradienti quanti sono le parti da colorare. 

https://www.facebook.com/groups/mangastudioitalia/permalink/5163352487109043
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Fig.  344 

Quando seleziono un gradiente (che andrà a prendere posto nell’anteprima, in “Color bar”), poi posso 
andarlo a modificare agendo sui nodi (nodes) al di sotto di essa. I nodi possono essere spostati, aggiunti o 
rimossi e gli si può anche cambiare colore (seleziono un nodo e gli cambio colore, in “Node color”), per 
creare dei nuovi effetti. Se non si vuole rovinare un gradiente con le modifiche, si può prima duplicarlo, 
all’interno del set, cliccandoci sopra col tasto destro e selezionando Duplicate Gradient (O). Alcuni set sono 
di sola lettura e non permettono alcune azioni sui gradienti. 

Ricordare che i nodi sono dei precisi punti che corrispondono ai valori tonali dell’immagine; nello 
specifico, in un gradiente con soli due nodi, uno all’estremo sinistro e l’altro all’estremo destro della Color 
bar, quello a sx rappresenta i valori più scuri dell’immagine, le ombre diciamo, mentre quello a dx i valori 
più chiari, cioè le luci. L’applicazione della Gradient map attribuisce le sfumature del gradiente ai valori 
tonali corrispondenti 

 

Lavorando con le selezioni si possono isolare le varie parti del disegno per ottenere effetti differenti in 
zone differenti. Devo fare delle prove, ma penso che anche lavorando con i livelli e limitando gli effetti ai 
livelli desiderati e non ad altri (es. con Clip to layer below) si possa agire separatamente.  

 

Le Gradient map si possono trovare a disposizione nell’Assets e quindi essere scaricate e  importate, ma 
il loro utilizzo è un po' arzigogolato; per  utilizzare una Gradient map scaricata dagli Assets: 

- vado sul layer dell’immagine, tasto destro > New correction layer > Gradient map…;  
- si apre la finestra di dialogo; clicco sulla chiave inglese > Add gradient set… ;  
- si apre la finestra dei materiali, scelgo il materiale scaricato e do l’ok. Essendo un set di materiali 

(ossia un insieme di gradienti da poter applicare), scelgo una dei gradienti di colori, poi clicco sulla 
seconda icona da sinistra sotto il set, una quadratino con la freccia, oppure clicco due volte 
velocemente sul gradiente. L’immagine si colora con la mappa gradiente selezionata. 

- Applico la Gradient map selezionata, cliccando OK. 
 

Dato che le Gradient map fanno parte dei Correction layer, il loro utilizzo non si esaurisce nella loro 
scelta e applicazione: servono a modificare quello che già c’è, non a sostituirlo. Beninteso, come detto nulla 
vieta di usarle come si vuole; per sfruttarle come Correction layer, una volta applicata la Gradient map 
scelta, è possibile cambiare il Blending mode del livello che la ospita (Overlay in genere, o quello che si 
vuole) e giocare con il valore di opacità del livello stesso. Quanto? Dipende da ciò che si vuole ottenere e 
dal proprio stile (vedi immagine successiva). 
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Fig. 345 – Immagine originale 
(ovviamente non è mia!) 

 
Fig. 346 – Applico una Gradient Map 

 
Fig. 347 – Modifico il Blending mode el’opacità 

 

 
Fig. 348 - Immagine finale: 
Superciuk! 
 

Le due immagini non 
sembrano molto diverse, 
ma questo dipende da 
quanto voglio intervenire 
sull’immagine iniziale. La 
cosa migliore è tentare. 
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Mesh transformation 
Qualche tempo fa girava su Facebook una campagna di sconti per l’acquisto di CSP, illustrata con la 

seguente immagine: 
 

 
Fig.  349 

Come si può vedere il mantello e la tuta del personaggio hanno dei particolari che seguono le curvature 
dei volumi, creando una sensazione di tridimensionalità. Non mi spiegavo come l’illustratore avesse 
ottenuto questo effetto, ho provato a chiedere nel gruppo Facebook e prontamente mi hanno illuminato: la 
soluzione è utilizzare Edit > Transform > Mesh transformation… 

Ecco la discussione: 
 

https://www.facebook.com/groups/mangastudioitalia/permalink/1943837015727289/ 
 

Matteo Paolelli  
Ho una curiosità: da alcuni giorni vedo quest'immagine su FB, associata a uno sconto di CSP. La tuta e 

il mantello hanno dei decori che si ripetono, dei pattern esagonali, che seguono i volumi del 
personaggio. Escludendo che chi ha disegnato questa immagine si sia costruito una griglia prospettica a 
n-mila punti di fuga, non riesco a capire come si possa ottenere un rivestimento simile: è possibile 
texturizzare così in CSP? 
 

Patrizia Mandanici 
Certo, usando il mesh transform 

 

Patrizia Mandanici 
https://www.facebook.com/groups/mangastudioitalia/permalink/1834692199975105/ 

 

Gabriele Moretti  
mah, io ci ho provato ma su una superficie così vasta a risoluzione 600 dpi il Mac mi manda un accidente ogni tre 

pixel :D 
 

Fabio D'Auria  

https://www.facebook.com/groups/mangastudioitalia/permalink/1943837015727289/
https://www.facebook.com/toongsteno?fref=gs&__tn__=%2Cd%2AF%2AF-R&eid=ARCLZBszdaSC9Lh-PH4gME8JJgnfaJL46mzjmyOD82XLpRxCsL3aPxJaRq_RF0nUc3P_LCpbwE6vdV_8&tn-str=%2AF&dti=509226542521684&hc_location=group_dialog
https://www.facebook.com/patrizia.mandanici
https://www.facebook.com/patrizia.mandanici
https://www.facebook.com/groups/mangastudioitalia/permalink/1834692199975105/?hc_location=ufi
https://www.facebook.com/IlmoRetty
https://www.facebook.com/cOMIFAB
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falla a pezzi, così puoi anche gestire "fughe" diverse. 
 

Gabriele Moretti  
e non si vedono le giunte? hai degli esempi da farmi vedere? 
 

Fabio D'Auria  
Col disegno qui postato, il mantello è ovviamente una texture unica, ma per il braccio ad 

esempio puoi dividere la texture in deltoide/braccio/brachioradiale. 
 

Gabriele Moretti  
ah, ok... no io parlavo della superficie del mantello, che è grossina. Il mio mac non ce la fa. Ok, è 

vecchiotto, ma son povero :D 
 

Fabio D'Auria  
è la ram che gestisce queste cose 
 

Gabriele Moretti 
sì, e infatti ha 8 giga. Una volta erano UN SACCO di ram, oggi ce l'ha il navigatore integrato della 

Panda. 
 

Stefano Azzalin  
Il problema è che questo genere di cose da Photoshop, Clip Studio le gestisce veramente male 

ed è lentissimo. Poco importa la ram, processore o scheda video: è semplicemente lento come la 
morte di suo.  

 

Matteo Paolelli 
Grazie Patrizia, non avrei saputo cosa cercare. Si sta sempre a imparare  
 

Lorenzo Bovo  
per ordini supremi, lavoro a 1200dpi... ma il problema si può in qualche modo aggirare: 

1) ti crei una selezione del mantello (in questo caso specifico), parecchio abbondante, con lo 
strumento Lasso 

2) importi un pattern e te lo regoli di conseguenza in termini di scala. 
A questo punto ti ritrovi un livello pattern con maschera di livello. 

3) rasterizzi il pattern 
4) click destro sulla maschera di livello>selection from layer>create selection 
5) Con la selezione attiva, cancelli l'esterno alla selezione cliccando su "Clear Outside Selection" 

Ora ti ritrovi il tuo pattern ridotto all'area del mantello, e lo puoi deformare con più agilità e 
precisione, con il comando Mesh Transform. 

Ben vengano nuovi suggerimenti! :) 
 

Matteo Paolelli  
proverò quanto prima :) 
 

Cristiano Gori  
Lorenzo Bovo ti conviene però lasciare del pattern al di fuori del mantello, in modo da poter 

tirare il lenzuolo senza creare buchi ai bordi. 
 

Cristiano Gori  
Comunque lo strumento transform è troppo limitato. 
 

Lorenzo Bovo  
Cristiano Gori si, certo... infatti ho scritto di creare una selezione parecchio abbondante :) 

 

  

https://www.facebook.com/IlmoRetty
https://www.facebook.com/cOMIFAB
https://www.facebook.com/IlmoRetty
https://www.facebook.com/cOMIFAB
https://www.facebook.com/IlmoRetty
https://www.facebook.com/ste.azza
https://www.facebook.com/toongsteno
https://www.facebook.com/lorenzobovo
https://www.facebook.com/toongsteno
https://www.facebook.com/cristiano.gori
https://www.facebook.com/lorenzobovo?hc_location=ufi
https://www.facebook.com/cristiano.gori
https://www.facebook.com/lorenzobovo
https://www.facebook.com/cristiano.gori?hc_location=ufi
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Il Mesh Transformation crea un reticolo con delle maniglie in una selezione, muovendo le quali è 
possibile distorcere il contenuto della selezione stessa. Se nel livello è presente solo l’oggetto che si vuole 
distorcere, non è necessario creare prima la selezione, basta attivare il Mesh Transformation. 

Il numero di maniglie puo essere modificato nella Tool property quando appare il reticolo. 
 

 
Fig.  350 A – Disegno un 
oggetto 

 

 
B - Creo una selezione 

 

 
C - Clicco su Mesh 
Transformation (Attenzione: 
icona non presente di 
default sul Selection 
Launcher) 

 

 
D - Appare il reticolo 

 
 

   
E -  Se serve modifico  
nella Tool property il 
numero delle maniglie 

 

 
F -  Il reticolo modificato 

 

 
G - Sposto le maniglie per 
modificare il contenuto 
della selezione 

 

 
H -  Do l’OK e ottengo 
l’oggetto trasformato 

Liquify 
Dalla v. 1.11.6 è stato aggiunto lo strumento Liquify. 
Liquify (= fluidifica) serve a distorcere localmente il disegno, cioè una parte limitata della sua superficie; 

non agisce modificandolo tutto. Come suggerisce il nome, sembra "sciogliere" localmente la trama del 
disegno permettendo, usato correttamente, di aggiustarlo, ad esempio spostando o modificando la 
grandezza dei particolari. 

Funziona su livelli raster ma anche sui selection layer e sulle layer mask. 
 

Nella Tool property si può selezionare il tipo di distorsione da applicare con il Liquify: 
- Push, spingi; 
- Expand, espandi; 
- Pinch, pizzica; 
- Push Left, sposta a sinistra; 
- Push Right, sposta a destra; 
- Twirl Clockwise, attorciglia in senso orario; 
- Twirl Anti-Clockwise, attorciglia in senso antiorario 

 

Non inserisco delle immagini di esempio per descrivere ogni effetto, ma rimando ai brevi video, molto 
efficaci, che si trovano in questa pagina, che invito a visitare. 

 

Oltre alla Brush Size, che definisce l'area di azione dello strumento, Liquify ha altri due parametri 
modificabili, Strength e Hardness, e una casellina spuntabile, Only refer to editing area. 

Strength è la forza con cui viene applicato l'effetto, più è alta è e più è marcato; 
Hardness è la durezza, più è alta e più l'effetto è visibile vicino al bordo dello strumento. 

https://tips.clip-studio.com/en-us/articles/5811
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 Infine, quando la casellina Only refer to editing area è spuntata, gli effetti dello strumento al di fuori 
della sua area sono minimi e ciò che sta al di fuori viene coinvolto marginalmente; se invece non è 
spuntata, allora anche quello che sta al di fuori dell'area dello strumento viene coinvolto nella distorsione. 

Per chi ha iniziato a usare CSP direttamente direttamente con la v. 1.12.0 (quindi una versione 

successiva alla 1.11.6),  Liquify  si trova nella Tool palette come strumento a sé stante.  
Chi invece ha fatto un’upgrade del programma da versioni precedenti, trova Liquify nello strumento 

Blend, quello con due gocce affiancate . 
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Strumenti utili 

Pick screen color 

Nel menù Edit è presente una coppia di strumenti che possono essere utili: Pick screen color (ex Obtain 
screen color) e Hide windows and pick screen color (ex Obtain screen color by hiding windows). Facendo una 
ricerca sui manuali delle vecchie versioni ho scoperto che questi strumenti esistono almeno dalla versione 
di Manga Studio 5.0.6. 

Con Edit > Pick screen color ottengo un contagocce che preleva il colore ovunque lo posiziono sullo 
schermo. Obtain screen color by hiding windows è quasi uguale, ma rende temporaneamente invisibile la 
finestra del programma, rendendo possibile la cattura del colore da ciò che c’è sul desktop. 

Sono quindi dei color picker che permettono di prendere un colore anche da un’area esterna a quella del 
programma.   

Contagocce (Eyedropper) 

Lo strumento Eyedropper ha due Sub Tool: Color picker e Pick up color from layer. 
Color picker ha la classica funzione del contagocce: se sono sopra a un punto colorato, prende quel 

colore. 
Pick up color from layer prende invece il colore del punto colorato nel layer selezionato.  
 Faccio un esempio. Considero un punto nel Canvas che nel Layer 1 (livello che sta sotto) ha un oggetto 

verde e nel Layer 2 (livello che sta sopra) ha un oggetto rosso. Se è selezionato il Layer 1 (quello sotto), 
allora con Color picker prendo comunque il colore rosso (il colore del livello superiore), mentre con Pick up 
color from layer prendo il colore verde (il colore del livello selezionato). 

 

 
 
 

È selezionato il livello 1 
 

Con Color picker 
 

Con Pick up color from layer 
Fig.  351 - Eyedropper 

Sub View palette 

Per campionare colori da una immagine di riferimento, può 
essere utile importarla nella Sub View palette. Questa palette si 
trova, di default, dietro al Navigator. Eventualmente la si può 
richiamare anche da Window > Sub View.  

Dalla palette si può importare un’immagine di riferimento, 
che apparirà come miniatura, tramite l’icona Import, a forma di 
cartellina. Successivamente selezionando l’icona a contagocce 
(Switch to eyedropper automatically), passando sopra alla 
miniatura è possibile catturare il colore del punto sottostante. 

Nella versione 1.11.9 (febbraio 2022) è stato introdotto 
l’cona Open image on canvas, a fianco di Import,che permette 
di aprire il file che si vede nella Sub View in un canvas, per 
poterlo modificare. Una volta salvato, le modifiche saranno 
visibili immediatamente anche nella Sub View. 
 

 
Fig.  352 - Sub View palette [la vignetta è 
tratta da I classici del Fumetto di Repubblica 
– Serie Oro – n. 60 - Tiramolla] 
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Auto Action 

Le Auto Action permettono di registrare più operazioni insieme e di replicarle a richiesta, anche su un 
documento diverso da quello in cui vengono create. 

Per creare una nuova Auto Action selezionare la palette Auto Action che si trova “dietro” la Layer 
palette: 

 

 
Fig.  353 – Auto Action palette (puntino rosso) 

Poi Create new auto action set: 
 

 
Fig.  354 

  
 

quindi dare un nome (in questo caso “Prova”).  
 

 
Fig.  355 

 
  
 

Viene creato il nuovo set e appare l’etichetta della prima Auto Action: dare un nome appropriato anche 
a questa. 

 

 
Fig.  356 

A questo punto bisogna premere il pallino rosso e tutte le azioni (command) che verranno eseguite 
verranno registrate. Ripremere il punto rosso (che sarà nel frattempo diventato quadrato) per concludere 
la registrazione. 

Per eseguire le stesse azioni automaticamente, anche su un altro progetto, basterà selezionare l’Auto 
Action desiderata e poi lanciare l’esecuzione premendo il triangolino (Start to play auto action). 
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Il set di azioni è quindi un insieme di Auto Action formate a loro volta da vari command. 
Le Auto Action di un set non vengono eseguite una di seguito all’altra, viene eseguita solo l’Auto Action 

selezionata. Il raggruppamento in un set viene fatto per comodità, e le varie Auto Action possono essere 
spostate o copiate anche in un altro set. 

 

Per eliminare un set, selezionarlo e poi cliccare nell’angolo in alto a sinistra, per fa apparire il menù. Da 
qui selezionare Delete set… 

 

 
Fig.  357 

Per ulteriori informazioni cercare nel Manuale Auto Action Palette. 
 

Timelapse 

Dalla versione 1.10.5 è possibile registrare un video in timelapse mentre si sta disegnando. È possibile 
registrare un nuovo lavoro dall’inizio oppure cominciare a registrare a lavoro già cominciato. 

Nel primo caso bisogna spuntare la casellina Record timelapse nell’angolo in basso a sinistra nella 
finestra New che si apre quando si crea un nuovo documento (32 in Fig.  38). Nel secondo caso selezionare 
File > Timelapse > Record timelapse.  Il timelapse registra solo il Canvas, non tutta la finestra di CSP. Perciò 
non è molto utile se si vogliono fare dei video didattici in cui si vogliono far vedere passo passo i vari 
strumenti utilizzati. Per mostrare l'evoluzione di un proprio lavoro invece è ok. 

Quando si è completato il lavoro e si vuole esportare il video, andare in File > Timelapse > Export 
timelapse e dalla finestra che appare scegliere le opzioni di esportazione. Il video esportato ha estensione 
.mp4. 

Attenzione: il timelapse viene incorporato nel file .clip, facendone aumentare le dimensioni.  
Se si salva il lavoro viene salvato anche il timelapse, la cui registrazione riprende una volta che si 

riprende a lavorare su quel file.  La cosa interessante è che i tempi morti non vengono registrati. 
Quando si è esportato il video, se si vogliono ridurre le dimensioni del file andare su File > Timelapse e 

togliere la spunta a Record timelapse. Si apre una finestrella: se si conferma, la registrazione viene 
cancellata, senza possibilità di poterla recuperare. 
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3D 
- Paragrafo in lavorazione - 

 

CSP ha nella propria libreria di materiali numerosi oggetti 3D. Questi possono essere trascinati nel 
Canvas, manipolati e utilizzati come riferimento per disegnare. Personaggi, sfondi, oggetti ecc. possono 
anche essere scaricati dagli Assets di Clip Studio. Non solo, ma CSP supporta anche file come il diffuso .obj, 
per cui se si è in grado di realizzare un modello in un programma 3D che esporta in .obj, poi lo si può 
importare CSP. 

È possibile poi utilizzare anche Clip Studio Modeler per importare un oggetto 3D e configurarlo come 
materiale.  

Posizionare più oggetti in scena 

Per un progetto ho acquistato negli Assets i modelli 3D delle varie parti di una batteria (lo strumento 
musicale). Avevo bisogno però di avere le varie parti raggruppate in un unico oggetto, da muovere a 
piacimento per ottenerne le varie viste. Cercando soprattutto nel gruppo Facebook ho capito che la 
gestione del 3D di CSP non è delle più agevoli e bisogna armarsi di un po’ di pazienza per ottenere i risultati 
desiderati. Ho trascinato nel Canvas il primo oggetto, creando un nuovo livello di tipo 3D, poi ho trascinato 
gli oggetti successivi: vengono tutti messi nello stesso livello ma apparentemente vengono disposti a caso.  

 

Per avere dei livelli 3D separati, dopo aver portato il primo oggetto in scena bisogna selezionare un 
livello non 3D prima di trascinare l’oggetto 3D successivo: trascino il primo oggetto, che crea un livello 3D > 
mi sposto su un livello non 3D > trascino il secondo oggetto, che crea un secondo livello 3D > mi sposto su 
un livello non 3D > trascino il terzo oggetto… ecc. 

 

I vari oggetti vanno trascinati il più vicino possibile alla posizione che avranno alla fine e bisogna inoltre 
cercare di “ragionare in 3D”, cioè capire in qualche modo come occuperanno lo spazio a disposizione una 
volta sul Canvas. Col mio primo esperimento ho messo più o meno in posizione le varie parti, salvo poi 
constatare che in prospettiva apparivano nella posizione corretta ma tentando di girarci attorno ho capito 
che alcune parti erano enormi e molto distanti, e ho dovuto spostarle e ridimensionarle più volte per 
ottenere ciò che volevo. Poi ho scoperto una funzione molto utile in questi casi, la finestra All sides view: da 
Windows > All sides view si può aprire una finestra divisa in quattro parti, in ciascuna delle quali è visibile la 
scena da un punto di vista diverso: di default da sopra (Top view), di fronte (Front view), dal lato destro 
(Right view) e in prospettiva (Perspective view). Gli oggetti si possono anche controllare da ciascuna di 
queste sotto-finestre, permettendo una gestione più agevole nel caso di più oggetti in scena. All sides view 
è disponibile solo nella versione EX. 

 

 
Fig.  358- Il modello dello scooter l’ho scaricato dagli Assets 
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Si potrebbe obiettare che, nell’immagine, nella finestra Rigth view in realtà si vede il lato sinistro dello 
scooter. Già, ma questo dipende da come è stato orientato l’oggetto dal suo ideatore al momento della 
costruzione. Nella barra sottostante ci sono alcuni controlli: la prima icona consente di selezionare quali 
sotto-finestre visualizzare.  

 

 
Fig.  359 

 

Manipolare gli oggetti 3D 

A proposito di controllo, quando un oggetto 3d viene trascinato nel Canvas, automaticamente appaiono 
due barre di comandi: una al di sopra dell’oggetto, con i comandi di colore azzurrino (Movement 
Manipulator); una al di sotto dell’oggetto, grigia con i comandi bianchi (Object Launcher). Se con il cursore 
tocco l’oggetto appare un terzo insieme di comandi, il Root Manipulator. Alcuni oggetti sono composti da 
più sotto-oggetti, ciascuno dei quali può avere un proprio Root Manipulator. Nell’immagine seguente si 
vedono tutti i controlli citati. 

 
Fig.  360 - La terna degli assi 3D: x= asse orizzontale, sinistra-destra, azzurrino; y= asse verticale, su-giù, verde; z=asse orizzontale, 
avanti-indietro, viola. 

Movement Manipulator 

Le prime tre icone rappresentano dei movimenti del punto di vista (PdV) che guarda l'oggetto. Sono dei 
"movimenti di camera": 
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1: Ruota. Ruotare e inclinare la scena  attorno all'oggetto; se sono presenti più oggetti la rotazione 
avviene attorno al primo oggetto messo in scena. 

2: Translate. Sposta il PdV in alto e in basso, a destra e a sinistra (movimento chiamato anche pan): se lo 
uso per spostare un oggetto, sposta tutta la scena 3D; 

3: Zoom. Avvicinamento o allontanamento del PdV. 
 

In alternativa, per questi movimenti è possibile utilizzare il mouse: 
 1: tenere premuto il tx sx per ruotare la scena; 
 2: tenere premuta la rotellina  per effettuare il pan; 
 3: tenere premuto il tx dx per fare lo zoom. 
O ancora, se si ha una tavoletta grafica, si può usare lo stilo, ma i movimenti variano a seconda delle 

impostazioni assegnate. 
 

Le successive icone agiscono sull'oggetto o su parti di esso (quando divisibile) e quindi consentono 
movimenti "fisici" nello spazio 3D: 

4: movimento sul piano di fronte al PdV: se lo uso per spostare un oggetto, lo muove nella scena 3D, 
tutto il resto resta fermo; 

5: rotazione del piano di fronte al PdV sull'asse verticale y o sull'asse orizzontale x, ovvero rotazione 
dell’oggetto nella scena; se non si trascina lungo uno di questi assi, si attiva una rotazione "libera"; 

6: rotazione dell'oggetto sul piano di fronte al PdV; 
7: ruota l'oggetto orizzontalmente nello spazio (quindi attorno all’asse verticale); 
8: muove l'oggetto nello spazio 3D; la componente orizzontale del trascinamento sposta l'oggetto a 

destra o a sinistra; la componente verticale lo sposta in profondità. 

Object Launcher 

9: seleziona l'oggetto 3d precedente; 
10: seleziona l'oggetto 3d successivo; 
11: Object List; mostra una lista di opzioni (contenute nel Sub Tool Detail) che possono essere 

attivate/disettivate; 
12: attiva una serie di PdV preimpostati da cui selezionare quello desiderato; 
13: posiziona la vista dell'oggetto (o una sua parte se è divisibile) al centro dello spazio 3D; 
14: porta l'oggetto a livello del suolo; 
15: se un oggetto è composto da più parti e queste sono state spostate, riporta tutto alle posizioni di 

default; 
16: se un oggetto è stato ingrandito o rimpicciolito, riporta le dimensioni a quelle di default; 
17: se un oggetto è stato ruotato, riporta la rotazione alla vista di default; 
18: un oggetto 3D può (non necessariamente però) essere visualizzato con diversi materiali applicati; 

questo pulsante consente la scelta del materiale; 
19: un oggetto 3D può (non necessariamente però) avere diversi layout; con questo pulsante si può 

scegliere quale; 
20: un oggetto 3D può (non necessariamente però) avere delle parti mobili rispetto alle altre; con 

questo pulsante si può scegliere una delle parti e con un cursore decidere l'entità dello spostamento 
rispetto alle altre (es. lo schermo di un laptop che può essere chiuso sulla tastiera o più o meno alzato 
rispetto a questa).  

Root Manipulator 

Consente di muovere, ruotare e scalare l’oggetto nello spazio: 
21, 22, 23: Movimenti lungo l'asse selezionato; 
24: se si riesce a beccarlo, consente il movimento lungo tutti gli assi; 
25, 26, 27: rotazione attorno all'asse del colore corrispondente; 
28: ingrandimento o rimpicciolimento. 
 

Se come oggetto 3D metto sul Canvas un manichino (= raffigurazione 3D di un essere umano) queste 
barre assumono un aspetto livemente diverso (a parte il Root Manipulator), mostrando nel caso del 
Movement Manipulator meno icone, e invece nel caso dell’Object Launcher più opzioni. 
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Se utilizzo la rotellina del mouse in un ambiente 3D, quello che ottengo è una variazione della lunghezza 
focale con cui sto osservando la scena e della distanza del punto di vista. Come risultato ho una variazione 
della prospettiva. Nella Tool property è possibile svincolare la variazione della lunghezza focale dalla 
posizione del punto di vista, togliendo la spunta a Perspective > Link camera advancing/retreating. 

Manichini 

- Piccole cose che sto scoprendo -  
È possibile utlizzare dei manichini tridimensionali come aiuto al disegno di personaggi: In Material > All 

materials > 3D > Body type si trova la libreria dei manichini; con lo stesso percorso ma in Pose si trova la 
libreria delle pose, che basta trascinare sul manichino per fargliele assumere. Le pose possono essere anche 
create dall’utente agendo sugli snodi del corpo del manichino; la posa creata può essere poi salvata tra i 
materiali.  Anche la “fisicità” del manichino può essere modificata, e così si può farlo dimagrire o ingrassare 
o si può variare la dimensione della testa  ecc. 

Quando si trascina un manichino sul Canvas al di sotto appare una serie di comandi tra cui quelli per 
salvare le pose create e per far variare i parametri fisici. È presente anche un interessante comando, il Pose 
Scanner, che facendo l’analisi di un’immagine di riferimento (presa ad esempio in rete) fa assumere al 
manichino la stessa posa della persona nell’immagine. Per far ciò si collega a un server della Celsys, per cui 
per funzionare serve la connessione a Internet. 

 

Esistono vari programmi che permettono di realizzare dei manichini che poi possono essere importati in 
CSP. Tra questi VDroid Studio (gratis), Make Human (gratis), Poser (a pagamento). 

Clip Studio Modeler  
Paragrafo in lavorazione 

Importare un oggetto .obj da CSM 

Creare un nuovo documento con New. Il programma chiede se creare un oggetto o un personaggio 
(Type of work). Sto creando un oggetto, quindi scelgo l’icona 3D Object; do l’ok con il pulsante Create 3D 
Object. Sulla destra del Canvas, trovo la finestra Object configuration: 

 

 
Fig.  361 

 clicco sull’icona con l’alberello, Node , e poi clicco l’icona Add from file . Seleziono l’.obj da 
importare e confermo con Apri. A questo punto posso registrarlo come materiale da File > Register as new 
material…; la libreria dei materiali in cui viene inserito è sempre la stessa, per cui dopo posso ritrovare 
l’oggetto importato in Material e utilizzarlo in CSP. 

Blender 

Blender è un programma di modellazione 3D gratuito, potente e open-source. 
Con Blender è possibile realizzare oggetti o intere ambientazioni in 3D e poi utilizzarle in CSP. Il limite, 

che io non ho purtroppo ancora superato, è dato dalla propria capacità di utilizzarlo.  
Sul gruppo Facebook Clip Studio Paint Italia si possono trovare numerosi tutorial per il suo impiego 

abbinato a CSP a opera di Luca Malisan, che mi sembra veramente un drago con questo programma.  

https://vroid.com/en/studio/
http://www.makehumancommunity.org/content/downloads.html
https://www.posersoftware.com/
https://www.blender.org/
https://www.facebook.com/groups/mangastudioitalia/
https://www.facebook.com/groups/mangastudioitalia/search/?query=malisan&epa=SEARCH_BOX


Appunti di Manga Studio/ClipStudioPaint   

220 

SweetHome 3D 

Esiste un programmino gratuito, Sweethome 3D (SH3D), che permette di disegnare una casa in maniera 
molto semplice e intuitiva. Si possono creare i muri, aggiungere i serramenti, la mobilia ecc. Per me è stato 
molto utile in passato per aiutarmi a visualizzare la casa mentre era in costruzione (e quindi a migliorare i 
rapporti con il piastrellista, l'idraulico ecc.  ). Mi sono chiesto se fosse possibile utilizzarlo per creare viste 
dell'interno di abitazioni da utilizzare in CSP, e ho scoperto che si può fare. SH3D esporta in .obj, che si può 
importare in CSP. Sebbene non sia ancora abile a manovrare il 3D in Clip, mi sembra funzionare.  

Per esportare in .obj da SH3D: menù Vista 3D > Esporta in formato OBJ…  

http://www.sweethome3d.com/it/?fbclid=IwAR1_FbUq8TSoKr026z7WwSP8RMuQaTPdWTLluLFY4727VThygbFmSe2MSHU
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Trasferire o ripristinare le impostazioni del programma 
Devo ripristinare il programma dopo aver dovuto formattare il PC o devo trasferire le impostazioni da un 

pc a un altro. Il problema è particolarmente sentito ad esempio se si hanno un sacco di pennelli modificati o 
creati da zero, perché vorrebbe dire ricaricarli uno a uno dopo aver reinstallato il programma.  

Si può fare nei modi illustrati di seguito. 

Copia della cartella CELSYS 

Copiare le impostazioni personali su un altro PC (Windows) 
Articolo originale qui. 
 

Le impostazioni e i materiali di CSP possono essere trasferiti manualmente, cartella a cartella, su un altro 
PC. Ciò che segue riguarda il trasferimento delle impostazioni tra due macchine che hanno Windows come 
OS. A questo link c’è la procedura per MacOS (pagina in inglese). 

Se si vogliono trasferire le impostazioni tra macchine che hanno OS diversi utilizzare il servizio Cloud di 
CSP. 
 

1) Fare un backup della cartella delle impostazioni utente di CSP 
 

Passo 1 
- Versione 1.10.13 o successive di CSP 
Assicurarsi di avere la cartella CELSYS in questo percorso: 
C:/Utenti/NomeUtente/AppData/Roaming/CELSYSUserData/CELSYS 
(o, se Win in inglese,  C:/Users/Username/AppData/Roaming/CELSYSUserData/CELSYS) 
 

Nota: se si è effettuato l’upgrade da una versione precedente alla 1.10.13 e non si è 
spostata la cartella, guardare la parte relativa alla versione 1.10.12 e precedenti (tra qualche 
riga). 

 

Nota: la cartella AppData è una cartella nascost. Per renderla visibile, in Esplora file 
(Explorer) andare su Visualizza (View) e mettere la spunta a Elementi nascosti (Hidden files). 

Per entrare direttamente in AppData/Roaming, sulla barra degli indirizzi di Esplora File 
(Explorer) digitare: %appdata% 

 

- Versione 1.10.12 o precedenti di CSP 
Assicurarsi di avere la cartella CELSYS in questo percorso: Questo PC/Documenti 
(o, se Win in inglese, This PC/Documents) 
 

Passo 2 
Chiudere tutti i programmi Clip Studio e copiare la cartella CELSYS su una chiavetta USB o 

un Hard Disk esterno. 
 

Nota: assicurarsi che la dimensione della cartella copiata sia la stessa della cartella 
sorgente. Se le dimensioni non corrispondono, la copia potrebbe risultare incompleta. In 
questo caso, cancellare la copia della cartella nel supporto esterno e ripetere la procedura. 

 
Precisazione: CSP ha una posizione predefinita dove registra i materiali (Clip Studio's Materials Location): 
C:\Users\Username\AppData\Roaming\CELSYSUserData\CELSYS\CLIPStudioCommon 

La si può vedere in CS da: 
 CS > icona ingranaggio in alto a destra > Location of Materials…   

*in CS vedo lo slash ,“/”, come “¥”. Non credo sia preoccupante, dato che funziona; credo sia solo un 
problema di visualizzazione: se si copia la stringa e la si incolla, ad esempio, in un documento di testo, 
torna lo slash]. 

 

Se si è cambiata la posizione dei Material 
Se si è cambiata la posizione dei Material dalla posizione predefinita, copiare nella 

posizione esterna (chiavetta o hard disk esterno) anche la cartella CLIPStudioCommon. 
 

[Qui non capisco bene, perché ClipStudioCommon è una sottocartella della cartella CELSYS appena 
vista. Quindi se copio CELSYS in teoria dovrei copiare di già anche CLIPStudioCommon. 

https://support.clip-studio.com/en-us/faq/articles/20190152?fbclid=IwAR0xRBWwed6hWtTO__RWeHoz9yPAGyPAyK89AUpLVlS7njXwTj-HBfc8NWQ#8202a63b
https://support.clip-studio.com/en-us/faq/articles/20210088
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A naso, penso che per “se si è cambiata la posizione di un materiale…” intenda “se si è cambiata la 
posizione della cartella CLIPStudioCommon”, cioè se si modifica il percorso appena visto. Non lo so; nel 
dubbio meglio non cambiare percorso ai materiali. 

Credo che il dubbio nasca dal fatto che l’articolo parla di UN materiale, al singolare (“If the storage 
location of a material has been changed”), mentre probabilmente dovrebbe riferirsi ai materiali in senso 
generale. Ho imparato a diffidare dell’inglese della Celsys…] 

 

2) Installare CSP su un nuovo PC 
Scaricare CSP (da qui) e installarlo sulla nuova macchina. Evito i dettagli di installazione. 

 

3) Copiare le impostazioni precedentemente salvate dal vecchio PC sul nuovo 
 

Passo 1 
Nel nuovo PC chiudere tutti i programmi Clip Studio, se aperti; 

 

Passo 2 
Nel nuovo PC, spostare la cartella  CELSYS da: 

C:/Utenti/NomeUtente/AppData/Roaming/CELSYSUserData/    [cioè la posizione vista 
prima] 

al desktop.  
Se non si trova nel percorso indicato, lanciare CSP e CS affinché venga creata 

automaticamente, dopodiché chiudere i programmi. 
Se si sta utilizzando una versione precedente alla 1.10.13 la cartella CELSYS da spostare sul 

desktop si trova nella cartella documenti (ometto qui gli analoghi percorsi nel caso si stia 
utilizzando l’OS in lingua inglese). 

 

Passo 3 
Dopo aver spostato la nuova cartella CELSYS dal percorso originale al desktop, copiare la cartella 

CELSYS di backup, cioè quella del vecchio PC, creata al punto 1), e incollarla nel percorso: 
C:/Utenti/NomeUtente/AppData/Roaming/CELSYSUserData/  
ripristinare cioè la situazione: 

 C:/Utenti/NomeUtente/AppData/Roaming/CELSYSUserData/CELSYS, solo che la cartella 
CELSYS nel nuovo PC è ora quella copiata dal vecchio. 

 

NOTA:  
Assicurarsi di rimpiazzare la cartella anziché sovrascriverla, poiché la sovrascrittura può 

causare il non perfetto allineamento.  
Quindi, ripetendo: spostare la cartella CELSYS del nuovo PC dal percorso originale a un'altra 

posizione (es. desktop) e al suo posto, nel percorso originale, incollare la cartella CELSYS 
copiata dal vecchio PC. 

 

Scegliere la posizione dei Material 
Dopo aver completato i passaggi precedenti, copiare la cartella CLIPStudioCommon nel 

nuovo PC nella stessa posizione dell’originale: 
Ad esempio, se si è spostata la cartella originale dal disco D nella cartella “A”, creare una 

cartella “A” nel disco D del nuovo computer, e incollarci dentro la cartella CLIPStudioCommon. 
Se il nuovo PC ha una configurazione differente da quello vecchio, seguire i seguenti 

passaggi. 
1. Copiare le cartelle Document e Material che sono all’interno della cartella 

CLIPStudioCommon precedentemente copiata dal vecchio PC e incollarle in CELSYS > 
CLIPStudioCommon nel nuovo PC. 

2. Cancellare la cartella Preference in CLIPStudioCommon del nuovo PC 
 

4) Applicare le impostazioni personali sul nuovo PC 
 

Passo 1 
Lanciare CS (solo CS!) e attendere il suo caricamento. 

 

 
 

https://www.clipstudio.net/en/dl
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Passo 2 
Una volta caricato, cliccare sull’ingranaggio in alto a destra > Maintenance Menu > Organize 

Materials e attendere il completamento del processo. Dopodiché si potrà usare CSP nel nuovo 
PC con le stesse impostazioni del vecchio. 

 

Note addizionali 
Se il Virtual memory path è cambiato 

Se il percorso della memoria virtuale, in File > Preferences > Performance > Virtual memory path  è 
stato cambiato nel vecchio PC, si potrebbero verificare dei comportamenti inaspettati una volta che le 
impostazioni sono trasferite al nuovo PC. 

In questo caso, seguire i seguenti passaggi dopo aver completato il punto 4) 
1. Lanciare CSP e andare in File > Preferences 
2. Andare in Performance e impostare  Virtual memory path sul percorso di default, C:/[Boot 

disk] 
3. Dare l’OK 

Utilizzare il cloud di Clip Studio: fare un backup  
[  attenzione, Clip Studio, NON Clip Studio Paint, vedi qui] 

- Chiudere Clip Studio Paint e avviare Clip Studio, effettuare il LogIn; 
- a fianco del proprio nome c'è il simbolo di una nube (cloud): cliccarlo per accedere al servizio di backup 

nella cloud di CS, che ha uno spazio di 10 Gb; 
- ora, secondo le indicazioni riportate qui, si apre una finestra con questi blocchi: 

 

 
Fig.  362 

- Cliccare su "Back up app settings now" il servizio si attiva e comincia a trasferire i dati sulla cloud; 
- Al termine procedere con la formattazione del pc e reinstallo CSP (e CS); 
- Apro  CS, effettuo il LogIn, clicco sulla nuvoletta e poi su Restore app settings. [-> Testato: funziona] 

 
La prima volta che si effettua il backup l’operazione richiede molto tempo, in particolar modo se si 

hanno molti materiali, molti pennelli ecc. Dalla volta successiva il processo è quasi istantaneo, dato che si 
limita ad aggiornare solo ciò che è stato modificato [Non uso questa utility così  spesso da capire se questa 
affermazione è ancora valida; ho fatto un backup dopo diverso tempo dall’ultima volta, ed è stato molto 
lento. Dall’ultima volta il programma ha avuto alcune release nuove, forse dipende da questo]. 

Vedi anche qui: https://tips.clip-studio.com/en-us/series/73?app=ice&ver=1.8.0 
Leggere questi post sull'argomento: 
https://www.facebook.com/groups/mangastudioitalia/permalink/840129489431386/ 
https://www.facebook.com/groups/mangastudioitalia/permalink/1721215151322811/ 
https://www.facebook.com/groups/mangastudioitalia/permalink/1175833662527632/ 

Esportazione/Importazione 

Se voglio essere sicuro di mantenere degli strumenti personalizzati  o creati appositamente, c’è anche 
un modo più laborioso ma sicuro: si tratta di esportare ogni singolo strumento e successivamente 
reimportarlo quando si è reinstallato il programma: 

https://www.informaticapertutti.com/cose-il-cloud-come-funziona/
https://tips.clip-studio.com/en-us/articles/887
https://tips.clip-studio.com/en-us/series/73?app=ice&ver=1.8.0
https://www.facebook.com/groups/mangastudioitalia/permalink/840129489431386/
https://www.facebook.com/groups/mangastudioitalia/permalink/1721215151322811/
https://www.facebook.com/groups/mangastudioitalia/permalink/1175833662527632/
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- esportare: tasto destro sullo strumento > Export sub tool… e scegliere una cartella dove salvarlo; 
oppure selezionare lo strumento, cliccare i tre trattini in alto a sx nella palette Sub Tool > Export sub 
tool… e scegliere la cartella di esportazione; 

- importazione: trascinare lo strumento dalla cartella di salvataggio alla palette Sub Tool; oppure 
cliccare i tre trattini in alto a sx nella palette Sub Tool > Import sub tool…; oppure posizionarsi su 
uno strumento esistente nella palette Sub Tool > tasto dx > Import sub tool… 

 

Se si hanno molti pennelli da esportare/importare, questo metodo è rognoso: bisogna armarsi di 
pazienza… Leggi anche questa discussione. 

Recuperare i file 
Un black-out improvviso o il programma che per qualche motivo implode: ore di lavoro svanite nel nulla. 

Per recuperare i propri file perduti in genere si inizia snocciolando le imprecazioni più feroci, 
accompagnandole, almeno qui in Veneto, con l’enumerazione e la classificazione delle qualità più oscure di 
varie divinità. Va da sé che questa pratica non sortisce i risultati sperati e bisogna agire in altro modo. 

Per tentare di recuperare i file che l’improvvisa interruzione ha dissolto, si può andare nella cartella (nel 
PC, in MAC credo esista qualcosa di molto simile): 

C:\Utenti\nomeutente\AppData\Roaming\CELSYSUserData\CELSYS\CLIPStudioPaintData;  
all’interno di CLIPStudioPaintData si trovano tre cartelle: DocumentBackup, InitialBackup, 

RecoveryBackup; all’interno di queste cartelle si dovrebbero trovare gli ultimi salvataggi dei file cercati. 
Attenzione: la posizione di queste cartelle è cambiata con le ultime versioni del programma, credo dalla 

v. 1.10.13. Nelle versioni precedenti il percorso era: 
 C:\Utenti\nomeutente\Documents\CELSYS\CLIPStudioPaintData 

Backup dei file 
È utile abilitare la funzione di auto salvataggio  del programma che si trova in File > Preferences > File, 

mettendo la spunta a Enable Canvas recovery e impostando l’intervallo di tempo X adeguato tra i salvataggi 
con Save recovery data every: X > minutes. 

 

Io ho anche installato nel PC un programmino gratuito che esegue il salvataggio dei file con l’intervallo 
desiderato, si chiama AutoSave It e si può scaricare da qui. Autosave It in pratica attiva il comando Save 
(CTRL+S) di CSP. Si possono impostare più programmi per cui fare il salvataggio, ognuno con un proprio 
intervallo. 

 

Un altro programma che ho scovato e che per me è utile è MoveBOT 2020. Questo programma, creato 
dall’Ing. Antonio Costarella, permette di copiare i file da una cartella a un’altra a scelta (nel PC, su chiavetta, 
ecc.) ad intervallo impostabile, in modo da avere una copia aggiornata del file in lavorazione in due 
destinazioni: quella di salvataggio (scelta con CSP) e un’altra; può essere un modo per sopperire a soluzioni 
più costose di backup dei dati.  

MoveBOT 2020 ha alcune funzionalità di base nella versione gratuita, più altre che possono essere 
sbloccate acquistando i relativi “potenziamenti”. In ogni caso, per la versione completa si spendono meno 
di 30€. MoveBOT 2020 si può trovare qui. Ciliegina sulla torta: l’Ing. Costarella è molto disponibile e in caso 
di dubbi o problemi basta contattarlo ed egli dà assistenza pressoché immediata. 

 

Infine, se possibile, è opportuno dotarsi di un gruppo di continuità discreto, in modo da poter avere il 
tempo di salvare il lavoro qualora avvenga un black-out. 
  

https://www.facebook.com/groups/mangastudioitalia/permalink/3429520540492255
https://download.html.it/software/autosave-it/
https://movebot.altervista.org/


Appunti di Manga Studio/ClipStudioPaint   

225 

Clip Studio 
Dalla versione 1.6.2, una volta eseguito il file di installazione di CSP ci si ritrova con un programma che si 

chiama semplicemente Clip Studio (senza Paint), che sembra una specie di browser da cui, tra l'altro, si può 
lanciare CSP e, se lo si è installato, CSM.  

Da CS si può gestire la propria libreria di materiali, accedere agli Assets da cui scaricare (o caricare) nuovi 
materiali, e accedere a numerose risorse online. 

Se nelle intenzioni di CelSys questo programma serve a semplificare l'accesso alle varie risorse, io mi 
trovo decisamente male a passare da CS per aprire CSP, per cui ho creato un collegamento diretto a CSP 
(come spiegato al paragrafo “È sparita l'icona di Clip Studio Paint!”, in Domande frequenti) e per lanciarlo 
uso quello. 

 

Per il resto, trovo CS concretamente utile. 

Assets  

Gli Assets (= Risorse) sono un insieme di materiali (con materiali intendo dai materiali veri e propri ai 
pennelli, dai color set agli workspace, ecc.) raccolti in una specie di browser specializzato, accessibile da Clip 
Studio.  

Tramite una casella si fa una ricerca della risorsa desiderata e, se viene trovata, si può scaricare. I 
materiali scaricati si trovano dentro alla cartella Download nei Material di Clip Studio Paint. È inoltre 
possibile caricare i propri materiali, vedi più sotto).  

Punti GOLD 

Alcuni materiali sono gratuiti, altri sono scaricabili previo pagamento di punti GOLD, a loro volta 
acquistabili dal sito di Clip Studio (attenzione: i punti GOLD sono validi per un anno dalla data di 
acquisto, dopodiché vengono cancellati! Comunque all’inizio del mese in cui scadono, arriva una e-
mail che ricorda di spendere i GOLD entro la fine del mese e l’avviso appare anche tra le notifiche in 
CS), oppure di punti Clippy, di recente introduzione. Per una panoramica su questi sistemi di 
punteggio vedi più sotto.  

Quanto costano i punti GOLD? Se in questa pagina si clicca su Enter card information (senza 
paura) si apre un’altra pagina in cui viene detto che 1 GOLD corrisponde a 1 ¥ e, a sua volta, a 
grossomodo 0,01 $ -un cent- tasse incluse (dipende dal cambio). Poi si può ricavare il valore in €. 

Non riesco a scaricare i materiali dall’Assets 

 da un post sulla pagina Facebook del 29 Maggio2019 

 Sabrina Soldati   
Scusate tanto se disturbo ma non riesco a scaricare pennelli ed immagini free dal programma.Come 

posso fare? 

Patrizia Mandanici  
Ciao Sabrina, hai letto il post fissato in alto? Tra le altre cose è importante dire quale versione si ha del 

programma, che pc, ecc. Probabile che tu abbia una versione antecedente alla 1.6.2 (che ha come 
novità Clip Assets, da dove scaricare pennelli e materiali); oppure no, e allora è importante sapere 
altre cose come quelle citate prima 

Sabrina Soldati  
Si credo sia la versione precedente... 

Patrizia Mandanici  
Aggiorna allora, è gratis 

Patrizia Mandanici  
Per maggiori info scarica il documento "argomenti di Manga Studio" e leggi la voce aggiornare (trovi 

tutto linkato nel post fissato in alto) 

Sabrina Soldati  
Grazie mille! Gentilissima! 

https://ec.clip-studio.com/en-us/gold-purchase/amount
https://www.facebook.com/patrizia.mandanici
https://www.facebook.com/sabrina.soldati.1829
https://www.facebook.com/patrizia.mandanici
https://www.facebook.com/patrizia.mandanici
https://www.facebook.com/sabrina.soldati.1829
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Pubblicare un pennello negli Assets di Clip Studio 

Come si pubblica un pennello o un altro materiale negli Assets? E se il mio pennello ha una punta 
composta da diversi materiali? Devo caricarli separatamente? Per renderlo disponibile come lo 
ricompongo? 

In realtà è possibile salvare il pennello nella sua interezza come materiale: nella palette Sub tool cliccare 
col tasto dx sulla miniatura del pennello > Register sub tool as material. Etichettare e salvare il nuovo 
material. Se si fa la prova e si trascina il material nella palette dei pennelli e poi si va a vedere la brush tip, si 
può verificare che la punta è effettivamente composta da diversi materiali. Nella scheda dei materiali, in un 
angolo dell'anteprima il pennello viene indicato con una piccola iconcina che indica il tipo di Sub tool (es. 
una penna); tale iconcina si può personalizzare. 

Nelle precedenti versioni di questi appunti scrivevo di cliccare qui per leggere la procedura da usare per 
caricare i materiali. Questo link è ancora funzionante ma la procedura è leggermente diversa; sinceramente 
non so con quale versione di CS è avvenuto il cambio.  

 

Con la 1.9.7 la procedura è la seguente: 
 

Aprire CLIP STUDIO;  nella colonna a sinistra selezionare Manage materials: 
 

 
Fig.  363 

Verranno mostrati materiali contenuti nella palette Material: 
 

 
Fig.  364 

Fare doppio clic sul materiale da pubblicare oppure fare tasto dx e cliccare su Manage materials…, 

oppure cliccare sull’icona Show Menu  e quindi su Manage materials… 
 

Dalla finestra che compare scegliere Publish to ASSETS: 
 

http://www.clipstudio.net/en/howto/material_upload_01
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Fig.  365 

Nella finestra successiva si può decidere il nome da dare al materiale, cambiare l’anteprima, fornire una 
breve descrizione, aggiungere dei tag e ulteriori spiegazioni: 

 

 
Fig.  366 

Se tutto è a posto, cliccare in alto su Proceed to set content information, se invece per qualche motivo ci 
si deve fermare si può cliccare su Save temporarily. In questa eventualità, il lavoro può essere ripreso 
successivamente tornando su Manage materials > Publish to ASSETS e scegliendo il materiale: 

 

 
Fig.  367 

Nella finestra che si apre successivamente è possibile impostare ancora qualcosa, come la versione di 
CSP su cui può essere scaricato il materiale creato, stabilire un eventuale prezzo in punti Clippy (non in 
punti GOLD, vedi poco più avanti) e chiarire se il materiale ha dei contenuti potenzialmente offensivi (sesso, 
violenza, ecc):  si viene quindi invitati a prendere visione della migliore prassi da utilizzare per pubblicare, e 
quindi regole da seguire, ecc.  

 

Alla fine cliccare su Temporary upload, che salva il materiale nell’attesa della definitiva pubblicazione. 
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Nella nuova pagina che appare cliccare quindi su My Uploads (nel frattempo CS fa l’upload negli Assets, 
lo si può vedere nell’icona del Communication Management, cioè le due frecce contrapposte in alto a 
destra. 

Appare l’ultima finestra in cui si ha un’anteprima di come apparirà il materiale negli Assets: 
 

 
Fig.  368 

Cliccare infine su Execute post; un’ultima pagina dà la conferma dell’avvenuta pubblicazione e dice che 
ci vorrà una decina di minuti perché sia visibile sugli Assets. 

Nell’esempio mostrato, ho seguito la pubblicazione di un mio pennello che crea uno stormo di uccelli 
(Starlings – by Matt); volevo provare a metterlo a pagamento, a un prezzo in punti GOLD puramente 
indicativo giusto per capire la procedura, ma non ci sono riuscito. Non so, forse i pennelli non si possono 
mettere a pagamento? Indagherò.  

 

 Edit: Ho chiesto in Clip Studio Ask, la comunità di utenti di CSP dedicata a chi ha dubbi di qualche 
sorta. A quanto pare, al momento gli unici che possono fornire i propri materiali dietro corresponsione di 
punti GOLD sono gli utenti giapponesi (con un conto corrente reale in una banca giapponese!), quindi 
qualsiasi materiale venga messo a disposizione da non giapponesi apparirà come gratuito (= free). 
 

↓ 

 
  

https://ask.clip-studio.com/en-us/draft
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Sono passati 10 minuti e, hey, sono stato pubblicato!  
 

 
Fig.  369 

Pubblicare un Material catalog  

Se si vogliono pubblicare negli Assets più materiali contemporaneamente, perché sono affini e si vuole 
evitare di caricarli uno per volta (es. una serie di pennelli a tema floreale, ognuno con un fiore diverso), si 
può decidere di creare un Material catalog. I tipi di materiali raggruppato possono essere diversi, ad es. 
pennelli, oggetti 3D, ecc., basta che non siano in numero maggiore di 200, che non si superino i 2 GB per 
invio e che non ci siano più di cinque oggetti 3D.  L’icona negli Assets che indica un Material catalog sembra 
una sovrapposizione di più icone: nell’immagine qui sopra, ad esempio, la prima icona è quella di un 
Material catalog. 

Pubblicare un Material catalog è simile a pubblicare un qualsiasi materiale. Qui c’è la pagina con la 
procedura da seguire. Le immagini che si vedono a corredo sono lievemente differenti da quello che si vede 
realmente in CS, probabilmente per qualche aggiustamento tra le versioni, ma in sostanza non cambia 
molto.  

Si deve premere a sinistra Manage materials e poi scegliere la cartella dei propri materiali dove si 
trovano quelli da caricare. Al di sotto dell’elenco delle cartelle si trova un altro spazio, con due etichette. Di 
default è attiva l’etichetta Created material catalog: premere il + o l’icona con il > per cominciare, dare un 
nome al catalog e infine trascinare all’interno i materiali che ne faranno parte.  

 

 
Fig.  370 

Poi seguire quanto scritto nella pagina appena indicata. In breve, dato che le informazioni nella pagina 
indicata non sono molto chiare: 

- cliccare su Manage in alto a destra; 
 

 
Fig.  371 

https://tips.clip-studio.com/en-us/articles/1323
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- nella schermata che appare, cliccare su Publish to Assets. 
Qui si può aggiungere una descrizione, modificare il titolo, l'ordine dei materiali, aggiungere 

un'immagine di anteprima, aggiungere un nome di Categoria; 
- cliccare su Proceed to set content information 

Ora si può stabilire se è gratis o a pagamento, decidere il prezzo, con quale versione di CSP può 
essere usato, se contiene materiale sensibile. Attenzione: quando si imposta il prezzo, CS 
aggiunge già uno zero: se voglio dare al mio materiale un prezzo di 50 Clippy allora dovrò 
digitare solo 5, poiché lo zero è aggiunto di default; ciò significa che il prezzo minimo per un 
materiale è di 10 Clippy point; 

- cliccare su Temporary upload; 
- aprire il menù Operation, sulla destra, e premere su Preview and post; 
- attendere la pubblicazione. 

 

Backup del programma 

Vedi più sopra. 

Punti GOLD, Clippy tokens e Clippy tickets 

Per i punti GOLD vedi più sopra; riassumendo, negli Assets si possono trovare vari materiali, che si 
possono scaricare gratuitamente (= free) o dietro corresponsione di punti GOLD, una specie di valuta 
interna a CS. I punti GOLD si possono acquistare dal sito di CS e sono validi per un anno dalla data del loro 
acquisto. In teoria sarebbe possibile vendere anche dei propri materiali e farsi pagare in punti GOLD ma, 
dopo aver chiesto nella comunità Clip Studio Ask ho scoperto che per poter vendere i propri materiali 
bisogna avere un conto corrente in una banca giapponese e questo annulla le mie velleità di diventare 
ricco. 

Nell’estate 2020 è stato lanciato un nuovo sistema a punti, parallelo ai GOLD, denominato Clippy points 
(CP), accessibile da chi ha un account Clip Studio. In questa pagina si trovano le informazioni per il loro 
utilizzo; ho provato a tradurla e a metterla un po’ in ordine.  

Il sistema Clippy è composto da due tipi di punti: i Clippy tokens (= gettoni) e i Clippy tickets (= biglietti); 
entrambi si possono accumulare utilizzando i servizi di CS, ma sia i Clippy tokens che i Clippy tickets non 
possono essere acquistati. 

Clippy tokens 

I Clippy tokens possono essere guadagnati: 
- diventando un membro GOLD di CS (si guadagnano tra i 1500 e i 1980 Clippy tokens con un 

abbonamento GOLD mensile da 200 punti GOLD, vedi più sotto); 
- pubblicando del materiale gratuito negli Assets (si guadagnano 100 Clippy tokens); 
- accedendo a CS e cliccando su Login Bonus (a sinistra, nel menù) in determinati periodi, dei quali si 

viene avvisati tramite email (si guadagnano 15 Clippy tokens al giorno per un massimo di 20 giorni 
nel periodo indicato, quindi un totale massimo di 300 Clippy tokens*). Il primo di questi periodi 
limitati è stato dal primo Settembre al primo Ottobre 2020. Dopo la fine del periodo dei Login 
Bonus, i Clippy tokens rimangono comunque disponibili. 

I Clippy tokens sono memorizzati in uno speciale Clippy wallet (= portafoglio Clippy), raggiungibile da CS 
premendo l’iconcina dei punti Clippy nella barra in alto (dalla versione 1.10.0, nelle precedenti bisogna 
cliccare sull’iconcina dei punti GOLD): 

 

 
Fig.  372 

 

I Clippy tokens possono essere spesi: 
- per comprare materiali Clippy (Clippy materials) negli Assets, vedi qui, a partire da 10 Clippy tokens; 
- lasciandoli come regalo nei materiali di un altro utente presenti negli Assets, da 10 a 50 Clippy 

tokens; 
- estendendo l’abbonamento a CSP per iPhone, 30 Clippy tokens. 

https://ask.clip-studio.com/en-us/draft
https://accounts.clip-studio.com/help?ui_locales=en-us#clippy
https://assets.clip-studio.com/en-us/search?pay=clippy&order=new
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I Clippy tokens scadono dopo sei mesi che sono stati guadagnati.. 
Non scadono se si ha una GOLD membership, vedi più sotto. 

 

 * Anche se non è sempre così. Nel Login Bonus di inizio 2021 (tra l’1 e il 31 gennaio), ogni cinque giorni il 
bonus valeva di più: 50, 100, 150 e 200 token rispettivamente. 

Clippy tickets 

I Clippy tickets invece possono essere guadagnati pubblicando materiali negli Assets e possono essere 
riscattati per ottenere dei premi. 

Per riscattare i Clippy tickets: 
- una volta guadagnato un certo ammontare di Clippy tickets si va alla pagina Uploads degli Assets, 

per vedere i premi  e riscattarli*; 
- scambiare i Clippy tickets con in Clippy tokens (a gruppi di 10) dal Clippy wallet. 
- la pagina che spiega l’utilizzo dei punti Clippy dice anche “You can also redeem your earned Clippy 

tickets for rewards from this page (Limited to 200,000 per month for GOLD charge codes)”, 
letteralmente “Puoi anche riscattare i tuoi Clippy tickets guadagnati per ottenere premi da questa 
pagina (limitato a 200.000 al mese per i codici di addebito GOLD) **.  

- Se si elimina un materiale, i Clippy tickets legati a quel materiale sono convertiti in Clippy tokens. 
Se un materiale negli Assets è ritenuto inappropriato da un amministratore può essere eliminato. I 

Clippy tickets legati a quel materiale non sono validi. 
Si possono guadagnare Clippy tickets: 
- postando materiali Clippy negli Assets (da 10 a 20.000 Clippy tickets). Se un altro utente acquista un 

materiale Clippy postato, si guadagnano i relativi Clippy tickets, che successivamente possono 
essere riscattati. 

- ricevendoli in regalo. Un altro utente può lasciare in regalo dei Clippy tickets per dei materiali, che 
poi possono essere riscattati. 

Si può vedere l’ammontare dei propri Clippy tickets da My Uploads negli Assets. I Clippy tickets sono 
convertiti in Clippy tokens un anno dopo che sono stati guadagnati; non scadono se si ha una GOLD 
membership, vedi più sotto. 

 

* Su questa parte ci ho veramente sbattuto la testa, e ora cerco di spiegare. Prima di tutto, credo che con 
“un certo ammontare” intenda il prezzo stabilito per il materiale moltiplicato per il numero di volte in cui il 
materiale è stato scaricato. Ovviamente, non avendo i materiali tutti lo stesso prezzo e non potendo sapere 
quante volte un materiale verrà scaricato, sta sul vago… 

Per premi invece credo intenda i vari metodi per convertire i tickets: Clippy tokens, punti Gold e materiali.. 
Ho caricato un Material catalog sugli Assets a 50 CP, ma nonostante fin da subito fosse scaricato da alcuni 

utenti, l’ammontare nel wallet rimaneva stabile.  
Per quanto riguarda la pagina Uploads degli Assets, il collegamento a questa si trova cliccando sulla 

miniatura del proprio profilo, in alto a destra nella pagina Assets di CS: 
 

 
Fig.  373 

Nella pagina Uploads si trovano i propri materiali caricati negli Assets, con informazioni  sui download 
effettuati  e  i like e i gift ricevuti. Inoltre è riportato l’ammontare dei CP guadagnati e un tasto, Redeem, per 
poterli aggiungere al proprio portafoglio. Con il  tasto Operation si possono effettuare altre operazioni di 
editing sul materiale, di immediata comprensione. 

 

 
Fig.  374 
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Cliccando su Redeem si apre un’altra pagina, Redeem Clippy Tickets, in cui ci sono le opzioni per riscattare il 
valore dei ticket: convertirli in tokens, in Gold o in un codice di attivazione per estendere il tempo di utilizzo del 
programma (quando si utilizza un piano mensile). Solo dopo aver convertito i tickets in token o in Gold 
l’ammontare nel portafoglio viene aggiornato. 

 

** Poco chiaro, non si capisce a quale pagina si riferisca, di sicuro non quella dove questa frase è scritta. 
Però mi sembra di capire che faccia riferimento sempre alla pagina Redeem Clippy Tickets. 

 

GOLD membership 

La GOLD membership (= sottoscrizione GOLD) è un servizio a cui ci si può iscrivere per 200 punti GOLD al 
mese e genera Clippy tokens ogni mese. 

- si ottengono 1500 Clippy tokens ogni mese. Con il primo mese di sottoscrizione si ottengono 1500 
Clippy tokens e, nei mesi successivi altri 1500 Clippy tokens più altri 20 Clippy tokens al mese (1500 
Clippy tokens il mese della sottoscrizione, 1520 Clippy tokens il secondo mese, 1540 Clippy tokens il 
terzo mese e così via,  fino a 1980 Clippy tokens). Più a lungo si mantiene l'iscrizione, più Clippy 
tokens si guadagnano ogni mese. Attualmente, la quantità massima di Clippy tokens che si possono 
ricevere in un mese è 1980. 

- I Clippy tokens e i Clippy tickets non scadono. I Clippy tokens e i Clippy tickets hanno una data di 
scadenza: i Clippy tokens scadono alla fine del mese, sei mesi dopo essere stati guadagnati. I Clippy 
tickets vengono spostati nel Clippy wallet e trasformati in Clippy tokens un anno dopo che sono 
stati guadagnati. Con una sottoscrizione GOLD, i Clippy tokens non scadono e i Clippy tickets non 
vengono trasformati in Clippy tokens. 

Per acquistare una GOLD membership andare qui (richiede prima il login, se non lo si è già fatto). 
 
Non amo molto tutto questo sistema di token e tickets, mi sembra cervellotico e per me crea una gran 

confusione. A parer mio bastava allargare un po’ le maglie dei punti GOLD. Boh, spero di ricredermi. 
  

https://accounts.clip-studio.com/account/membership/apply
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Problemi di visualizzazione  

Per molto tempo l’interfaccia di Clip Studio, in particolar modo la finestra della gestione del cloud, mi è 
apparsa così: 

 

 
Fig.  375 

In pratica, nessuna veste grafica. Dopo uno stretto scambio di email, il supporto Celsys è riuscito a 
risolvere il problema. Si trattava di un conflitto che CS ha con un altro programma che era installato nel mio 
PC, Macromedia Dreamweaver. Rimosso quel programma, l’interfaccia è tornata a essere quella normale: 

 

 
Fig.  376  
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CSP con il cellulare: modalità Companion 
Come visto, CSP è disponibile per vari dispositivi: computer, tablet, cellulari.  
Nei cellulari, oltre a poter usare l’applicazione in sé, o gratuitamente per un’ora al giorno o a pagamento 

con una licenza dedicata, è possibile utilizzare CSP in modalità Companion (Companion Mode). 
Con questa modalità il cellulare si trasforma in una sorta di telecomando per il CSP sul computer o sul 

tablet, su cui vengono duplicate alcune funzioni del programma che magari è più comodo non utilizzare 
direttamente sullo schermo principale. 

L’uso della modalità Companion non fa scalare il tempo di utilizzo gratuito di CSP né richiede l’acquisto 
di una licenza, ma permette l’uso combinato con il dispositivo principale per tutto il tempo che si vuole. Se 
però si sta utilizzando CSP solo con il cellulare e, mentre si ha un canvas attivo (sempre sul cellulare), si 
passa alla modalità Companion per connettersi a un PC/tablet, il timer non viene sospeso ma continua a 
scalare il tempo, scaduto il quale per continuare serve la licenza (in realtà, i primi sei mesi di licenza per 
cellulare sono gratuiti). 

Companion mode può essere comoda, se ci si abitua a utilizzare il cellulare come periferica; ha però un 
piccolo scotto da pagare: le dimensioni del file. CSP per il cellulare è piuttosto pesante (il download della v. 
1.12.1 è di 309 MB), ma se ciò non costituisce un problema, perché no? 
 

Come usare la modalità Companion 
La prima volta: 

- scaricare CSP sul cellulare, assicurarsi che sia sul cellulare che sul PC/tablet ci siano le versioni 
aggiornate del programma e collegare sia cellulare che il dispositivo principale alla stessa rete; 

- lanciare CSP sul PC/tablet; 

- cliccare sull’icona Connect to smartphone,  , presente nella Command bar: verrà visualizzato un 
QR code. Può essere che venga richiesta un’autorizzazione per la trasmissione dei dati la prima volta 
che si utilizza Connect to smatphone; 

- lanciare CSP sul cellulare; 

- cliccare sull’icona Get Started, ; attendere che appaia la schermata Manage 
works,  
 

 
Fig. 377 

quindi cliccare sull’icona Companion mode (identica alla Connect to smartphone del PC/tablet); 
- quando appare il messaggio di conferma, cliccare Scan QR code; scansionare il QR code sul 

PC/tablet. 
- nell’app della fotocamera del cellulare appare quindi un link: cliccarlo per avviare CSP nel cellulare in 

modalità Companion. 
 

Dalle volte successive alla prima:  
avviare CSP sul PC/tablet, avviare CSP sul cellulare, cliccare  Get Started e quando appare la schermata 

Manage works cliccare sull’icona Companion mode.  
Se non dovesse funzionare, probabilmente si è sbagliato l’ordine delle operazioni o la rete non funziona. 

 

Per quanto riguarda le funzionalità del Companion mode, dare un occhio a questo link e fare delle prove.  

https://tips.clip-studio.com/en-us/articles/5995?fbclid=IwAR2gA9Ie3mf6QKw4Kvarfln7UL19yCrvDREdSjAUDXJa3TjI6Fp8fDFAfo0#ed4378ee
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Compatibilità con altri programmi 

Photoshop 

Importare file  

Con CSP si possono aprire direttamente i file di Adobe Photoshop (.psd o .psb) con la loro organizzazione 
in livelli. Basta andare in File > Open  e scegliere il file desiderato. È possibile importare un flie PS in un 
documento aperto con la funzione File > Import, ma in questo caso viene importato il contenuto del file 
come unico livello. Vedi a proposito: 

 

da un post di Luigi Giordano del 3 dicembre 2019 nel gruppo FB Clip Studio Paint Italia 
 

Luigi Giordano 
Buonasera a tutti. Grazie per avermi accettato. Ho una domanda. Sono passato da manga studio4 a 

clip studio. Una cosa non mi è chiara: con manga studio, dopo aver importato un file da Photoshop in 
bianco e nero (non scala di grigio), era possibile intervenire con gli strumenti del software (es. Pennino, 
gomma) fare eventualmente correzioni ed esportare. Ora, con clip studio, il livello che si crea quando 
nel progetto importo un file esterno non accetta simili interventi. Ricordo anche che era possibile 
importare in livelli separati, invece, ora, tutti i livelli vengono uniti in uno solo. C è una soluzione 
alternativa? Grazie. 

 

Patrizia Mandanici  
Clip Studio Paint apre i file di Photoshop con livelli, direttamente. E naturalmente si può intervenire 

su tutti i livelli con tutti gli strumenti. Se invece scegli "Import" si crea un file "immagine" che non è 
modificabile se non quando si converte in file raster (di solito si usa "Import" per aprire all'interno del 
nostro file qualche foto, e bisogna sempre convertire il layer). 

 

Luigi Giordano  
grazie! ora provo.. 
 

Esportare con i livelli 

Attenzione: salvare ed esportare sono due operazioni differenti. Si può salvare un file CSP con un 
formato PS (.psd o .psb). Se si salva da File > Save as…, il file manterrà la struttura dei livelli (anche se i livelli 
vettoriali non saranno più tali ma raster); se si esporta invece, da File > Export (Single Layer), scegliendo 
ancora .psd o .psb, il documento risultante avrà i livelli uniti. 

Importare pennelli  

Dalla versione 1.10.5 si possono importare in CSP i pennelli di Photoshop (estensione .abr). I pennelli si 
importano o trascinando il file .abr all’interno della finestra Sub Tool, oppure cliccando sulle tre lineette in 
alto a sinistra nella finestra Sub Tool e scegliendo l’opzione Import sub tool…  

Dopo aver importato il pennello è possibile che l’aspetto in CSP sia differente da quello che aveva in PS. 
Bisogna armeggiare un po’ con le impostazioni nella finestra Sub Tool Detail per ottenere un aspetto simile.  

In questo video (in inglese) sono spiegate le novità introdotte con la versione 1.10.5; lo faccio partire dal 
punto in cui viene spiegata l’importazione dei pennelli, al minuto 18:44. Una decina di minuti dopo, dal 
minuto 27:05 più o meno, viene spiegato che col pennello importato bisogna appunto giocare un po’ con le 
opzioni. In particolar modo, se si seguono i sottotitoli, fare attenzione a quanto scritto quando dice che 
all’opzione Scatter(-ing) di PS corrisponde l’opzione Spring effect in CSP. Qui c’è un errore dei sottotitoli 
(generati automaticamente): l’opzione corrispondente è Spraying effect. 

Non è al momento possibile esportare i pennelli di CSP verso Photoshop. 

Importare ed esportare Color palette  

Vedi il paragrafo Color Palette. 

Esportare testo compatibile con Photoshop 

Il comparto testo di CSP è giudicato spesso macchinoso e poco flessibile; i testi sono di non immediata 
manipolazione e volendo esportarli in PS (.psb o .psd), che ha una gestione più fluida, fino alla versione 
1.12.0 di CSP era inutile perché tutti i livelli risultavano rasterizzati. Un’altra ragione per gestire i testi con 

https://www.facebook.com/groups/mangastudioitalia/permalink/2591803597597291/
https://youtu.be/i34aFmaQkR8?t=1125
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PS, non meno importante stando a quanto dicono qui, era dovuta al fatto che è sempre più necessario 
tradurre in più lingue i testi dei fumetti per raggiungere un pubblico più vasto e, dopo la traduzione, 
riscrivere i testi nelle nuvolette nelle lingue non originali.  Con PS risulta più semplice (e quindi più 
economico) affrontare queste riscritture, non fosse altro che per la sua estrema diffusione, che CSP ancora 
non ha. 

Dalla versione 1.12.0 di CSP (maggio 2022) è possibile esportare il livelli testo mantenendo la 
compatibilità con PS, utilizzando i comandi Save Duplicate o Batch export. 

 

Save Duplicate 
- File > Save Duplicate > .psb o .psd;  
- appare la finestra psb/psd  export 

settings; 
- mettere la spunta alla casella Text; 
- in Text layer scegliere Text only; 
- dare l’OK. 
 

 Batch export 
- File > Export multiple pages > Batch export; 
- appare la finestra Batch export; 
- scegliere il formato PS desiderato, .psb o .psd; 
- togliere la spunta alla casella Combine and export image; 
- dare l’OK; 
- appare la finestra psb/psd export settings; 
- mettere la spunta alla casella Text; 
- in Text layer scegliere Text only; 
- dare l’OK. 
 

La casella Text layer ha tre opzioni: 
Image only: per ogni balloon con testo nel file CSP viene creato un livello raster, con balloon e testo 

uniti; 
Image and text: per ogni balloon con testo nel file CSP viene creato un livello raster con balloon e testo 

uniti, al di sotto del quale viene creata una cartella (non visibile di default) che contiene il livello testo 
modificabile e un livello raster per il balloon; 

Text only: per ogni balloon con testo nel file sotto viene creata una cartella (visibile) che contiene il 
livello testo modificabile e un livello raster per il balloon. 

 

Il testo esportato per PS mantiene il font, la dimensione e il colore scelti in CSP, ma non gli altri tipi di 
formattazione o effetto, come ad esempio il grassetto o il bordo attorno. Se si esporta come Image and 
text, formattazioni ed effetti saranno solo sul livello raster; se si esporta come Text only, verrà esportato 
solo il livello testo modificabile senza formattazioni ed effetti che, non essendo esportato un livello raster, 
verranno persi. 

Per altre informazioni vedi questo articolo (in inglese). 

Illustrator 

Importare ed esportare file 

Dalla versione 1.10.0 è possibile l’interscambio di file vettoriali .svg con Adobe Illustrator.  
Da quello che ho visto, è possibile copiare un livello vettoriale da Illustrator e incollarlo in CSP, però su 

un livello raster. 
Le note di rilascio parlano di "copiare immagini da AI e incollare le loro linee e riempimenti convertiti in 

.svg in CSP come vettori"; inoltre dicono che si possono "copiare i layer vettoriali in CSP e incollarli in AI con 
i control point". Sembrerebbe che in realtà non si possono copiare/incollare come vettoriale (perché così fa 
la conversione in raster), ma bisogna passare per esporta/importa. 

Da alcune prove ho notato che se copio una linea vettoriale da un file CSP in cui ci sono vari livelli (raster 
e vettoriali), quando vado a incollarlo in AI me ne incolla, come raster, solo un pezzo. Per avere tutta la 
linea in AI, nel file CSP ci deve essere solo il livello che copio. 

Se da Illustrator esporto in .svg un vettoriale con linea e riempimento, viene importato in CSP solo come 
linea. Se esporto da Illustrator solo il riempimento, in CSP viene importato il contorno (quindi la linea), che 
ha però il colore del riempimento. 

Non so se questo corrisponda alle intenzioni degli sviluppatori; molto probabilmente devo capire meglio 
io. 

https://tips.clip-studio.com/en-us/articles/6549
https://tips.clip-studio.com/en-us/articles/6549
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Importare ed esportare immagini 
È possibile importare delle immagini in un file .clip, da File > Import > Image…; le immagini importate 

vengono posizionate in un livello di tipo chiamato Image material layer, con limitate possibilità di gestione: 
una volta importata, è bene rasterizzare l’immagine (> convertirla in un livello di tipo raster) con il comando 
Rasterize (tx dx sul livello > Rasterize) o convertendo il livello con tx dx > Convert Layer (H)…  e scegliendo 
Raster Layer in Type. 

Si possono convertire anche in livelli vettoriali, ma bisogna giocare un po’ con i parametri in Vector 
settings nella finestra che appare, non ho fatto molte prove e non so che qualità si possa ottenere. 

Infine si possono convertire le immagini in linee e toni (> retini), da tx dx sul livello > Convert in lines and 
tones…: anche qui, se interessati, fare delle prove; io non mi ci sono dilungato troppo. 

Una cosa interessante è che finché un’immagine non è stata convertita e voglio ad esempio copiarne 
una selezione e incollarla su un livello vuoto (che verrà bellamente ignorato), viene creato un livello, 
sempre Image material layer, mascherato, in cui vedo effettivamente solo la parte selezionata 
dell’immagine, ma che in realtà la contiene interamente. 

 

Se si apre direttamente un’immagine (intendo un’immagine raster, tipo una .jpg) con File > Open… viene 
creato un documento che ha un unico livello di tipo raster, contenente l’immagine, che poi può essere 
integrato e lavorato come un  qualsiasi file .clip . 

 

L’esportazione di un’immagine viene utilizzata ad esempio alla fine di un lavoro, quando tiro le somme 
di tutto il processo creativo. In parte ne ho parlato più sopra, aggiungo solo che ci sono varie modalità di 
esportazione: con File > Save as… o con File > Export (Single layer); ce ne sono altre, ma parlando di 
immagini mi fermo qui. Se si vogliono mantenere i livelli nell’immagine finale, gli unici formati che lo 
consentono sono Photoshop Document, .psd, e  Photoshop Big Document, .psb, selezionati da Save as…, 
negli altri casi i livelli vengono unificati.  

 

Con Export (Single layer) si possono impostare le varie opzioni di esportazione (ad esempio, scegliere di 
non esportare i Draf layer), cosa non possibile con il Save as… 

Esportare Tiff con i livelli 

Non è possibile esportare Tiff multilayer; per esportare i livelli bisogna esportare in .psd e da Photoshop 
esportare poi in .tif . 

Importare un’immagine e ridimensionarla esattamente 

Se voglio che un’immagine abbia in CSP determinate dimensioni c’è da star freschi: se la importo con 
File > Import > Image… poi non ho modo di vedere quali sono le sue dimensioni effettive sulla pagina, 
anche rasterizzandola. Posso usare il comando Scale/Rotate, ma dalla Tool property posso tener d’occhio il 
ridimensionamento solo percentualmente, il che è un po’ scomodo. 

C’è un modo però per  aggirare l’ostacolo e impostare le dimensioni di un’immagine con precisione (vedi 
questo post di Gloria Spinelli sul gruppo FB e relativa risposta di Federica Di Meo): basta aprire l’immagine 
direttamente in CSP, cioè non aprendo un file e importando l’immagine, ma proprio aprire l’immagine con il 
comando File > Open…  

Una volta aperta l’immagine andare in Edit > Change  Image Resolution…; nella finestra che appare sono 
riportate le dimensioni e la risoluzione dell’immagine, che possono essere modificate a piacere 
(mantenendo però le proporzioni).  

 

https://www.facebook.com/100010419362702/videos/777714810304685
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Fig.  378 

Poi si salva l’immagine e la si può importare nel file di lavorazione come spiegato più su. 
Se si vogliono modificare le propozioni dell’immagine prima di importarla, allora bisogna utilizzare un 

editor di immagini che lo permetta. 

Altre impostazioni personali 
*Ignorare tranquillamente* 
Sfondo icone strumenti aggiunti v. 1.10.10:  RGB 162.188.210 HEX A2BCD2 
Sfondo icona Object. 157.89.180 
Sfondo icona Move layer: 195.170.84 
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APPENDICE 001 - Come PJ Holden taglia le vignette 
Dic. 2018 - Ho tradotto finalmente questi post di PJ Holden. Di recente ho seguito un webinar di PJ su 

questi stessi argomenti (lo trovi qui su Youtube) e ho fatto un po’ di fatica a stargli dietro perché parla 
molto stretto e un po’ si mangia le parole (certo, io non sono una cima in inglese…). Le stesse difficoltà le 
ho avute con questi articoli, perché a mio modo di vedere PJ usa la punteggiatura un po’ a caso… Se 
qualcuno volesse fare una traduzione più accurata della mia, posso girargli il testo originale. Ricordo che 
tutto quello che si trova tra parentesi quadre sono mie note personali. Non ho numerato le immagini. 

Disegnare Vignette in Manga Studio/Clip Studio Paint – Parte 1 

Sunday 31st January, 2016  

Ok, per prima cosa mettiamoci d’accordo sulla nomenclatura… 
 
Panel, cornici, box [Panels or frames or boxes nell’originale – N.d.M.] o… quelle cose rettangolari o quasi  che 

ospitano il contenuto di una parte di un fumetto. Io le chiamo panel (e le linee attorno: bordi dei panel) ed 
è così che le chiamiamo nel Regno Unito. 

[Va da sé che essendo questi appunti in italiano e che in italiano si chiamano vignette, da ora in poi tradurrò panel 
od ogni altro termine equivalente con “vignetta”, e panel borders “bordi” ecc.  
PS: A metà della traduzione ho notato che spesso PJ usa panel border anche come sinonimo di vignetta, 
costringendomi a una noiosa revisione: ho cercato di usare il termine più adatto affidandomi al senso del discorso - 
N.d.M.]. 

 
Manga studio È Clip Studio Paint. Mi riferirò normalmente a Manga Studio, perché l’ho usato con questo 

nome per anni. Però potrei riferirmi al programma con MS, o MS/CSP. Ma attenzione: di fatto sono lo 
stesso programma con due nomi differenti. Non c’è differenza, valgono le stesse cose. 

Ok, le parole sono sistemate, vediamo alcune nozioni di base. 
 

Manga Studio ha alcuni strumenti veramente forti per disegnare le vignette. Però una cosa che fa di 
default è creare un nuovo layer per ogni vignetta. Io questa cosa la detesto, preferisco che il numero delle 
mie cartelle sia basso (una per le matite, una per le chine, una per i bordi delle vignette e talvolta una per le 
tinte piatte e una per gli effetti). 

Per creare la gabbia di partenza si va sul menù Layer. 
 

 

Questo crea un nuovo Frame folder. Ciò che verrà inserito in questa cartella verrà mostrato come 
limitato dai bordi della vignetta e non ne uscirà. 

[Non è esattamente quello che scrive JP (“anything dropped in to this folder will, cleverly, ONLY show the contents 
of the drawing.“), ma è quello che accade - N.d.M.] 

 
Per questo esempio userò una pagina da Monsterology Book 2: Sabbaticals (dovresti comprarlo nella tua 

fumetteria di fiducia, è fantastico…)  
 

Qui ci sono le mie matite grezze: 

https://www.youtube.com/watch?v=LDBVJGJE2Zc&feature=youtu.be&fbclid=IwAR3UA6aSovTqfoUWWur5RyXE-uG2PruhzGk1jT0awJvYgrNuaSEjxq5PRCo
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Appunti di Manga Studio/ClipStudioPaint   

241 

Dunque, il primo passo è creare un nuovo Frame folder. Si aprirà una finestra con alcune impostazioni:  
- il nome della cartella (che cambio raramente, dato che tendo a lavorare con un’unica cartella, 

mantenendone il nome);  
 

 

- Draw border [disegna il bordo]: dato che sto facendo tutto questo solo per avere i bordi delle vignette, 
beh, mi assicuro che sia spuntata; 

 
- Line width [spessore della linea], impostato come si ritiene opportuno. Mi piacciono i bordi belli grossi, e 

uso 1,4 mm di spessore (il programma mi chiede la misura in mm perché tutto il documento è 
impostato nel sistema metrico, il tuo potrebbe essere impostato in pollici). Inoltre ho un rapido 
Rotring da 1,44 mm che ho usato per decenni per disegnare i bordi, e questo ha contato nella mia 
scelta.  

 
- Anti-aliasing Qui è disabilitato perché il mio tipo di layer di default è in bianco e nero e quindi questa 

opzione (ovvero il processo che usa i toni di grigio per simulare una definizione più alta) non è 
disponibile. 

 
Ciò crea una nuova cartella con una maschera; una cartella con la maschera contiene aree trasparenti e 

aree opache, in cui i disegni contenuti si vedono solo attraverso le zone trasparenti. Personalmente lo trovo 
un po’ limitante quando sto facendo le matite, ma è utile per mantenere il lavoro pulito e aiuta a non 
distrarmi. 
 

La mia cartella ora appare così: 
 

 

E i miei disegni appaiono così (la zona blu è la maschera, che ancora non nasconde i disegni perché i 
disegni non sono DENTRO il frame folder ma sono sotto, e la maschera quindi non ha effetti su di essi): 
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Ora comincio a tagliare i bordi! 
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Manga Studio/Clip Studio Paint ha una serie di  subtools [sottostrumenti] utili per tagliare i bordi delle 
vignette. 

Questi sono i miei (incluso uno nuovo che ho creato io e che è molto utile!) 

  

 

Un subtool è fondamentalmente uno strumento [tool] a cui sono stati modificati i parametri e questi 
parametri sono stati registrati, cosicché se ne possono creare un sacco di versioni differenti, ciascuna 
specifica per il proprio lavoro o le proprie preferenze. 

 
Lo strumento più utile è tuttavia il “Divide Frame Folder”, che permette di suddividere la vignettona 

appena creata in maniera arbitraria (se si preme lo SHIFT mentre si taglia la vignetta la direzione sarà 
forzata a rimanere orizzontale o verticale). 

 
Se hai mai letto i 2000AD 10 commandments, potresti voler tenere uno spazio tra le vignette di 5 mm 

(come faccio io) e il “Divide Frame Folder” ha un’impostazione che permette di specificare tale spazio sia in 
orizzontale che in verticale (io uso 5 mm per entrambi; per qualche strano motivo, probabilmente legato ai 
manga, di default il programma tiene uno spazio verticale maggiore di quello orizzontale. Io lo trovo… 
sconvolgente). 

 
Di default, lo strumento “Divide frame folder” creerà una nuova sottocartella per ogni vignetta, quindi se 

si divide una pagina in due vignette alla fine avremo due cartelle separate, ognuna con la propria 
mascheratura, e ciò che contengono potrà essere spostato senza interferire con l’altra vignetta. La 
mascheratura nasconderà le parti di disegno che non si vogliono far vedere. Il che sembra utile, se è così 
che si lavora. Ma io non lavoro così, quindi la prima cosa che faccio  è cambiare il comportamento di default 
nel seguente modo… 

http://www.pauljholden.com/blog/2003/07/09/2000ad-10-commandments/
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 (A questo punto potresti trovarti a pensare “l’inglese delle opzioni di questo menu è piuttosto… 
strano”… già, concordo)  

 
AGGIORNAMENTO: E' stato sottolineato, correttamente, che le impostazioni che ho cambiato hanno 

trasformato "Divide Frame Folder" nello strumento esistente "Divide Frame Border", cosa che non avevo 
mai notato prima. Quindi potete scegliere di cambiare le impostazioni o semplicemente usare "Divide 

Frame Border"...    [qui PJ conferma quanto notato anche da me, vedi qui – N.d.M] 
 
Quindi, ora, usando questo strumento, faccio tagliuzzo tutto come preferisco e la faccio finita qui…: 
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(consiglio veloce: se si preme lo SHIFT, cliccando all’incirca a metà di dove si vuole posizionare il bordo e 
muovendo leggermente su o giù, la vignetta sarà tagliata perfettamente lì dove si trova il mouse, il tutto in 
pochi secondi). *boh, l’aveva già detto…+ 

 
Ora, non è esattamente dove lo voglio. Per esempio, vorrei che la prima vignetta fosse aperta sopra, 

vorrei che la testa del nostro villain nell’ultima vignetta sbucasse un po’ fuori e che i bordi destro e sinistro 
dell’ultima vignetta andassero fuori pagina. 

 
Per prima cosa  occupiamoci dell’estensione dell’ultima  vignetta. Selezioniamo il Select tool, o più 

precisamente l’Object Select tool (che appare così: ) , che si trova qui: 
 

 

 (Una cosa frustrante è che la toolbar sulla sinistra mostra il subtool usato più di recente di ogni 
strumento, rendendo talvolta dannatamente impossibile trovare lo strumento che stai cercando se hai UN 
SACCO di subtool… Ad esempio, questo menù può apparire anche così:  

 

 

È per questo che la gente spesso si lamenta di non riuscire a trovare un particolare ruler: è perché il ruler 
è un subtool di una serie e la toolbar attualmente ne mostra l’icona di un’altra. Un giorno qualcuno 
intelligente aggiungerà un comando “cerca” al menù degli strumenti solo per cercare tra i milioni di 
fantastici strumenti di disegno che ho comprato da frenden…) 

Ok, sto divagando. Dopo aver selezionato lo strumento Object Selection (ricorda, appare così: ) si 
può selezionare la vignetta che si vuole estendere fuori pagina. Ci sono più modi per estendere i bordi delle 
vignette, vediamoli velocemente. 
 

http://store.frenden.com/
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Ci sono due serie di maniglie per muovere la vignette: la più esterna si collega rigidamente alle altre 
vignette o al lato della pagina; la più interna è più flessibile, per esempio si può prendere la maniglia 
dell’angolo superiore sinistro e tirarlo su, così: 

 

 

 
Invece, muovendo la maniglia corrispondente della serie esterna semplicemente si stira verso l’alto la 

vignetta senza deformarla: 
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Se ci si limita a bordi delle vignette squadrati e abbastanza semplici, allora le maniglie esterne fanno 
bene il loro lavoro (anche se, come me, potreste non trovarvi mai nemmeno a pensare a queste maniglie e 
a usarle solo per limitare l’area della vignetta. A essere sinceri, dopo anni di utilizzo di MS questa è la prima 
volta che ho bisogno di pensare a cosa servono  queste maniglie…) 

 
Quindi afferro le maniglie esterne e tiro la vignetta fino a che i bordi sono fuori dalla pagina.  

*originale:  “…are off the hook. I mean page. Off the page.”, trad. “…sono fuori dai guai. Voglio dire dalla pagina. 
Fuori dalla pagina.”+ 
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Normalmente, trascino le maniglie fuori dalla pagina. Si possono lasciare a filo pagina, ma a seconda di 
come è impostata la pagina per la stampa, si potrebbero trovare i bordi della vignetta visibili a bordo 
pagina. Meglio tirarli fuori fino alla zona grigia che non si vede mai. 

 
Lo spostamento dei bordi delle vignette può essere un po’ complicato. Manga Studio ha alcuni grandi 

trucchi per affrontarlo, anche se può essere un po’ frustrante provarli. Nelle proprietà del Select Object si 
possono trovare alcune caselle di controllo utili… 
 

 

Snap to Another Frame Border  [Aggancia a un altro bordo]. In realtà si aggancia sia ai bordi della vignetta che 
allo spazio invisibile impostato a tra loro (nel mio caso i 5 mm).  

 

*qui credo voglia dire che se muovo una maniglia questa si aggancia sia al bordo di un’altra vignetta sia al prolungamento, 
che non vedo, dei bordi delle vignette, cioè lo spazio invisibile impostato. Vedi questa immagine, in cui la maniglia 1 si 
aggancia al bordo vignetta, la maniglia 2 si aggancia al prolungamento dello spazio (invisibile) tra le due vignette in alto. 
 

  - N.d.M.] 
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Work with another frame border. Permette di muovere il bordo di una vignetta e tenere il bordo della 
vignetta vicina sempre alla distanza impostata per lo spazio tra vignette (il bordo della vignetta vicina 
si muove parallelamente a quello della vignetta che si sta modificando).  Se si vogliono vignette che si 
sovrappongono deselezionare l’opzione. 

 
Frame Border / Draw Border. Sì, grazie. A meno che non si voglia il bordo attorno… 
 
Snap. Deselezionandolo si è liberi di posizionare i bordi come si vuole, anziché mantenere quei rigorosi 5 

mm che ci siamo autoimposti. 
 
Ok, abbiamo trattato l’estensione di una vignetta oltre la pagina. Dato che questo argomento ha 

occupato più spazio di quanto mi aspettassi, la prossima volta parlerò di come spezzare il bordo: portare un 
disegno al di fuori della vignetta. C’è un modo intelligente di farlo che non comporta il disegnare oltre il 
bordo, sbianchettare *nell’originale tippexing, da Tipp-Ex, una marca di correttore bianco… Ah, l’inglese!] il bordi che non ci 
interessano e riscansionare il disegno. Avrei solo voluto capirlo prima… 
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Le vignette in Manga Studio - parte 2 
Monday 1st February, 2016  

Una piccolo aggiunta alla prima parte: quando si tagliano le vignette con il “Divide Frame Folder / Divide 
Frame Border”, se si trascina lo strumento di taglio attraverso più vignette (e si devono tagliare tutte fino 
all’altra parte) si vede l’anteprima del taglio mentre lo si fa e alla fine tutte queste vignette risultano 
tagliate. È un buon modo per assicurarsi che i tagli siano allineati 

 
Ok, questa volta parleremo di come spezzare il bordo: lo si può fare se si vuole. Qui c’è un esempio di 

cosa sto parlando: 
 

 

Qui il piede di Harry (il robottone gigante) rompe il bordo della vignetta e irrompe nell’altra. Non faccio 
di frequente questo genere di cose, più spesso faccio queste: 
 

 

dove taglio via un pezzo di bordo per lasciare la vignetta aperta. Ci sono più modi di far ciò. Il vecchio metodo 
che utilizzavo (in cui lasciavo che il programma disegnasse tutto il bordo e poi lo cancellavo) funzionava ma era 
piuttosto rigido. Il nuovo metodo (o almeno il metodo che uso per il momento) mantiene il bordo altamente 
editabile, ma richiede di pensarci un po’ di più. 

*ok, qui mi sono arrampicato un po’ sugli specchi: PJ scrive “…I “render” the panel frame and then erase the border”; 
quel “render” è ovvio che si riferisca al processo con cui il programma disegna il bordo attorno alla vignetta, ma 
dovevo tradurlo in qualche modo… - N.d.M.] 

 

http://www.pauljholden.com/blog/2016/02/01/panel-borders-in-manga-studio-part-2/
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Questo metodo si bassa sul fatto che le vignette possono sovrapporsi e possono avere i bordi invisibili e, 
per aiutare, ho creato un subtool speciale, chiamato “Remove Panel Border” [rimuovi i bordi della vignetta]. 
Per crearlo, ho duplicato il subtool “Polyline Frame” e ho modificato I parametri come segue, e infine l’ho 
salvato come nuovo default: 
 

 

(in realtà l’ho anche esportato e si può importare in Manga Studio per il proprio utilizzo. Per importare 
innanzitutto scaricare e dezippare il file “Remove Panel Border.sut.zip” e poi trascinare il file .sut nel toolset 
che si preferisce, oppure dal menù Sub Tool selezionare Import e importarlo da lì).  

 
Sub Tool menù: 

 

 

 

[Il link che fornisce PJ Holden è relativo al suo vecchio sito, che non esiste più, in cui c’erano anche questi post che 
fortunatamente ho copiato. Lo strumento che ha creato non è più disponibile, ma è facilmente ricreabile 
ripercorrendo i suoi passi, come ha spiegato: 
- duplico lo strumento Polyline frame  e lo chiamo Remove Panel Border; 



Appunti di Manga Studio/ClipStudioPaint   

253 

- imposto i parametri come li ha impostati lui; l’interfaccia è un leggermente cambiata da quando PJ ha scritto il 
post, metto di seguito i Sub Tool Detail per il Polyline frame e per il Remove Panel Border come appaiono nella 
versione 1.8.5 di CSP:  

 

     
Polyline frame     Remove Panel Border          - N.d.M.] 

 

Ora, per usarlo, semplicemente selezionare il subtool “Remove Panel Border” e quindi disegnare attorno 
alle parti di bordo che si vogliono escludere… 
 

Disegnare l’area da escludere: 
 

 

 
 
 
 
 
 
 
 
 
segue… 
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L’area è stata esclusa: 

 

 

E se si vuole, si può tornare indietro e editare la forma per renderla più accurata: 
 

 

E I nuovi bordi delle vignette appaiono così: 
 

 

Notare: l’area blu è la zona mascherata delle vignette; la parte dei disegni che sta nella parte sottostante 
la maschera non viene mostrata. 

 
Quindi, qui sopra, i disegni stanno su un layer AL DI SOTTO della cartella della vignetta [frame folder], ma 

non NELLA cartella. I miei layer hanno questa struttura: 
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segue… 

 

Questo significa che mentre la maschera blu funziona appunto da maschera quando il mio livello delle 
matite [pencil layer] è all’interno del Frame folder, non ha nessun effetto se questo livello non è contenuto 
nel Frame folder. 
 

 

Già, la differenza è minima, ma si vede che il layer delle matite è leggermente più rientrato e il suo 
destino è ora legato al destino del Frame folder. Quindi, se si spegne il Frame folder, cliccando sull’occhio a 
sinistra del Frame 1, la vignetta diventa invisibile, così come QUALSIASI cosa sia contenuta nel Frame folder 
(ad esempio le nostre matite). 

 
Alla fine, ottengo questo: 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
segue…  
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Il blu chiaro qui indica che ho selezionato il livello delle matite, ma c’è una MASCHERA nella cartella in 
cui si trova. Se si guarda nel gutter (lo spazio tra le vignette), si nota che lì non si vede nulla (ci sono un 
sacco di scarabocchi nei miei gutter, ma la mascheratura li toglie dalla vista). 

 
Prossimo argomento: sovrapporre le vignette e capire con quale ordine son disegnate veramente (e son 

dolori…) 
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Le vignette in Manga Studio Parte 3 
Tuesday 2nd February, 2016  

Fino ad ora, se siete arrivati in ritardo, abbiamo parlato di come Disegnare Vignette e di come spezzare 
il bordo. 

 
Questa volta parleremo di come sovrapporre bordi di vignette diverse, nel caso si volessero fare cose del 

genere: 
 

   

Queste tavole sono tratte da Dept of Monsterology, book 2: Sabbaticals (disponibile per l’acquisto online 
su comixology UK o US (o ovunque, in realtà), o potresti trovare il primo e il secondo libro nella tua 
fumetteria, su amazon o dall’ editore (o da me se mi becchi a qualche convention). 

 

Ok, basta pubblicità, andiamo avanti… 
 

Quando si creano delle vignette, Manga Studio (o Clip Studio Paint, sono lo stesso programma) cerca di 
fare due cose: creare una maschera per nascondere qualsiasi cosa nello spazio tra le vignette e disegnare il 
bordo delle vignette stesse. Sovrapporre delle vignette implica qualcosa di più complesso e nell’affrontare 
questo problema, MS, all’insaputa dell’utente, registra uno speciale diario segreto di quale vignetta 
disegnare per prima. Che non è la stessa cose dell’ordine di lettura, dato che, per esempio, a seconda di 
come si disegnino le vignette, Manga Studio può registrarle nel seguente ordine: 
 

 

http://www.pauljholden.com/blog/2016/02/02/panel-borders-in-manga-studio-part-3/
https://www.comixology.co.uk/Dept-of-Monsterology/comics-series/20259
https://www.comixology.com/Dept-of-Monsterology/comics-series/20259
http://amzn.to/1Kn8MlP
http://www.renegadeartsentertainment.com/dept-of-monsterology
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So cosa state pensando.. state pensando “MACCHECXXXX PJ???”. Ok, ecco quello che accade: l’ordine di 
Manga Studio riflette l’ordine in cui le vignette sono state create. Usando lo strumento “Divide Frame 
Folder/Divide Frame Border”, una singola vignetta viene divisa in due (in realtà possono venir divise anche 
più vignette) e questo crea una numerazione che ha senso per il computer ma non ha molto senso per noi 
come lettori. 

 
Però quest’ordine è importante, perché determina il modo in cui verranno disegnate le vignette quando 

si sovrappongono. 
 
Il numero più alto in questo diagramma rappresenta ciò che sta in cima. Quindi, trascinando la vignetta 

6 (così come l’ho numerata io, piuttosto che la vignetta 6 che vi sareste aspettati in quanto umani) sopra le 
altre vignette, risulta che sta sopra tutte le altre, così: 
 

 
 

Questo è esattamente il tipo di cosa  che vorreste e che vi aspettereste… 
 

Ma diciamo che io voglia che la vignetta 5 stia sopra la vignetta 6; se trascino semplicemente i bordi 
della vignetta 5, ottengo questo: 
 

 
 
segue… 
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Ora, come artista vorrei che la vignetta 5 fosse al di sopra della vignetta sei, e che le vignette 3 e 4 

fossero al di sopra della vignetta 5, ma per il computer la vignetta 5 non rappresenta l’ordine in cui questa 
verrà letta, ma rappresenta l’ordine con cui deve disegnarla, quindi la vignetta 5 sta ESATTAMENTE dove il 
computer si aspetterebbe che sia. 

 
Quindi, come risolvere il problema? Bene, molto semplicemente, andiamo sul menù Layer > Panel Order 

> Move Panel Back…  
AHAH! Pesce d’aprile! No, non esiste una via semplice. Diversamente da altri programmi che hanno 

affrontato problemi simili (ad esempio, Powerpoint), apparentemente non esiste un modo di riorganizzare 
l’ordine delle vignette. Vi siete imbattuti in una delle poche opzioni poco soddisfacenti…  

 

[Attenzione, in realtà il sistema Layer > Panel Order > Move Panel Back funziona egregiamente se la divisione della 
vignetta è stata fatta con il Divide Frame Folder. Cambia l’ordine dei layer ma ne mantiene il nome. Ciò che JP 
spiega di seguito è come fare se la divisione della vignetta è stata fatta con Divide Frame Border, che non crea una 
cartella separata per ogni vignetta, ma divide solo il bordo della vignetta di partenza – N.d.M.] 

 
1. Ridisegna le vignette, ricordandoti di disegnarle nell’ordine che VUOI (quindi, in questo caso, 

vorrei disegnare la vignetta 5… uhm, no aspetta, devo ridisegnare la vignetta 6 come seconda 
vignetta, quindi, uhm… la vignetta 5 dovrebbe essere la terza? Diavolo, è troppo complicato…) 

2. Smettere di provare a fare qualcosa che Manga Studio non sa fare bene e riposizionare le vignette 
in modo tale che non sia doloroso (strada che ho percorso più di una volta...) 

3. Un po’ più facilmente… si può usare un trucchetto. 
 

Il trucchetto… 
 

Il trucco sta nel dividere a metà la vignetta che si vuole sopra le altre e poi unire le due metà . Questo 
sposta QUELLA vignetta in cima… Dato che in questo esempio voglio che la vignetta 5 stia SOTTO la vignetta 
6, ma sopra le vignette 3 e 4 [2 and 3 nell’originale, un errore+ applico questo trucco nel seguente ordine: 
 

1. Spostare la vignette 5 in cima (ciò implica tagliare la vignetta a metà e poi unire le due metà) 
2. Spostare la vignetta 3 e poi la vignetta 4 in cima (con lo stesso sistema) 
3. Si può tagliare la vignetta facilmente usando il “Divide Frame Border”, questo semplicemente taglia la 

vignetta 5 a metà; le due metà quindi saltano IN CIMA all’ordine di disegno… 
 

 

segue… 
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Quindi, usando lo strumento Select Object, seleziono le due metà della vignette 5 (tenendo premuto 
SHIFT mentre si sta usando lo strumento Select Object si possono selezionare più oggetti): 
 

 
 

(qui ho selezionato le due metà della vignetta) 
 

Quindi usare Layer > Ruler Frame > Combine-Frame (ricordare, quelli che io chiamo “panels” Manga 
Studio li chiama “Frames” *qui entrambi “vignette” – N.d.M.], e quello che io chiamo Manga Studio io lo 
chiamo pure Clip Studio Paint) 
 

 
 
 
 

Usando lo stesso trucchetto sulle vignette 3 e 4 (non vi annoio rifacendo la spiegazione, perché è la 
stessa cosa vista più sopra…) alla fine si arriverà a questa situazione: 
 
 
 
 
 
 
 
 
 
 
 
segue… 
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segue… 

Qui ho mantenuto la numerazione delle vignette perché il tutto 
risulti il più semplice possibile (e mi scuso perché probabilmente 
questa cosa crea comunque confusione, ma così è), ma MS adesso 
probabilmente ridisegna le vignette in questo ordine: 
 

Questo trucchetto per portare in alto una vignetta funziona 
veramente bene solo su vignette rettangolari, che possono essere 
unite facilmente. Forme strane si comportano in maniera strana, e 
non c’è una maniera semplice di spedire una vignetta sotto, se non 
forse muovendo tutte le altre sopra. E anche se alla fine non si 
utilizza questo trucco, si spera che il motivo per cui Manga Studio 
disegna le vignette sovrapposte nel modo in cui lo fa abbia un 
senso. 
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Ovviamente, se avessi voluto disegnare una bella vignetta circolare, questa sarebbe diventata la vignetta 
7 e sarebbe stata sopra tutte le altre, così: 
 

 
 

Nella prossima parte rallenterò un po’ e mostrerò come tagliare una singola vignettona in varie vignette 
tutte uguali (TUTTI COL RETICOLO DI NOVE VIGNETTE! YEEEHA!) 
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Vignette in Manga Studio parte 4 
Wednesday 3rd February, 2016  

Hey, stavolta una cosa veloce e semplice, prometto. 
 
Diciamo che vogliate disegnare una di quelle eleganti tavole con 9 vignette. Ecco come Manga Studio (o 

Clip Studio Paint, dato che sono la stessa cosa) può venire in aiuto! 
 
Passo 1: Creare un nuovo Frame folder (vedere come nella Parte 1). 
 
Passo 2 : Selezionare lo strumento Object Selection (anche questo si può vedere nella prima parte), e 

cliccare sulla vignettona sul Canvas. 
 

 

Passo 3: Selezionare dal menu Layer: Layer > Ruler Frame > Divide Frame Border Equally 
 

 

Passo 4: Si aprirà una nuova finestra che chiede come si vuole dividere la vignetta, e per un reticolo 
ordinato di nove vignette dovreste avere una cosa così: 
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La piccolo grafica è solo un esempio di come funziona la divisione: NON È un’anteprima di quello che 
accadrà. “Fit to side Direction of Frame” permette di giocare col modo in cui le divisioni operano su vignette 
che sono leggermente distorte, per esempio. Selezionandolo, la grafica cambierà così: 
 

 

Ma, ancora, la grafica aiuta a capire cosa accadrà, ma non è un’anteprima. Se si sta tagliando una 
vignetta perfettamente rettangolare, entrambe le opzioni daranno lo stesso risultato. 

 
Che è questo: 
  

 

Come sempre, preferisco tenere le mie vignette in una sola cartella, per cui ho utilizzato “Divide folder: 
Not change”. Si possono dividere come meglio si crede. 

 
Questo strumento è in realtà molto utile, ad esempio per dividere un singolo livello in tre/quattro (o 

qualsivoglia) vignette di dimensioni uniformi. È un trucco che uso molto 
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Sto programmando di fare prossimamente un veloce video su Youtube dove metterò queste cose, per 
cui se avete domande che vi piacerebbe farmi sulle vignette, cose poco chiare o che non ho trattato, 
lasciate un commento qua sotto, grazie! 

 
E questo conclude la mia trattazione sulle vignette. La prossima volta? Magari diamo un’occhiata a come 

fare i flat su Manga Studio. 
 

[I post originali sono stati pubblicatida PJ Holden giorno dopo giorno, per cui i riferimenti alle varie parti non erano 

con “la prossima volta” ma “domani” ecc., così come la trattazione dei flat era prevista per la settimana successiva a 

quella delle vignette. Ho cambiato i riferimenti per dar continuità alla trattazione così come è presentata qui. Ho 

salvato alcuni dei post di JP Holden, ma non tutti, per cui molti sono “…perduti nel tempo, come lacrime nella 

pioggia…”. Qualcosa si può trovare nel suo canale Youtube PJ Holden – N.d.M.] 

Torna a parte 1, pag. 239 
Torna a parte 2, pag. 251 
Torna a parte 3, pag. 257 
Torna a inizio parte 4, pag. 263 

  

https://www.youtube.com/user/pauljholden
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APPENDICE 002 - Modelli colore  
Non sono un esperto di colore, ho solo raccolto qui alcune informazioni che ogni tanto torno a rileggere. 

L’argomento andrebbe di sicuro approfondito più di quanto abbia fatto in queste righe. 

HSV e HSL 

In CSP troviamo, oltre a RGB  e CMYK, anche i modelli HSV e HSL (chiamato HLS).  
HSV = Hue, Saturation, Value > Tinta, Saturazione, Valore. Sinonimi: HSB (B= Brightness), HSI 

(I=Intensity). 
HSL=  Hue, Saturation, Lightness > Tinta, Saturazione, Luminosità. 
 

HSV e HSL sono rappresentazioni alternative del modello di colore RGB , progettato negli anni ‘70 per la 
computer grafica con lo scopo di essere più fedele alla percezione dei colori dell’occhio umano. 
 

Il modello HSV (Fig.  379) rappresenta il modo in cui diversi colori si mescolano tra loro, con il parametro 
Saturazione che rappresenta i vari gradi di pienezza del colore [se è vivo o smunto] e il parametro Valore  che 
rappresenta la miscela di questo colore con diverse quantità di nero o bianco.  

 

Il modello HSL (Fig.  380) tenta di assomigliare a modelli di colore più percettivi come il sistema di colore 
naturale (NCS) o sistema Munsell, mettendo colori completamente saturi intorno ad un cerchio, posto a un 
valore di luminosità di ½ , in cui il valore 0 è completamente nero e 1 è completamente bianco. 

[trad. e adattato da Wikipedia] 
 

I due sistemi si possono rappresentare come dei cilindri in cui i tre parametri sono rappresentati dalle 
tre dimensioni. Lungo la circonferenza trovo i valori di Hue (tinta, tonalità; cioè il colore: lungo la 
circonferenza trovo tutti i colori); lungo il raggio trovo la Saturation (saturazione: quanto il colore è “pieno”. 
Ad esempio il rosa è un rosso poco pieno; il rosso si trova sulla circonferenza, il rosa più all’interno 
viaggiando lungo il raggio). 

Lungo l’altezza del cilindro, nel modello HSV trovo V, Value = valore, cioè quanto il colore  si scosta dal 
nero, con 0 = nero e 1 = colore pieno. 

 

Nel modello HSL troviamo L = Lightness, luminosità: quanto un colore è “luminoso”. La variazione va dal 
nero al bianco, con il colore saturo che si trova a metà strada. Infatti un valore di L pari a 0 significa nero, 1 
significa bianco, mentre il colore saturo ha un valore di 0,5. 

 

In pratica sembrerebbe che, mentre il cilindro HSV si ferma a metà dell’altezza (cioè al colore saturo) del 
cilindro HSL, quest’ultimo prosegue invece fino al bianco. Non sono sicuro sia corretto vederla così, perché 
Lightness e Value, da quello che ho capito, sono due cose diverse. 

 

 
Fig.  379 – Modello colore HSV, da Wikipedia 

 

 
Fig.  380 – Modello colore HSL, da Wikipedia 

 

Alcune risorse su questo argomento: 
Sopra le righe; 
Wikipedia (in inglese); la stessa pagina c’è in italiano ma è inspiegabilmente incompleta. C’è la traduzione 

completa qui: non so cosa esattamente sia questa pagina, ma la traduzione è catastrofica (automatica, voglio sperare), 
da lasciar perdere; 

Gianluca Tramontana Blog; 
Boscarol.com; leggere anche i commenti a fine pagina, in cui Maurizio Boscarol dà ulteriori chiarimenti 

rispondendo a una domanda. 
Questo video di Luca Malisan. 

  

https://en.wikipedia.org/wiki/HSL_and_HSV
https://en.wikipedia.org/wiki/HSL_and_HSV
https://en.wikipedia.org/wiki/HSL_and_HSV
https://www.sopralerighe.org/il-metodo-hsb/
https://en.wikipedia.org/wiki/HSL_and_HSV
https://it.wikipedia.org/wiki/Hue_Saturation_Brightness
https://it.qwe.wiki/wiki/HSL_and_HSV
https://www.gianlucatramontana.it/blog/2017/05/teoria-del-colore-i-modelli-rgb-cmyk-hsb-e-lab/
http://www.boscarol.com/blog/?p=17718
https://www.youtube.com/watch?v=GGzOZ7QjMZw


Appunti di Manga Studio/ClipStudioPaint   

267 

APPENDICE 003 – I Blending mode 
Di seguito ha tradotto la parte del Manuale che spiega come agiscono i vari metodi di fusione. 
Con l’asterisco * indico le voci presenti solo nell’elenco dei metodi dei pennelli. In verde ho indicato i 

corrispondenti comandi in Photoshop, quando hanno un nome diverso; non tutti i metodi esistono in 
entrambi i programmi;   

 

Configura come sovrapporre il riempimento sui colori originali. Selezionare un metodo dai vari modi di unione 
descritti sotto. 

 

I metodi di fusione sono spiegati nel Manuale in Layer Palette > Layer Operations > Setting the Blending Mode. 
 

Normal  Normale 
Sovrappone il riempimento così com’è sopra il colore originale. 

 Darken   Scurisci 
I valori RGB del riempimento e il colore originale sono confrontati e viene mostrato il valore più basso 

Multiply  Moltiplica 
I valori RGB del riempimento vengono moltiplicati per quelli del colore originale. Dopo la fusione, i colori sono più 
scuri degli originali. Quando il colore di riempimento è bianco il colore nel layer sottostante viene mostrato così 
com’è. 

Color burn  Brucia 
Produce un effetto simile alla “bruciatura” nella fotografia tradizionale, I colori originali sono dapprima scuriti per 
aumentare il contrasto e poi uniti al colore di riempimento. Quando il colore di riempimento è bianco, il colore 
originale rimane com’è. 

Linear burn  Brucia lineare 
I colori originali sono dapprima scuriti e poi uniti al colore di riempimento. Quando il colore di riempimento è 
bianco, il colore originale rimane com’è. 

Black burn  Bruciatura  scura * 
Scurisce l’area di disegno producendo un effetto simile alla sottoesposizione in fotografia. L’effetto non viene 
applicato quando il colore originale è trasparente. 

Subtract  Sottrai 
I valori RGB del colore di riempimento sono sottratti da quelli del colore originale. Dopo l’unione, i colori sono più 
scuri degli originali. Quando il colore di riempimento è il nero, il colore originale rimane com’è. 

Lighten  Schiarisci 
I valori RGB e il colore originale sono confrontati e viene mostrato  il colore con il valore più alto. 

Screen  Schermo Scolora 
I colori originali sono dapprima invertiti e poi moltiplicati per il colore di riempimento. Dopo l’unione, i colori sono 
più luminosi degli originali. Comunque, quando il colore di riempimento è il nero, il colore originale viene mostrato 
com’è. Quando il colore di riempimento è il bianco, viene mostrato il bianco. 

Color dodge  Schermatura colore Colore Scherma 
Così come il “Dodge” nella fotografia tradizionale, rende più luminosi i colori del layer sottostante diminuendo il 
contrasto. Quando il colore di riempimento è il nero, il colore originale è mostrato com’è. 

Glow dodge   Scherma Bagliore Scherma 
Produce un effetto sulle aree semitrasparenti più forte del [Color dodge]. Quando il colore di riempimento è il 
nero, il colore originale è mostrato com’è. 

White burn * 
Al momento in cui scrivo (Novembre 2022) non è presente nel Manuale. Da prove, vedo che schiarisce il colore 
sottostante, non ho capito con quale criterio. 

Add  Somma 
I valori RGB del colore di riempimento vengono sommati a quelli del colore originale. Dopo l’unione, i colori sono 
più luminosi degli originali. Quando il colore di riempimento è il nero, il colore originale è mostrato com’è. 

Add (Glow)  Somma (Bagliore) 
Sulle aree semitrasparenti produce un effetto più forte dell’ *Add+. Quando il colore di riempimento è il nero, il 
colore originale è mostrato com’è. 

Overlay  Sovrapponi 
Unisce applicando il [Multiply] o lo [Screen] a seconda dei colori sovrapposti. Dopo l’unione, le aree più luminose 
sono ancor più luminose, le zone più scure ancora più scure. 

Soft light  Luce soffusa 
Produce risultati differenti a seconda della luminosità del colore di riempimento. Quando il colore di riempimento 
è più luminoso del grigio al 50%, il risultato è più luminoso del colore originale, come nell’effetto Dodge. Quando il 
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colore di riempimento è meno luminoso del grigio al 50%, il risultato è più scuro del colore originale, come 
nell’effetto Burn. Quando il colore è luminoso come il grigio al 50% il colore originale non viene modificato. 

Hard light  Luce forte Luce intensa 
Produce effetti differenti a seconda della luminosità del colore di riempimento. il colore di riempimento è più 
luminoso del grigio al 50%, il risultato è un colore luminoso che assomiglia a quello dell’effetto *Screen+. Quando il 
colore di riempimento è meno luminoso del grigio al 50%, il risultato è un colore che ricorda quello dell’effetto 
[Multiply]. Quando il colore è luminoso come il grigio al 50% il colore originale non viene modificato. 

Difference  Differenza 
Sottrae il colore di riempimento dal colore originale e sostituisce il colore originale con il valore assoluto della 
differenza. 

Erase (ex Clear)  Pulisci Cancella * 
Il disegno è cancellato nell’area riempita 

Background  Sfondo * 
Mette il colore di riempimento sotto il colore originale. Il colore di riempimento si comporta come se fosse 
applicato per primo. 

Replace alpha  Sostituisci alfa * 
Sovrappone il colore di riempimento al colore originale. L’opacità dell’area sovrapposta è convertita nell’ *Opacity+ 
specificata nella finestra di dialogo.  

Compare density  Confronta la densità * 
Riempie solo quando l’opacità del colore di riempimento è maggiore di quella del colore originale. 

Erase (compare)  Cancella (confronta) * 
Cancella il disegno solo quando il risultato della sottrazione dell’opacità del riempimento da 100 è più piccolo 
dell’opacità del colore originale. 

Vivid light  Luce vivida 
Il contrasto è rafforzato o indebolito a seconda del colore di riempimento. Se il colore di riempimento è più 
brillante del grigio al 50%, è applicato il Brucia e l’immagine è resa più luminosa. Se è più scuro del grigio al 50%, è 
applicato il Dodge e il contrasto dell’immagine aumenta. 

Linear light  Luce lineare 
La luminosità è aumentata o diminuita a seconda del colore di riempimento. Se il colore di riempimento è più 
luminoso del grigio al 50% l’immagine è resa più luminosa. Se è più scuro del grigio al 50%, l’immagine è resa più 
scura. 

Pin light  Luce puntiforme 
I colori dell’immagine sono sostituiti a seconda del colore di riempimento. Se il colore di riempimento è più 
luminoso del grigio al 50%, il colore originale è sostituito dal colore di riempimento solo se il colore originale è più 
scuro. Se il colore di riempimento è più scuro del grigio al 50%, il colore originale è sostituito dal colore di 
riempimento solo se il colore originale è più chiaro. 

Hard mix  Miscela dura 
I valori RGB del colore di riempimento sono sommati a quelli del colore originale. Se il totale di uno dei valori RGB 
è maggiore di 255, è convertito a 255. Se il totale di uno dei valori RGB è minore di 255, è convertito a 0. 

Exclusion  Esclusione 
Un effetto simile a [Difference], tranne che per un contrasto minore. Se il colore di riempimento è il bianco, il 
colore dellayer sottostante è invertito quando avviene la fusione. Quando il colore di riempimento è il nero, il 
colore originale rimane com’è. 

Darker color  Colore più scuro 
 La luminosità del colore di riempimento e quella del colore originale vengono confrontate ed è mostrato il colore 
con il valore più basso. 

Lighter color  Colore più chiaro 
La luminosità del colore di riempimento e quella del colore originale vengono confrontate ed è mostrato il colore 
con il valore più alto. 

Divide  Dividi 
I valori di RGB del colore originale sono moltiplicati per 255 e poi divisi per I valori RGB del colore di riempimento. 

Hue  Tonalità  
È applicata la tonalità del colore di riempimento, mantenendo la luminosità e la saturazione del colore originale. 

Saturation  Saturazione  
È applicata la saturazione del colore di riempimento, mantenendo la luminosità e la tonalità del colore originale. 

Color  Colore 
Sono applicate la tonalità e la saturazione del colore di riempimento e viene mantenuta la luminosità del colore 
originale. 
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Brightness Luminosity  Luminosità  
È applicata la luminosità del colore del riempimento mantenendo la tonalità e la saturazione del colore originale. 
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APPENDICE 004 - Glossario della stampa e prestampa 
Ho trovato questo utile glossario sul blog di Mauro Boscarol e sulla pagina Wikipedia “Glossario della 

stampa e prestampa”, che credo sia sempre frutto dello stesso autore o altro che a lui si ispira (sono scritte 
le stesse parole…). Riporto qui una fusione delle due fonti; per gli originali vedere i link appena indicati. 

 

A A 
La serie "A" è uno standard di formati carta ISO internazionale (ISO 216), che va dal formato A0 (più grande) al 
formato A10 (più piccolo). Ogni misura piegata in due perpendicolarmente al lato lungo rappresenta il formato 
della misura successiva. Vedi anche Formato carta. 
Abrasione 
Il processo di logoramento per attrito. Danneggiamento della superficie a causa dello strofinamento di una 
parte contro un'altra parte o superficie. 
Abbondanza (di rifilo) 
(eng. Trapping) Tecnica che minimizza gli effetti del “fuori registro” in stampa, consistente nel sovrastampare di 
poco le aree di stampa i cui bordi sono adiacenti per evitare che il fuori registro di un colore in foratura evidenzi 
il classico filetto bianco sul foglio stampato (vedi immagine qui sotto). Talvolta il termine viene usato con il 
significato di rifilo *in questo caso credo sia il “bleed”+ e in tal caso il trapping viene 
chiamato compensazione o sormonto  (terminologia sconsigliata). 
 

 
Allargamento del punto 
(eng. Dot Gain) Vedere anche Tone Value Increase, allargamento del valore tonale. 
Allestimento dello stampato 
Complesso delle operazioni di finitura di un semilavorato per ottenere il prodotto finito. Si divide in 
cartotecnica, legatoria e confezionamento finale. 
Angolo di retino 
È l'angolo che la linea dei punti forma con la verticale. 
Anilox 
Cilindro retinato che serve per il trasferimento e la dosatura dell'inchiostro, secondo volumi variabili e definiti, 
dal calamaio/serbatoio al cliché e quindi al supporto stampato. La quantità di colore trasferito dipende da: 
rapporto fra alveoli e bianchi interalveolari 
finezza del retino 
angolazione dell'alveolo 
profondità dell'alveolo 
forma dell'alveolo 
In base a questi parametri è possibile calcolare l'entità del trasporto ossia il volume degli alveoli in cm3/mq. 
Assorbenza 
Capacità di un supporto cartaceo di assorbire un liquido. Nel caso degli inchiostri si fa riferimento ad un test 
con nero porometrico, nel caso di liquidi acquosi, all'indice di Cobb (gr di acqua/mq). Concettualmente, minore 
è l'assorbenza di un supporto maggiore dovrà essere la velocità d'essiccazione dell'inchiostro da utilizzare. 
Astralon  
(eng. Astralon) Foglio di plastica indeformabile utilizzato per il montaggio manuale delle pellicole al fine di 
incidere lastre offset. 

B B  
La serie "B" è uno standard di formati carta ISO internazionale (ISO 216), che va dal formato B0 (più grande) al 
formato B10 (più piccolo). Ogni misura piegata in due perpendicolarmente al lato lungo, rappresenta il formato 
della misura successiva. 
 
 
 

http://www.boscarol.com/blog/?p=4097
http://www.boscarol.com/blog/
https://it.wikipedia.org/wiki/Glossario_della_stampa_e_prestampa
https://it.wikipedia.org/wiki/Glossario_della_stampa_e_prestampa
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Biadesivi  
Servono per montare e far aderire le matrici sul cilindro di stampa (manica). Le caratteristiche di spessore, 
comprimibilità, densità (alta, media, bassa) e resilienza (rapidità di ritorno alla condizione iniziale dopo l'uscita 
di pressione) influenzano sensibilmente la qualità della stampa. Esempio: biadesivi a bassa densità riducono 
normalmente il dot gain dei retinati ma possono causare effetto di perlinatura nei pieni. Quelli a media densità 
producono pieni più uniformi ma maggiore dot gain mentre i biadesivi ad alta densità sono maggiormente 
adatti per pieni di grandi dimensioni. 
Bianco (grado di)  
(eng. brightness). Esprime la porzione di luce blu (457 nm) riflessa dalla superficie della carta in condizioni 
definite (ISO 2470 Illuminante C) e viene percepita come effetto di chiarezza, bianchezza collegata alla presenza 
di sostanze fluorescenti, azzurranti che riflettono nella zona dei blu. 
Bianca  
Facciata del foglio di stampa opposta alla Volta, che riporta la pagina 1 della segnatura. 
Bianco tipografico  
La parte di una matrice di stampa che non trasferisce inchiostro. Contrografismo. 
Bianchezza  
(eng. whiteness). Definisce la sensazione di bianchezza della carta e dei supporti in genere all'osservazione 
umana. Si misura rilevandone il colore superficiale per mezzo di un colorimetro (ISO 11475 D65/10°). 
Bicromia  
Stampa a due colori. 
Bilanciamento dei grigi  
Usato per valutare obiettivamente i colori poiché l’occhio umano rileva facilmente gli spostamenti di neutralità 
quando le aree neutre sono confrontate fianco a fianco e non c’è alcuna fusione di colori nell’area neutra. Nel 
sistema di riproduzione dei colori, il bilanciamento dei grigi è la condizione in cui i valori dei colori primari sono 
bilanciati per dare un grigio visivamente neutro. Un grigio visivamente neutro non può essere ottenuto 
utilizzando valori uguali di ciascun colore CMY. I valori di bilanciamento dei grigi di una serie data di inchiostri, 
di una carta e delle caratteristiche di trasferimento tonale descrivono le relazioni reciproche dei 3 colori, 
necessarie per mantener un grigio in tutta la scala tonale. 
Bleed   
(eng., letteralmente “sanguinare”) → rifilo 
BMP  
È il formato standard per la definizione delle immagini bitmap in ambiente Windows. Supporta i metodi RGB, 
scala di colore, scala di grigio e bitmap; non supporta canali alfa. Si può specificare il formato Microsoft 
Windows o OS/2, una risoluzione in bit e, per le immagini a 4 e 8 bit è possibile usare la compressione RLE. 
Brochure  
(eng. [ fr!]) si può tradurre con opuscolo, spesso di prestigio per l’uso di immagini, la carta impiegata, l’uso 
sintetico del testo. 
Bucatura o Foratura  
(eng. Knockout) Eliminazione di una parte di un grafismo per fare in modo che un altro grafismo non 
sovrastampi. per esempio, nell’immagine più su, la stella ciano “buca” lo sfondo magenta; opposto di → 
sovrastampa; 

C C  
La serie "C" è uno standard di formati carta ISO internazionale (ISO 216), che va dal formato C0 (più grande) al 
formato C10 (più piccolo). Ogni misura piegata in due perpendicolarmente al lato lungo, rappresenta il formato 
della misura successiva. 
Calibro  
Spessore del supporto secondo Tappi T411, su imisrise.tappi.org. 
Carattere  
(eng. Font) Identifica una serie di caratteri tipografici aventi una comune caratteristica stilistica. I Font sono dei 
files codificati mediante un formato. 
Cartotecnica  
Allestimento di stampati extralibrari come: packaging, cartelli espositori, rubriche, scatole, buste, shopper, 
etichette etc. 
Ciano  
(eng. Cyan) Il colore di uno dei quattro inchiostri di quadricromia (gli altri sono magenta, giallo e nero). 
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Cianografica  
(eng. Proof, Blueprint) Indica una prova di stampa realizzata con una stampante digitale valida solo per il 
posizionamento e il montaggio, non valida come prova colore. 
CIE XYZ  
CIE XYZ è uno dei primi spazi colori definito matematicamente dalla Commissione internazionale 
sull'illuminazione (CIE) nel 1931. Questo spazio colore deriva da una serie di esperimenti fatti alla fine degli anni 
venti del XX secolo da W. David Wright e John Guild. I loro risultati sperimentali furono combinati nelle 
specifiche dello spazio di colore CIE RGB, dal quale CIE XYZ fu derivato. 
Cliché  
Matrice in zinco per la stampa di illustrazioni in tipografia o nella stampa a caldo. Zincografia. In tempi recenti 
sono state introdotte le più economiche matrici di fotopolimeri. 
Cliente finale, Committente  
(eng. Consumer Product Company). Azienda che richiede un prodotto stampato, ne definisce le caratteristiche e 
ne ordina l'esecuzione. 
CMYK  
È la sigla di Cyan, Magenta, Yellow, Key black; è un modello di colore detto anche di quattricromia o 
quadricromia. 
CMS (Color Management System)  
Software ideati per facilitare l’uso della gestione del colore nelle applicazioni. Su Mac OS abbiamo ColorSync, su 
PC ICM o WCS. Questi CMS comprendono un motore di colore, un modo per organizzare la memorizzazione e il 
recupero dei profili ICC, un modo per assegnare (ed eventualmente modificare) il profilo del monitor. 
Colore Pantone  
Colore a tinta piatta indicato con una sigla proveniente da una delle librerie di colori proposte dalla società 
americana Pantone oggi acquisita da X-Rite. 
Pantone fornisce due tipi di librerie: librerie di colori spot e librerie di colori equivalenti in colori di 
quadricromia; tipicamente con il termine “colore Pantone” si intende un colore spot e non di quadricromia; la 
parola Pantone rimane invariata al plurale, come euro. 
Colore Spot  
(eng. Spot Color) Colore ottenuto con un singolo inchiostro speciale, non con inchiostri di quadricromia. Anche 
detto: tinta piatta, colore dichiarato, colore di barattolo, colore di scatola, quinto colore, colore di calamaio. 
Compensazione →abbondanza 
Composizione 
(eng. typesetting) [da inserire] 
Contrasto di stampa  
Calcolo che confronta le letture di densità di un retino al 70 o 80% con il 100% di superficie piena dello stesso 
colore. Un buon contrasto di stampa indica la capacità di un sistema di stampa di tenere aperte le zone non 
stampanti pur continuando a mantenere un’alta saturazione dei pieni (densità). 
Contrografismo  
Zona non stampante. 
Conversione in quadricromia 
[da inserire] 
Converting  
Insieme delle lavorazioni, materiali, prodotti attinenti al packaging  
Copertura inchiostro 
(eng. total ink limit) [da inserire] 
Creativo  
Azienda, Persona, che crea il progetto esecutivo. 
Cromalin  
È un sistema di prova contrattuale a colori della DuPont, in origine analogico (nato nel 1972 ed utilizzava le 
pellicole e toner colorati), successivamente il sistema analogico è stato sostituito da una serie di stampanti 
digitali. 
Impropriamente il termine “cromalin” viene talvolta usato per indicare qualunque prova colore. 
CTF  
Computer to Film. Sistema computerizzato di scrittura diretta della pellicola. 
CTP  
Computer to Plate. Sistema computerizzato d'incisione diretta della matrice. 
CTP LAMS  
vedi LAMS. 
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Curvatura  
Deformazione della carta o del cartone causata da tensione disuniforme delle due superfici. Il fenomeno è 
collegato alle condizioni di umidità relativa. 

D DCS (Desktop Color Separation)  
È una versione dello standard EPS sviluppata da Quark. DCS1.0 supporta file CMYK; DCS2.0 supporta file 
multicanale CMYK con un canale alfa e più canali di tinte piatte. 
Digitaldruck (deu.) →stampa digitale 
Digital proof (eng.) →prova digitale 
Downsampling (eng.) →ricampionamento 
DPI  
(eng. DPI) Unità di misura. Sigla di Dots Per Inch, ossia punti per pollice. È la misura della risoluzione 
(orizzontale o verticale) dei punti di stampa di una periferica di stampa; per esempio una stampante laser ha 
tipicamente una risoluzione di 300 punti per pollici e un platesetter (incisore di lastra) o imagesetter (incisore di 
pellicola) ha una risoluzione di 2400 punti per pollice. 
Durometro  
È lo strumento che permette di misurare la durezza della matrice in gradi Shore A per determinare, ad 
esempio, le differenze di livello di polimerizzazione. In funzione dello spessore della matrice (inferiore a 6 mm 
che è il valore minimo previsto dalla norma DIN 53505 per la misurazione della durezza della gomma) le 
misurazioni non avranno carattere assoluto ma consentiranno di avere un ottimo riferimento relativo per il 
controllo del processo. 

E Elastomero  
Materiale capace di ritornare alla dimensione precedente a seguito di una deformazione. 
Emulsificazione  
Dispersione dell’acqua di bagnatura nell’inchiostro. 
EPS o EPSF (Encapsulated PostScript)  
È un formato grafico in grado di descrivere sia immagini vettoriali che bitmap ed è riconosciuto da quasi tutti i 
programmi di grafica e di impaginazione. Il formato EPS può contenere tracciati di ritaglio per mascherare le 
immagini una volta importate in un programma di impaginazione. Supporta i canali alfa. 

F File digitale  
Contenitore di informazioni digitali. 
Finissaggio  
Parte finale dell'allestimento: Inscatolamento, pallettizzazione, etc. 
FIRST  
Flexographic Image Reproduction Specifications & Tolerances, su flexography.org.: Specifiche e tolleranze per la 
riproduzione delle immagini in Flessografia. Sono le linee guida, dati e tolleranze di lavorazione preparate 
dall'Associazione FTA, su flexography.org. per i propri associati. 
Flessografia o Flexografia  
La flessografia o, più comunemente chiamata flexo, è un metodo di stampa rotativa diretta, che usa lastre 
matrici a rilievo di gomma o di materiali fotopolimerici, detti cliché. 
Foratura o Bucatura  
(eng. Knockout) Eliminazione di una parte di un grafismo per fare in modo che un altro grafismo non 
sovrastampi. 
Fotopolimerico  
Materiale ottenuto per fotopolimerizzazione, vedi Fotopolimero. In ambito flessografico il termine identifica 
prodotti adatti alla realizzazione di matrici rilievografiche per la stampa tramite incisione laser diretta. 
Fotopolimero o Cliché  
Con il termine fotopolimeri si indicano i materiali fotosensibili adatti alla realizzazione di matrici flessografiche 
su cui l'immagine viene trasferita tramite diversi metodi (pellicola, toner ablativo) e dove la creazione dei 
grafismi viene realizzata tramite un processo fotochimico che prevede l'esposizione alla luce UV e lo sviluppo 
per la rivelazione dei rilievo stampante. 
Foratura →bucatura 
Forma di stampa  
Dispositivo atto a trasferire o ad attivare un elemento di contrasto su un supporto di stampa. 
Frequenza di retino  
Il numero di punti per unità di misura. In genere espresso in punti al cm o punti al pollice. 
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FTA  
Flexographic Technical Association, su flexography.org., Inc. È l'Associazione tecnica tra flessografi che si 
interessa della definizione e diffusione di standard di lavorazione nel settore. 

G Gamut di una periferica 
Insieme di colori producibili da una periferica: un monitor o una stampante; non “gammut” come si legge 
spesso 
GCR (Grey Component Replacement, rimozione del componente di grigio)  
Tecnica che ha un effetto ingrigente con l’inchiostro nero usato per sostituire gli inchiostri dei colori di 
processo. Il componente grigio di un colore stampato è determinato dall’inchiostro complementare che 
scurisce un colore (per esempio, la quantità di giallo nel blu, di ciano nel rosso o di magenta nel verde). GCR 
identifica gli effetti combinati dei tre inchiostri e li sostituisce con un nero unico. Ciò stabilisce i neutri nelle 
illustrazioni, poiché il grigio non dipende più dal preciso bilanciamento di CMY. Se l’inchiostro nero non 
raggiunge una densità sufficientemente alta, alcuni CMY possono essere riportati indietro per supportare le 
ombre molto scure (vedere UCA). 
GIF (Graphics Interchanges Format)  
È un formato grafico compresso utilizzato per la definizione di immagini in scala di colore destinate ad essere 
utilizzate principalmente sul Web o in altri documenti Html. In questo caso si utilizza la compressione 
reversibile LZW. Supporta fino a 256 colori e consente di ottenere buoni risultati con immagini a tinte piatte o 
al tratto contenenti un numero limitato di colori, mentre è sconsigliabile per fotografie o immagini che 
contengono sfumature. Può includere in un unico file più immagini in modo da creare animazioni di cui è 
possibile specificare la temporizzazione (GIF animate). Consente di memorizzare le immagini con una struttura 
tale che, all'atto della consultazione via Web, appaiano con una definizione via via migliore durante la fase di 
caricamento e visualizzazione (GIF interlacciate). Può assegnare una trasparenza ad uno qualsiasi dei colori 
della palette, in modo tale che attraverso le aree occupate da tale colore risulti visibile lo sfondo su cui 
l'immagine si trova (GIF trasparenti). 
Grado di liscio  
Si intende la rugosità superficiale di un supporto,quindi ampiezza e profondità delle asperità superficiali. Il 
grado di liscio si determina con il metodo Bekk (per flusso d'aria) e può influenzare la copertura del supporto da 
parte del film d'inchiostro. Con supporti molto rugosi è indispensabile utilizzare alte cariche d'inchiostro (anilox 
profondi e di bassa lineatura) per coprire gli avvallamenti più profondi. 
Grafismo  
Zona stampante. 
Giallo  
(eng. Yellow) Il colore di uno dei quattro inchiostri di quadricromia (gli altri sono ciano, magenta e nero). 

H Half-tone proof print  
(eng.) →prova colore retinata 
Hard proof  
(eng.) →prova colore 

K Knockout  
(eng.) →bucatura 

I  ICC (International Color Consortium)  
Organizzazione indipendente fondata nel 1993 allo scopo di sviluppare e mantenere uno standard aperto, a 
livello di sistema operativo e multipiattaforma per la gestione digitale del colore e a questo scopo pubblica 
proprie specifiche di modalità di costruzione e uso dei profili di colore. 
Inchiostro di stampa  
Elemento di contrasto, liquido, solido od in polvere, trasferito o attivato sul supporto di stampa per costituire il 
grafismo. 
ISO  
International Standards Organization. È l'organo preposto a livello internazionale alla definizione e sviluppo 
degli standard internazionali. Il Comitato Tecnico di ISO per le Arti Grafiche è TC 130. 

J  JFIF (JPEG File Interchange Format) o JPEG o JPG  
Si tratta di un formato grafico compresso secondo lo standard JPEG, largamente utilizzato per la definizione di 
immagini destinate ad un utilizzo sul Web o in altri documenti Html. JFIF, comunemente chiamato JPEG, 
supporta i metodi RGB, CMYK, scala di grigio, ma non i canali alfa utilizzabile per immagini fino a 16,7 milioni di 
colori. L'algoritmo di compressione utilizzato per generare questo formato consente di ridurre drasticamente le 
dimensioni dei file, ma porta inevitabilmente ad una perdita di dati che ne compromettono in parte la qualità. Il 
fattore di compressione è variabile e può essere selezionato dall'operatore nei programmi che supportano tale 
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metodo in un range che va da un fattore 2:1 (compressione senza perdita di dati) ad un fattore di 40:1. 
Naturalmente maggiore è il grado di compressione, minore è la qualità dell'immagine e viceversa. Una variante 
del JPEG è il JPEG progressivo che fornisce più rappresentazioni della stessa immagine corrispondenti a diversi 
valori di compressione via via meno elevati; all'atto della visualizzazione via Web un JPEG progressivo appare 
via via più definito man mano che procede il suo caricamento. Le immagini JPEG si decomprimono 
automaticamente all'apertura. 
JPEG (Joint Photographic Experts Group)  
Formato di compressione dati. Tecnica lossy supportata dai formati JPEG, PDF e Postscript. Garantisce i migliori 
risultati con immagini a tono continuo come le fotografie. 

L  Lab  
Lo Spazio colore Lab o CIELAB o CIE 1976 (L*, a*, b*) è uno spazio colore-opponente con la dimensione L per la 
luminosità e a e b per le dimensioni colore-opponente, basato sulle coordinate dello spazio colore non lineare 
compresso CIE XYZ. Le coordinate di Hunter 1948 sono quindi L, a e b. 
LAMS (Laser Ablation Mask System)  
(eng. LAMS) L'immagine da trasportare sul polimero viene costruita ablando una superficie di colore nero stesa 
sopra il polimero vergine. 
Lastra (offset)  
La lastra litografica , o lastra offset , è il supporto (forma) utilizzato nella stampa offset che fisicamente 
trasferisce l'inchiostro su un supporto gommato (caucciù) che a sua volta lo trasferisce, per contatto, sulla 
carta. 
Legatoria  
Allestimento di stampati librari e simili: libri, opuscoli, riviste, depliants, cataloghi, etc. 
Libro  
Prodotto stampato composto da interno e copertina unite tra loro da colla (brossura e/o cartonato). 
LPI (Lines Per Inch)  
(eng. LPI) unità di misura. Esprime in numero di linee per ogni pollice. 
LZW (Lempel-Ziv-Welch)  
Formato di compressione dati. Tecnica lossless supportata dai formati TIFF, PDF, GIF e Postscript. Ideale per 
comprimere immagini al tratto o a tinte piatte con un numero limitato di colori. 

M  Magenta  
(eng. Magenta) Il colore di uno dei quattro inchiostri di quadricromia (gli altri sono ciano, giallo e nero). 
Manica  
Cilindro cavo utilizzato per il montaggio della matrice in macchina da stampa. 
Marezzatura o Moiré  
(eng. [fr!] Moirèe) Effetto ottico di iterazione geometrica conseguente alla sovrapposizione o alla 
sovrastampa di retinati aventi le stesse caratteristiche di ripartizione. 
Matrice di stampa  
Elemento che permette il trasferimento ripetitivo dell'inchiostro sul substrato. Può essere di tipologia diversa a 
seconda del sistema di stampa. 
Matrice Flessografica  
È una forme di stampa rilievografica che presenta zone stampanti (grafismi) a rilievo rispetto alle zone non 
stampanti (contro-grafismi). La struttura del materiale utilizzato, gomma o materiali fotopolimerici, resiliente e 
flessibile è la caratteristica principale che ha dato il nome alla stampa flessografica. 
Mezzatinta 
[da definire] forma del punto. 
Microscopio  
Per la verifica della riproduzione dei grafismi è opportuno utilizzare un microscopio con un coefficiente di 
ingrandimento nella gamma tra ~50x fino a ~800x. Questi strumenti consentono una verifica bidimensionale 
del grafismo e non consentono la verifica di profondità. 
Misuratore di valore tonale  
Per la misurazione del valore tonale, ovvero del rapporto tra l'area della superficie stampante e quella non 
stampante, si utilizzano delle telecamere dotate di un sistema di calcolo che è in grado di analizzare l'effettiva 
area stampante del grafismo. Questi strumenti possono essere basati su telecamere con focali oppure da veri e 
propri sistemi interferometrici che consentono di calcolare la topografia della superficie della matrice. È inoltre 
necessario disporre di un densitometro in bianco/nero (possibilmente con filtro UV) per la verifica dei materiali 
in pellicola e del toner nero sulle lastre digitali ablative. 
Moirée  Marezzatura 
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Monocromia  
Stampa ad un solo colore. 
Montaggio 
(eng. imposition) [da definire] 

N  Nero  
(eng. Black) Il colore di uno dei quattro inchiostri di quadricromia (gli altri sono ciano, magenta e giallo). 

O  Offset  
Sistema di stampa piana indiretta, in quanto i grafismi ed i contrografismi sono sullo stesso piano, che si basa 
sulla repulsione tra acqua ed inchiostro grasso. 
Opuscolo  
Prodotto stampato e allestito con cucitura a punto metallico, termoplastici o similari. 
Orfano  
Titolo di un capitolo nell’ultima riga della pagina precedente. 
Originale  
Soggetto da riprodurre. 

P  Packaging o Imballaggio  

Operazioni attinenti alle tecnologie di produzione di imballi rigidi o flessibili. 
Perlinatura  
(eng. mottle) mancanza di uniformità di un pieno di colore stampato. Si usa anche il termine “buccia d'arancio”. 
PCX  
È un formato grafico ormai caduto ormai in disuso ma che ha rappresentato per lungo tempo uno standard per 
le applicazioni grafiche su piattaforma PC. Supporta i metodi RGB, scala di colore, scala di grigio e bitmap, ma 
non i canali alfa. Le immagini possono avere risoluzioni di 1, 4, 8 o 24 bit; è possibile usare la compressione RLE. 
PDF (Portable Document Format)  
È una formato creato da Adobe e utilizzato da Adobe Acrobat, un pacchetto software per l'editoria elettronica 
utilizzabile su piattaforma Windows, Macintosh, Unix e DOS. I file PDF possono essere visualizzati con 
l'applicazione Acrobat Reader. Come tutti i formati PostScript, il PDF può contenere sia immagini bitmap che 
vettoriali, oltre a funzioni di ricerca e navigazione all'interno del documento. Supporta i metodi RGB, CMYK, 
scala di colore, scala di grigio, bitmap, LAB, ma non i canali alfa. Supporta altresì le compressioni JPEG e ZIP. Il 
PDF rappresenta l'ossatura di una nuova filosofia sviluppata da Adobe per la gestione e lo scambio dei 
documenti elettronici (e-paper) e che ha portato in breve tempo questo formato a rappresentare uno standard 
riconosciuto in diversi Paesi. 
PICT (Macintosh Picture)  
Standard per la definizione di file grafici su piattaforma Macintosh. Supporta il metodo RGB con un canale alfa e 
i metodi scala di colore, scala di grigio e bitmap senza canali alfa. PICT2 supporta il colore a 24 bit. Efficace nella 
compressione di immagini che presentano grandi aree di colore uniforme e dei canali alfa. le immagini RGB 
possono avere risoluzioni di a 16 o 32 bit, quelle a scala di grigio 2, 4 o 8 bit per pixel. 
Piegatura  
Operazione che trasforma i fogli stesi in fogli piegati o in segnature. 
PNG (Portable Network Graphics)  
Formato compresso pensato come alternativa al GIF, a differenza di quest'ultimo supporta immagini a 24 bit 
con una gamma fino a 16,7 milioni di colori e può produrre sfondi trasparenti di buona qualità. Supporta i 
metodi scala di grigio, RGB con un solo canale alfa, bitmap e scala di colore senza canali alfa. Progettato 
appositamente per consentire la compressione di file grafici senza alterazioni di qualità è adatto a qualsiasi tipo 
di immagine, ma non è supportato da tutti i browser. 
Policromia  
Stampa a più colori. 
PPI (Pixel Per Inch)  
(eng. PPI) Unità di misura. Rappresenta i pixel per pollice. È la misura di risoluzione (orizzontale o verticale) di 
una immagine raster (cioè una immagine composta di pixel) quando visualizzata su un display o stampata con 
una periferica di stampa; anche misura di risoluzione di un display raster (cioè composto di pixel); la risoluzione 
orizzontale di una immagine o di un monitor è in relazione con la sua dimensione e con il numero di pixel: 
numero di pixel di base / base dell'immagine o del monitor in pollici = risoluzione in pixel per pollice 
(analogamente per la verticale). 
Prematrice  
Modello intermedio fra l'originale e la matrice necessario per ottenere la formatura grafica. 
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Prestampa  
(eng. Prepress) Complesso di operazioni che, partendo dall'originale, porta, attraverso la progettazione grafica, 
alla realizzazione di prematrici, matrici e forme di stampa. 
Procedimento grafico  
Gruppo di processi finalizzati ad ottenere un prodotto stampato. 
Processo grafico  
Operazioni svolte in prestampa ed in stampa per ottenere un prodotto stampato. 
Profilo ICC  
Un profilo ICC è un insieme di dati che descrivono, secondo regole e standard promulgate dall'ICC 
(International Color Consortium), il modo in cui i colori sono rappresentati numericamente in un determinato 
spazio dei colori. 
Profilo colore  
File contenente informazioni utili ad identificare lo spazio colore di riferimento. 
Progressiva a colori  
Sequenza delle stampe dei monocromi dei colori primari di stampa e delle diverse combinazioni fra loro. 
Prova colore  
(eng. hard proof) Simulazione di una immagine stampata, fatta con una diversa periferica di stampa, allo scopo 
di riprodurre il colore dell'immagine entro tolleranza stabilite. 
Prova colore a monitor  
(eng. soft proof) Simulazione digitale di una immagine stampata, fatta su un monitor, allo scopo di riprodurre il 
colore dell'immagine. 
Prova colore certificata  
(eng. certified color proof) Una prova colore digitale tecnicamente corretta ed entro le tolleranze della 
normativa (attualmente la ISO 12647-7) la cui correttezza è certificata da un ente terzo. 
Prova colore retinata  
(eng. half-tone proof print) È una prova colore ottenuta usando la stessa tecnologia di retinatura dello 
stampato da simulare. 
Prova concettuale  
Prova non profilata e quindi non copiabile in Stampa. Utilizzata dal Creativo/Grafico per visionare il lavoro e 
concordarne le caratteristiche di contenuto con il Cliente. 
Prova contrattuale  
Prova profilata, cioè eseguita con le caratteristiche del processo e sul supporto previsto per la stampa finale. 
Utilizzata per le verifiche e l'approvazione del prodotto da parte del Cliente e accettata dallo Stampatore che 
ne garantisce la copiatura in macchina. 
Puntino  
Elemento di densità costante e dimensione variabile di un soggetto retinato. 

Q  Quadricromia  
Stampa in quattro colori. Tre colori primari sottrattivi (ciano, magenta, giallo) e il nero. Sigla CMYK. 

R  Rasterizzazione  
La rasterizzazione è il lavoro di conversione di un'immagine bidimensionale descritta da vettori (in grafica 
vettoriale), in un'immagine raster o bitmap, ovvero formata da pixel. 
Resilienza  
È la capacità di un materiale di assorbire energia di deformazione elastica, ritornando allo stato precedente 
Retino di stampa  
Sistema di rappresentazione dei toni di grigio tramite piccoli elementi stampanti di dimensione diversa ed 
uguale densità. Essendo elementi molto piccoli l'occhio li integra riformando una sensazione di valore tonale 
equivalente. 
Retinatura  
Operazione ottica od elettronica atta a trasformare un elemento a tono continuo in uno a tono discontinuo, 
cioè costituito da grafismi di uguale densità ed area variabile (retino tradizionale, AM) oppure da grafismi di 
area e densità constanti e frequenza (numero di punti per unità di superficie) variabile (vedasi retino 
stocastico). 
Registro  
Condizione di posizionamento ottimale dei vari elementi stampanti. 
Retino Ottico  
Mezzo ottico impiegato per ottenere la retinatura fotografica. 
Retino Stocastico  
Vedi: Stocastico. 
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Ricampionamento  
Tecnica informatica applicabile ai file raster finalizzata a ridurre od aumentare la risoluzione. 
Rilievografia  
Procedimento ad impatto che impiega forme con grafismi in rilievo. 
RIP (Raster Image Processor)  
Dispositivo hardware o software che traduce i dati di file elettronici in un insieme di punti e linee che possono 
essere stampati. 
RLE (Run Lenght Encoding)  
Formato di compressione dati. Tecnica lossless supportata dai formati Photoshop e TIFF. 
Rotocalco o Rotocalcografia  
Sistema di stampa diretta incavografica, dove i grafismi sono in incavo. 

S  Sleeve  
Vedi: Manica 
Silografia o Xilografia  
È un processo di stampa rilievografica con forma di legno. L'incisione consiste nell'abbassare il livello nelle zone 
non stampanti con bulini, sgorbie ed altri attrezzi. 
Soggetto al tratto  
Soggetto costituito da elementi di immagine privo di variazioni tonali. 
Sovrastampa  
(eng. overprint) Stampa di un grafismo sopra un altro; in stampa offset gli inchiostri sono semitrasparenti e 
dunque un grafismo sovrastampato ha un aspetto (un colore) diverso dallo stesso grafismo non sovrastampato. 
Solid Ink Density (SID), densità inchiostro a fondo pieno  
Misura della quantità di luce complementare (filtro maggiore) che è assorbita da una porzione di fondo pieno 
in una barra di colore: è ottenuta con un densitometro per riflessione. 
Soluzione di bagnatura  
Additivi chimici aggiunti all’acqua nella soluzione di bagnatura della macchina da stampa. 
Sormonto (trapping)  
L’efficienza con cui uno strato di pellicola di inchiostro umido è accettato dallo strato di inchiostro umido 
sottostante. 
Spessimetro  
È lo strumento che permette di misurare lo spessore dei diversi livelli sulla matrice, dallo spessore totale a 
quello della base. La precisione dello strumento deve consentire una lettura a 0,01 mm. 
Squadra  
È il lato del foglio di stampa, che con il lato pinza forma un angolo di 90° e che viene utilizzato dal registro della 
macchina da stampa; esso servirà come riferimento per tutte le successive lavorazioni di allestimento. 
Stampa  
Riproduzione iterativa dei grafismi della forma o dispositivo stampante su un supporto di stampa, mediante il 
trasferimento o l'attivazione di un elemento di contrasto. 
Stampa diretta  
Condizione di trasferimento diretto dell'inchiostro od elemento stampante, dalla forma al supporto di stampa. 
Stampa indiretta  
Condizione di trasferimento intermedio dell'inchiostro od elemento stampante, ad un elemento interposto tra 
forma e supporto di stampa. 
Stampato  
Oggetto finale di uno o più processi grafici costituito da un supporto riportante grafismi. 
Stampatore  
(eng. Printer) Azienda di stampa e finissaggio che provvede ad eseguire (o a far eseguire) le matrici e ad 
effettuare la produzione secondo quanto stabilito con il Cliente. 
Stocastico  
È un tipo di Retino di stampa dove la variazione del tono è ottenuta modificando la distribuzione dei punti 
cambia in frequenza (retino FM) e non in ampiezza (retino AM). 
Supporto di stampa  
Materiale in grado di trattenere il grafismo ricevuto o attivato dalla forma di stampa. 

T  TAC (Total Area Coverage), copertura totale zona  
Definisce in percentuale la zona di punto CMYK (valore tonale) aggiungendo i valori di ciascun colore nella zona 
più scura della selezione. In teoria, deponendo i fondi pieni al 100% di ciascun colore (TAC del 400%) si ottiene 
la zona nera migliore, ma ciò causa variabilità del colore. Il TAC viene misurato sul file originale e controllato 
durante la preparazione dell’immagine. Il TAC va controllato nelle zone più scure della pellicola o del file 
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elettronico e letto nello stesso punto per ciascun colore sulla pellicola finale o sul file del CTP. Il TAC massimo è 
influenzato dal supporto. 
Taglio di rifilo  
Operazione di taglio per ottenere il formato finito del prodotto stampato. 
Tensione superficiale  
È la proprietà di una superficie solida di lasciarsi bagnare da un liquido. La tensione superficiale rappresenta 
l'energia libera superficiale di un solido rispetto ad un liquido. In pratica la bagnabilità di un solido è misurata 
dal valore della sua tensione superficiale espressa in dynes/cm. Essa è in relazione con l'angolo di contatto che 
si crea tra una goccia di liquido ed un solido. Per ogni coppia "liquido-solido" esiste un valore detto tensione 
superficiale critica che per la stampa flexografica è 38 Dyne al di sotto della quale viene compromessa 
l'adesione dell'inchiostro al supporto. 
TIF o TIFF (Tagged-Image File Format)  
È un formato sviluppato principalmente per essere utilizzato da applicazioni per l'impaginazione, è supportato 
anche dai principali programmi per l'elaborazione di immagini e disegno ed è trasferibile su diverse 
piattaforme. Supporta i metodi RGB, CMYK, scala di grigio con canali alfa, i file LAB in scala di colore e bitmap. I 
file TIFF possono essere compressi utilizzando la codifica LZW che non provoca perdita di dati e riduce le 
dimensioni dei file fino al 50%. Il formato TIFF può memorizzare la separazione dei colori CMYK all'interno di un 
unico file, generando automaticamente la selezione dei colori quando il file viene inserito all'interno di un 
documento destinato alla stampa. 
Tinta piatta  
Vedi: Colore Spot. 
Tipografia  
È un processo di stampa rilievografica; la forma, piana o curva, può essere unitaria o composta da più elementi 
combinabili di metallo, lega ternaria, legno, gomma e polimeri; vengono impiegati inchiostri ad elevata 
viscosità. 
Tipometro  
Il tipometro è uno strumento utilizzato per la misurazione del corpo e della giustezza dei caratteri in tipografia. 
Tono continuo  
Percezione tonale di valore variabile senza soluzione di continuità. 
Tono discontinuo  
Percezione tonale di un soggetto ripartito in elementi di densità costante e di area variabile (retino AM) oppure 
di densità costante e frequenza variabile (retino FM). 
Trattamento corona  
Al fine di migliorare la capacità di adesione dei film, in particolare quelli poliolefinici (Polipropilene, polietilene 
ecc) le loro superfici devono essere sottoposte ad un processo di "ossidazione" superficiale ottenuto con il 
"trattamento corona" che producendo una scarica elettrica ad alto voltaggio ionizza l'aria producendo "ozono" 
che provoca reazioni di ossidazione superficiali con formazione di gruppi polari ,aumentando superficialmente 
cariche e dipoli idonei per l'adesione. 
Tricromia  
Stampa a tre colori. 
TVI (Tone Value Increase, incremento del valore tonale) o allargamento del punto  
Allargamento fisico dei punti di mezzatinta, durante la creazione dell’immagine, dovuto al processo di stampa e 
all’assorbimento dell’inchiostro da parte della carta (allargamento meccanico del punto); leggero spargimento 
intorno e sotto i punti (allargamento ottico del punto). La combinazione di entrambi dà come risultante il 
valore tonale per l’allargamento apparente del punto durante il processo di stampa. 

U  UCA (Under Colour Addition, addizione del sotto-colore)  
Addizione di colori di quadricromia per assicurare il TAC nelle zone d’ombra. 
UCR (Under Colour Removal, rimozione del sotto-colore)  
Riduce i contenuti di colore di quadricromia nelle zone scure e neutre della riproduzione e li sostituisce con del 
nero extra. L’UCR può essere eseguito soltanto nelle parti scure e neutre dell’illustrazione. 
UV  
Parte dello spettro elettromagnetico non visibile, indicativamente al di sotto di dei 380nm, la definizione ISO 
per UV indica dai 400 ai 100nm. 

V  Valore tonale  
Intensità luminosa di un colore deposto su un supporto. Rapporto percentuale tra la parte assorbita di un 
flusso luminoso incidente su un'area ed il flusso totale. 
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Viraggio  
Condizione chimica che riverifica 3-5 giorni dopo la stampa, quando la superficie dell’immagine diventa opaca e 
senza vita. Le cause comprendono un TAC più alto di quello raccomandato, un non corretto allargamento del 
punto e temperature di macchine fuori della norma. 
VOC  
Volatile Organic Compound: indica le sostanze organiche volatili emesse nell'ambiente in presenza e con 
l'impiego dei solventi. 
Volta  
Facciata del foglio di stampa opposto alla Bianca. 

Z  ZIP  
Formato di compressione dati. Tecnica lossless supportata dal formato PDF. Ha caratteristiche simili alla 
compressione LZW. Comprimendo un qualsiasi file in formato ZIP, questo viene ridotto in dimensioni (Kbytes). 
Per il riutilizzo di un file compresso, è necessario decomprimerlo e riportarlo al suo stato originale. 
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APPENDICE 005 - Scorciatoie da tastiera 
 Molte scorciatoie per la versione Windows; per la versione Mac sostituire Alt con Option e CTRL con 

Command (almeno credo: mi fido di quanto dice il Manuale in merito). 
È riportato anche l’utilizzo di tasti con determinati Tool o SubTool. Per una lista completa, vedere qui. 
Tutte le shortcut si trovano alla fine del Manuale di istruzioni, capitolo Shortcut list. 

 

Alcune delle shortcut trovate nel Manuale non funzionano (non le ho riportate); in qualche caso dovrebbe 
trattarsi della mappatura della tastiera: ricordo infatti che le scorciatoie riportate nel Manuale sono pensate 
per la tastiera in configurazione ENG; molte sono valide anche per la configurazione ITA, ma non tutte (es. non 
si possono usare combinazioni di tasti con le parentesi quadre perché nella tastiera italiana anche le parentesi 
quadre si ottengono con una combinazione di tasti). Per passare da una configurazione all’altra premere Shift + 
Alt (bisogna aver installato la tastiera US nel sistema operativo). In altri casi invece sospetto che si tratti della 
mia tastiera, già tempo addietro ho visto che non supporta alcune combinazioni di tasti. Vabbé. 
 

Ho raccolto le shortcut secondo due ordinamenti diversi, perché a volte cerco il significato di una 
combinazione di tasti, altre l’azione che voglio ottenere.  Infine ho fatto una raccolta per contesti, perlopiù 
corrispondenti alle voci della barra dei menù, come fa il manuale e come ho trovato più volte in giro. 

 

Ordine per tasto o combinazione di tasti 
Tasto o combinazione di tasti Azione 

' (apostrofo) diminuzione dimensioni pennello 
ì  aumento dimensioni pennello 

W bacchetta magica (Magic Wand) 
E  Passa a gomma (Eraser) (poi alterna tra Hard eraser e Vector, imp. personale) 
R Move > Rotate 
T  testo (Text) 
Y  correzione segno (passa all’ultimo Sub Tool selezionato dello strumento Correct  

line); alterna tra Pinch vector line e Correct line width (imp. personale) 
U   strumento Figure (cioè Ruler ecc.) 
I   contagocce (Eyedropper) 

O  Operation > Object (da me Select > Object) 
P  passa a penna (Pen) e poi alterna tra penna (Pen) e matita (Pencil) 
A Colora con il colore selezionato (Convert to drawing color, (imp. personale) 
S  riflessione verticale (Flip vertical, imp. personale) 
D  Operation > Select layer (da me Select > Layer selection) 
F  riflessione orizzontale (Flip Horizontal, imp. personale) 
G   passa a Gradient, poi alterna tra Gradient, Fill e Contour line paint 
H  Move > Hand temporaneo: sposta il foglio di lavoro (come con Spacebar) 
J  Blend 
K   Muove il contenuto del layer (Move layer): premi e muovi con frecce / tasto sx 

mouse / stilo 
L  Operation > Light table (da me Select > Light table), poi alterna tra Light table e 

Edit timeline 
ù  zoom 
Z Crop: rifila l’area di lavoro lungo i bordi di una (imp. personale) 
X  alterna tra Colore principale (Main color) e Colore secondario (Sub color) 
C 

 
alterna tra Colore trasparente (Transparent color) e quello tra Main e Sub color 
che era selezionato precedentemente 

B   passa a Brush e poi alterna tra Brush, Airbrush, Decoration 
M  selezione (Marquee) 

, (virgola)  scorre i diversi subtool del tool selezionato, verso l'alto 
. (punto)  scorre i diversi subtool del tool selezionato, verso il basso 

à ruota foglio in senso orario dell'angolo prefissato 
-  (lineetta) ruota foglio in senso antiorario dell'angolo prefissato 

  
Alt + Zoom zoom - 
Alt + Move layer duplica livello 

https://www.clip-studio.com/site/gd_en/csp/userguide/csp_userguide/900_shortcut/900_shortcut_operation.htm
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Alt + Operation o strumenti di 
disegno 

Eyedropper temporaneo (cioè attivo finché è premuto) 

Alt + Add to selection toglie dalla selezione 
Alt + Backspace o Canc riempi 
Alt + L Duplica livello (imp. personale) 
Alt + ì Livello sopra 
Alt + ‘ Livello sotto 
  
Backspace cancella il contenuto del layer o della selezione 
Spacebar (Barra spaziatrice) Move > Hand temporaneo: sposta il foglio di lavoro (come premendo H) 
  
CTRL + cursore: con layer raster, Move temporaneo); con layer vettoriali, Object temporaneo. 
CTRL + 0 adatta la vista alla finestra attiva 
CTRL + 1 attiva/disattiva lo snap al ruler 
CTRL + 2 attiva/disattiva lo snap allo Special ruler 
CTRL + 3 attiva/disattiva lo snap alla grid 
CTRL + 4 alterna i vari Special ruler presenti 
CTRL + A seleziona tutto 
CTRL + B Cambia il colore del livello 
CTRL + D deseleziona 
CTRL + E unisce al layer sottostante 
CTRL + I colora gli oggetti nel layer con il colore complementare 
CTRL + J All sides view (imp. personale) 
CTRL + K apre le Preferences 
CTRL + O apre un documento (Open) 
CTRL + P stampa 
CTRL + Q  chiude il programma (Quit) 
CTRL + R attiva/disattiva i righelli 
CTRL + S  salva (Save) 
CTRL + W chiude il documento corrente 
CTRL + Y ripristina ultima azione 
CTRL + Z annulla ultima azione 
CTRL + ò ripristina vista 
CTRL + + ingrandimento foglio 
CTRL  + -   rimpicciolimento foglio 
CTRL + Shift Object > Select layer temporaneo (toccare un oggetto del layer col cursore per 

selezionare il layer) 
CTRL + Alt + 0   Zoom al 100% 
CTRL + Alt + G   Clip to Layer Below: limita la visualizzazione di un layer al contenuto del layer 

immediatamente sotto: Es. se una linea in un layer incrocia una linea nel layer sotto e 
attivo questa opzione, allora continuo a vedere la linea del layer sotto, mentre della linea 
del layer “clippato” vedo solo le parti che toccano la linea sottostante. Poco chiaro? Fare 
una prova  

CTRL + Alt + S   salva con nome (Save as…) 
CTRL + Spacebar + stilo   zoom 
CTRL + Shif + Alt   Eraser temporaneo  
CTRL + Shif + E unisce i livelli visibili 
CTRL + Shif + D riseleziona (carica l’ultima selezione creata) 
CTRL + Shif + I inverti la selezione 
CTRL +Shift + S salva con nome (stessa funzione con Shift +Alt + S) 
CTRL + Shif + T   trasformazione libera 
CTRL + Shif + Alt + K   apre impostazioni Shortcut (default, ma a me non funziona) 
CTRL + Shif + Alt + M   apre impostazioni Shortcut (imp. personale): ho aggiunto questa scorciatoia 

perché con la tastiera che uso non funziona la combinazione precedente 
CTRL + Shif + Alt + Y apre impostazioni Modifier Key 
  
Shift + V visualizza/nascondi il Selection Launcher (imp. personale) 
Shift + B visualizza/nascondi il bordo della selezione (imp. personale) 
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Shift + Tab toglie la Title bar > toglie la Menu bar > ripristina entrambe 
Shift + Del cancella al di fuori della selezione 
Shift + Alt Seleziona dalla selezione, utilizzandolo con uno strumento selezione 
Shift + Alt + S salva con nome (stessa funzione con CTRL +Shift + S) 
Shift + Spacebar + stilo   rotazione foglio 
  
Tab nasconde/visualizza le palette 
Del oppure Canc cancella, pulisci; se è presente una selezione opera all’interno della selezione 
  
AltGr  o CTRL + Alt   ha diverse funzioni temporanee, a seconda del tool selezionato: 

 Zoom : passa da temporaneamente da ingrandimento a rimpicciolimento e 
viceversa (se selezionato Zoom in passa a Zoom out, e viceversa); 

 Operation, Fill, Gradient, Contour line paint, Text : passa a Eyedropper; 

 Magic Wand : in modalità Select new, Select additionally e Select already 
selected part passa a Deselect; 

 Pen, Pencil, Brush, Airbrush, Decoration, Eraser, Blend, Correct line : 
trascinando la penna o il mouse aumenta o diminuisce la dimensione dello 
strumento. 

 
 
 
 

F1 aiuto. Premendolo, si apre la versione online del Manuale (è stato corretto 
l’indirizzamento della scorciatoia, che precedentemente portava altrove);  

F2 taglia 
F3 copia 
F4 incolla 

 

Ordine per azione 
Ci sono delle ripetizioni perché alcune azioni le ho riportate sia in italiano che in inglese. 
Dove, in Azione, ci sono più descrizioni separate da  > , significa che premendo più volte il tasto indicato si alternano 

le azioni descritte. 
Dove, in Tasto o combinazione di tasti, sono presenti più righe, significa che esistono più vie per compiere 

quell’azione, una  per ogni riga. 
 
 

 Azione  Tasto o combinazione di tasti 
A Adatta lo zoom  allo schermo  CTRL + 0 
 Aggiungi, a una selezione, la selezione del 

contenuto di un altro livello 
 CTRL + Shift + click sulla miniatura dell’altro livello 

 Aiuto  F1 (apre il manuale online) 
 All sides view  CTRL + J (imp. personale) 
 Alterna colore principale/secondario  X 
 Alterna Special ruler  CTRL + 4 
 Alterna trasparenza e colore selezionato  C 
 Annulla  CTRL + Z 
 Apri  CTRL + O 
B Bacchetta Magica  W 
 Blend  J 
 Bordo selezione (mostra/nascondi)  Shift + B (imp. personale) 
 Brush > Airbrush >  Decoration  B 
C Cambia il colore del livello  CTRL + B 
 Cancella  Canc 

Backspace 
CTRL + Canc 
CTRL + Backspace 

 Cancella fuori dalla selezione  Shift + Canc 
Shift + Backspace 

 Canvas precedente**  CTRL + Shift + Tab 
 Canvas successivo**  CTRL + Tab 
 Chiude documento  CTRL + W 
 Clip to layer below  CTRL + Alt + G 
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 Close document  CTRL + W 
 Collegare un livello  CTRL + click sul livello (nella Layer palette) 
 Colora con il colore selezionato   A (imp. personale) 
 Colore complementare (inverte i colori del 

contenuto del livello) 
 CTRL + I 

 Contagocce  I 
 Convert to drawing color  A (imp. personale) 
 Copia  F3 

CTRL + C 
 Correct line (passa all’ultimo Sub Tool selezionato 

dello strumento Correct  line); alterna tra Pinch 
vector line e Correct line width (imp. personale) 

 Y 

 Create Folder and insert layer (quelli selezionati)  CTRL + G (imp. personale)* 
 Crop  Z (imp. personale)* 
 Cut  F2 

CTRL + X 
D Delete  Canc 

Backspace 
CTRL + Canc 
CTRL + Backspace 

 Delete outside selection  Shift + Canc 
Shift + Backspace 

 Deseleziona  CTRL + D 
 Densità +  CTRL + ‘(imp. personale) 
 Densità -  CTRL + ì  (imp. personale) 
 Dimensione pennello -  ‘ (apostrofo) 
 Dimensione pennello +  ì 
 Duplica livello  Alt + trascina il livello 

Alt + L (imp. personale) 
E Edit timeline > Light table  L  
 Eraser temporaneo  CTRL + Shift + Alt (imp. personale) 
 Esci  CTRL + Q 
 Eyedropper  I 
F Figure (passa all’ultimo Sub Tool selezionato 

dello strumento Figure) 
 U 

 Fill  Alt + Canc 
Alt + Backspace 

 Fit to screen  CTRL + 0 
 Flip orizzontale  F (imp. personale) 
 Flip verticale  S (imp. personale) 
 Free transform  CTRL + Shift +T 
G Gomma > Hard eraser > Vector    E (il passaggio a Gomma è di default, gli altri imp. personali) 
 Gomma temporanea  CTRL + Shift + Alt (imp. personale) 
 Gradient > Fill > Contour line paint  G 
 Gradiente > Riempimento > Contour line paint  G 
 Gradiente inverso  CTRL + I 
H Hand (per muovere il foglio)  Spazio 
 Help  F1 (apre il manuale online) 
 Hide Title Bar > Hide Menu Bar > Mostra tutto  Shift + Tab 
 Hue/Saturation  CTRL + U 
I Impostazioni delle Modifier Key  CTRL + Shift + Alt + Y 
 Impostazioni delle Shortcut   CTRL + Shift + Alt + K 
 Incolla  F4 

CTRL + V 
 Incolla su un nuovo livello, al centro del Canvas  CTRL + Shift +V 
 Instruction Manual  F1 
 Inverti selezione  CTRL + Shift + I 

Shift + F7 
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L Layer selection  D + click su elemento del livello 
CTRL + Shift + click su elemento del livello 

 Light table  >  Edit timeline  L  
 Livello sopra  Alt + ì (imp. personale) 
 Livello sotto  Alt + ‘(imp. personale) 
M Magic wand  W 
 Mano (per muovere il foglio)  Spazio 
 Manuale di istruzioni  F1 
 Marquee  M 
 Merge selected layers  Shift + Alt + E 
 Merge to layer below  CTRL + E 
 Merge visible layers  CTRL + Shift + E 
 Modifica la timeline > Tavolo luminoso  L  
 Modifier Key Settings  CTRL + Shift + Alt + Y 
 Mostra > Nascondi tutte palette   Tab 
 Mostra solo un livello > Mostra tutti i livelli  Alt + click sull’icona occhio del livello 
 Muovi contenuto livello raster (temporaneo)  CTRL + tocca il contenuto di un livello raster 
 Muovi il foglio = Move = Mano   Spazio + sposta col cursore; 

H + sposta col cursore 
 Muovi livello = Move layer  K + sposta col cursore 
N Nacondi la Tiltle Bar > Nascondi la Menu Bar > 

Mostra tutto 
 Shift + Tab 

 Nascondi varie barre  Shift + Tab 
 New Raster Layer  CTRL + Shift + N 
 New Vector Layer  CTRL + Shift + M (imp. personale) 
 Next Canvas**  CTRL + Tab 
 Nuovo documento  CTRL + N 
 Nuovo livello raster  CTRL + Shift + N 
 Nuovo livello vettoriale  CTRL + Shift + M (imp. personale) 
O Object  O 
 Object su livello vettoriale (temporaneo)  CTRL + tocca il contenuto di un livello vettoriale 
 Open  CTRL + O 
 Opacità +  Alt + ‘(imp. personale) 
 Opacità -  Alt + ì  (imp. personale) 
P Paste  F4  

CTRL + V 
 Paste to shown position (incolla su un nuovo 

layer, al centro del Canvas) 
 CTRL + Shift + V 

 Penna > Matita  P 
 Pennello > Aerografo > Decorazioni  B 
 Preferences  CTRL + K 
 Previous Canvas**  CTRL + Shift + Tab 
 Print  CTRL + P 
Q Quit  CTRL + Q 
R Raddrizza il foglio  Shift + Spazio + doppio click  sul foglio  
 Redo  CTRL + Y 

CTRL + Shift + Z 
 Reset display (se il foglio è ruotato e zoomato, lo 

raddrizza e lo adatta allo schermo) 
 CTRL + ò  

 Riempi  Alt + Canc 
Alt + Backspace 

 Righelli laterali graduati (attiva/disattiva)  CTRL + R 
 Ripristina  CTRL + Y 

CTRL + Shift + Z 
 Riseleziona (carica l’ultima selezione creata)  CTRL + Shift + D   
 Rotate  R  

Shift + Spazio 
 Rotate clockwise  à 
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 Rotate counterclockwise  - (lineetta) 
 Rulers laterali (attiva/disattiva)  CTRL + R 
 Ruota  R 

 Shift + Spazio  
 Ruota antiorario  - (lineetta) 
 Ruota in senso orario  à 
S Salva  CTRL + S 
 Salva con nome  CTRL + Shift + S 

CTRL + Alt + S  
Shift + Alt +S  

 Save  CTRL + S 
 Save as…  CTRL + Shift + S 

CTRL + Alt + S  
Shift + Alt +S 

 Scale/Rotate  CTRL + T 
 Select all  CTRL + A 
 Selection border (mostra/nascondi)  Shift + B (imp. personale) 
 Selection Launcher (mostra/nascondi)  Shift + V (imp. personale) 
 Seleziona dalla selezione  Shift + Alt + click su selezione 
 Seleziona il contenuto di un livello  CTRL + click sulla miniatura del livello 
 Seleziona overlap (Seleziona l’area del contenuto 

di un livello che si sovrappone alla selezione del 
contenuto di un altro livello: uff… complicato 
ma corretto) 

 CTRL + Shift + Alt + click sulla miniatura del livello 

 Seleziona livello  D + click su elemento del livello 
CTRL + Shift + su click elemento del livello 

 Seleziona tutto  CTRL + A 
 Selezione   M 
 Shortcut settings  CTRL + Alt + Shift + K 
 Show/Hide all palettes  Tab 
 Snap to grid  CTRL + 3 
 Snap to ruler  CTRL + 1 
 Snap to Special ruler  CTRL + 2 
 Sposta  H 
 Stampa  CTRL + P 
 Subtool precedente  ,  (virgola) 
 Subtool successivo  . (punto) 
T Taglia  F2 

CTRL +X 
 Tavolo luminoso > Modifica la timeline  L  
 Testo (passa all’ultimo Sub Tool selezionato dello 

strumento Text) 
 T 

 Tinta/Saturazione  CTRL + U 
 Togli la selezione del contenuto di un livello  CTRL + Alt + click sulla miniatura del livello 
 Trasformazione libera  CTRL + Shift + T 
U Undo  CTRL + Z 
 Ungroup Layer Folder  CTRL + Shift + G 
 Unisci i livelli  visibili  CTRL + Shift + E 
 Unisci i livelli selezionati  Shift + Alt + E 
 Unisci sotto  CTRL + E 
V Vista da tutti i lati  CTRL + J (imp. personale)  
 Visualizza la finestra di dialogo New Raster Layer  Alt + click sull’icona New Raster Layer (nella Command bar della 

Layer palette) 
 Visualizza la finestra di dialogo New Vector Layer  Alt + click sull’icona New Vector Layer (nella Command bar della 

Layer palette) 
Z Zoom  ù  

CTRL + Spazio + trascina a dx/sx   
Alt  + Spazio + trascina a dx/sx 
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 Zoom –  CTRL + -  
Alt  + Spazio + click 

 Zoom +  CTRL + +  
CTRL + Spazio + click 

 Zoom al 100%  CTRL + Alt + 0 
 Zoom finestra (adatta allo schermo)  CTRL + 0 
 

AltGr  
CTRL + Alt  

 

 Diverse funzioni temporanee, a seconda del tool 
selezionato:  

- Zoom: passa da temporaneamente da ingrandimento 
a rimpicciolimento e viceversa (se selezionato Zoom in 

passa a Zoom out, e viceversa);  
- Operation, Fill, Gradient, Contour line paint, Text: 

passa a Eyedropper;  
- Magic Wand: in modalità Select new, Select 

additionally e Select already selected part passa a 
Deselect;  

-  Pen, Pencil, Brush, Airbrush, Decoration, Eraser, Blend, 
Correct line: trascinando la penna o il mouse 
aumenta o diminuisce la dimensione dello 
strumento. 

-------- 
* Crop ha Z come shortcut. Però di default non funziona (nella mia copia almeno, ma credo che sia così per tutti, 

suppongo che dipenda dalla mappatura della tastiera italiana). Ho così riassegnato Z a Crop, che diventa quindi 
un’impostazione personale. 

La stessa cosa vale per il comando Create Folder and insert layer indicato nel manuale con la shortcut CTRL + G, ma non presente, 
di default, nel mio CSP. 

**L’ordine con cui vengono selezionati i canvas non dipende dall’ordine di creazione/apertura, ma dall’ordine in cui 
sono stati selezionati precedentemente all’uso di questo comando. 

Ordine per contesto 
Valgono le stesse note riportate precedentemente. 

  Shortcut 
FILE   
New  CTRL + N 
Open  CTRL + O 
Close  CTRL + W 
Save  CTRL + S 
Save as   

CTRL + Shift + S 
CTRL + Alt + S  
Shift + Alt +S 

Print  CTRL + P 
Preferences  CTRL + K 
Shortcut settings  CTRL + Shift + Alt + M (imp. personale) 
Modifier Key Settings  CTRL + Shift + Alt + Y 
Quit CLIP STUDIO PAINT  CTRL + Q 
   
EDIT   
Undo  CTRL + Z 
Redo  CTRL + Y 
Taglia  CTRL + X 

F2  
Copia  CTRL + C 

F3 
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Incolla  CTRL + V 
F4 

Paste to shown position  CTRL + Shift + V 
Delete  Canc 

Backspace 
CTRL + Canc 
CTRL + Backspace 

Delete Outside Selection  Shift + Canc 
Shift + Backspace 

Fill  Alt +Canc 
Alt + Backspace 

Convert to drawing color  A (imp. personale) 
Crop   Z (imp. personale) 
Flip Verticale  F (imp. personale) 
Flip Orizzontale  S (imp. personale) 
Scala/Ruota  CTRL + T 
Trasformazione libera  CTRL + Shift + T 
   
SELECT   
Seleziona tutto  CTRL + A 
Deseleziona  CTRL + D 
Riseleziona  CTRL + Shift + D 
Inverti selezione  CTRL + Shift + I 

Shift + F7 
Cancella (nella selezione)  Canc 

Backspace 
CTRL + Canc 
CTRL + Backspace 

Cancella al di fuori della selezione  Shift + Canc 
Aggiungi, a una selezione, la selezione del contenuto di 
un altro livello  

 CTRL + Shift + click sulla miniatura dell’altro livello  

Seleziona overlap (Seleziona l’area del contenuto di un 
livello che si sovrappone alla selezione del contenuto di 
un altro livello) 

 CTRL + Shift + Alt + click sulla miniatura del livello 

   
VIEW   
Zoom +  CTRL + + 
Zoom -  CTRL + - 
Zoom 100%  CTRL + Alt + 0 
Zoom adatta allo schermo  CTRL + 0 
Reset display  CTRL + ò 
Snap to ruler  CTRL + 1 
Snap to Special ruler  CTRL + 2 
Snap to grid  CTRL + 3 
Alterna Special ruler  CTRL + 4 
Mostra/Nascondi righelli laterali  CTRL + R 
Mostra/Nascondi Selection Launcher  Shift + V 
   
WINDOW   
Canvas successivo  CTRL + Tab 
Canvas precedente  CTRL + Shift + Tab 
Mostra/Nacondi Palette  Tab 
Mostra/Nascondi Title Bar - Menu Bar  Shift + Tab 
All Sides View  CTRL + J 
   
HELP   
Manuale  F1 
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SUB TOOL   
Sub Tool precedente  , 
Sub Tool successivo  . 
   
BRUSH SIZE   
Pennello +  ì 
Pennello -  ‘ 
   
TOOL PROPERTY   
Aumenta opacità  CTRL + ì (imp. personale) 
Diminuisci opacità  CTRL + ‘ (imp. personale) 
Aumenta densità  Ctrl + Shift + è (imp. personale)* 
Diminuisci densità  Ctrl + Shift + O 
Attiva/Disattiva Refer multiple (strumento Fill)  0 
   
COLORE   
alterna tra Colore principale (Main color) e Colore 
secondario (Sub color) 

 X 

alterna tra Colore trasparente (Transparent color) e 
quello tra Main e Sub color che era selezionato 
precedentemente 

 C 

Colore complementare (inverte i colori del contenuto 
del livello) 

 CTRL + I  
 

   
 
LIVELLI 

  

Duplica livello  Alt + trascina il livello da duplicare 
Alt + L (imp. personale) 

Cambia il colore del livello  CTRL + B 
Collegare un livello  CTRL + click sul livello (nella Layer palette)  
Incolla su un nuovo livello, al centro del Canvas  CTRL + Shift +V 
Seleziona il livello  D + click su un elemento nel livello 

CTRL + Shift + click su un elemento del livello  
Seleziona il contenuto di un livello  CTRL + click su miniatura livello 
Aggiungi, a una selezione, la selezione del contenuto di 
un altro livello 

 CTRL + Shift + click sulla miniatura dell’altro livello 

Seleziona overlap (Seleziona l’area del contenuto di un 
livello che si sovrappone alla selezione del contenuto di 
un altro livello) 

 CTRL + Shift + Alt + click sulla miniatura del livello 

Cancella la selezione  CTRL + Alt + click sulla miniatura del livello 
Mostra un solo un livello/Mostra tutti i livelli  Alt + click sull’icona occhio del livello  
Muovi contenuto livello raster (temporaneo)   CTRL + tocca il contenuto di un livello raster  
Muovi livello  K + sposta il livello col cursore 
Nuovo livello raster   CTRL + Shift + N  
Nuovo livello vettoriale   CTRL + Shift + M (imp. personale)  
Create folder and insert layer  CTRL + G (imp. personale) 
Ungroup Layer Folder  CTRL + Shift + G 
Clip to Layer Below  CTRL + Alt +G 
Merge with layer below  CTRL + E 
Merge selected layers  Shift + Alt + E 
Merge visible layers  CTRL + Shift + E 
Livello sopra  Alt + ì 
Livello sotto  Alt + ‘ 
Object su livello vettoriale (temporaneo)   CTRL + tocca il contenuto di un livello vettoriale  
Visualizza la finestra di dialogo New Raster Layer   Alt + click sull’icona New Raster Layer (nella Command 

bar della Layer palette)  
Visualizza la finestra di dialogo New Vector Layer   Alt + click sull’icona New Vector Layer (nella Command 

bar della Layer palette)  
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LAYER MASK   
Abilita/Disabilita la maschera  Shift + click sulla miniatura della maschera 
Mostra/Nascondi l’area mascherata  Alt + click sulla miniatura della maschera 
Maschera la selezione  Alt + click sull’icona Create layer mask nella 

Command bar della Layer palette 
Duplica la maschera  Alt + trascina la miniatura della maschera 
   
RULER   
Attiva/Disattiva  Shift + click sull’icona del ruler** 
Duplica   Alt + trascina l’icona del ruler 
   
*Secondo varie fonti, la shortcut è  CTRL + Shift + P. Oltre a non averla di default, non riesco neanche a impostarla 
come shortcut personalizzata, per cui ho ripiegato su CTRL + Shift + è. 
**Nel Manuale, la shortcut riportata è CTRL + Shift + click sull’icona, ma non funziona, mentre funziona così come l’ho 
scritta. 

 
Per la tastiera italiana, ho raccolto varie shortcut nell'immagine seguente (Fig.  381),da me realizzata 

sulla base di quella realizzata da czartmop e pubblicata su Deviantart (Fig.  382). 
 

https://www.deviantart.com/czartamop/art/CMYKEYBOARD-Clip-Studio-Paint-PRO-526473404
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 Mappa shortcut 

 
Fig.  381- Mappatura delle shortcut con Windows -  tastiera italiana  – Clicca qui per scaricare  la versione stampabile, a 300 dpi 

 Per i comandi con sfondo grigio basta premere il tasto corrispondente;  

 per quelli con sfondo ciano chiaro bisogna premere contemporaneamente CTRL;  

 con lo sfondo salmone premere insieme lo Shift; 

 sfondo giallo: premere contemporaneamente Alt; 

 per quelli con sfondo viola premere insieme a CTRL e Shift;  

 per quelli con sfondo verde premere insieme a CTRL e Alt;   

 sfondo marrone: premere anche CTRL + Alt + Shift; 

 sfondo blu: premere anche Shift + Alt. 

 Alt e AltGr svolgono varie funzioni, a seconda del tool attivo.  
Non tutti sono in italiano, per questioni di spazio e/o comodità; quelli formattati in corsivo sono relativi a impostazioni personali, non di default. Non sono riportati i 

comandi temporanei.  

http://www.paolelli.com/Risorse/CSP/CSP_Shortcut.htm
https://www.paolelli.com/Risorse/CSP/img_big/TastieraClipStudioPaint_BIG.jpg
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Fig.  382 - Mappatura delle shortcut con Windows - tastiera US (da https://www.deviantart.com/czartamop/art/CMYKEYBOARD-Clip-
Studio-Paint-PRO-526473404)  

Shortcut pin-up per Cintiq 
Della Mappa ho poi fatto una versione da appiccicare alla tavoletta Wacom Cintiq da 24 pollici che 

utilizzo, ordinando i tasti che abbiano almeno una shortcut  in maniera arbitaria in due colonne. Una volta 
stampata, ho tagliato le due colonne e le ho attaccate ai lati dello schermo della Cintiq per avere le 
scorciatoie più vicine; essendo miope, sono d’aiuto. Clicca qui o sull’immagine per scaricare la versione 
stampabile, a 300 dpi.  
 

 
Fig. 383 Shortcut pin-up per Cintiq- Clicca qui o sull’immagine 
per scaricare la versione stampabile, a 300 dpi 

 Oh, scrivo per Cintiq 24 pollici perché l’ho 
ottimizzata per la mia tavoletta; ovviamente 
nulla vieta di utilizzarla su altri dispositivi, se si 
adatta.  

La versione riportata è la stessa della 
Mappa shortcut più sopra, perché deriva da 
quella e tenderò a tenerle allineate. 

  

https://www.deviantart.com/czartamop/art/CMYKEYBOARD-Clip-Studio-Paint-PRO-526473404
https://www.deviantart.com/czartamop/art/CMYKEYBOARD-Clip-Studio-Paint-PRO-526473404
https://www.paolelli.com/Risorse/CSP/img_big/CSP_Shortcuts_Cintiq.jpg
https://www.paolelli.com/Risorse/CSP/img_big/CSP_Shortcuts_Cintiq.jpg
https://www.paolelli.com/Risorse/CSP/img_big/CSP_Shortcuts_Cintiq.jpg
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Link utili 

Risorse 

- Manuale. Se ci son problemi, per prima cosa consultare il Manuale! 
 

- Startup Guide. Altro documento utilissimo è la Startup Guide, da leggere soprattutto se si inizia a 
usare il programma da zero. 

 

- Tool Settings Guide. È la guida alle impostazioni degli strumenti, una specie di approfondimento del 
Manuale dedicato alle funzioni che hanno strumenti (Tool) e sottostrumenti (Sub tool).  La trovi qui. 

 

- Clip Studio Ask. È la community di supporto ufficiale in cui trovare risposta alle proprie domande e 
risolvere i problemi. Se si sa un po’ di inglese, quando si incappa in un problema ci si può dare un 
occhio. Clip Studio Ask 

 

- Gruppo Facebook Clip Studio Paint Italia (ex Manga Studio e Clip Studio Paint), amministrato dagli 

ottimi Patrizia Mandanici, Luigi Coppola e Federica di Meo (e con me come umile moderatore  ), in 
cui molti professionisti e appassionati si danno una mano a vicenda. Molto importante e utilissimo, 
da sfruttare! 

I problemi più comuni sono stati trattati più volte nel gruppo e  la maggior parte delle volte basta 
cercare nella casellina di ricerca con qualche parola chiave per trovare risposte ai propri dubbi (PS. 
Leggere il primo post a questo link).  

 

- Documento redatto da Patrizia Mandanici e scaricabile da qui (gruppo FB Clip Studio Paint Italia), in 
cui ci sono informazioni importanti su colore, uso del programma, installazione, ecc.; risoluzione dei 
problemi più comuni. In italiano, aggiornato periodicamente.  

 

-  La Fumettista Curiosa, blog di Patrizia Mandanici. In questa pagina, post e tutorial raccolti da Patrizia 
e costantemente aggiornati. 

 

- Graphixly.com, partner di Celsys, organizzano spesso dei webinar gratuiti (perlopiù in inglese, ma 
anche in spagnolo, tedesco, portoghese e italiano) in cui alcuni professionisti svelano i loro segreti. 
Consiglio di iscriversi alla loro newsletter per sapere quando sarà il prossimo. 

 

- Pagina Facebook Wacom. Wacom è una ditta produttrice di tavolette grafiche; nella loro pagina 
pubblicano tutorial o organizzano webinar legati all’uso delle loro tavolette, qualche volta specifici 
per l’uso con CSP ma che possono essere seguiti anche da chi la tavoletta non ce l’ha.  

 

- A chi ha problemi con tavolette grafiche Wacom può essere utile il gruppo Facebook Wacom User 
Group Italia. 

 

- Il mio spazio su DeviantArt. Qui  alcune risorse (pennelli, ruler) create da me. 
 

- Alcune risorse create da me per CSP, sugli Assets. Qui. 
 

- Il sito di P.J. Holden e il suo canale Youtube. 
 

- Lo spazio di 888toto su DeviantArt. Qui numerose risorse. 
 

- Il sito ufficiale di Clip Studio Paint, prodotto dalla CelSys.  
 

- Qualche tutorial dal sito ufficiale: Official Tips & Tutorials 
 

- Il blog di Mauro Boscarol sulla gestione digitale del colore, molto interessante. 
 

- L’account Twitter non ufficiale Clip Studio Paint Artist. Brevi tutorial e trucchetti per CSP, in inglese. 
 

- Elenco di tutorial, su Google Drive, curato da Patrizia Mandanici. Raccolta di vari tutorial, video e non, 
raggruppati per argomento.  

http://www.clip-studio.com/site/gd_en/csp/userguide/csp_userguide/006_new/006_new_0.htm
https://www.clip-studio.com/site/gd_en/csp/startupguide/table_of_contents.htm
https://www.clip-studio.com/site/gd_en/csp/toolguide/table_of_contents.htm
https://ask.clip-studio.com/en-us/
https://www.facebook.com/groups/mangastudioitalia/
https://www.facebook.com/groups/mangastudioitalia/
https://www.facebook.com/groups/mangastudioitalia/announcements/
https://www.facebook.com/download/352665262311546/Tutto%20su%20Clip%20Studio%20Paint%20-%20FAQ%20e%20INFO.rtf?av=1402838585&eav=AfbO0z_minFrxTu8cDECW7bv3KpfImgzSUDe4Y8y1Tb7o3OqopVaNOdMMsHUyDEwr54&hash=Acof9mqSMDDE-_5d
https://patriziamandanici.blogspot.it/2012/11/tutti-i-post-e-tutorial-su-manga-studio.html
https://graphixly.com/blogs/webinars
https://www.facebook.com/Wacom/
https://www.facebook.com/groups/1471101602900031
https://www.facebook.com/groups/1471101602900031
https://www.facebook.com/groups/1471101602900031
http://toongsteno.deviantart.com/gallery/53927513/Resources
https://assets.clip-studio.com/en-us/search?word=Toongsteno&order=new
http://www.pauljholden.com/
https://www.youtube.com/user/pauljholden
http://888toto.deviantart.com/gallery/34067672/Brushes-Fonts-and-tutorials
http://www.clipstudio.net/en
https://tips.clip-studio.com/en-us/
http://www.boscarol.com/blog/?p=2167
https://twitter.com/ClipStudioTips
https://docs.google.com/document/d/1FjhHXyhc7sWW87hdfikB6sOK0mO_OcjJgNSzr17UAXg/edit?fbclid=IwAR2sFpsJccH74n2NqxIcVAFoq1CS_am7rwS_uM9lafH9LgZ8JAKTbCXYwjw
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Riferimenti video 

Youtube: su Youtube si trova veramente tantissimo, basta inserire le giuste parole chiave per la ricerca e 
si apre un mondo.  

 

Il canale di Alejandro Garcia, ci sono alcuni video molto interessanti; 
 

Il canale di Graphixly, dove vengono pubblicati i webinar (vedi più su) poche ore dopo la diretta. 
 

Il canale di Wacom, dove pubblicano tutorial e webinar anche legati all’uso di CSP. 
 

Il canale di Luca Malisan, in cui spiega tra l’altro come utilizzare Blender in funzione di CSP. 
 

Il canale di Virtual SG, in cui si trovano alcuni tutorial per CSP, molto chiari. 
 

Udemy: piattaforma di e-learning in cui trovare numerosi corsi. Nonostante la mia avversione 
all’apprendimento tramite video, ho trovato alcuni corsi molto economici (li propongono sempre 
iperscontati, tanto che penso che in realtà non siano mai a prezzo pieno) e tutto sommato utili.  

Ho seguito qualcosa di Ed Foychuk e di Robert Marzullo. 
 

21 Draw: altra piattaforma di corsi online, specificatamente tarata per il disegno, in particolar modo in 
digitale. Ho acquistato a una sessantina d’euro l’accesso per un anno a tutti i corsi del catalogo (sono, nel 
momento in cui scrivo, una trentina) quando uno ne costa in media 25. Consigliato. 

 

Domestika: anche questa è una piattaforma per corsi, a tema generalmente artistico. L’offerta è molto 
varia e i corsi sono generalmente molto economici. 

Su Domestika si trova, da Maggio 2022, un corso base in italiano proprio su CSP, tenuto dal fumettista 
Giacomo Bevilacqua. 

 

Artstation: nella sezione Learning di questa piattaforma è disponibile un breve corso gratuito, di 47 
minuti circa: Making Comics in Clip Studio Paint: Tools, Tips, and Tricks.  

In otto brevi tutorial vengono affrontati alcuni aspetti dell’utilizzo di CSP. È in inglese, con sottotitoli in inglese; talvolta l'audio è 
un po' veloce e magari occorre ripetere alcuni passaggi, ma tutto sommato è piuttosto chiaro. Una cosa che mi ha colpito è che 
spesso si addentra in veloci spiegazioni tecniche che non ho visto trattare altrove. Le stesse lezioni si possono trovare anche nel 
canale Youtube di CSP, con sottotitoli anche in italiano: per trovarle facilmente, cercare nella barra di Youtube "Jake Hercy Draws", 
l'autore del corso.  

Sempre su Artstation si trovano anche altri corsi dedicati a CSP.  
 

 

 

 

 Tutti i nomi, i marchi, loghi, immagini 
ecc. presenti appartengono ai legittimi 
creatori o proprietari, li ho utilizzati solo a 
scopo esplicativo. Questi appunti sono 
realizzati e condivisi senza scopo di lucro; 
tranne dove diversamente indicato, il 
l’autore e il redattore degli appunti sono io, 
Matteo Paolelli. 

Se vuoi suggerirmi delle modifiche, 
segnalarmi degli errori o offrirmi una birra, 

scrivimi all’email info@paolelli.com . 
 

Se ti va, seguimi su: 

- www.paolelli.com 
- Instagram 
- Facebook 
- Blogger 
- DeviantArt  
- Twitter 
- Wittygraphy 
- Cartoonist Club 
- Toons Mag 
- Youtube 
- Society6 
- Red Bubble 
 

  

https://www.youtube.com/
https://www.youtube.com/channel/UCJW_WMWM_YrOp351t4MJUiQ
https://www.youtube.com/channel/UCwZ_hTuRBLN8TUa300JvSlw
https://www.youtube.com/channel/UCK_sOh1nSLzQMFJNHphmclQ
https://www.youtube.com/channel/UCBomaDmeppD-jUQAZTXFEwA
https://www.youtube.com/c/VirtualSG/featured
https://www.udemy.com/
https://www.udemy.com/courses/search/?q=Ed%20Foychuk&src=sac&kw=ed%20foychuk
https://www.udemy.com/courses/search/?q=Robert%20Marzullo&src=sac&kw=Robert%20Marzullo
https://www.21-draw.com/
https://www.domestika.org/en
https://www.domestika.org/en/courses/3650-clip-studio-paint-for-beginners-create-your-own-comic/
https://www.artstation.com/?sort_by=community
https://www.artstation.com/learning
https://www.artstation.com/.../using-vectors-to-ink-comics
https://www.artstation.com/?sort_by=community
https://www.artstation.com/learning/search?q=clip%20studio%20paint
mailto:info@paolelli.com
http://www.paolelli.com/
https://www.instagram.com/matt_at_pencils/
https://www.facebook.com/mattpaoart/
https://matteopaolelli.blogspot.com/
https://www.deviantart.com/matteopaolelli
https://twitter.com/mattpaoart
http://www.wittygraphy.com/MatteoPaolelli
https://www.cartoonistclub.com/user/Matt
https://www.toonsmag.com/members/matt/
https://www.youtube.com/channel/UCugSDOZFD5k2zm3riNeEeKA
https://society6.com/matteopaolelli
https://www.redbubble.com/people/MattPao/shop?asc=u


Appunti di Manga Studio/ClipStudioPaint   

295 

Indice analitico 
3 

3D ..........................................................................216 

All sides view ......................................................216 

comandi .............................................................217 

manichini ...........................................................219 

manipolare gli oggetti ........................................217 

Movement Manipulator .....................................217 

Object Launcher ......................................... 217; 218 

Root Manipulator ....................................... 217; 218 

SweetHome 3D ..................................................220 

variazione prospettiva ........................................219 

3D Preview for binding ............................................ 53 

A 

Abbreviazioni .......................................................... 13 

abr ...................................Vedi Importare ed esportare 

Acquisto di CSP ....................................................... 15 

All sides view ..........................................................216 

Allineamento cursore .............................................. 19 

Angoli appuntiti .....................................................181 

Animazioni .............................................................. 13 

Annukka .................................................................188 

Applicare un bordo.................................................185 

Area di lavoro ..................................... Vedi Workspace 

Area scaling ..................................................... 84; 200 

Assets ...................................................... 14; 123; 225 

pubblicare un Material catalog ..........................229 

pubblicare un materiale .....................................226 

scaricare materiali ..............................................225 

Auto Action ...................................................... 48; 214 

palette ................................................................ 68 

B 

Backup 

cartella CELSYS ...................................................221 

file .....................................................................224 

impostazioni ......................................................223 

manuale.............................................................221 

Balloon.................................................................... 87 

agganciare al testo .............................................. 90 

Balloon pen ......................................................... 88 

Balloon tail.......................................................... 88 

cambiare le proprietà .......................................... 87 

collegare due balloon .......................................... 87 

creare un balloon ................................................ 90 

Curve balloon ...................................................... 88 

Ellipse balloon ..................................................... 88 

Fill color .............................................................. 89 

Line color ............................................................ 89 

Rectangle balloon ................................................88 

Rounded balloon ..................................................89 

tagliare un balloon ...............................................90 

tail (=pipetta) .......................................................87 

Text .....................................................................88 

Thought balloon tail .............................................88 

Batch 

export ..................................Vedi Esportare in batch 

process ................................................................54 

Bézier ........................................... Vedi Curve di Bézier 

Bilanciamento dell’immagineVedi Visualizzare in scala 

di grigi 

Binding ....................................................................40 

Bleed.................................................................. 40; 42 

Blender .................................................................. 219 

Blending mode 

elenco ................................................................ 267 

nei layer ............................................................. 183 

nei pennelli ........................................................ 134 

Border effect .................................................. 117; 185 

Bottiglie ................................................................. 144 

Brushes ................................................... Vedi Pennelli 

C 

Canvas ............................................................... 22; 40 

switching tab .......................................................22 

trovare centro.................................................... 158 

window ................................................................22 

Cellulare ................................. Vedi Uso con il cellulare 

Centrare 

un'immagine nel Canvas .................................... 158 

Centro 

del Canvas ......................................................... 158 

Change brush tip color......... Vedi Pennelli > Color Jitter 

Clip at Layer Below ..................Vedi Clip to Layer Below 

Clip Studio........................................................ 14; 225 

cloud.................................................................. 223 

problemi di visualizzazione ................................. 233 

Clip Studio Ask................................................ 228; 293 

Clip Studio Modeler................................................ 219 

importare .obj .................................................... 219 

Clip Studio SHARE .....................................................60 

Clip to Layer Below ............................ 58; 129; 130; 176 

Clipping layer ................................................. 129; 130 

Clippy points .......................................................... 230 

Clippy tickets .......................................................... 231 

Clippy tokens .......................................................... 230 

Clippy wallet .......................................................... 230 

CMYK ............................................................. 188; 199 
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Color holds ..................... Vedi Lineart: cambiare colore 

Color Jitter ......................... Vedi  Pennelli > Color Jitter 

Color Mixing palette ................................................ 28 

Color palette ........................................................... 26 

importare ed esportare ....................................... 27 

unire ................................................................... 27 

Color picker .... Vedi Contagocce; Vedi  Pick screen color 

Color set ........................................... Vedi Color palette 

Colore ....................................................................188 

campionare ............................ Vedi Sub View palette 

prelevare .............................. Vedi  Pick screen color 

Command bar ......................................................... 23 

aggiungere pulsanti ...................................... 23; 154 

spostare icone .................................................... 29 

Companion mode ...................................................234 

Compatibilità .........................................................235 

Comprare CSP .............................. Vedi Acquisto di CSP 

Contagocce ............................................................213 

registrazione automatica colori ........................... 27 

Contour line paint...................................................204 

Contrasto ................................................................ 85 

Control point ..........................................................181 

Convert brightness to opacity .................................. 81 

Convert to lines and tones…. ...................... Vedi Lineart 

Correction layer ......................................................205 

Crop .................................. Vedi Rifilare l'area di lavoro 

Curve di Bézier ................................................. 95; 160 

Cubic ...................................................... 95; 97; 160 

disegnare con Direct Draw .................................160 

disegnare ruler .................................................... 96 

Quadratic ............................................... 95; 96; 160 

D 

Default border (inner) size ....................................... 40 

Dimensioni file .......................................................154 

Dimensioni icone..................................................... 18 

Direct draw .............................................. 69; 160; 181 

Disegni geometrici.............................. Vedi Direct draw 

Dissolvenza ............................................................172 

Dividing method ...................................................... 71 

Do not cross lines of reference layer........................139 

Documenti multipagina ........................................... 46 

Align crop mark ................................................... 46 

Binding point ...................................................... 46 

Combine into two-page spreads .......................... 46 

Cover page .......................................................... 47 

Specify spine width .............................................. 47 

Start page ........................................................... 46 

Domande frequenti ................................................. 15 

Doug Hills ...............................................................110 

Dpi .........................................................................155 

dimensioni del carattere .................................... 155 

Draft Layer .................................................. Vedi Layer 

Duplicate Page .........................................................49 

E 

Edit text ................................................................. 118 

Edizione 

Debut - Pro - Ex ....................................................17 

Eraser .................................................................... 150 

e ruler simmetrico .............................................. 150 

Esportare .................................................................50 

Anteprima 3D ......................................................53 

dimensioni del foglio ............................................50 

in batch ...............................................................52 

livelli Photoshop ................................................ 235 

tavolozza colori ....................................................27 

Tiff ..................................................................... 237 

Eye Level ............................... Vedi  Linea dell'orizzonte 

Eyedropper ........................................ Vedi Contagocce 

F 

File object ................................................................67 

Fill .......................................................................... 200 

Fill leftover ...............................................................85 

Fill up to vector path ........................................ 84; 200 

Flip......................................................................... 153 

Foil layer ..................................................................60 

Folio .........................................................................45 

Fondo bianco 

togliere ................................................................81 

Font ............................................................ Vedi Testo 

Frame borders ......................................... Vedi Vignette 

Framing template ....................................................46 

Fumetti .................................................... Vedi Balloon 

G 

Garbage cleaner .......................................................85 

Glossario della stampa ........................................... 270 

GOLD ................................................. Vedi Punti GOLD 

GOLD membership ................................................. 232 

Gomma ...................................................... Vedi Eraser 

Goniometro ........................................................... 186 

Gradient......................................................... 204; 205 

Dithering............................................................ 205 

Gradient map ................................................. 205; 206 

Grid ....... Vedi  Ruler prospettico > Griglie prospettiche 

Gruppo Facebook ................................................... 293 

H 

Hide windows and pick screen colorVedi Pick screen 

color 
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History palette ........................................................ 68 

HLS ............................................... Vedi Modelli colore 

HSB ............................................... Vedi Modelli colore 

HSI ................................................ Vedi Modelli colore 

HSL ............................................... Vedi Modelli colore 

HSV ............................................... Vedi Modelli colore 

I 

Icona 

colore ................................................................. 18 

Icone 

chiave inglese ..................................................... 24 

colore ................................................................. 24 

modificare .......................................................... 30 

Illustrator ...............................................................236 

IME control ............................................................118 

Importare ed esportare 

Color palette ................................ Vedi Color palette 

file da Illustrator.................................................236 

file da Photoshop ...............................................235 

immagini ............................................................237 

immagini con dimensioni esatte .........................237 

pennelli da Photoshop .......................................235 

un filmato ........................................................... 67 

un timelapse ......................................................215 

Inchiostrazione.......................................................151 

Installare ................................................................. 16 

Interfaccia ............................................................... 21 

Item bank ................................................................ 62 

L 

Layer ....................................................................... 54 

Draft layer .......................................................... 54 

duplicare............................................................. 68 

eliminare ............................................................ 68 

File object ........................................................... 67 

in un nuovo documento ...................................... 57 

Layer Mask ......................................................... 63 

Layer Property .................................................... 60 

Merge visible to new layer................................... 59 

raster .................................................................. 55 

Reference layer ................................................... 55 

Search Layer ....................................................... 61 

svuotare ............................................................. 68 

vettoriali ............................................................. 55 

Layer palette ........................................................... 58 

Command bar ..................................................... 58 

Property bar ........................................................ 59 

Libreria dei materiali ..............................................123 

Linea dell’orizzonte ................................................106 

Lineart .................................................................... 80 

cambiare colore ................................................. 127 

estrarre con Convert to lines and tones… ..............81 

estrarre da un disegno .........................................80 

estrarre da una fotografia ....................................81 

Linee guida .................................................. Vedi Ruler 

Link utili ................................................................. 293 

Liquify .................................................................... 211 

Livelli .......................................................... Vedi Layer 

Lock transparent pixels .................................. 128; 177 

LT conversion of layer...Vedi Convert to lines and 

tones... 

M 

Manipolare oggetti 3D .................................... Vedi 3D 

Manuale .......................................................... 14; 293 

Mappa shortcut tastiera ......................................... 291 

Mappe gradiente ............................Vedi Gradient map 

Maschera veloce ................................ Vedi Quick Mask 

Material ................................................................. 124 

Material catalog .................................................... 229 

Materiali ................................................................ 124 

aggiungere ......................................................... 123 

pubblicare sugli Assets ....................................... 124 

Menu bar .................................................................22 

Mesh transformation ............................................. 209 

Metodo di fusione ......................... Vedi Blending mode 

Modelli colore ........................................................ 266 

HSV e HSL .......................................................... 266 

Modificare una pagina .............................................43 

Modifier Key........................................................... 162 

Settings.............................................................. 162 

Monitor 

risoluzione ...........................................................20 

Mood ..................................................................... 185 

Move layer ...............................................................68 

Multiple pages ................. Vedi Documenti multipagina 

N 

Nero vero............................................................... 197 

Nuovo aspetto .........................................................18 

Nuvolette ................................................. Vedi Balloon 

O 

Outer white Action ................. Vedi Vignette particolari 

Outline Selection .................................................... 167 

P 

Page Manager .........................................................46 

Penna Wacom ........................................................ 163 

Side switch ......................................................... 163 

Tail switch.......................................................... 163 
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Pennelli ..................................................................127 

Angle .................................................................136 

Brush Size ..........................................................132 

Color Jitter .........................................................135 

colore ................................................................127 

Density...............................................................134 

di Photoshop......................................................235 

Dimensioni e unità di misura ..............................134 

direzione ............................................................146 

dual brush ..........................................................147 

Opacity ..............................................................134 

pubblicare sugli Assets .......................................226 

punta .................................................................135 

salvare come materiale ......................................226 

Starting and ending ............................................137 

Taper .................................................................137 

Thickness ...........................................................136 

Vector magnet ...................................................137 

Perspective ruler.....................................................105 

Photoshop .............................................................235 

compatibilità testo .............................................235 

Importare ed esportare ......................................235 

Pick screen color .....................................................213 

hide windows .....................................................213 

Pick up from layer .............................. Vedi Contagocce 

Pipetta ............................................... Vedi Balloon tail 

PJ Holden ...............................................................239 

Pose Scanner ..........................................................219 

Preferences ........................................................ 19; 31 

Edit text .............................................................. 36 

Tablet PC ............................................................ 19 

Wintab................................................................ 19 

Preset ................................................................ 40; 48 

Pubblicare negli Assets ...........................................226 

Pulizia della tavola ................................................... 85 

Punti GOLD .................................................... 225; 230 

costo..................................................................225 

Punto di fuga..........................................................107 

aggiungere .........................................................107 

Punto tipografico ...................................................155 

Q 

Quick Access............................................................ 29 

aggiungere pulsanti ...................................... 29; 154 

spostare icone .................................................... 29 

Quick Mask ............................................................171 

R 

Randomize per stroke .......... Vedi Pennelli > Color Jitter 

Recuperare i file .....................................................224 

Reference layer ........................................... Vedi Layer 

Retini ..................................................................... 125 

utilizzando un pennello ...................................... 125 

Riempimenti ................................................... Vedi Fill 

Rifilare l'area di lavoro ........................................... 166 

Righelli ................................................................... 157 

spostare lo zero ................................................. 157 

Ripristinare 

file .......................................... Vedi Recuperare i file 

strumenti ........................................................... 180 

workspace ...........................................................21 

Rotate canvas ........................................................ 153 

Ruler ........................................................................94 

Concentric circle ................................................. 101 

Curve ruler ...........................................................96 

Figure ruler ..........................................................97 

Guide ................................................................. 102 

Linear ruler ..........................................................95 

Modificare un ruler ............................................ 111 

Multiple curve .................................................... 100 

Parallel curve .......................................................99 

Parallel line ..........................................................99 

Radial curve ....................................................... 101 

Radial line .......................................................... 100 

Ruler pen .............................................................97 

Salvare un ruler .................................................. 111 

Scale ....................................................................95 

Scomparsa ......................................................... 104 

Snap .................................................................. 104 

Special ruler ................................................... 94; 98 

attivare o disattivare ........................................94 

suddivisione .........................................................95 

Symmetrical ruler ............................................... 103 

Ruler a 4 e 5 punti di fuga ....................................... 110 

Ruler prospettico ................................................... 105 

Griglie prospettiche ........................................... 107 

Ruotare il foglio.............................. Vedi Rotate canvas 

S 

Safety margin...........................................................44 

Scansione ........................................................... 82; 84 

Schegge ................................................................. 144 

Scorciatoie da tastiera .................................... 162; 281 

Segno ..................................................................... 148 

problemi ............................................................ 148 

Select ..................................................................... 127 

Select Color Gamut ................................................. 169 

Select garbage .........................................................85 

Select layer ..............................................................23 

Selection Launcher ................................................. 168 

spostare icone ............................................. 29; 168 

Selezionare 
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contenuto di più livelli ........................................170 

un colore Vedi Select Color Gamut; Vedi Select Color 

Gamut 

Selezione ...............................................................167 

contorno ................................ Vedi Outline Selection 

creare da un layer ..............................................168 

modificare .......................................................... 62 

salvare una selezione .........................................167 

Selezioni 

Reselect .............................................................167 

Select Overlapping Vectors .................................169 

Select Vectors Within Area .................................169 

Selection Launcher .............................................168 

Selection Layer ...................................................168 

Sharp angles ............................... Vedi Angoli appuntiti 

Shortcut ......................................................... 162; 281 

mappa sulla tastiera ...........................................291 

ordine per azione ...............................................283 

ordine per contesto ...........................................287 

ordine per tasto .................................................281 

Show vector paths .................... Vedi Tracciati vettoriali 

Sito ufficiale ...........................................................293 

Sommario ................................................................. 2 

Specchio ................................................................. 86 

Startup Guide ................................................... 14; 293 

Story Editor 

Page area ..........................................................119 

text area ............................................................119 

Strumenti ...............................................................179 

scomparsi ..........................................................180 

Struttura del documento ......................................... 48 

Sub Tool .................................................................179 

Sub Tool Detaill palette ........................................... 25 

Sub Tool palette ...................................................... 24 

Sub View palette ....................................................213 

svg ...................................Vedi Importare ed esportare 

T 

Tavoletta 

driver .................................................................. 20 

penna .......................................................... 20; 163 

risoluzione .......................................................... 20 

Tavolozza ......................................... Vedi Color palette 

Template ............................................................ 40; 49 

Framing template .......................................... 46; 48 

Testo ......................................................................115 

con bordo ..........................................................117 

curvo .................................................................116 

esportare per Photoshop ...................................236 

font ....................................................................115 

wrap ..................................................................115 

Tiff 

multilayer .................................................... 19; 237 

Timelapse .............................................................. 215 

Title bar ...................................................................22 

Tone ........................................................... Vedi Retini 

Tool ..................................................... Vedi Strumenti 

Tool palette ...................................................... 24; 179 

spostare icone .....................................................29 

Tool property palette................................................24 

Tool Settings Guide .......................................... 14; 293 

Tracciati vettoriali 

mostra .................................................................57 

Trasferire o ripristinare le impostazioni .................. 221 

Trasportare un oggetto .......................................... 114 

U 

Unità di misura....................................................... 155 

dpi e mm ........................................................... 155 

Righelli ............................................................... 157 

Use of work ..............................................................39 

Uso con il cellulare ................................................. 234 

V 

Vanishing point ............................... Vedi Punto di fuga 

Versione 

1.x.x .....................................................................15 

2.0 .......................................................................15 

Debut – Pro - Ex .................................. Vedi Edizione 

Vignette ...................................................................69 

angoli arrotondati ................................................74 

area violetta ........................................................70 

bordo viola ..........................................................79 

disegnare con Direct draw ....................................69 

disegnare con Frame ............................................70 

dividere in parti uguali .........................................71 

Framing template ................................................70 

interrompere il bordo ..........................................72 

modificare il bordo...............................................74 

particolari ............................................................77 

spazio tra le vignette ............................................74 

spessore ..............................................................74 

unire ....................................................................73 

Visualizzare in scala di grigi ..................................... 178 

W 

Wacom Destop Center............................................ 163 

Workspace ...............................................................21 

Z 

Zero pagina ............................................................ 157 

Zoom ..................................................................... 153 



Appunti di Manga Studio/ClipStudioPaint   

300 

 


